Table of Contents
<table>
<thead>
<tr>
<th>Page</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>9</td>
<td>Playback and the Transport panel</td>
</tr>
<tr>
<td>10</td>
<td>Background</td>
</tr>
<tr>
<td>13</td>
<td>Operations</td>
</tr>
<tr>
<td>15</td>
<td>Options and Settings</td>
</tr>
<tr>
<td>19</td>
<td>Recording</td>
</tr>
<tr>
<td>20</td>
<td>Background</td>
</tr>
<tr>
<td>21</td>
<td>Basic recording methods</td>
</tr>
<tr>
<td>25</td>
<td>Audio recording specifics</td>
</tr>
<tr>
<td>37</td>
<td>MIDI Recording Specifics</td>
</tr>
<tr>
<td>47</td>
<td>Options and Settings</td>
</tr>
<tr>
<td>51</td>
<td>The Project Window</td>
</tr>
<tr>
<td>52</td>
<td>Background</td>
</tr>
<tr>
<td>54</td>
<td>Window Overview</td>
</tr>
<tr>
<td>62</td>
<td>Operations</td>
</tr>
<tr>
<td>97</td>
<td>Options</td>
</tr>
<tr>
<td>101</td>
<td>Folder tracks</td>
</tr>
<tr>
<td>102</td>
<td>About folder tracks</td>
</tr>
<tr>
<td>103</td>
<td>Using folders</td>
</tr>
<tr>
<td>109</td>
<td>Using Markers</td>
</tr>
<tr>
<td>110</td>
<td>About markers</td>
</tr>
<tr>
<td>111</td>
<td>The Marker Window</td>
</tr>
<tr>
<td>114</td>
<td>Using the Marker track</td>
</tr>
<tr>
<td>121</td>
<td>Fades and Crossfades</td>
</tr>
<tr>
<td>122</td>
<td>Creating Fades</td>
</tr>
<tr>
<td>125</td>
<td>The Fade Dialogs</td>
</tr>
<tr>
<td>128</td>
<td>Creating Crossfades</td>
</tr>
<tr>
<td>130</td>
<td>The Crossfade Dialog</td>
</tr>
<tr>
<td>133</td>
<td>Auto Fades and Crossfades</td>
</tr>
<tr>
<td>135</td>
<td>The Mixer</td>
</tr>
<tr>
<td>136</td>
<td>About this chapter</td>
</tr>
<tr>
<td>137</td>
<td>Overview</td>
</tr>
<tr>
<td>146</td>
<td>The audio channel strips</td>
</tr>
<tr>
<td>148</td>
<td>The MIDI channel strips</td>
</tr>
<tr>
<td>149</td>
<td>The Common panel</td>
</tr>
<tr>
<td>150</td>
<td>The Master section</td>
</tr>
<tr>
<td>151</td>
<td>The VST Outputs window</td>
</tr>
<tr>
<td>152</td>
<td>Basic mixing procedures</td>
</tr>
<tr>
<td>156</td>
<td>Audio specific procedures</td>
</tr>
<tr>
<td>169</td>
<td>MIDI specific procedures</td>
</tr>
<tr>
<td>171</td>
<td>Utilities</td>
</tr>
<tr>
<td>177</td>
<td>Audio effects</td>
</tr>
<tr>
<td>178</td>
<td>Background</td>
</tr>
<tr>
<td>180</td>
<td>Using effects</td>
</tr>
<tr>
<td>196</td>
<td>The included effects</td>
</tr>
<tr>
<td>197</td>
<td>Installing and managing effect plug-ins</td>
</tr>
<tr>
<td>205</td>
<td>VST Instruments</td>
</tr>
<tr>
<td>206</td>
<td>Introduction</td>
</tr>
<tr>
<td>207</td>
<td>Activating and using VST instruments</td>
</tr>
<tr>
<td>211</td>
<td>A1 Synthesizer</td>
</tr>
<tr>
<td>225</td>
<td>VB-1 Bass Synth</td>
</tr>
<tr>
<td>227</td>
<td>LM-7 Drum Machine</td>
</tr>
<tr>
<td>231</td>
<td>Surround sound (Cubase SX only)</td>
</tr>
<tr>
<td>232</td>
<td>Background</td>
</tr>
<tr>
<td>234</td>
<td>Window overview</td>
</tr>
<tr>
<td>237</td>
<td>Operations</td>
</tr>
</tbody>
</table>
Table of Contents

249 Automation
250 Background
253 Automation subtrack operations
258 Using Write/Read automation
261 Working with automation curves
268 Tips and common methods
269 Options and Settings

271 Remote Controlling the Mixer
272 Background
272 Operations
276 Remote control device specifics

293 Audio processing and functions
294 Background
295 Audio processing
314 Applying plug-ins (Cubase SX only)
317 The Offline Process History dialog
320 Detect Silence
323 The Spectrum Analyzer (Cubase SX only)
326 Statistics (Cubase SX only)

329 The Sample Editor
330 Background
330 Opening the Sample Editor
331 Window overview
336 Operations
348 Options and settings

351 The Audio Part Editor
352 Background
352 Opening the Audio Part Editor
353 Window overview
356 Operations
358 Common methods
360 Options and Settings

361 Working with hitpoints and slices
362 Background
363 Using Hitpoints
366 Editing hitpoints
375 Creating slices
376 Creating Groove Quantize maps
377 Divide audio events
377 Using the Close Gaps function

379 The Pool
380 Background
382 Window Overview
386 Operations
405 Options and Settings

407 MIDI devices and patches
408 About program change and bank select
409 Opening the MIDI Device Manager
410 Installing a MIDI Device
413 Selecting a patch for an installed device
414 Renaming patches in a device
<table>
<thead>
<tr>
<th>Page</th>
<th>Topic</th>
</tr>
</thead>
<tbody>
<tr>
<td>415</td>
<td>Defining a new device</td>
</tr>
<tr>
<td>419</td>
<td>Exporting and importing device setups</td>
</tr>
<tr>
<td>421</td>
<td>MIDI realtime parameters and effects</td>
</tr>
<tr>
<td>422</td>
<td>Introduction</td>
</tr>
<tr>
<td>423</td>
<td>The Inspector – General handling</td>
</tr>
<tr>
<td>424</td>
<td>Basic track settings</td>
</tr>
<tr>
<td>426</td>
<td>Track parameters</td>
</tr>
<tr>
<td>430</td>
<td>MIDI effects</td>
</tr>
<tr>
<td>433</td>
<td>The available effects</td>
</tr>
<tr>
<td>460</td>
<td>Managing plug-ins</td>
</tr>
<tr>
<td>461</td>
<td>The Channel section</td>
</tr>
<tr>
<td>462</td>
<td>Merge MIDI in Loop</td>
</tr>
<tr>
<td>465</td>
<td>MIDI processing and quantizing</td>
</tr>
<tr>
<td>466</td>
<td>Introduction</td>
</tr>
<tr>
<td>467</td>
<td>Quantizing</td>
</tr>
<tr>
<td>477</td>
<td>Other MIDI menu functions</td>
</tr>
<tr>
<td>483</td>
<td>Dissolve Part</td>
</tr>
<tr>
<td>485</td>
<td>The MIDI Editors</td>
</tr>
<tr>
<td>486</td>
<td>About editing MIDI</td>
</tr>
<tr>
<td>487</td>
<td>Opening a MIDI editor</td>
</tr>
<tr>
<td>488</td>
<td>The Key Editor – Overview</td>
</tr>
<tr>
<td>493</td>
<td>Key Editor operations</td>
</tr>
<tr>
<td>515</td>
<td>The Drum Editor – Overview</td>
</tr>
<tr>
<td>518</td>
<td>Drum Editor operations</td>
</tr>
<tr>
<td>521</td>
<td>Working with drum maps</td>
</tr>
<tr>
<td>530</td>
<td>Using drum name lists</td>
</tr>
<tr>
<td>532</td>
<td>The List Editor – Overview</td>
</tr>
<tr>
<td>534</td>
<td>List Editor operations</td>
</tr>
<tr>
<td>540</td>
<td>The Score Editor – Overview (Cubase SL only)</td>
</tr>
<tr>
<td>543</td>
<td>Score Editor operations (Cubase SL only)</td>
</tr>
<tr>
<td>559</td>
<td>Common MIDI editor options and settings</td>
</tr>
<tr>
<td>561</td>
<td>The Logical Editor, Transformer and Input Transformer</td>
</tr>
<tr>
<td>562</td>
<td>Introduction</td>
</tr>
<tr>
<td>564</td>
<td>Opening the Logical Editor</td>
</tr>
<tr>
<td>564</td>
<td>Window overview</td>
</tr>
<tr>
<td>565</td>
<td>Selecting a preset</td>
</tr>
<tr>
<td>566</td>
<td>Setting up filter conditions</td>
</tr>
<tr>
<td>577</td>
<td>Selecting a function</td>
</tr>
<tr>
<td>579</td>
<td>Specifying actions</td>
</tr>
<tr>
<td>583</td>
<td>Performing the Logical editing</td>
</tr>
<tr>
<td>584</td>
<td>Working with presets</td>
</tr>
<tr>
<td>585</td>
<td>The Input Transformer</td>
</tr>
<tr>
<td>589</td>
<td>The Tempo Track Editor</td>
</tr>
<tr>
<td>590</td>
<td>Background</td>
</tr>
<tr>
<td>590</td>
<td>Opening the Tempo Track Editor</td>
</tr>
<tr>
<td>591</td>
<td>Window overview</td>
</tr>
<tr>
<td>594</td>
<td>Operations</td>
</tr>
<tr>
<td>599</td>
<td>Options and settings</td>
</tr>
<tr>
<td>600</td>
<td>The Beat Calculator</td>
</tr>
<tr>
<td>603</td>
<td>The Project Browser</td>
</tr>
<tr>
<td>604</td>
<td>Background</td>
</tr>
<tr>
<td>604</td>
<td>Opening the Project Browser</td>
</tr>
<tr>
<td>604</td>
<td>Window Overview</td>
</tr>
<tr>
<td>605</td>
<td>Navigating in the Browser</td>
</tr>
<tr>
<td>607</td>
<td>Customizing the View</td>
</tr>
<tr>
<td>607</td>
<td>About the Sync Selection option</td>
</tr>
<tr>
<td>608</td>
<td>Editing audio tracks</td>
</tr>
<tr>
<td>610</td>
<td>Editing MIDI tracks</td>
</tr>
</tbody>
</table>
1

Playback and the Transport panel
Background

This chapter describes the various methods available for controlling Playback and Transport functions in Cubase SX/SL.

The Transport panel

Below you can find a brief description of each item on the Transport panel.
The main Transport functions (Play/Stop/Cycle/Record) are also available on the toolbar.

In addition, various play options are available on the Transport menu.

Hiding and showing

The Transport panel is shown by default when you launch a new project. To hide or show it, select the “Transport Panel” item from the Transport menu (or use the corresponding key command, by default [F2]).

About Preroll and Postroll

These items are described in the Recording chapter – see page 48.

Resizing

You can change the size of the Transport panel by deciding which parts of it you wish to be visible. If you right-click (Win) or [Ctrl]-click (Mac) anywhere within the Transport panel area, a pop-up menu will appear. On this menu, you can check or uncheck elements of the Transport panel as desired.
The numeric keypad

In the default Key Command settings, the numeric keypad on the computer keyboard is assigned various Transport panel operations. The keypads are slightly different on PC and Macintosh computers:

**PC:**

- **Cycle On/Off**
- **Record**
- **Rewind On/Off**
- **Fast Forward On/Off**
- **Play**
- **Go to right locator**
- **Go to left locator**
- **Go to Marker number 3-9**
- **Stop**
- **Return to Zero**

**Mac:**

- **Cycle On/Off**
- **Record**
- **Rewind On/Off**
- **Fast Forward On/Off**
- **Play**
- **Go to right locator**
- **Go to left locator**
- **Go to Marker number 3-9**
- **Stop**
- **Return to Zero**
Operations

Setting the Project cursor position

There are several methods you can use to move the project cursor position:

- By using Fast Forward and Rewind.
- By dragging the project cursor.
- By clicking in the ruler.
  Double clicking in the ruler will start or stop playback, moving the cursor at the same time.
- If the option “Locate When Clicked in Empty Space” is activated in the Preferences (Transport page) you can click anywhere in an empty section of the Project window to move the cursor position.
- By changing the value in the position display.
- By using the position slider.
  The range of the slider relates to the Length setting in the Project Setup dialog. Hence, moving the slider all the way to the right will take you to the end of the project.
- By using the nudge position buttons (see page 14).
- By using markers (see page 110).
- By using playback options (see page 16).
- By using functions on the Transport menu.

The following functions are available:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Locate Selection</td>
<td>Moves the project cursor to the beginning of the current selection. For this to be available, you must have selected one or more events or parts, or made a selection range.</td>
</tr>
<tr>
<td>Locate Next/Previous Marker</td>
<td>This moves the project cursor to the closest marker to the right or left (see page 110).</td>
</tr>
<tr>
<td>Locate Next/Previous Event</td>
<td>This moves the project cursor forwards or backwards respectively, to the closest beginning or end of any event on the selected track(s).</td>
</tr>
</tbody>
</table>

- If Snap is activated when dragging the project cursor, the Snap value is taken into account. This can be helpful for finding exact positions quickly.
About the Transport panel display format

The time unit shown in the ruler can be independent from the time unit shown in the Transport panel. This means that you can display time-code in the transport position display and bars and beats in the ruler, for example. The following rules apply:

- If you change the display format from the Transport panel, this will apply "globally" in the project. This is the same as changing the display format in the Project Setup. Thus, to have different display formats in the ruler and the Transport panel, you should change the format in the ruler.

- The Transport panel display format is set on the pop-up menu to the right in the position display.

- The setting here also determines the time format displayed for the left and right locators.

Using the nudge position buttons

The + and – buttons to the left of the Position slider allows you to nudge the project cursor position to the right or left, respectively. The increments depend on the display format selected on the Transport panel:

- If the Seconds format is selected, the position will be nudged by whole seconds.
- If any frame-based format is selected, the position will be nudged by frames.
- If Bars+Beats is selected, the position will be nudged by ticks. There are 480 ticks per beat.
- If the Samples format is selected, the position will be nudged by samples.
Options and Settings

The “Return to Start Position on Stop” preference

You have the option to set the behavior of the project cursor when you press Stop. This is done in the Preferences dialog on the Transport page:

1. Open the Preferences dialog from the File menu (on the Mac, the Preferences are located on the Cubase SX/SL menu) and select the Transport page.

2. Activate or deactivate the “Return to Start Position on Stop” item.
   - If activated (ticked), the project cursor will automatically return to the position where recording or playback last was activated from, when you press Stop.
   - If deactivated, the project cursor will remain at the position where you hit Stop. Pressing Stop again will return the project cursor to the position where recording or playback last was activated from.

3. Click OK to close the Preferences dialog and apply the changes.

About track disable/enable

For audio tracks, the track context menu contains an item named “Disable Track”. This shuts down all disk activity for the track, as opposed to using Mute, which merely turns down the output volume for a track. If you often record “alternative takes”, you can easily build up a large number of takes that are actually still “playing back” from the hard disk during playback, although the tracks may be muted. This puts an unnecessary load on your disk system, so using “Disable Track” is recommended for such situations.

- Select “Disable Track” when you have recorded many alternative takes of a performance on separate tracks, that you want to keep for later evaluation and/or editing. Select “Enable Track” from the track context menu to re-enable disabled tracks.
Playback functions

Apart from the standard transport controls on the Transport panel, you can also find a number of functions that can be used to control playback on the Transport menu. The items have the following functionality:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Play from Selection Start</td>
<td>This activates playback from the beginning of the currently selected range.</td>
</tr>
<tr>
<td>Play from Selection End</td>
<td>This activates playback from the end of the currently selected range.</td>
</tr>
<tr>
<td>Play until Selection Start</td>
<td>This activates playback two seconds before the start of the currently selected range and stops at the selection start.</td>
</tr>
<tr>
<td>Play until Selection End</td>
<td>This activates playback two seconds before the end of the selected range and stops at the selection end.</td>
</tr>
<tr>
<td>Play until Next Marker</td>
<td>This activates playback from the project cursor and stops at the next marker.</td>
</tr>
<tr>
<td>Play Selection Range</td>
<td>This activates playback from the start of the selected range and stops at the selection end.</td>
</tr>
<tr>
<td>Loop Selection</td>
<td>This activates playback from the start of the selected range and continuously starts over again upon reaching the selection end.</td>
</tr>
</tbody>
</table>

⚠ The functions listed above (except “Play to Next Marker”) are only available if you have selected one or more events or made a selection range.
**About Chase**

Chase is basically a function that makes sure your MIDI instruments sound as they should when you locate to a new position and start playback. This is accomplished by having the program transmitting a number of MIDI messages to your instruments each time you move to a new position in the project, making sure all MIDI devices are set up correctly with regard to Program Change, controller messages (such as MIDI Volume) etc.

For example, let’s say you have a MIDI track with a Program Change event inserted at the beginning. This event makes a synth switch to a piano sound.

In the beginning of the first chorus you have another Program Change event which makes the same synth switch to a string sound.

You now play back the song. It begins with the piano sound and then switches to the string sound. In the middle of the chorus you stop and rewind to some point between the beginning and the second Program Change. The synth will now still play the string sound although in this section it really should be a piano!

The Chase function takes care of that. If Program Change events are set to be chased, Cubase SX/SL will track the music back to the beginning, find the first Program Change and send this out, so that the synth is set to the right sound.

The same thing can apply to other event types as well. The Chase Events Filter settings in the Preferences dialog (MIDI-Chase Events Filter page) determine which event types will be chased when you locate to a new position and start playback.

- Event types for which the checkbox is activated in this dialog will not be chased.
2

Recording
Background

This chapter describes the various recording methods that you can use in Cubase SX/SL. As it is possible to record both audio and MIDI tracks in Cubase SX/SL, both of these recording methods are covered in this chapter.

Before you start

This chapter assumes that you are reasonably familiar with certain basic recording concepts, and that the following initial preparations have been made:

• You have properly set up, connected and calibrated your audio hardware.
  This is described in the Getting Started book.

• You have opened a project and set the project setup parameters to your specifications.
  Project Setup parameters determine the record format, sample rate, project length etc. that affect the resulting audio recordings you make during the course of the project. See page 62.

• If you plan to record MIDI, your MIDI equipment should be set up and connected correctly.
  See the Getting Started book.
Basic recording methods

This section describes the general methods used for recording. However, there are additional preparations and procedures that are specific to audio and MIDI recording respectively. Make sure to read these sections before you start recording (see page 25 and page 37).

Record enabling a track

Cubase SX/SL can record on a single track or on several tracks (audio and/or MIDI) simultaneously. To make a track ready for recording, click the Record Enable button for the track in the Track list, in the Inspector or in the Mixer. When activated, the button(s) turn red, indicating record ready mode.

- If the option “Enable Record on Selected Track” is activated in the Preferences dialog (Editing page), tracks are automatically record enabled when you select them in the Track list.

- The exact number of audio tracks you can record simultaneously depends on your computer CPU and hard disk performance. Furthermore, it would be pointless to record more audio tracks than you have audio inputs, since this would only result in duplicate tracks and audio files (see page 25).
Manually activating recording

You activate recording by clicking the Record button on the Transport panel or toolbar, or by using the corresponding key command (by default [*] on the numeric keypad).

Recording can be activated from Stop mode (from the current cursor position or from the left locator) or during playback:

- If you activate recording from Stop mode, and the option “Start Record at Left Locator” is activated on the Transport menu, recording will start from the left locator. The preroll setting or the metronome count-in will be applied (see page 48).
- If you activate recording from Stop mode, and the “Start Record at Left Locator” is deactivated, recording will start from the current project cursor position.
- If you activate recording during playback, Cubase SX/SL will immediately enter Record mode and start recording at the current project cursor position. This is known as “manual punch in”.

Automatically activating recording

Cubase SX/SL can automatically switch from playback to recording at a given position. This is known as “automatic punch in”. A typical use for this would be if you need to replace a section of a recording, and want to listen to the previously recorded audio up to the recording start position.

1. Set the left locator to the position at which you want recording to start.
2. Activate the Punch In button on the Transport panel.

Punch In activated.

3. Activate playback from some position before the left locator.
   When the project cursor reaches the left locator, recording is automatically activated.
**Stopping recording**

Again, this can be done automatically or manually:

- If you click the Stop button on the Transport panel (or use the corresponding key command, by default [0] on the numeric keypad), recording is deactivated and Cubase SX/SL goes to Stop mode.

- If you click the Record button or use the key command for recording, by default [*], recording is deactivated but playback continues. This is known as “manual punch out”.

- If the Punch Out button is activated on the Transport panel, recording will be deactivated when the project cursor reaches the right locator. This is known as “automatic punch out”. By combining this with automatic punch in, you can set up a specific section to record – again very useful if you want to replace a certain part of a recording. See also page 47.

Punch In and Out activated.
Cycle recording

Cubase SX/SL can record and play back in a cycle — a loop. You specify where the cycle starts and ends by setting the left and right locators. When cycle is active, the selected section is seamlessly repeated until you hit Stop or deactivate cycle mode.

• To activate cycle mode, click the cycle button on the Transport panel. If you now activate Play, the section between the left and right locator is repeated indefinitely until you stop.

![Cycle activated.](image)

• To record in Cycle mode, you can start recording from the left locator, from before the locators or from within the cycle, from Stop mode or during playback. As soon as the project cursor reaches the right locator, it will jump back to the left locator and continue recording a new lap.

• The results of cycle recording are different for audio (see page 34) and MIDI (see page 42).
Audio recording specifics

Activating and selecting VST inputs

Cubase SX/SL allows you to use audio hardware with multiple inputs and route different inputs to different audio channels. To activate inputs, first open the VST Inputs window on the Devices menu.

Note that active inputs use processing power! Make it a habit to only activate audio inputs that you actually intend to use.

The VST Inputs window is divided into three columns:

- The left column contains the available physical input ports on the audio hardware.
- The middle column indicates which input pairs are activated. You turn input pairs on or off by clicking the buttons in this column.
- The right column shows the names that will be used for each input throughout the program. You can rename an input by clicking in this column and typing a new name.

If you deactivate an input pair that is currently used (selected as input source for one or several audio channels), you will be asked whether you want Cubase SX/SL to remap these inputs (change the input source selection for the channels in question).
Routing activated VST inputs to a channel

Selecting an input source for a track’s corresponding channel is done in the Mixer. Proceed as follows:

1. Open the Mixer from the Devices menu.
2. Locate the mixer channel strip for the audio track on which you plan to record.
3. Pull down the input pop-up for the channel strip and select the input to which the signal source you want to record is connected.

Selecting a recording file format

The format of recorded files is set in the Project Setup dialog on the Project menu. There are three settings: sample rate, record format (bit depth) and record file type. While the sample rate is set once and for all when you start working on a new project, the bit depth and file type can be changed at any time.
Record format (bit depth)

- The record format setting is disregarded if you activate the TrueTape recording mode (see page 28).

The available options are 16 bit, 24 bit and 32 bit float. Use the following guidelines:

- Normally, select record format according to the bit depth delivered by your audio hardware.
  For example, if your audio hardware has 20 bit A/D converters (inputs), you may want to record at 24 bit resolution, to capture the full bit depth. On the other hand, if your hardware has 16 bit inputs, it’s pointless to record with a higher bit depth – this will only make the audio files larger, with no difference in audio quality. The exception to this is the TrueTape recording mode, which produces 32 bit float files but is fully usable with 16 or 24 bit audio hardware – see below.

- The higher the bit depth, the larger the files and the more strain is put on the disk system.
  If this is an issue, you may want to lower the record format setting.

Record file type

The Record File Type setting determines which type of files will be created when you record:

<table>
<thead>
<tr>
<th>File Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wave File</td>
<td>Wave files have the extension &quot;.wav&quot; and are the most common file format on the PC platform.</td>
</tr>
<tr>
<td>Broadcast Wave File</td>
<td>In terms of audio content, the same as regular Wave files, but with embedded text strings for supplying additional information about the file (see below).</td>
</tr>
<tr>
<td>AIFF File</td>
<td>Audio Interchange File Format, a standard defined by Apple Computer Inc. AIFF files have the extension &quot;.aif&quot; and are used on most computer platforms.</td>
</tr>
</tbody>
</table>

- If you select Broadcast Wave File, you can specify Author, Description and Reference text strings that will be embedded in the recorded file.
  This is done on the Audio—Broadcast Wave page in the Preferences dialog.
Activating TrueTape™ (Cubase SX only)

TrueTape is a unique Steinberg technology that emulates the behavior of a professional analog tape recorder. While digital audio recording has a number of benefits, some may perceive digital sound to be somewhat “sterile” and “cold” compared to high quality analog recordings. The TrueTape feature remedies this problem by recreating the sound of analog tape saturation at the recording stage.

Note:

- **TrueTape produces 32 bit float files.**
  The hard disk and processor speed considerations of the regular 32 bit format apply here as well.

- **Unlike the regular 32 bit float record format, you can use the TrueTape mode even if your audio hardware only supports 16 bit resolution.**
  This is because the TrueTape feature converts the signal to 32 bit float format, and adds audio information in the floating point domain.

You activate and set up TrueTape in the following way:

1. Pull down the Devices menu and select TrueTape.
   The TrueTape panel appears.

2. Click the power button to activate TrueTape.
   In Cubase SX/SL for Windows, the power button is located in the top left corner, in Cubase SX/SL for Mac OS X the power button is located in the lower left corner.

3. Use the Drive control to adjust the amount of tape saturation effect to your liking.
   If you are monitoring through Cubase SX/SL, you will hear how the changes color the sound of the monitored signal. This allows you to try out the settings before actually recording.
The pop-up menu in the TrueTape panel allows you to select one of four Drive presets, for quick changes. These contain no “hidden parameters” – selecting the “24dB Super Saturation” preset is the same as moving the Drive control all the way to the right. Note that any adjustments you make to the Drive control are automatically applied to the selected preset. You can also rename a preset by clicking and typing in a new name.

Raising the Drive level will also raise the level in the audio file, and you can easily reach 0.0 (clipping) on the input level meters. Unlike when recording in 16 bit format, this is nothing to worry about – it is virtually impossible to get digital distortion in a 32 Bit float file. However, you may want to check your input levels with TrueTape turned off to make sure the clipping doesn’t occur in the audio hardware.

Setting up tracks for mono or stereo recording

One of the initial decisions you have to make before you start recording audio is whether the recording should be stereo or mono. This is determined by the stereo/mono status of the audio track selected for recording:

To set a track to mono or stereo, click the Stereo/Mono button in the Track list or in the Inspector. A lit stereo button indicates a stereo track, while a dark mono button indicates a mono track.

For more details about mono/stereo track compatibility, see page 76.
Monitoring

In this context, "monitoring" means listening to the input signal during recording. There are three fundamentally different ways to do this: via Cubase SX/SL, externally (by listening to the signal before it reaches Cubase SX/SL) or by using ASIO Direct Monitoring (which is a combination of both of the other methods – see page 31).

Monitoring via Cubase SX/SL

If you monitor via Cubase SX/SL, the input signal is mixed in with the audio playback. The advantage of this is that you can adjust the monitoring level and panning in the Mixer, and add effects and EQ to the monitor signal just as during playback. The disadvantage of monitoring via Cubase SX/SL is that the monitored signal will be delayed according to the latency value (which depends on your audio hardware and drivers). Therefore, monitoring via Cubase SX/SL requires an audio hardware configuration with a low latency value (see the Getting Started book).

When monitoring via Cubase SX/SL, you can select one of four modes in the Preferences dialog (VST page):

- **Manual.**
  This option allows you to turn input monitoring on or off by clicking the Monitor button in the Inspector, the Track list or in the Mixer.

- **While Record Enabled.**
  With this option you will hear the audio source connected to the channel input whenever the track is record enabled.

- **While Record Running.**
  This option switches to input monitoring only during recording.

- **Tapemachine Style.**
  This option emulates standard tapemachine behavior: input monitoring in stop mode and during recording, but not during playback.
External monitoring

External monitoring (listening to the input signal before it goes into Cubase SX/SL) requires some sort of external mixer for mixing the audio playback with the input signal. This can be a stand-alone physical mixer or a mixer application for your audio hardware, if this has a mode in which the input audio is sent back out again (usually called “Thru”, “Direct Thru” or similar).

When using external monitoring, you cannot control the level of the monitor signal from within Cubase SX/SL, or add VST effects or EQ to the monitor signal. The latency value of the audio hardware configuration does not affect the monitor signal in this mode.

• If you want to use external monitoring, you need to make sure that monitoring via Cubase SX/SL isn’t activated as well.
  Select the “Manual” monitoring mode in the Preferences dialog (VST page) and simply don’t activate the Monitor buttons.

ASIO Direct Monitoring

If your audio hardware is ASIO 2.0 compatible, it may support ASIO Direct Monitoring. In this mode, the actual monitoring is done in the audio hardware, by sending the input signal back out again. However, monitoring is controlled from Cubase SX/SL. This means that the audio hardware’s direct monitoring feature can be turned on or off automatically by Cubase SX/SL, just as when using internal monitoring.

• To activate ASIO Direct Monitoring, open the Device Setup dialog on the Devices menu and use the Direct Monitoring checkbox on the Setup tab for the VST Multitrack device.
  If the checkbox is greyed out, this means that your audio hardware (or its current driver) doesn’t support ASIO Direct Monitoring. Consult the audio hardware manufacturer for details.

• When ASIO Direct Monitoring is activated, you can select a monitoring mode in the Preferences dialog (VST page), as when monitoring via Cubase SX/SL (see page 30).

• Depending on the audio hardware, it may also be possible to adjust monitoring level and panning from the Mixer.
  Consult the documentation of the audio hardware if in doubt.

• VST effects and EQ cannot be applied to the monitor signal in this mode, since the monitor signal doesn’t pass through Cubase SX/SL.
• Depending on the audio hardware, there may be special restrictions as to which audio outputs can be used for direct monitoring. For details on the routing of the audio hardware, see its documentation.
• The latency value of the audio hardware configuration does not affect the monitor signal when using ASIO Direct Monitoring.

Setting input levels

When monitoring a channel signal source in stop mode, the meters show the level at the input selected for the audio channel. So if the connected signal source is sounding you should see activity in both the Track list meter and in the mixer strip for that channel.

❐ Note that it is not possible to set input gain with the mixer fader!

Check the levels coming in to Cubase SX/SL, and if necessary, adjust the input level in one of the following ways:

• Adjust the output level of the sound source or external mixer.
• Use the audio hardware’s own application program to set the input levels, if this possibility is provided.
  See the documentation of the audio hardware.
• If your audio hardware supports the ASIO Control Panel function, it may be possible to make input level settings.
  To open the ASIO Control Panel, open the Device Setup dialog on the Devices menu and click the Control Panel button on the Setup tab for the VST Multitrack device.

❐ Input levels should be as high as possible, without exceeding 0dB.
Recording

Recording is done using any of the general recording methods (see page 21). After you finish recording, an audio file has been created in the Audio folder within the projects folder. In the Pool, an audio clip is then created for the audio file, and an audio event that plays the whole clip appears on the recording track. Finally, a waveform image is calculated for the audio event. If the recording was very long, this may take a while.

- If the option "Create Images During Record" is activated in the Preferences dialog (Audio page), the waveform image will be calculated and displayed during the actual recording process. This should only be activated if you have a fairly powerful computer system, since the real-time calculation uses some extra processing power.

Undoing recording

If you decide that you don’t like what you just recorded, you can delete it by selecting Undo from the Edit menu. The following will happen:

- The event(s) you just created will be removed from the Project window.
- The audio clip(s) in the Pool will be moved to the Trash folder.
- The recorded audio file(s) will not be removed from the hard disk. However, since their corresponding clips are moved to the Trash folder, you can delete the files by opening the Pool and selecting “Empty Trash” from the Pool menu.

About overlap and audio tracks

If you record again where something has already been recorded, you get a new event that overlaps the previous one(s). When you play back, only the events that are actually visible are played back.

[One audio track can only play back one audio event at a time.]

The functions “Move to Front” and “Move to Back” on the Edit menu (see page 82) are useful for managing overlapping events, as is the “To Front” function (see below).
Recording audio in cycle mode

If you are recording audio in Cycle mode, the result depends on the “Cycle Record Mode” setting in the Preferences dialog (Audio page):

Create Events

When Cycle Record Mode is set to “Create Events”, the following will happen when you record audio in Cycle mode:

- One continuous audio file is created during the entire recording process.
- For each recorded lap of the Cycle, one audio event is created. The events will have the name of the audio file plus the text “Take *”, where “*” indicates the number of the take.
- The last take (the last recorded lap) will be on top (and will thus be the one you hear when you activate playback).

To select another take for playback, proceed as follows:

1. Right-click (Win) or [Ctrl]-click (Mac) the event and select “To Front” from the pop-up menu that appears. A submenu appears, listing all the other (obscured) events.

2. Select the desired take. The corresponding event is brought to front.
This method allows you to quickly combine the best parts of each take, in the following way:

1. Use the Scissors tool to split the events in several sections, one for each part of the take.
   For example, if you recorded four lines of vocals (in each take), you can split the events so that each line gets a separate event.

   ![Image](image)

   The events after splitting. Note that since the original take events overlap each other, clicking with the Scissors tool will split all takes at the same position.

2. For each section of the take, use the “To Front” function to bring the best take to the front.
   This way, you can quickly combine the best sections of each take, using the first vocal line from one take, the second line from another take and so on.

   You can also compile a “perfect” take in the Audio Part Editor, as described on page 358.

Create Regions

When Cycle Record Mode is set to “Create Regions”, the following will happen when you record audio in Cycle mode:

- One continuous audio file is created during the entire recording process.
- The audio event in the Project window displays the name of the audio file plus the text “Take *” (with “*” indicating the number of the last completed Cycle lap).
- If you play back the recorded event, you will only hear what was recorded during the last lap of the Cycle recording.
  The previous “takes” recorded in the Cycle are still available, however.
• The audio clip is divided into regions (called takes), one for each lap of the Cycle that was recorded.
   If you locate the audio file you just recorded in the Pool, and click on the plus sign beside it, you can see the regions that have been created, one for each lap of the Cycle that was completed during recording.

   ![Screenshot of Pool window with regions labeled Take 1 to Take 4]

   “Take” regions in the Pool window.

   To play back the different “takes”, proceed as follows:

   1. In the Project window, right-click (Win) or [Ctrl]-click (Mac) the event that was created during Cycle recording. The Quick menu appears.
   2. Select the “Set To Region” menu item. A submenu appears with the takes you recorded during Cycle record.
   3. Now you can freely select any of the takes from the submenu and it will replace the previous take event in the Project window.

   ![Screenshot of Quick menu with “Set To Region” and takes]

   Use this method to listen through the various takes. Select the best single take, or compile a “perfect” take by cutting out the best bits from each take and putting them together (see page 359).

**Create Events + Regions**

In this mode, both events and regions are created. If you work with the takes as events in this mode, you can edit the events freely (e.g. splitting them as described on page 34). However, in case you want to go back to the original takes, they are still available as regions (on the “Set To Region” submenu, in the Pool or in the Sample Editor).
MIDI Recording Specifics

Activating MIDI Thru

As described in the Getting Started book, the normal way to work with MIDI is to have MIDI Thru activated in Cubase SX/SL, and Local Off selected in your MIDI Instrument(s). In this mode, everything you play during recording will be “echoed” back out again on the MIDI output and channel selected for the recording track.

1. Make sure the option “MIDI Thru Active” is activated in the Preferences dialog (MIDI page).

2. Record Enable the track(s) on which you want to record.

Now, incoming MIDI is “echoed” back out again, for all Record Enabled MIDI tracks.

- If you just want to use the thru function for a MIDI track without recording, activate the monitor button for the track instead.

This is useful e.g. if you want to try out different sounds or play a VST instrument in real time without recording your playing.

Setting MIDI channel, input and output

Setting the MIDI channel in the instrument

Most MIDI synthesizers can play several sounds at the same time, each on a different MIDI channel. This is the key to playing back several sounds (bass, piano etc.) from the same instrument. Some devices (such as General MIDI compatible sound modules) always receive on all 16 MIDI channels. If you have such an instrument, there’s no specific setting you need to make in the instrument. On other instruments you will have to use the front panel controls to set up a number of “Parts”, “Timbres” or similar so that they receive on one MIDI channel each. See the manual that came with your instrument for more information.
Naming MIDI ports in Cubase SX/SL

MIDI inputs and outputs can often be shown with unnecessarily long and complicated names. If you wish, you can rename your MIDI ports to more descriptive names:

1. Open the Device Setup dialog from the Devices menu.
2. Select the Windows MIDI or DirectMusic (Windows) or MIDI System (Mac OS X) device in the Device list.
   The available MIDI inputs and outputs are listed under the Setup tab. Under Windows, which device to choose depends on your system.
3. To change the name of a MIDI port, click in the Device column and type in a new name.
   After closing the dialog, the new names will appear on the MIDI “in:” and “out:” pop-ups.

Setting the MIDI input in the Inspector

You select MIDI inputs for tracks in the Inspector – the area to the left of the track list in the Project window:

1. If the Inspector is hidden, click the Show Inspector button on the toolbar.
2. Select the track by clicking in the Track list.
   The Inspector shows the settings for the selected track (for details, see page 56).
3. Click the tab in the upper right corner of the Inspector to make sure the topmost section is shown.

4. Pull down the “in” pop-up and select an input. The available MIDI inputs are shown. The items on the menu depend on the type of MIDI interface you are using etc.

- If you select the “All MIDI Inputs” option, the track will receive MIDI data from all available MIDI inputs.
- If you hold down [Ctrl]/[Command] and select a MIDI input, this is selected for all MIDI tracks.
Setting the MIDI channel and output

The MIDI channel and output settings determine where the recorded MIDI is routed during playback, but are also relevant for MIDI Thru in Cubase SX/SL. Channel and output can be selected in the Track list or in the Inspector.

1. To show the settings in the Inspector, proceed as when selecting a MIDI input (see above).

2. Pull down the “out:” pop-up and select an output. The available MIDI outputs are shown. The items on the menu depend on what type of MIDI interface you are using etc.

   - If you hold down [Ctrl]/[Command] and select a MIDI output, this is selected for all MIDI tracks.

3. Use the “chn” pop-up menu to select a MIDI channel for the track.

   - If you set the track to MIDI channel “Any”, each MIDI event on the track will be sent out on the channel stored in the event itself. In other words, the MIDI will be played back on the channel(s) used by the MIDI input device (the MIDI instrument you play during recording).
Selecting a sound

You can select sounds from within Cubase SX/SL, by instructing the program to send Program Change and Bank Select messages to your MIDI device. This is done using the “prg” and “bnk” value fields in the Inspector or Track list.

However, it is also possible to select sounds by name. For descriptions of how to set this up, see page 408.

Recording

Recording MIDI is done according to the basic recording methods (see page 21). When you finish recording, a part containing MIDI events is created in the Project window.

About overlap and the Rec Mode setting

MIDI tracks are different from audio tracks when it comes to overlapping parts:

• **All events in overlapping parts are always played back.**
  If you record several parts at the same locations (or move parts so that they overlap), you will hear the events in all parts on playback, even though some of the parts are obscured in the Project window.

  When recording overlapping parts, the result depends on the Rec Mode setting on the Transport bar:

  • If Rec Mode is set to “Normal”, overdub recording works as with audio tracks, i.e. if you record again where something has already been recorded, you get a new part that overlaps the previous one(s).

  • If Rec Mode is set to “Merge”, the overdubbed events are added to the existing part.
About punch in and out on MIDI tracks

Performing and setting up manual and automatic punch in/out recording for MIDI tracks is done in exactly the same way as for audio tracks. There is one thing to note, however:

- Punching in and out on recordings with Pitch Bend or controller data (modulation wheel, sustain pedal, volume etc.), may lead to strange effects (apparently hanging notes, constant vibrato etc.). If this happens, you may need to use the Reset command on the MIDI menu (see page 44).

About the Auto Quantize function

If Auto Quantize is activated on the Transport panel (the “AQ” button), the notes you record are automatically quantized according to the current Quantize settings. For more information about quantizing, see page 467.

Recording MIDI in Cycle mode

When you record MIDI in Cycle mode, the result depends on which Cycle Rec mode is selected on the Transport panel:

**Cycle Rec mode: Mix**

For each completed lap, everything you record is added to what was previously recorded, in the same part. This is useful for building up rhythm patterns, for example. Record a hi-hat part on the first lap, the bass drum part on the second lap etc.

**Cycle Rec mode: Overwrite**

For each completed lap, everything you record replaces what was previously recorded in the same part.
Recording different types of MIDI messages

- You can decide exactly which event types should be recorded by using the MIDI filters – see page 46.

Notes

With MIDI, when you press and release a key on your synth or other MIDI keyboard, a Note On (key down) and a Note Off (key up) message are sent out. The MIDI note message also contains the information which MIDI channel was used. Normally, this information is overridden by the MIDI channel setting for the track, but if you set the track to MIDI channel “Any”, the notes will be played back on their original channels.

Continuous Messages

Pitch bend, aftertouch and controllers (like modulation wheel, sustain pedal, volume etc.) are considered as MIDI Continuous events (as opposed to the momentary key down and key up messages). If you move the Pitch bend wheel on your synthesizer while recording, this movement is recorded together with the key (Note On and Note Off messages), just as you’d expect. But the continuous messages can also be recorded after the notes have been recorded (or even before). They can also be recorded on their own tracks, separately from the notes to which they belong.

Say for instance that you record one or several bass parts on track 2. If you now set another track, like track 55, to the same output and MIDI channel as track 2 you can make a separate recording of just pitch bends for the bass parts. This means that you activate recording as usual and only move the pitch bend wheel during the take. As long as the two tracks are set to the same output and MIDI channel it will appear to the MIDI instrument as if the two recordings were made at the same time.
Program Change Messages

Normally, when you switch from one program to another on your keyboard (or whatever you use to record), a number corresponding to that program is sent out via MIDI as a Program Change message. These can be recorded on the fly with the music, recorded afterwards on a separate track, or manually entered in the MIDI or List Editors.

System Exclusive Messages

System Exclusive (SysEx) is a special type of MIDI message used to send things that only make sense to a unit of a certain make and type. Every major MIDI manufacturer has its own SysEx identity code and these are part of practically all SysEx messages. SysEx can be used to transmit a list of the numbers that make up the settings of one or more sounds in a synth. For more about viewing and editing SysEx messages, see page 617.

The Reset function

The Reset function on the MIDI menu sends out note-off messages and resets controllers on all MIDI channels. This is sometimes necessary if you experience hanging notes, constant vibrato, etc.

- Cubase SX/SL can also automatically perform a MIDI Reset after recording, during playback (after each part) and/or on stop.
  You turn these functions on or off in the Preferences dialog (MIDI page).
MIDI Preferences

The following options and settings in the Preferences dialog (MIDI page) affect MIDI recording and playback:

“Note On” Priority

When this is activated, MIDI Note On messages are given priority over other types of MIDI messages, ensuring tight timing even if you use a lot of continuous MIDI data.

Length Correction

Adjusts the length of notes so that there always is a short time between the end of one note and the start of another (of the same pitch and on the same MIDI channel).

Snap Record Parts to Bars

When this is activated, recorded MIDI parts will automatically be lengthened to start and end at whole bar positions. If you are working in a Bars+Beats-based context, this can make editing (Moving, Duplicating, Repeating, etc.) easier.

Solo Record in Editors

If this is activated and you open a part for editing in a MIDI editor, its track is automatically Record Enabled. Furthermore, Record Enable is deactivated for all other MIDI tracks until you close the editor again.

This makes it easier to record MIDI data when you're editing a part – you will always be sure the recorded data ends up in the edited part and not on any other track.

Record Catch Range

When you record starting at the left locator, this setting helps you make sure the very start of the recording is included. A very annoying scenario is when you have recorded a perfect MIDI take, only to find out that the very first note wasn’t included – because you started playing a little bit too early! If you raise the Record Catch Range, Cubase SX/SL will catch the events played just before the recording start point, eliminating this problem.
Filtering MIDI

The MIDI–Filter page in the Preferences dialog allows you to prevent certain MIDI messages from being recorded and/or “thruput” (echoed by the MIDI Thru function).

The dialog is divided into four sections:

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>Activating any of these options prevents that type of MIDI message from being recorded. It will, however, be thruput, and if already recorded, it will play back normally.</td>
</tr>
<tr>
<td>Thru</td>
<td>Activating any of these options prevents that type of MIDI message from being thruput. It will, however, be recorded and played back normally.</td>
</tr>
<tr>
<td>Channels</td>
<td>If you activate a channel button, no MIDI messages on that MIDI channel will be recorded or thruput. Already recorded messages will, however, be played back normally.</td>
</tr>
<tr>
<td>Controller</td>
<td>Allows you to prevent certain MIDI controller types from being recorded or thruput. To filter out a controller type, select it from the list at the top of the section and click “Add”. It will appear on the list below. To remove a controller type from the list (allow it to be recorded and thruput), select it in the lower list and click “Remove”.</td>
</tr>
</tbody>
</table>
Options and Settings

Recording-related Preferences

A couple of settings in the Preferences dialog (Transport page) are relevant for recording. Set these according to your preferred method of work:

Deactivate Punch In on Stop

If this is activated, punch in on the Transport panel is automatically deactivated whenever you enter Stop mode.

Stop after Automatic Punchout

If this is activated, playback will automatically stop after automatic punch out (when the project cursor reaches the right locator and punch out is activated on the Transport panel). If the postroll value on the Transport panel is set to a value other than zero, playback will continue for the set time before stopping (see below).
About Preroll and Postroll

The preroll and postroll value fields on the Transport panel have the following functionality:

- By setting a preroll value, you instruct Cubase SX/SL to “roll back” a short section whenever playback is activated. This applies whenever you start playback, but is perhaps most relevant when recording from the left locator (punch in activated on the Transport panel) as described below.

- By setting a postroll value, you instruct Cubase SX/SL to play back a short section after automatic punch out, before stopping. This is only relevant when punch out is activated on the Transport panel and “Stop after Automatic Punchout” is activated in the Preferences dialog (Transport page).

- To enable or disable the pre/postroll function, select the option “Use Pre/Post-Roll” on the Transport menu.

An example:

1. Set the locators to where you want to start and end recording.
2. Activate punch in and punch out on the Transport panel.
3. Activate the option “Stop after Automatic Punchout” in the Preferences dialog (Transport page).
4. Set suitable preroll and postroll times by clicking in the corresponding fields on the Transport panel and typing in time values.
5. Make sure Click is deactivated on the Transport panel. If the Click is activated when you record from the left locator in stop mode, the preroll setting is disregarded and the metronome precount is used instead (see page 49).
6. Pull down the Transport menu and tick the option “Use Pre/Post-Roll”.
7. Activate recording.

The project cursor “rolls back” by the time specified in the preroll field and playback starts. When the cursor reaches the left locator, recording is automatically activated. When the cursor reaches the right locator, recording is deactivated, but playback continues for the time set in the postroll field before stopping.
Using the metronome

The metronome will output a click that can be used as a timing reference. The two parameters that govern the timing of the metronome are tempo and time signature, and these are edited in the Tempo Track window (see page 594).

- To activate the metronome, click the Click button on the Transport panel, or use the corresponding key command (by default [C]).

Metronome settings

You make settings for the metronome in the Metronome Setup dialog, opened from the Transport menu.

The metronome can use either an audio click played back via the audio hardware, send MIDI data to a connected device which will play back the click or do both.
The following metronome parameter settings can be made in the dialog:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MIDI Click on/off</td>
<td>Selects whether or not the metronome will sound via MIDI.</td>
</tr>
<tr>
<td>MIDI Output</td>
<td>Use the pop-up to select a MIDI output for the metronome click.</td>
</tr>
<tr>
<td>Channel</td>
<td>Selects the MIDI channel for the metronome click.</td>
</tr>
<tr>
<td>High Note</td>
<td>Sets the MIDI note number for the “high note” (the first beat in a bar).</td>
</tr>
<tr>
<td>High Velocity</td>
<td>Sets the velocity value for the “high note” (the first beat in a bar).</td>
</tr>
<tr>
<td>Low Note</td>
<td>Sets the MIDI note number for the “low note” (the other beats).</td>
</tr>
<tr>
<td>Low Velocity</td>
<td>Sets the velocity value for the “low note” (the other beats).</td>
</tr>
<tr>
<td>Audio Click On/Off</td>
<td>Selects whether or not the metronome will sound via the audio hardware.</td>
</tr>
<tr>
<td>Audio Click Volume</td>
<td>Adjusts the volume for the audio click.</td>
</tr>
<tr>
<td>slider</td>
<td></td>
</tr>
<tr>
<td>Precount on/off</td>
<td>Turns on or off the metronome count-in before recording starts (when starting recording from stop mode).</td>
</tr>
<tr>
<td>Precount Bars</td>
<td>Sets the number of bars the metronome will count in before it starts recording if precount is activated.</td>
</tr>
<tr>
<td>From Master Track</td>
<td>When this is activated, the precount will be in the time signature set in the Master Tempo track.</td>
</tr>
<tr>
<td>Use Signature</td>
<td>If “From Master Track” is deactivated, you can use these fields to set a time signature for the precount.</td>
</tr>
<tr>
<td>Click during</td>
<td>Allows you to specify whether the metronome should be heard during playback, recording or both (when Click is activated on the Transport bar).</td>
</tr>
<tr>
<td>Use Count Base</td>
<td>If this option is activated, you use the field to the right to specify the “rhythm” of the metronome. Normally, the metronome plays one click per beat, but setting this to e.g. “1/8” gives you eighth notes – two clicks per quarter note beat. It’s also possible to create unusual metronome rhythms such as triplets etc.</td>
</tr>
</tbody>
</table>
The Project Window
Background

The Project window is the main window in Cubase SX/SL. This provides you with an overview of the project, allowing you to navigate and perform large scale editing. Each project has one Project window.

About tracks

The Project window is divided vertically into tracks, with a time line running horizontally from left to right. The following track types are available:

<table>
<thead>
<tr>
<th>Track type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio</td>
<td>For recording and playing back audio events and audio parts. Each audio track has a corresponding audio channel in the Mixer. An audio track can have any number of automation &quot;subtracks&quot; for automating mixer channel parameters, insert effect settings etc.</td>
</tr>
<tr>
<td>Folder</td>
<td>Folder tracks function as containers for other tracks, allowing you to edit several tracks at the same time amongst other things. See page 101.</td>
</tr>
<tr>
<td>Group Channel</td>
<td>Group channels function as subgroups: by routing several audio channels to a Group channel, you can mix them with a single set of controls, apply the same effects to them, etc. (see page 165). A Group channel track contains no events as such, but displays settings and automation curves for the corresponding Group channel. Each Group channel track has a corresponding channel strip in the Mixer.</td>
</tr>
<tr>
<td>MIDI</td>
<td>For recording and playing back MIDI parts. Each MIDI track has a corresponding MIDI channel strip in the Mixer. A MIDI track can have a number of automation &quot;subtracks&quot; for automating mixer channel parameters, insert and send effect settings etc.</td>
</tr>
<tr>
<td>Marker</td>
<td>The Marker track displays markers, and allows you to move and rename them directly in the Project window (see page 114). There can only be one Marker track in the project.</td>
</tr>
<tr>
<td>Master Automation</td>
<td>Contains automation curves for master volume and global effect input levels. There can only be one Master Automation track in the project, but you can expand it to display any number of automation curves.</td>
</tr>
<tr>
<td>Plug-in Automation</td>
<td>Each send effect, master effect or VST Instrument can have its own individual Plug-in Automation track, allowing for automation of all plug-in parameters. An automation track for a plug-in is automatically created the first time you automate any of its parameters. See page 258.</td>
</tr>
<tr>
<td>Video</td>
<td>For playing back video events. A project can only have one Video track.</td>
</tr>
</tbody>
</table>
About parts and events

Events are the basic building blocks in Cubase SX/SL. Different event types are handled differently in the Project window:

- Video events and automation events (curve points) are always viewed and rearranged directly in the Project window.
- MIDI events are always gathered in MIDI parts, containers for one or more MIDI events. MIDI parts are rearranged and manipulated in the Project window. To edit the individual MIDI events in a part, you have to open the part in a MIDI Editor (see page 486).
- Audio events can be displayed and edited directly in the Project window, but you can also work with audio parts containing several events. This is useful if you have a number of events which you want to treat as one unit in the project.

An audio event and an audio part.
Window Overview

The toolbar.

The info line.

The overview line.

The track list with various track types.

The ruler.

The inspector.

The event display, showing audio parts and events, MIDI parts, automation, markers, etc.
The Track list

The Track list is the area to the left in the Project window. It contains name fields and various settings for the tracks. Different track types have different controls in the Track list. To see all the controls you may have to resize the track in the Track list (see page 65):

- The Track list area for an audio track:

  - Mute & Solo
  - Track name
  - Record Enable
  - Monitoring on/off
  - Automation Read/Write buttons
  - Output activity indicator
  - Stereo on/off
  - Musical/Linear time base (see page 72)
  - Expand automation track (show more parameters)
  - Mute
  - Lock track button
  - Automation parameter (click to select parameter)

  Indicates whether effect sends, EQ or insert effects are activated for the track. Click to bypass.

- The Track list area for an automation subtrack (revealed by clicking the + button on a track):

  - Expand automation track (show more parameters)
  - Automation Read/Write buttons
  - Automation parameter (click to select parameter)

- The Track list area for a MIDI track:

  - Mute
  - Solo
  - Track name
  - Monitoring on/off
  - Lock track button
  - Record Enable
  - Drum map assign button
  - MIDI channel
  - MIDI Output
  - Automation Read/Write buttons
  - Bank
  - Program
  - Output activity indicator

The Track list is the area to the left in the Project window. It contains name fields and various settings for the tracks. Different track types have different controls in the Track list. To see all the controls you may have to resize the track in the Track list (see page 65):
The Inspector

The area to the left of the Track list is called the Inspector. This can show additional controls and parameters for the track you have selected in the Track list. If several tracks are selected (see page 71), the Inspector shows the setting for the first (topmost) selected track.

To hide or show the Inspector, click the Inspector icon in the toolbar.

The Inspector icon.

The contents and usage of the Inspector depends on the selected track’s class, as described below.

- For some track classes, the Inspector is divided in sections. You can hide or show sections by clicking the tabs in their top right corner. Clicking the tab for a hidden section brings it to view and hides the other sections. [Ctrl]/[Command]-clicking the tab allows you to hide or show a section without affecting other sections. Finally, [Alt]/[Option]-clicking a tab shows or hides all sections in the Inspector.

- Folding a section does not affect the functionality but merely hides the section from view.
  In other words, if you have set up a track parameter or activated an effect, your settings will still be active even if you fold the Inspector section.
## Audio tracks

![Audio track Inspector](image)

For audio tracks, the Inspector contains the same controls as the Track list, as well as some additional buttons and parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Fades Settings button</td>
<td>Opens a dialog in which you can make separate Auto Fade settings for the track. See page 134.</td>
</tr>
<tr>
<td>Edit button</td>
<td>Opens the Channel Settings window for the track, allowing you to view and adjust effect and EQ settings, etc. See page 158.</td>
</tr>
<tr>
<td>Volume</td>
<td>Use this to adjust the level for the track. Changing this setting will move the track's fader in the Mixer window, and vice versa. See page 152 to learn more about setting levels.</td>
</tr>
<tr>
<td>Delay</td>
<td>This adjusts the playback timing of the audio track. Positive values delay the playback while negative values cause the track to play earlier. The values are set in milliseconds.</td>
</tr>
<tr>
<td>Pan</td>
<td>Use this to adjust the panning of the track. As with the Volume setting, this corresponds to the Pan setting in the Mixer.</td>
</tr>
<tr>
<td>Inserts section</td>
<td>Allows you to add insert effects (up to eight for SX - up to 5 for SL) to the track, see page 185. The Edit button at the top of the section opens the Channel Settings window for the track.</td>
</tr>
<tr>
<td>Equalizers section</td>
<td>Lets you adjust the EQs for the track. You can have up to four bands of EQ for each track, see page 160. The Edit button at the top of the section opens the Channel Settings window for the track.</td>
</tr>
<tr>
<td>Sends section</td>
<td>Allows you to route the track to one or several send effects (up to eight), see page 180. There are two edit buttons at the top of this section – the left opens the VST Send Effects window and the right opens the Channel Settings window for the track.</td>
</tr>
<tr>
<td>Channel section</td>
<td>Shows a duplicate of the corresponding Mixer channel strip.</td>
</tr>
</tbody>
</table>
MIDI tracks

When a MIDI track is selected, the Inspector contains a number of parameters and effects, affecting the MIDI events in real time (e.g. on playback). This is described in a separate chapter, see page 423.

Marker tracks

When a marker track is selected, the Inspector shows the marker list. See page 111.

Folder tracks

When a folder track is selected, the Inspector shows the folder and its underlying tracks, much like a folder structure in the Windows Explorer or Mac OS X Finder.

- You can click one of the tracks shown under the folder in the Inspector to have the Inspector show the settings for that track.
  This way, you don’t have to “open” a folder track to access the settings for the tracks within it.

Here, an audio track within the folder is selected.
Other tracks

For the remaining track classes, the Inspector isn’t used.

The toolbar

The toolbar contains tools and shortcuts for opening other windows and various project settings and functions:

- Active project indicator
- Show/hide info line
- Automation mode (Cubase SX only)
- Show/hide Overview
- Open Pool
- Open Mixer
- Project window tools
- Autoscroll on/off
- Transport controls (Stop, Play, Record and Cycle)
- Snap on/off
- Grid pop-up menu
- Color pop-up menu
- Snap mode
- Quantize value
The info line

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
<th>Start</th>
<th>End</th>
<th>Length</th>
<th>Of</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read</td>
<td>Read</td>
<td>00:01:01:00</td>
<td>00:04:02:10</td>
<td>13:31:10</td>
<td>00</td>
</tr>
</tbody>
</table>

The info line shows information about the currently selected event or part in the Project window. You can edit almost all values in the info line using regular value editing. Length and position values are displayed in the format currently selected for the ruler (see page 61).

- To hide or show the info line, click the corresponding icon on the tool-bar.

The following elements can be selected for display and editing on the info line:

- Audio events.
- Audio parts.
- MIDI parts.
- Video events.
- Markers.
- Automation Curve Points.

Note that the info line will only display information if a single element is selected.
The ruler

The ruler at the top of the event display shows the timeline. Initially, the Project window ruler uses the display format specified in the Project Setup dialog (see page 62), as do all other rulers and position displays in the project. However, you can select an independent display format for the ruler by clicking on the arrow button to the right of it and selecting an option from the pop-up menu that appears.

<table>
<thead>
<tr>
<th>Option</th>
<th>Positions and lengths displayed as</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bars+Beats</td>
<td>Bars, beats, sixteenth notes and ticks, with 120 ticks per sixteenth note.</td>
</tr>
<tr>
<td>Seconds</td>
<td>Hours, minutes, seconds and milliseconds.</td>
</tr>
<tr>
<td>24 fps</td>
<td>Hours, minutes, seconds and frames, with 24 frames per second.</td>
</tr>
<tr>
<td>25 fps</td>
<td>Hours, minutes, seconds and frames, with 25 frames per second.</td>
</tr>
<tr>
<td>29.97 fps</td>
<td>Hours, minutes, seconds and frames, with 29.97 frames per second.</td>
</tr>
<tr>
<td>30 fps</td>
<td>Hours, minutes, seconds and frames, with 30 frames per second.</td>
</tr>
<tr>
<td>29.97 dfps</td>
<td>Hours, minutes, seconds and frames, &quot;Drop frame&quot; with 29.97 frames per second.</td>
</tr>
<tr>
<td>30 dfps</td>
<td>Hours, minutes, seconds and frames, &quot;Drop frame&quot; with 30 frames per second.</td>
</tr>
<tr>
<td>Samples</td>
<td>Samples.</td>
</tr>
</tbody>
</table>

- The selection you make here affects the ruler, the info line and tool tip position values (appear when you drag an event in the Project window). You can also select independent formats for other rulers and position displays.

- To set the display format globally (for all windows), use the display format pop-up on the Transport panel, or hold down [Ctrl]/[Command] and select a display format in any ruler.
Operations

Creating a new project

You create a new project in the following way:

1. Select “New Project” from the File menu.
   A dialog appears, listing a number of project templates, including any custom templates that you have created (see page 700).

2. Select a template and click OK.
   A file dialog appears, allowing you to specify a location for the project folder. This will contain all files related to the project.

3. Select an existing folder or type the name of a new one. Click OK.
   A Project window appears. The new project will be based on the selected template, and include tracks, events and settings from the template.

The Project Setup dialog

General settings for the project are made in the Project Setup dialog. This is opened by selecting “Project Setup...” from the Project menu.
The following settings are available in the Project Setup dialog:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>The start time of the project. Allows you to have the project start at another time than zero. Also used for setting the sync start position when synchronizing Cubase SX/SL to external devices (see page 651).</td>
</tr>
<tr>
<td>Length</td>
<td>The length of the project.</td>
</tr>
<tr>
<td>Frame Rate</td>
<td>Used if you are synchronizing Cubase SX/SL with external equipment. If Cubase SX/SL is the slave, this value is automatically set to the frame rate of the incoming sync signal. If Cubase SX/SL is master, this determines the frame rate of the sent sync signal. See page 658.</td>
</tr>
<tr>
<td>Display Format</td>
<td>This is the global display format used for all rulers and position displays in the program. However, you can make independent display format selections for the individual rulers and displays if you like. For descriptions of the different display format options, see page 61.</td>
</tr>
<tr>
<td>Display Offset</td>
<td>Offsets the time positions displayed in the ruler etc., allowing you to compensate for the Start Position setting. Typically, if you synchronize Cubase SX/SL to an external source starting at a frame other than zero, you set the Start Position to this value. However, if you still want the display in Cubase SX/SL to start at zero, set the Display Offset to the same value too.</td>
</tr>
<tr>
<td>Sample Rate</td>
<td>This is the sample rate by which Cubase SX/SL records and plays back audio files.</td>
</tr>
<tr>
<td>Record Format</td>
<td>When you record audio files in Cubase SX/SL, they are recorded with this resolution. See page 26.</td>
</tr>
<tr>
<td>Record File Type</td>
<td>Determines which file types should be created when you record audio. See page 26.</td>
</tr>
<tr>
<td>Stereo Pan Law</td>
<td>Decides whether panning should use power compensation or not. This is explained on page 155.</td>
</tr>
</tbody>
</table>

- While most settings in the Project Setup can be changed at any time, you should select a sample rate once and for all when starting with a new project! All audio files must be of this sample rate to play back correctly.
Zoom and view options

Zooming in the Project window is done according to the standard Zoom procedures (see the Getting Started book), with the following special notes:

- When using the vertical zoom sliders, the tracks are scaled relatively. In other words, if you have made any individual track height adjustments (see below), the relative height differences are maintained.

The following options are available on the Zoom submenu on the Edit menu:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom In</td>
<td>Zooms in one step, centering on the project cursor.</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Zooms out one step, centering on the project cursor.</td>
</tr>
<tr>
<td>Zoom Full</td>
<td>Zooms out so that the whole project is visible. “The whole project” means the timeline from the project start to the length set in the Project Setup dialog (see above).</td>
</tr>
<tr>
<td>Zoom to Selection</td>
<td>Zooms in horizontally so that the current selection fills the screen.</td>
</tr>
<tr>
<td>Zoom to Event</td>
<td>This option is available only in the Sample Editor (see page 336).</td>
</tr>
<tr>
<td>Zoom In Vertical</td>
<td>Zooms in one step vertically.</td>
</tr>
<tr>
<td>Zoom Out Vertical</td>
<td>Zooms out one step vertically.</td>
</tr>
<tr>
<td>Zoom In Tracks</td>
<td>Zooms in selected track(s) one step vertically.</td>
</tr>
<tr>
<td>Zoom Out Tracks</td>
<td>Zooms out selected track(s) one step vertically.</td>
</tr>
<tr>
<td>Zoom Tracks Exclusive</td>
<td>This zooms in vertically on the selected track(s) and minimizes the height of all other tracks.</td>
</tr>
</tbody>
</table>

- You can zoom the contents of parts and events vertically, using the Waveform Zoom slider in the top right corner of the event display. This can be useful to better view quiet audio passages.
To get an approximate reading on the level of the audio events by viewing the waveforms, make sure the slider is all the way down. Otherwise, zoomed waveforms may be mistaken for clipped audio.

- If you activate the option Quick Zoom in the Preferences (Event Display page), the contents of parts and events will not be continuously redrawn when you zoom manually. Instead, the contents are redrawn once you have stopped changing the zoom – activate this if screen redraws are slow on your system.

Resizing tracks in the Track list

- You can change the height of an individual track by clicking on its lower border in the Track list and dragging up or down. To change the height of all tracks, hold down [Ctrl]/[Command] and resize one of the tracks in the same way. If “Snap Track Heights” is activated on the Track scale pop-up (see below), the track height will change in larger increments when you resize it.
- You can also change the width of the Track list area, by dragging the border between the Track list and the event display.
- The controls shown for tracks in the Track list are adaptable to track size. This means that when resizing a track’s height or width some of the controls will be dynamically placed where they best “fit in”.
- You can use the Track scale pop-up (opened by clicking the arrow button above the vertical zoom control) to set the number of tracks to view in the current Project window. The track height will be adjusted to show only the number of tracks specified on the pop-up menu. By selecting “Zoom N Tracks” from the pop-up you can manually set the number of tracks to fit in the current Project window.
Zoom presets and Cycle markers

The pop-up menu to the left of the horizontal zoom control allows you to select, create and organize zoom presets. These are useful if you want to toggle between different zoom settings (e.g. one where the whole project is displayed in the project window and another with a high zoom factor for detailed editing). With this pop-up menu, you can also zoom in on the area between cycle markers in the project.

The upper part of the menu lists the zoom presets:

- To store the current zoom setting as a preset, select Add from the pop-up menu. A dialog appears, allowing you to type in a name for the preset.
- To select and apply a preset, select it from the pop-up menu.
- The “Zoom to Locators” preset is always available. Selecting this option zooms in on the range between the left and right locators, so that only this range is shown in the event display.
• If you want to delete a preset, select “Organize…” from the pop-up menu. 
In the dialog that appears, select the preset in the list and click the corresponding button in order to delete the preset. The preset is removed from the list.

![Image of the Organize dialog]

• If you want to rename a preset, select “Organize…” from the pop-up menu. 
In the dialog that appears, select the desired preset in the list and click the Rename button. A second dialog opens, allowing you to type in a new name for the preset. Click OK to close the dialogs.

> **Zoom presets are global for all projects, i.e. they are available in all projects you open or create.**

The middle part of the pop-up lists the cycle markers you created for the project:

• If you select a cycle marker form this menu, the event display is zoomed in to encompass the marker area (see page 117).

• You cannot edit the cycle markers in this pop-up menu. For information on editing markers, see “Using Markers”.

> **Only the cycle markers you created in the current project are available on the menu.**
Adjusting how parts and events are shown

The Preferences dialog on the File menu (on the Mac, the Preferences dialog is located on the Cubase SX/SL menu) contains several settings for customizing the display in the Project window.

On the Event Display page you will find common settings for all track types:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Colorize Event Background</td>
<td>Determines whether the backgrounds or “contents” (waveforms, etc.) of parts and events will be colorized. See page 72.</td>
</tr>
<tr>
<td>Quick Zoom</td>
<td>If this is activated, the contents of parts and events are redrawn once you have stopped changing the zoom.</td>
</tr>
<tr>
<td>Transparent Events</td>
<td>When this is activated, events and parts will be transparent, showing the waveforms and MIDI events only.</td>
</tr>
<tr>
<td>Show Data on Small Track Heights</td>
<td>If this is activated, the contents of events and parts will be shown, even if the height of a track is very small.</td>
</tr>
<tr>
<td>Show Event Names</td>
<td>Determines whether the names of parts and events should be shown in the Project window.</td>
</tr>
</tbody>
</table>

The Event Display–Audio page contains settings for audio events:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interpolate Audio Images</td>
<td>If the option is deactivated, single sample values are drawn as “steps”. If the option is activated they are interpolated to form “curves”.</td>
</tr>
<tr>
<td>Wave Image Style</td>
<td>Determines whether audio waveforms should be displayed as solid images, frames or “inverted” images (solid+frame). This selection affects all waveform images in the Project window, Sample Editor and Audio Part Editor. Note that the “Framed” and “Solid and Framed” styles are more demanding for the computer. If the system feels slower in these modes, please switch back to “Solid” wave image style.</td>
</tr>
<tr>
<td>Show Event Volume Curves Always</td>
<td>If this is activated the “volume curves” created with the volume and fade handles are always shown – if not, the curves are only shown for selected events.</td>
</tr>
</tbody>
</table>
The Event Display–MIDI page contains settings for MIDI parts:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Edit Action</td>
<td>Determines which editor should be opened when you double click a MIDI part or select it and press [Ctrl]/[Command]-[E]: the Key, Drum, List or Score editor. Note that this setting is overridden for tracks with drum maps if the option “Edit as Drums when Drummap is assigned” is activated.</td>
</tr>
<tr>
<td>Part Data Mode</td>
<td>Determines how events in MIDI parts should be shown in the Project window: as lines, as score notes or as drum notes. Note that this setting is overridden for tracks with drum maps if the option “Edit as Drums when Drum Map is assigned” is activated.</td>
</tr>
<tr>
<td>Show Controllers</td>
<td>Governs whether non-note events (controllers, etc.) should be shown in MIDI parts in the Project window.</td>
</tr>
<tr>
<td>Edit as Drums when Drum Map is assigned</td>
<td>If this is activated, parts on MIDI tracks with drum maps assigned will be shown with drum note symbols in the Project window. Also, the parts will automatically open in the Drum editor when double clicked (overriding the Default Edit Action setting above).</td>
</tr>
<tr>
<td>Note Name Style</td>
<td>Determines how MIDI note names (pitches) should be displayed in editors, etc.</td>
</tr>
</tbody>
</table>

The Event Display–Video page contains settings for video events:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Video Thumbnails</td>
<td>When this is activated, thumbnail frames of the video contents are shown on the Video Track.</td>
</tr>
<tr>
<td>Video Cache Size</td>
<td>This determines how much memory is available for video thumbnails. If you have long video clips and/or work with a large zoom factor (so that a lot of frames are shown in the thumbnails), you may have to raise this value.</td>
</tr>
</tbody>
</table>
Zooming and navigating in the overview line

By clicking the Show Overview button on the toolbar, an extra pane appears under the toolbar, the project overview line.

Show Overview button

In the overview line, events and parts on all tracks are displayed as boxes. You can use the overview line to zoom in or out, and for navigating to other sections of the project. This is done by moving and resizing the track view rectangle in the overview line:

- The track view rectangle indicates the section of the project currently displayed in the event display.
- You can zoom in or out vertically by resizing the track view rectangle. Resizing is done by dragging the edges of the rectangle.
- You can drag the track view rectangle to view other sections of the project. The number of tracks shown will not change.
Handling tracks

To add a track to the Project, select “Add Track” from the Project menu and select a track type from the submenu that appears. The new track is added below the currently selected track in the Track list.

- The “Add Track” menu is also available as a separate item on the Quick Menu.

- There is an additional option at the bottom of the Add Track submenu, called “Multiple...”. Selecting this brings up a dialog allowing you to add more than one track in one operation. You can set whether audio, MIDI or group tracks should be created by selecting from the pop-up in the dialog. The number of tracks to add is entered in the “Count” value field.

Once you have created tracks, you can manipulate and rearrange them in various ways:

- To rename an audio or MIDI track, double click in the name field and type in a new name. If you hold down any modifier key when pressing [Return] to close the name field, all events on the track will get the name you entered.

- To select a track, click on it in the Track list. A selected track is indicated by a light grey color in the Track list.

- To move a track, click and drag it up or down in the list.

- To duplicate a track, complete with all contents and channel settings, right-click in the Track list and select “Duplicate track” from the context menu. The duplicated track will appear above the original track.

![This track is selected.](image)

It is possible to select several tracks, by pressing [Ctrl]/[Command]. To select a continuous range of tracks, use [Shift]-clicking.

The Project Window
• You can colorize the contents of selected track(s), or selected parts and events by clicking the Color button on the toolbar and selecting a color from the pop-up menu that appears.
  If one or several tracks are selected, all events and parts on the track(s) will get the selected color, as will any events and parts you add to the track later. If individual events or parts are selected, only these will be affected. Individually colorized events and/or parts will keep the applied color even if the track they belong to is later set to another color. The option “Colorize Event Background” in the Preferences dialog (User Interface–Event Display page) determines whether the backgrounds or waveforms of events will be colorized.

• To remove the selected tracks, select “Remove Selected Tracks” from the Project menu.
  You can also right-click directly on a track in the Track list and select “Remove Track” from the context menu that appears.

Switching between Musical or Linear time base

Tracks can be either “musical” (tempo) or “linear” (time) based.

• On a track using linear time base, the events will be positioned on specific time positions – changing the playback tempo will not affect the time position of events.

• On a track using musical time base, the positions of events are represented as meter values (bars, beats, 1/16th notes and ticks, with 120 ticks per 1/16th note). If you change the playback tempo, the events will play back at an earlier or later time.

Whether to use musical or linear time base depends on the type of project and recording situation. By default, audio and MIDI tracks use musical time base, while the Marker track and Video track use linear time base. However, you can change this setting individually for each audio, MIDI and marker track. This is done by clicking the musical/linear time base button in the Inspector or Track list. Musical time base is indicated by a note symbol, while linear time base is indicated by a clock symbol.
Note that internally, events on musical time based tracks use the same high precision for positioning (64 bit floating point values) as linear time based events. However, switching between linear and musical time base results in a very small loss of precision (introduced by the mathematical operations used for scaling values in the two different formats). Therefore you should avoid switching repeatedly between the two modes.

For more information about tempo changes, see page 590.

Adding events to a track

There are a number of ways to add events to a track:

- By recording (see page 21).
  This is possible for audio and MIDI tracks.

- By selecting "Audio File..." or "Videofile..." from the Import submenu on the File menu.
  This opens a file dialog, allowing you to locate the file you wish to import. When you import a file this way, a clip is created for the file and an event that plays the whole clip is added to the selected track, at the position of the project cursor.
  You can also import MIDI files by using the Import submenu, but this works in a slightly different way (see page 702).

- By grabbing audio CD tracks and converting these to audio files, see page 706.

- By using Copy and Paste on the Edit menu.
  This allows you to copy all kinds of events between different projects. You can also use Copy and Paste for copying events within the project, from the Audio Part Editor or Sample Editor.

- By drawing.
  Some types of events (markers and automation events) can be drawn directly into the Project window. For audio and MIDI tracks, you can draw parts (see page 77).
• By dragging files and dropping them on the track at the desired position. You can create events by dragging and dropping from the following locations:

  The Desktop.
  The Pool.
  The Project window of another open project.
  The Audio Part Editor of any open project.
  The Sample Editor of any open project – press [Ctrl]/[Command] and drag to create an event of the current selection, or click in the left column of the Region List and drag to create an event from a Region.
  The “Find media” dialog.

While you drag the clip in the Project window, its position will be indicated by a marker line and a numerical position box. See also page 387.

Audio file import options

When you are importing audio files, you can choose to copy the file into the project’s audio folder and have the project make reference to the copied file instead. This helps you keep your project “self-contained”. Furthermore, you may want all files in the project to have the same sample rate and sample size (resolution).

There is a setting for this in the Preferences dialog (Audio page). Select one of the options on the “On Import Audiofile” pop-up:
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do Nothing</td>
<td>The files are imported without being copied or converted.</td>
</tr>
<tr>
<td>Open Options Dialog</td>
<td>An Options dialog appears when you import, allowing you to select whether you want to copy the files to the Audio folder and/or convert them to the project settings. Note:</td>
</tr>
<tr>
<td></td>
<td>- When importing a single file of a format other than the project settings, you can specify which properties (sample rate and/or resolution) should be changed.</td>
</tr>
<tr>
<td></td>
<td>- When importing multiple files at the same time, you can select to have the imported files automatically converted if necessary, i.e. if the sample rate is different than the project’s or the resolution is lower than the project setting.</td>
</tr>
<tr>
<td>Copy to Project Folder</td>
<td>If files are not already in the project’s audio folder they are copied there before being imported.</td>
</tr>
<tr>
<td>Copy and Convert</td>
<td>If files are not already in the project’s audio folder they are copied there before being imported. Furthermore, if the files have a different sample rate or a lower resolution than the project settings, they are automatically converted.</td>
</tr>
<tr>
<td>Convert if needed</td>
<td>If files have a different sample rate or a lower resolution than the project settings, they are copied to the project’s Audio folder and the copies are automatically converted before being imported. Files that conform to the project settings are imported from their original location, without being copied.</td>
</tr>
</tbody>
</table>
About Stereo/Mono

Audio tracks can be either stereo or mono. You can change this setting manually as described below, but it can also be done automatically, according to the following rules:

- Whenever a file is imported, copied or moved to a track, Cubase SX/SL sets the stereo/mono status of the track according to its contents:
  - If the majority of events on the track are in stereo, the track is set to stereo and vice versa.
  - This means that if you import a file to an empty track, the track is automatically set to stereo or mono according to the imported file.

  Stereo events on mono tracks (or vice versa) are indicated by the label “Mono/stereo mismatch”, and will not be played back:

A stereo file on a mono track.

To manually change the stereo/mono status, click the stereo button in the Track list or Inspector. A lit button with double circles indicates stereo, a dark button with a single circle indicates mono.

Setting the track to stereo.
Creating parts

Parts are containers for MIDI or audio events. If you record MIDI, a MIDI part is automatically created, containing the recorded events. You can also create empty audio or MIDI parts and later add events to them. There are two ways to do this:

• Draw a part on a MIDI or audio track with the Pencil tool.
• Double click with the Arrow tool on a MIDI or audio track, between the left and right locator.

To add events to a MIDI part, you use the tools and functions in a MIDI editor (see page 488). Adding events to audio parts is done in the Audio Part Editor (see page 353) by pasting or by using drag and drop.

• You can also gather existing audio events into a part, by using the “Events to Part” function on the Audio menu. This creates an audio part containing all selected audio events on the same track. To remove the part and make the events appear as independent objects on the track again, select the part and use the “Dissolve Part” function on the Audio menu.
Auditioning audio parts and events

Audio parts and events can be auditioned in the Project window with the Speaker tool:

- When auditioning, audio will be routed directly to Bus 1, bypassing the audio channel's settings, effects and EQs.

1. Select the Speaker tool.
   Note that the Speaker tool and the Scrub tool share the same icon. If the rightmost tool icon on the toolbar isn't a Speaker symbol, first click on the icon to select it, then click again and select “Play” from the pop-up menu that appears.

2. Click where you want playback to start, and keep the mouse button pressed.
   Only the track on which you click is played back, starting at the click position.

3. Release the mouse button to stop playback.
Scrubbing

The Scrub tool allows you to locate positions in the audio by playing back, forwards or backwards, at any speed:

1. Select the Scrub tool.
   Note that the Speaker tool and the Scrub tool share the same icon. If the rightmost tool icon on the toolbar isn’t a “Scrub symbol”, first click on the icon to select it, then click again and select “Scrub” from the pop-up menu that appears.

2. Click at the desired position and keep the mouse button pressed.
   The project cursor is moved to the position at which you click.

3. Drag to the left or right.
   The project cursor follows the mouse pointer and the audio is played back. The speed and pitch of the playback depends on how fast you move the pointer.

• You can adjust the responsiveness of the Scrub function in the Preferences dialog (VST page).
Editing parts and events

This section describes techniques for editing in the Project window. If not explicitly stated, all descriptions apply to both events and parts, even though we use the term "event" for convenience.

When you are using the tools for editing parts and events, you can in many cases get additional functions by pressing modifier keys (e.g. pressing [Alt]/[Option] and dragging with the Pencil tool creates a copy of the dragged event or part). On the following pages, the default modifier keys are described, but you can customize these if needed. This is done in the Preferences dialog on the Editing – Tool Modifiers page (see page 724).

Selecting events

Selecting events is done using any of the following methods:

- Use the Arrow tool.
  The standard selection techniques apply.

- Use the Select submenu on the Edit menu.
  The options are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Selects all events in the Project window.</td>
</tr>
<tr>
<td>None</td>
<td>Deselects all events.</td>
</tr>
<tr>
<td>In Loop</td>
<td>Selects all events that are partly or wholly between the left and right locator.</td>
</tr>
<tr>
<td>From Start to Cursor</td>
<td>Selects all events that begin to the left of the project cursor.</td>
</tr>
<tr>
<td>From Cursor to End</td>
<td>Selects all events that end to the right of the project cursor.</td>
</tr>
<tr>
<td>All on Selected Tracks</td>
<td>Selects all events on the selected track.</td>
</tr>
<tr>
<td>Select Event</td>
<td>This is available in the Sample Editor (see page 331).</td>
</tr>
<tr>
<td>Left/Right Selection Side to Cursor</td>
<td>These two functions are only used for range selection editing (see page 92).</td>
</tr>
</tbody>
</table>
Note that these functions work differently when the Range Selection tool is selected (see page 92).

- Select all events on a track by right-clicking in its Track list and selecting "Select All Events" from the pop-up menu that appears.

- You can also use the arrow keys on the computer keyboard, to select the closest event to the left, right, above or below. If you press [Shift] and use the arrow keys, the current selection will be kept, allowing you to select several events.

- If the option “Auto Select Events under Cursor” is activated in the Preferences dialog (Editing page), all events currently “touched” by the project cursor are automatically selected. This can be helpful when rearranging your project, since it allows you to select whole sections (on all tracks) simply by moving the project cursor.

- It is also possible to select ranges, regardless of the event and track boundaries. This is done using the Range Selection tool (see page 92).

### Moving events

To move events in the Project window, use any of the following methods:

- Click and drag to a new position. All selected events will be moved, maintaining their relative positions. You can only drag events to tracks of the same type. If Snap is activated, this determines to which positions you can move the events (see page 97). Note also, that you can restrict movement to be either horizontal or vertical only, by holding down [Ctrl]/[Command] while dragging.

You will note that there is a slightly delayed response when you move an event by dragging. This helps you avoid accidentally moving events when you click on them in the Project window. You can adjust this delay with the Drag Delay setting in the Preferences dialog (Editing page).
• Use the “Move to” functions on the Edit menu.
The following functions are available:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to Cursor</td>
<td>Moves the selected event to the project cursor position. If there are several selected events on the same track, the first event will start at the Cursor, and the following will be lined up end-to-start after the first one.</td>
</tr>
<tr>
<td>Move to Origin</td>
<td>Moves the selected events to their original positions, i.e. the positions at which they were originally recorded.</td>
</tr>
<tr>
<td>Move to Front,</td>
<td>This function doesn't actually change the position of the events, but moves the selected events to the front or back, respectively. This is useful if you have overlapping events, and want to see one that is partially obscured. For audio events, this is an extra important feature, since only the visible sections of events will be played back. Moving an obscured audio event to front (or moving the obscuring event to back) will allow you to hear the whole event on playback. Note that it is also possible to use the “To Front” function on the event context menu for this (although this works in a different way, see page 34).</td>
</tr>
<tr>
<td>Move to Back</td>
<td></td>
</tr>
</tbody>
</table>

• Select the event and edit the Start position in the info line.
With this method, you can only move one event at a time.

**Duplicating events**

Events can be duplicated in the following ways:

• Hold down [Alt]/[Option] and drag the event to a new position.
  If Snap is activated, this determines to which positions you can copy the events (see page 97).

- If you hold down [Ctrl]/[Command] as well, movement direction is restricted to either horizontal or vertical. That means if you drag an event vertically it can not be moved horizontally at the same time.
• Audio and MIDI parts can also be duplicated by pressing [Alt]/[Option] + [Shift] and dragging.
  This creates a shared copy of the part. If you edit the contents of a shared copy, all other shared copies of the same part are automatically edited in the same way.

  [Image: A screenshot showing shared copies of audio events with shares indicated by an icon in the lower right corner of the part.]

  Shared copies are indicated by the part name in italics and an icon in the lower right corner of the part.

  Note:

  • When you duplicate audio events, the copies are always shared. This means that shared copies of audio events always refer to the same audio clip (see page 295).
  • You can convert a shared copy to a real copy by selecting “Convert to Real Copy” from the Edit menu. This creates a new version of the clip (that can be edited independently) and adds this to the Pool. Note that no new files are created by this operation – for that you need to use the “Freeze Edits” function (see page 319).
  • Selecting “Duplicate” from the Edit menu creates a copy of the selected event and places it directly after the original. If several events are selected, all of these are copied “as one unit”, maintaining the relative distance between the events.
  • Selecting “Repeat...” from the Edit menu opens a dialog, allowing you to create a number of copies (regular or shared) of the selected event(s). This works just like the Duplicate function, except that you can specify the number of copies.
  • Selecting “Fill Loop” from the Edit menu creates a number of copies starting at the left locator and ending at the right locator. The last copy is automatically shortened to end at the right locator position.

  [Image: A screenshot showing a loop fill with original and copies labeled accordingly.]
Using Cut, Copy and Paste

You can cut or copy selected events, and paste them in again, using the functions on the Edit menu.

• When you paste an event it is inserted on its original track, positioned so that its Snap point is aligned with the project cursor position. See page 97 for information about the Snap point.

• If you use the “Paste at Origin” function, the event is pasted at its original position (the position from which you cut or copied it).

Renaming events

By default, audio events show the name of their clip, but you can enter a separate descriptive name for separate events if you like. This is done by selecting the event and typing in a new name in the “Description” field in the info line.

• You can also give all events on a track the same name as the track by changing the track name, holding down a modifier key and pressing [Return]. See page 71.

Splitting events

You can split events in the Project window in the following ways:

• Click with the Scissors tool on the event you want to split.
  If Snap is activated, this determines the exact split position (see page 97).

• Select “Split at Cursor” from the Edit menu.
  This splits the selected events at the position of the project cursor. If no events are selected, all events (on all tracks) that are intersected by the project cursor will be split.

• Select “Split Loop” from the Edit menu.
  This splits events on all tracks at the left and right locator positions.

⚠️ If you split a MIDI part so that the split position intersects one or several MIDI notes, the result depends on the option “Split MIDI Events” in the Preferences dialog (MIDI–Function Parameters page). If the option is activated, the intersected notes will be split (creating new notes at the beginning of the second part). If it is deactivated, the notes will remain in the first part, but “stick out” after the end of the part.
Gluing events together

Clicking on an event with the Glue Tube tool glues it together with the next event on the track. The result is a part containing the two events, with one exception:

- If you first split an event and then glue the two sections together again (without moving or editing them first), they become a single event again. In other words, gluing can create a single event if the two events are lined up end to start and play a continuous section of the same clip.

Resizing events

Resizing events means to move their start or end positions individually. In Cubase SX/SL, there are three types of resizing:

<table>
<thead>
<tr>
<th>Resizing type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal Sizing</td>
<td>The contents of the event stay fixed, and the start or end point of the event is moved to “reveal” more or less of the contents.</td>
</tr>
<tr>
<td>Sizing Moves Contents</td>
<td>The contents follow the moved start or end of the event (see the figure below).</td>
</tr>
<tr>
<td>Sizing Applies Time Stretch</td>
<td>The contents will be time stretched to fit the new event length (see separate description on page 86).</td>
</tr>
</tbody>
</table>

To select one of the resizing modes, select the Arrow tool and then click again on the Arrow tool icon on the toolbar. This opens a pop-up menu from which you can select one of the resizing mode options.

The icon on the toolbar will change shape, indicating the selected resizing mode.
The actual resizing is done by clicking and dragging the lower left or right corner of the event. If Snap is activated, the Snap value determines the resulting length (see page 97).

- If the event is selected, there will be resize handles in the lower left and right corners. However, you can resize unselected events in the same way – just click and drag one of the lower corners.

- If several events are selected, all will be resized in the same way.

- You can also resize events with the Scrub tool. This works just the same as when resizing with the Arrow tool, but the audio under the pointer is played back (scrubbed) while you drag.

**Resizing events using time stretch**

If you want to resize a part and make its contents “fit” the new size, you should use this option. Proceed as follows:

1. Click the Arrow icon on the toolbar and select the “Sizing applies timestretch” option from the pop-up menu.

2. Point close to the end point of the part you want to stretch.
3. Click and drag left or right.  
When you move the mouse, a tooltip information shows the current mouse position and length of the part. Note that the snap value applies, as with any part operation.

4. Release the mouse button.  
The part is “stretched” or “compressed” to fit the new length.

- For MIDI parts, this means that the events are moved, so that the relative distance between events is maintained.

- For audio parts, this means that the events are moved, and that the referenced audio files are time stretched to fit the new length.  
A dialog box shows the progress of the time stretch operation.

- You can adjust the quality settings for the time stretch algorithm on the Preferences page (Audio–Time Stretch Tool page).  
For more general information about time stretch, see page 311.

**Sliding the contents of an event or part**

You can move the contents of an event or part without changing its position in the Project window. By default, this is done by pressing [Ctrl]/[Command]+[Alt]/[Option], clicking in the event or part and dragging to the left or right.

- When sliding the contents of an audio event, you cannot slide past the start or end of the actual audio clip. If the event plays the whole clip, you cannot slide the audio at all.
Locking events

If you want to make sure you don’t edit or move an event by accident, you can lock it. Locking can affect one (or any combination) of the following properties:

<table>
<thead>
<tr>
<th>Lock Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>If this is locked, the event cannot be moved.</td>
</tr>
<tr>
<td>Size</td>
<td>If this is locked, the event cannot be resized.</td>
</tr>
<tr>
<td>Other</td>
<td>If this is locked, all other editing of the event is disabled. This includes adjusting the fades and event volume, processing, etc.</td>
</tr>
</tbody>
</table>

- To specify which of these properties should be affected by the Lock function, use the “Lock Event Attributes” pop-up menu in the Preferences dialog (Editing page).

- To lock events, select them and select “Lock...” from the Edit menu. The events will be locked according to the options specified in the Preferences dialog.

The padlock symbol indicates that one or more of the lock options are activated for the event.
• You can adjust the lock options for a locked event by selecting it and selecting “Lock...” from the Edit menu again. This opens a dialog in which you can activate or deactivate the desired lock options.

• To unlock an event (turn off all lock options), select it and select “Unlock” from the Edit menu.

• It is also possible to lock a whole track, by clicking the padlock symbol in the Track list or in the Inspector. This disables all editing of all events on the track.

**Muting events**

You can Mute individual events in the Project window in the following way:

• To mute or unmute a single event, click on it with the Mute tool.

  ![The Mute tool.](image)

• To mute several events, click on an unmuted event with the Mute tool, keep the mouse button pressed and drag the pointer over the desired events. All events “touched” by the Mute tool will be muted.

• To unmute several events, click on a muted event with the Mute tool, keep the mouse button pressed and drag the pointer over the desired events. All events “touched” by the Mute tool will be unmuted.

• You can click in an empty area with the Mute tool and drag a selection rectangle around the events you want to mute or unmute. This changes the mute status of all events in the selection rectangle. If you hold down a modifier key when releasing the mouse button, you can force all events to be muted or unmuted, regardless of their previous status. The default modifier keys are [Shift] for mute and [Ctrl]/[Command] for unmute.
• You can mute events by selecting them and selecting “Mute” from the Edit menu. Similarly, you can unmute the selected events by selecting “Unmute” from the Edit menu.

• If a single event is selected, you can also change its Mute status in the info line.

• You can also Mute whole tracks by clicking the Mute (“X”) button in the Track list, the Inspector or the Mixer. Clicking the Solo (“S”) button for a track mutes all other tracks.

Muted events can be edited as usual (with the exception of adjusting fades), but are not played back.

Muted events are “greyed out”. 
Removing events

To remove an event from the Project window, use any of the following methods:

• Click on the event with the Eraser tool.
  If you press [Alt]/[Option], all following events on the same track will be deleted.
• Select the event(s) and press [Backspace], or select “Delete” from the Edit menu.

Creating new files from events

As described in the Getting Started book, an audio event plays a section of an audio clip, which in turn refers to one or more audio files on the hard disk. However, in some situations you may want to create a new file that consists only of the section played by the event. This is done with the function Bounce Selection on the Audio menu:

1. Select one or several audio events.

2. Set up fade in, fade out and event volume (on the info line or using the volume handle) as desired.
   These settings will be applied to the new file. For details on fades and event volume, see page 122.

3. Select “Bounce Selection” from the Audio menu.
   You are asked whether you want to replace the selected event or not.

• If you click “Replace”, a new file is created, containing only the audio in the original event. A clip for the new file is added to the Pool, and the original event is replaced by a new event playing the new clip.

• If you click “No” a new file is created and a clip for the new file is added to the Pool.
  The original event is not replaced.

   You can also apply the Bounce Selection function to an audio part. In that case, the audio from all events in the part will be combined into a single audio file. If you choose “Replace” when asked, the part will be replaced with a single audio event playing a clip of the new file.
Range editing

Editing in the Project window isn’t necessarily restricted to handling whole events and parts. You can also work with selection ranges, which are independent from the event/part and track boundaries.

Creating a selection range

To make a selection range, drag a rectangle with the Range selection tool.

When the Range selection tool is selected, the Select submenu on the Edit menu has the following items for making selection ranges:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Makes a selection that covers all tracks, from the start of the project to the end (as defined by the Length setting in the Project Setup dialog).</td>
</tr>
<tr>
<td>None</td>
<td>Removes the current selection range.</td>
</tr>
<tr>
<td>In Loop</td>
<td>Makes a selection between the left and right locator, on all tracks.</td>
</tr>
<tr>
<td>From Start to Cursor</td>
<td>Makes a selection on all tracks, from the start of the project to the project cursor.</td>
</tr>
<tr>
<td>From Cursor to End</td>
<td>Makes a selection on all tracks, from the project cursor to the end of the project.</td>
</tr>
<tr>
<td>All on selected Tracks</td>
<td>Only used for event selection (see page 80).iali</td>
</tr>
<tr>
<td>Select event</td>
<td>This is available in the Sample Editor (see page 341).</td>
</tr>
<tr>
<td>Left Selection Side to Cursor</td>
<td>Moves the left side of the current selection range to the project cursor position.</td>
</tr>
<tr>
<td>Right Selection Side to Cursor</td>
<td>Moves the right side of the current selection range to the project cursor position.</td>
</tr>
</tbody>
</table>

• Double clicking on an event with the Range Selection tool creates a selection range encompassing the event.
  If you hold down [Shift] you can double click several events in a row, and the selection range will expand to encompass them all.
Adjusting the size of the selection range

You can adjust the size of a selection range in the following ways:

• By dragging its edges.
  The pointer takes the shape of a double arrow when you move it over an edge of the selection range.

• By holding down [Shift] and clicking.
  The closest selection range edge will be moved to the position at which you clicked.

• By adjusting the selection range start or end position numerically on the info line.

Making selection ranges for several non-contiguous tracks

As described above, selection ranges can cover several tracks. However, it is also possible to exclude tracks from a selection range:

1. Create a selection range from the first to the last desired track.

2. Press [Ctrl]/[Command] and click in the selection range on the tracks you want to exclude from the selection.

3. In the same manner, you can add a track to the selection range by [Ctrl]/[Command]-clicking in the selection range area on the track.

Moving and duplicating

• To move a selection range, click and drag it to a new position.
  This will move the contents of the selection range to the new position. If the range intersected events or parts, these will be split before moving, so that only the sections within the selection range are affected.

• To duplicate a selection range, hold down [Alt]/[Option] and drag.
  You can also use the Duplicate, Repeat and Fill Loop functions, just as when duplicating events (see page 82).
Using Cut, Copy and Paste

When working with selection ranges, you can either use Cut, Copy and Paste on the Edit menu, or use the functions “Cut Time” and “Paste Time” on the Range submenu on the Edit menu. These work differently to their related functions on the Edit menu:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>Cuts out the data in the selection range and moves it to the Clipboard. The selection range is replaced by empty track space in the Project window, meaning that events to the right of the range keep their positions.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copies the data in the selection range to the clipboard.</td>
</tr>
<tr>
<td>Paste</td>
<td>Pastes the clipboard data at the start position and track of the current selection. Existing events are not moved to make room for the pasted data.</td>
</tr>
<tr>
<td>Paste at Origin</td>
<td>Pastes the clipboard data back at its original position. Existing events are not moved to make room for the pasted data.</td>
</tr>
<tr>
<td>Cut Time</td>
<td>Cuts out the selection range and moves it to the Clipboard. Events to the right of the removed range are moved to the left to fill out the gap.</td>
</tr>
<tr>
<td>Paste Time</td>
<td>Pastes the clipboard data at the start position and track of the current selection. Existing events are moved to make room for the pasted data.</td>
</tr>
<tr>
<td>Paste Time at Origin</td>
<td>Pastes the clipboard data back at its original position. Existing events are moved to make room for the pasted data.</td>
</tr>
</tbody>
</table>
Deleting selection ranges

Again, you can either use “regular” Delete or “Delete Time”:

- If you use the Delete function on the Edit menu (or press [Backspace]), the data within the selection range is replaced by empty track space. Events to the right of the range keep their position.

- If you use “Delete Time” on the Edit menu’s Range submenu, the selection range is removed and events to the right are moved to the left to close up the gap.

Other functions

On the Range submenu on the Edit menu, you will find three more range editing functions:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Split</td>
<td>Splits any events or parts that are intersected by the selection range, at the positions of the selection range edges.</td>
</tr>
<tr>
<td>Crop</td>
<td>All events or parts that are partially within the selection range are cropped, that is, sections outside the selection range are removed. Events that are fully inside or outside the selection range are not affected.</td>
</tr>
<tr>
<td>Insert Silence</td>
<td>Inserts empty track space at the start of the selection range. The length of the inserted silence equals the length of the selection range. Events to the right of the selection range start are moved to the right to “make room”. Events that are intersected by the selection range start are split, and the right section is moved to the right.</td>
</tr>
</tbody>
</table>
Region operations

Regions are sections within a clip, with various uses. While regions are perhaps best created and edited in the Sample Editor (see page 344), the following region functions are available on the Audio menu in the Project window:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event as Region</td>
<td>This function is available when one or several audio events are selected. It creates a region in the corresponding clip, with the start and end position of the region determined by the start and end position of the event within the clip.</td>
</tr>
<tr>
<td>Events from Regions</td>
<td>This function is available if you have selected an audio event whose clip contains regions within the boundaries of the event. The function will remove the original event and replace it with event(s) positioned and sized according to the Region(s).</td>
</tr>
</tbody>
</table>
**Options**

**Snap**

The Snap function helps you to find exact positions when editing in the Project window. It does this by restricting horizontal movement and positioning to certain positions. Operations affected by Snap include moving, duplicating, drawing, sizing, splitting, range selection, etc.

- You turn Snap on or off by clicking the Snap icon in the toolbar.

Snap activated.

- **When you are moving audio events with Snap activated, it isn’t necessarily the beginning of the event that is used as Snap position reference. Instead, each audio event has a Snap Point, which you can set to a relevant position in the audio (such as a downbeat, etc.).**

The Snap Point is preferably set in the Sample Editor since it will allow for a higher degree of precision (see page 339). You can however also set the Snap Point directly in the Project Window, in the following way:

1. Select the event.
2. Place the project cursor at the desired position within a selected audio event.
3. Pull down the Audio menu and select “Snap Point To Cursor”.

The Snap Point is set at the cursor position.

The Snap Point for an event is displayed as a blue line in the Project window.
Exactly how Snap works depends on which mode is selected on the Snap mode pop-up menu.

The following sections describe the different Snap modes:

**Grid**

In this mode, the Snap positions are set with the Grid pop-up menu to the right. The options depend on the format selected for the ruler. For example, if the ruler is set to show bars and beats, the grid can be set to bars, beats or the quantize value set with the next pop-up menu to the right. If a time- or frame-based ruler format is selected, the grid pop-up menu will contain time- or frame-based grid options, etc.

When seconds is selected as ruler format, the grid pop-up menu contains time-based grid options.

**Events**

In this mode, the start and end positions of other events and parts become "magnetic". This means that if you drag an event to a position near the start or end of another event, it is automatically aligned with the start or end of the other event. For audio events, the position of the Snap point is also magnetic (see page 339).

- Note that this includes marker events on the marker track. This allows you to snap events to marker positions, and vice versa.
Shuffle

Shuffle mode is useful when you want to change the order of adjacent events. If you have two adjacent events and drag the first one to the right, past the second event, the two events will change places.

The same principle works when changing the order of more than two events:

Magnetic Cursor

When this mode is selected, the project cursor becomes “magnetic”. Dragging an event near the cursor causes the event to be aligned with the cursor position.

Grid + Cursor

This is a combination of the “Grid” and “Magnetic Cursor” snap modes.

Events + Cursor

This is a combination of the “Events” and “Magnetic Cursor” snap modes.

Events + Grid + Cursor

This is a combination of the “Events”, “Grid” and “Magnetic Cursor” snap modes.
**Snap to Zero Crossing**

When this option is activated in the Preferences dialog (Audio page), all audio edits are done at zero crossings (positions in the audio where the amplitude is zero). This helps you to avoid pops and clicks which might otherwise be caused by sudden amplitude changes.

- This setting is global for all windows in all open projects. It is also available as an icon on the Sample Editor.

**Auto scroll**

Auto scroll activated.

When this option is activated, the waveform display will scroll during playback, keeping the project cursor visible in the window.

- If the option “Stationary Cursors” is activated in the Preferences dialog (Transport page), the project cursor will be positioned in the middle of the screen (if possible).
Folder tracks
About folder tracks

Just as the name implies, a folder track is a folder that contains other tracks. Moving tracks into a folder is a way to structure and organize tracks in the Project window. For example, grouping several tracks in a folder track makes it possible for you to “hide” tracks (thus giving you more working space on the screen). You can solo and mute several tracks in a quicker and easier way, and perform editing on several tracks as one entity. Folder tracks can contain any type of track including other folder tracks.
Using folders

Creating a folder track

Folder tracks are created just like any other track: Select “Add Track” from the Project menu and select “Folder” from the submenu that appears.

Moving tracks into a folder

You can move any type of track into a folder by using drag and drop:

1. In the Track List, click on a track that you want to move into a folder, and drag it onto a folder track.
   A green arrow pointing to a folder appears when you drag the track onto the folder track in the list.
2. Release the mouse button.
   The track is now placed in the folder track, and all parts and events on the track will be represented by a corresponding folder part (see page 105), that displays a graphical representation of all parts and events in the folder.

   Since you can move any type of track into a folder track, it is possible to create sub-folders by moving one folder track into another. This is called “nesting”. For example, you could have a folder containing all the vocals in a project, and each vocal part could have a nested folder containing all the takes, in a subfolder for easier handling etc.

Removing tracks from a folder

To remove a track from a folder, simply drag it out of the folder and release it in the Track list.
Hiding/Showing tracks in a folder

You can hide or show the tracks located in a folder by clicking on the “Show/Hide” button (the plus sign) in the Track list for the folder track. Hidden tracks are still played back as usual.

When a folder is “closed” this way, the folder part(s) still give you a graphic representation of the parts and events within the folder.

Muting and soloing folder tracks

One of the main advantages of using folder tracks is that they provide you with a way to mute and solo several tracks as one unit. Muting and soloing a folder track affects all tracks in the folder. You can also solo or mute individual tracks in the folder.

Muting a folder track

You can mute a folder track (and thereby mute all tracks within it) the same way you mute other tracks by clicking in the Mute (“X”) button in the Track list.

Soloing a folder track

You can solo a folder track (all tracks outside the folder are muted) the same way you solo other tracks, by selecting it and clicking the Solo button.

Soloing or muting tracks within a folder

This can be done by showing the tracks in the folder and using the Mute and Solo buttons in the Track list as usual for any tracks inside the folder.
About folder parts

The parts contained in a folder track are shown as folder parts, a graphic representation of the contained events and parts horizontal and vertical position, as well as their respective length. If part colors are used, these are also taken into account in the folder part.
Handling folder parts

When several tracks have been put into a folder track the parts and events on the tracks may end up in several separate folder parts. A new folder part is created automatically if there is a gap between parts and events on the tracks, or in certain circumstances if there is an overlap between the folder part and an event on a track within the folder. This works as follows:

• When an event overlaps with a folder part more than half of its total length, it will be included in the folder part.
  If the overlap is half its length or less it will be placed in a new folder part.

The MIDI part overlaps the folder part, by more than half its length, so it is included in the folder part.

If you move the MIDI part slightly to the right, more than half of the part is positioned outside the folder part, so a new folder part is created.

• If a part “belongs” to a specific folder part, but is placed in a separate folder part due to the overlap, you can simply select both the folder parts if you wish to move the position of the parts together.
Editing folder parts

Folder parts are editable. You can perform most standard editing commands like cut, copy, paste and move etc. The difference compared to normal part or event editing is that all tracks in the folder are affected. For example, in the illustration below you can see the result of splitting a folder part using the Scissor tool.

Splitting the folder part will split all contained parts or events present at that position.

In most respects a folder part can be handled just like other events or parts in the event display.

- Any editing performed on a folder part affects all tracks within the folder.

Resizing folder parts

If you resize a folder part, events and parts within the folder part are resized according to the currently selected type of resizing.

This is set by clicking the Arrow tool icon on the toolbar and selecting either “Normal Sizing” or “Sizing Moves Contents” from the pop-up menu – see page 85. The third option on the pop-up “Sizing Applies Time Stretch” cannot be used to resize folder parts.
Editing tracks within folder parts

Tracks inside a folder can be edited as one entity, by performing the editing directly on the folder part containing the tracks as explained above. You can also edit individual tracks within the folder, by showing the contained tracks, selecting parts and opening an editor as usual.

Double clicking a folder part opens the editors for the corresponding track classes present in the folder. The following applies:

• All MIDI parts located on the tracks within the folder, are displayed as if they were on the same track, just like when opening the Key Editor with several MIDI parts selected.
To be able to easily discern the different tracks in the Editor, give each track a different color in the Project window and use the “Part Colors” option in the Editor (see page 559).

• If the folder contains tracks with audio events and/or audio parts, the Sample and/or Audio Part Editors are opened, with each audio event and audio part in a separate window.
5

Using Markers
About markers

Markers are used to quickly locate to any position. If you often find yourself jumping to a specific position, you can set up that position as a marker. There are two types of markers:

- Cycle markers, which allow you to store the start and end positions of a range.
- Standard markers which store a specific position.

Markers can be created and edited in several ways:

- By using the Marker window (see page 111).
- By using the Marker track (see page 114).
- By using the Project Browser (see page 119).

About the left and right locators

The first two markers are the left and right locators (indicated on the Transport panel by “L” and “R”, respectively). As described on page 22, these are used for specifying punch-in and punch-out positions during recording, and as boundaries for Cycle playback and recording.

The locators can be managed in the same way as the other markers, but there are also some special functions for setting locator positions:

- To set the left locator, press [Ctrl]/[Command] and click at the desired position in the ruler. Similarly, pressing [Alt]/[Option] and clicking in the ruler sets the right locator.
- Holding down [Ctrl]/[Command] and pressing [1] or [2] on the numeric keypad sets the left or right locator to the current project cursor position.
- By creating cycle markers you can store any number of left and right locator positions, which can be recalled by simply clicking the marker, see page 117.
- Selecting “Locators to Selection” from the Transport menu (key command [P]) sets the locators to encompass the current selection. For this to be available, you must have selected one or several events, or made a selection range.
- You can also adjust the locator positions numerically in the Transport panel.
The Marker Window

In the Marker window you can perform most editing operations concerning markers. Markers are displayed sequentially starting from the top of the window in the order that they occur in the project. Most functions in the Marker window are also available in the Inspector when the Marker track is selected.

To open the Marker window, select “Markers” from the Project menu or use the key command (by default [Ctrl]/[Command]-[M]).

The Marker window columns

The Marker window is divided into six columns which are used for performing the following operations:

- The leftmost column is the Locate column. Clicking in this column will move the project cursor to the corresponding Marker position. A blue arrow indicates the Marker at the project cursor position (or the closest marker before the project cursor).

- The ID column is used to edit marker ID-numbers. See “About Marker ID-numbers” below.

- The Position column displays the markers’ time positions (or start positions for cycle markers). The marker positions can be edited directly in this column.

- The End and Length columns display the end positions and length of cycle markers – see page 114. These values can also be edited directly in the respective column.

- The Description column lets you enter names or descriptions for markers. The left and right locator descriptions cannot be changed.
Adding markers in the Marker window

You add position markers (in Stop mode, during playback or during recording) by clicking the Add button or by pressing [Insert] on the computer keyboard. Markers are always added at the current project cursor position.

- To add a cycle marker, select "Cycle Markers" from the Show pop-up menu and click the Add button.
  This adds a cycle marker between the left and right locator. You can also draw cycle markers on the Marker track (see page 115).

Removing markers in the Marker window

To remove a marker, select it and click the Remove button.

Moving marker positions in the Marker window

The Move button in the Marker window can be used to "reprogram" marker positions. Proceed as follows:

1. Set the project cursor to the position to which you want to move (or re-program) a marker.

2. Select the marker which you want to change in the Marker window.
   Do not select the marker by clicking in the leftmost column, as this will move the project cursor you set up in the previous step.

- If a cycle marker is selected, the Move operation affects the cycle marker start position.
  The length of the range is not affected.

3. Click the Move button.
About marker ID-numbers

Each time you add a marker it is automatically and sequentially assigned an ID-number, starting from ID 3 and onwards. Marker IDs 1 and 2 are always assigned to the left and right locators and cannot be changed, but all other ID-numbers can be changed later. The purpose of changing ID-numbers is to assign specific markers to key commands (see below).

IDs for cycle markers are shown in brackets and start from [1]. These may also be changed, but as IDs for cycle markers cannot be assigned to key commands, the numbers simply serve to identify a cycle marker. Instead you use the left and right locators to access cycle markers, see page 117.

Assigning markers to the numeric keypad

As explained earlier, marker ID-numbers are assigned automatically and sequentially each time you add a marker. The (default) numeric pad key commands 3 to 9 always correspond to marker ID-numbers 3 to 9. Hence, if you have more than 6 markers in a project, markers assigned ID-numbers from 10 and onwards cannot be accessed using the numeric key pad.

If you want to keep all current markers, but want to specify which markers are assigned to the numeric key pad, the solution is to reassign the marker ID-numbers. Proceed as follows:

1. First decide which of the current markers with an ID between 3 and 9 you want to reassign to a new ID-number, and thus remove its assignment to the numeric key pad.
   Memorize the ID-number.

2. Type in this ID-number in the ID column of the marker you want to assign to a numeric pad key and press enter.
   The two marker ID-numbers are switched, and the key now locates to the marker selected in this step.

3. Repeat as necessary for other markers.

• You can also simply remove a marker with an ID-number between 3 to 9 to free up a key – see “Removing markers” on page 112.
Using the Marker track

The Marker track is used to view and edit markers. Markers shown on the Marker track are exactly the same as shown in the Marker window, and any changes made on the Marker track are reflected in the Marker window and vice versa. Standard position markers in the Marker track are shown as marker events, vertical lines with the marker name (if assigned) and number beside it. If you select the Marker track, all markers are shown in the Inspector, much like in the Marker window.

About cycle markers

Cycle markers are shown on the Marker track as two events joined together by a horizontal line. Cycle markers are ideal for storing sections of a project. By setting cycle markers for sections of a song, for example "Intro", "Verse", "Chorus" etc., this enables you to quickly navigate to the song sections, and also to optionally repeat the section (by activating Cycle on the Transport bar). In addition, Cycle markers appear on the horizontal Zoom pop-up menu in the Project window. If selected the screen is automatically zoomed to encompass the Cycle marker range.

Opening the Marker track

To open the Marker track, select "Marker" from the Project menu – Add Track submenu. You can only have one Marker track in a project.
Editing markers on the Marker track

The following basic editing functions can be performed directly on the Marker track:

1. **Add position markers “on the fly”**.
   Use the [Insert] key or the “Add Marker” button in the Track list for the Marker track to add position markers at the current cursor position during playback.

2. **Add a cycle marker at the left and right locator positions**.
   Clicking the “Add Cycle Marker” button in the Track list for the Marker track adds a cycle marker spanning the area between the left and right locator.

3. **Selecting markers**.
   You can use standard selection techniques like click dragging to make a selection rectangle or using [Shift] to select separate markers.

4. **Draw position markers**.
   By clicking with the Pencil tool (or pressing [Alt]/[Option] and clicking with the Arrow tool), you can create or “draw” position marker events at any position on the track. If snap is activated on the toolbar, this determines at which positions you can draw markers.

5. **Draw cycle markers**.
   To draw a cycle marker range, you press [Ctrl]/[Command] and use the Pencil tool or the Arrow tool. Snap settings are applied if activated.
Cycle markers can freely overlap.

- Resize a cycle marker.
  Select a cycle marker by clicking on it. As you can see, two handles appear at the bottom of the start and end events. If you click and hold one of the handles you can drag the event left or right to resize the cycle marker. This can also be done numerically on the info line.

- Move markers.
  Use usual techniques as object selection and dragging or editing on the info line to move selected markers. As usual, snap is taken into account if activated.

- Remove markers.
  This is done exactly the same way as for other events, i.e selecting and pressing Backspace, using the Erase tool etc.

- Naming markers.
  A selected marker’s name can be edited by clicking the name on the info line.
Navigating using cycle markers

Cycle markers are not directly used to navigate the position, but represent ranges that you can move the left and right locators to by simply selecting the cycle marker.

- If you double click on a cycle marker, or select it from the Cycle pop-up menu in the track list, the left and right locators are moved to encompass the cycle marker.

  You can now set the project cursor position to the start or the end of the cycle marker by selecting the left or right locator from the Locate pop-up menu, or by using the numeric pad keys [1] and [2].

Zooming to cycle markers

- By selecting a cycle marker on the Zoom pop-up menu, the event display is zoomed in to encompass the selected range only.

  This can also be done by keeping [Alt]/[Option] pressed while double-clicking on the cycle marker in the event display.

Editing cycle markers using tools

Cycle markers can be edited on the Marker track using the following tools. Note that the snap value applies as with regular events:

<table>
<thead>
<tr>
<th>Tool</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pencil</td>
<td>Press [Ctrl]/[Command] and use the Pencil tool to create new ranges (as described above).</td>
</tr>
<tr>
<td>Eraser</td>
<td>Click with the Eraser tool to delete a cycle marker. If you hold down [Alt]/[Option] when you click, all consecutive markers will also be deleted.</td>
</tr>
<tr>
<td>Scissors</td>
<td>Click with the Scissors tool to split the cycle marker in two. If you hold down [Alt]/[Option] and click, the range will be split into many ranges with the same length (the length is governed by where in the range you click).</td>
</tr>
</tbody>
</table>

Selection Range  This is described on page 118.

The other tools cannot be used with cycle markers.
Using markers to make range selections in the Project window

Besides enabling you to quickly move the locators and the project cursor, cycle markers can be used in conjunction with the Range Selection tool to make range selections in the Project window. This is useful if you quickly want to make a selection that spans all tracks in the project.

• Double click on a cycle marker to set the left and right locator to the start and end position of the range, then double click inside the cycle marker with the Range Selection tool.

Or...

• Double click with the Range Selection tool between any two position markers.

This selects everything in the Project window located inside of the marker range (or locator positions), just as if you had used the Range Selection tool to draw a rectangle. Any functions or processing you perform will now affect the selection only.

In this example, Verse 1 has been selected with the Range Selection tool.
Moving and Copying parts

This is a quick way to move or copy complete sections of the project (on all tracks):

1. Click on a cycle marker with the Range Selection tool.
   Everything in the project within the cycle marker boundaries is selected.

2. Drag the cycle marker to a new position.
   The selection in the Project window is moved to the same position.

• If you hold down [Alt]/[Option] while you drag the cycle marker, the selection in the Project window is copied instead.

Editing markers in the Project Browser

❖ To view and edit markers in the Project Browser, the Marker track must be added to the Project window.

If you have a Marker track in the Project window, you can create and edit all marker parameters, including marker ID’s, in the Project Browser. Proceed as follows:

1. Open the Project Browser by selecting it on the Project menu.

2. Select “Marker” in the Project Structure window.
   A list of the markers is shown in the main Browser window.

3. Now you can edit marker names, positions and ID numbers, by selecting an item and typing in values as usual in the main Editor window.
   For details about editing in the Project Browser see page 605.

• You can use the Add pop-up menu and Add button to insert new markers or cycle markers when the Marker track is selected in the Project Browser.
   This works just like the Add button in the Marker window (see page 112).
6

Fades and Crossfades
Creating Fades

There are two main types of fade-ins and fade-outs in audio events in Cubase SX/SL:

Fades created by using the Fade handles

Selected audio events have blue handles in the upper left and right corners. These can be dragged to create a fade-in or fade-out respectively.

Creating a fade-in. The fade is automatically reflected in the shape of the event’s waveform, giving you a visual feedback of the result when you drag the fade handle.

Fades created with the handles are not applied to the audio clip as such. Instead, Cubase SX/SL seamlessly switches between the fade sections and the actual clip on playback. This means that several events referring to the same audio clip can have different fade curves.

Note that if you select multiple events and drag the fade handles on one of them, the same fade will be applied to all selected events.

- A fade can be edited in the Fade dialog, as described on the following pages. You open the dialog by double clicking on the fade, or by selecting the event and selecting “Open Fade Editor(s)” from the Audio menu (note that this will open two dialogs if the event has both fade-in and fade-out curves). If you adjust the shape of the fade curve in the Fade dialog, this shape will be maintained when you later adjust the length of a fade.

- You can make the fade longer or shorter at any time, by dragging the handle. You can actually do this even without selecting the event first, i.e. without visible handles. Just move the mouse pointer along the fade curve until the cursor turns into a bidirectional arrow, then click and drag.

- If the option “Show Event Volume Curves Always” is activated in the Preferences dialog (Event Display – Audio page), the fade curves will be shown in all events, regardless of whether they are selected or not. If the option is deactivated, the fade curves are shown in selected events only.
Creating and adjusting fades with the Range Selection tool

“Handle-type” fades can also be created and adjusted with the Range Selection tool, in the following way:

1. Select a section of the audio event with the Range Selection tool.
   The result depends on your selection, in the following way:
   • If you select a range from the beginning of the event, a fade-in will be created within the range.
   • If you select a range that reaches the end of an event, a fade-out will be created in the range.
   • If you select a range encompassing a middle section of the event, but not reaching neither the start nor the end, both a fade-in and a fade-out will be created outside of the selected range. In other words, the fade-in will cover the area from the beginning of the event to the beginning of the selected range, and the fade-out will cover the area from the end of the selected range to the end of the event.

2. Pull down the Audio menu and select “Adjust Fades to Range”.
   The fade areas are adjusted according to the selection range.

❖ You can select multiple audio events on separate tracks with the Range Selection tool, and apply the fade to all of them simultaneously.

About the volume handle

A selected audio event also has a blue handle in the top middle. This is the volume handle, and it provides a quick way of changing the volume of an event, directly in the Project window. It stands in direct correlation with the volume setting in the info line, that is, dragging the volume handle also changes the value in the info line.

The volume change is displayed numerically in the info line.

The event waveform reflects the volume change.

Drag the Volume handle up or down to change the volume of the event.
Fades created by processing

If you have selected an audio event or a section of an audio event (using the Range Selection tool), you can apply a fade-in or fade-out to the selection by using the “Fade In” or “Fade Out” functions on the Process submenu on the Audio menu. These functions open the corresponding Fade dialog, allowing you to specify a fade curve.

- Note that the length of the fade area is determined by your selection. In other words, you specify the length of the fade before you enter the Fade dialog.

- Also note that you can select multiple events and apply the same processing to all of them simultaneously.

Fades created this way are applied to the audio clip rather than to the event. This has the following consequences:

- If you later create new events that refer to the same clip, these will have the same fades.
- At any time you can remove or modify the fades using the Offline Process History (see page 317).

If other events refer to the same audio clip, you will be asked whether you want the processing to be applied to these events or not.

- Continue will apply the processing to all events that refer to the audio clip.
- New Version will create a separate, new version of the audio clip for the selected event.
- You can also choose to put a checkmark in the “Do not ask this message again” box. Regardless of whether you then choose “Continue” or “New Version”, any and all further processing you do will conform to the option you select.

- You can change this setting at any time in the Preferences dialog (Audio page), under “On Processing Shared Clips”.

Removing fades

To remove a fade, select the event and select “Remove Fades” from the Audio menu.

You can also use the Range Selection tool to remove fades and crossfades:

1. Drag the Range Selection tool in the Project window, so that the selection encloses all of the fades and crossfades you wish to remove.
2. Select “Remove Fades” from the Audio menu.

The Fade Dialogs

The Fade dialogs appear when you edit an existing fade or use the “Fade In”/“Fade Out” functions on the Audio menu’s Process submenu. The picture below shows the Fade In dialog; the Fade Out dialog has identical settings and features.

- If you open the Fade dialog(s) with several events selected, you can adjust the fade curves for all these events at the same time.
  This is useful if you want to apply the same type of fade-in to more than one event, etc.

Curve Kind

These buttons determine whether the fade curve should consist of spline curve segments (left button) or linear segments (right button).
Fade Display

Shows the shape of the fade curve. The resulting waveform shape is shown in dark grey, with the current waveform shape in light grey.

You can click on the curve to add points, and click and drag existing points to change the shape. To remove a point from the curve, drag it outside the display.

Restore button

The Restore button (the button to the right above the fade display) is only available when editing fades made by dragging the fade handles. Click this to cancel any changes you have made since opening the dialog.

Curve shape buttons

These buttons give you quick access to some common curve shapes.

Default button

Clicking the “As Default” button stores the current settings as the default fade. This shape will be used whenever you create new fades.

Presets

If you have set up a fade-in or fade-out curve that you may want to apply to other events or clips, you can store it as a preset by clicking the Store button.

- To apply a stored preset, select it from the pop-up menu.
- To rename the selected preset, double click on the name and type a new one.
- To remove a stored preset, select it from the pop-up menu and click Remove.

- Stored fade-in presets will only appear in the Fade In dialog, and fade-out presets will only appear in the Fade Out dialog.
### Preview, Apply and Process

The buttons in the bottom row are different depending on whether you are editing a fade made with the fade handles or applying a fade using processing:

The Edit Fade dialogs have the following buttons:

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK</td>
<td>Applies the set fade curve to the event, and closes the dialog.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Closes the dialog.</td>
</tr>
<tr>
<td>Apply</td>
<td>Applies the set fade curve to the event, without closing the dialog.</td>
</tr>
</tbody>
</table>

The Process Fade dialogs have the following buttons:

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preview</td>
<td>Plays back the fade area. Playback will repeat until you click the button again (the button is labeled &quot;Stop&quot; during playback).</td>
</tr>
<tr>
<td>Process</td>
<td>Applies the set fade curve to the clip, and closes the dialog.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Closes the dialog without applying any fade.</td>
</tr>
</tbody>
</table>
Creating Crossfades

Overlapping audio material on the same track can be crossfaded, for smooth transitions or special effects. You create a crossfade by selecting two consecutive audio events and selecting the Crossfade command on the Audio menu (or using the corresponding key command, by default [X]). The result depends on whether the two events overlap or not:

- If the events overlap, a crossfade is created in the overlapping area. The crossfade will be of the default shape – initially a linear, symmetric crossfade, but you can change this as described below.

- If the events don’t overlap but are directly consecutive (lined up end-to-start, with no gap) it’s still possible to crossfade them – provided that their respective audio clips overlap! In this case, the two events are resized so that they overlap, and a crossfade of the default length and shape is applied.

The default crossfade length and shape are set in the Crossfade dialog (see page 132).
An example:

The events in themselves do not overlap, but their clips do. Therefore, the events can be resized so that they overlap, which is required for a crossfade to be created.

When you select the Crossfade function, the two events are resized so that they overlap, and a default crossfade is created in the overlapping section.

- If the events don’t overlap, and cannot be resized enough to overlap, a crossfade cannot be created.

- Once you have created a crossfade, you can edit it by selecting one or both crossfaded events, and selecting “Crossfade” from the Audio menu again (or by double clicking in the crossfade zone). This opens the Crossfade dialog, as described below.

Removing Crossfades

To remove a crossfade, select the events and select “Remove Fades” from the Audio menu, or use the Range Selection tool:

1. Drag the Range Selection tool in the Project window, so that the selection encloses all of the fades and crossfades you wish to remove.

2. Select “Remove Fades” from the Audio menu.
The Crossfade Dialog

The Crossfade dialog contains separate settings for the fade-in and fade-out curve in the crossfade, as well as common settings.

The left part of the Crossfade dialog contains two sections with settings for the fade-in and fade-out curves in the crossfade. These two sections have identical settings.

Play buttons

The “Play Fade” and “Play Dry” buttons allow you to audition the fade-in or fade-out part, with or without the crossfade.

The “Play” button plays back the whole crossfade. Playback will continue repeatedly until you click the button again (the button will be labeled “Stop” during playback).

Curve kind buttons

These buttons determine whether the corresponding fade curve should consist of spline curves (left button) or linear segments (right button).
Fade Displays

Shows the shape of the fade-out and fade-in curve, respectively. You can click on the curve to add points, and click and drag existing points to change the shape. To remove a point from the curve, drag it outside the display.

Curve shape buttons

These buttons give you quick access to some common curve shapes.

Crossfade Display

The bottom display shows the shape of the whole crossfade curve and the resulting waveform. You cannot edit the curve in this display.

Equal Power and Gain

If you activate the “Equal Power” checkbox, the fade curves are adjusted, so that the energy (power) of the crossfade will be constant all along the crossfade region.

Equal Power curves have only one editable curve point. You cannot use the Curve kind buttons or the presets when this mode is selected.

If you activate the “Equal Gain” checkbox, the fade curves are adjusted so that the summed fade-in and fade-out amplitudes will be the same all along the crossfade region. This is often suitable for short crossfades.

Length settings

You can adjust the length of the crossfade area numerically in the “Length” field. Use the pop-up menu in the field below to select a time format (see page 61).

- The specified length is applied when you click “Apply” or “OK”.
- If possible, the length change will be applied equally to “both sides” of the crossfade (i.e. Cubase SX/SL tries to “center” the crossfade).

To be able to resize a crossfade this way, it must be possible to resize the corresponding event. For example, if the left crossfaded event already plays its audio clip to the end, its endpoint cannot be moved any further to the right.
Default buttons
Clicking the “As Default” button stores all of the current settings as the default crossfade. These settings will then be used whenever you create new crossfades.

• The Crossfade Length setting is included in the Default settings. However, it is only applied if the events to be crossfaded don’t overlap – otherwise the crossfade will be in the overlap area (see page 128).

Clicking the “Recall Default” button copies the curves and settings in the Default crossfade to the Crossfade dialog.

Presets
If you have set up a crossfade shape that you may want to apply to other events, you can store it as a preset by clicking the Store button.

• To apply a stored preset, select it from the pop-up menu.

• To rename the selected preset, double click on the name and type a new one.

• To remove a stored preset, select it from the pop-up menu and click Remove.

Restore
Restores the crossfade curve to the shape it had when you opened the dialog.

OK
Applies the settings to the crossfade and closes the dialog.

Cancel
Closes the dialog without applying any changes.

Apply
Applies the settings to the crossfade without closing the dialog.
Auto Fades and Crossfades

Cubase SX/SL features an Auto Fade function that can be set both globally, i.e. for the entire project, and separately for each audio track. The idea behind the Auto Fade function is to create smoother transitions between events by applying short (1–500 ms) fade-ins and fade-outs.

- Note that Auto Fades are not applied to the audio events, but calculated in real time during playback. This means that the larger the number of audio tracks with Auto Fades activated in a project, the more the playback performance will be negatively affected.

Making global Auto Fade settings

1. To make Auto Fades settings globally for the project, select “Auto Fades Settings...” from the Project menu. This opens the Auto Fades dialog for the project.

2. Use the checkboxes in the upper right corner to activate or deactivate Auto Fade In, Auto Fade Out and Auto Crossfades, respectively.
3. Use the Length value field to specify the length of the auto fade or crossfade (1-500 ms).

4. To adjust the shapes of Auto Fade In and Auto Fade Out, select the “Fades” tab and make settings as in the regular Fade dialogs.

5. To adjust the shape of the Auto Crossfade, select the “Crossfades” tab and make settings as in the regular Crossfade dialog.

6. If you want to use the settings you have made in forthcoming new projects, click the “As Default” button. The next time you create a new project, it will use these settings by default.

7. Click OK to close the dialog.

Making Auto Fade settings for a separate track

By default, all audio tracks will use the settings you have made in the Project Auto Fades dialog. However, since Auto Fades use computing power, a better approach may be to turn Auto Fades off globally, and activate them for individual tracks, as needed:

1. Right-click (Win) or [Ctrl]-click (Mac) the track in the track list and select “Auto Fades Settings...” from the context menu (or select the track and click the “Auto Fades Settings” button in the Inspector). The Auto Fades dialog for the track appears. This is identical to the Project Auto Fades dialog, with the addition of a “Use Project Settings” option.

2. Deactivate the “Use Project Settings” option. Now, any settings you make will be applied to the track only.

3. Set up the Auto Fades as desired and close the dialog.

Reverting to Project Settings

If you want a track to use the global Auto Fade settings, open the Auto Fades dialog for the track and activate the “Use Project Settings” checkbox. This makes the track use the Auto Fade settings you have made for the project.
7
The Mixer
About this chapter

This chapter contains detailed information about the elements used when mixing audio and MIDI in the Mixer. Some mixing-related features are not described in this chapter. These are the following:

- Setting up and using audio effects.  
  See page 180.

- Setting up and using MIDI effects.  
  See page 430.

- Surround Sound.  
  See page 232.

- Automation of all Mixer parameters.  
  See page 250.

- How to mix down several audio tracks (complete with automation and effects if you wish) to a single audio file.  
  See page 627.
Overview

The Mixer offers a common environment for controlling levels, pan, solo/mute status etc. for all channel types.

- The picture above shows the Mixer in Cubase SX - the expanded upper pane is not available in Cubase SL (see page 156).
Opening the Mixer

There are in fact two separate mixer items selectable from the Devices menu; “Mixer” and “Mixer 2”. These are not separate Mixers, but rather separate Mixer windows that can be configured independently, using the various View options (see below) and Channel View sets functions (see page 144) that are described in this chapter. Using two Mixer windows in conjunction with the aforementioned View functions enables you to switch between a multitude of user configurations of the Mixer with ease.

- To open the Mixer, select “Mixer” from the Devices menu.
  Each audio, MIDI and group channel track in the Project window is also represented by a “channel strip” in the Mixer.
- The order of the audio and MIDI channel strips (from left to right) in the Mixer corresponds to the Project window Track list.
  If you reorder audio and MIDI tracks in the Track list, this will be reflected in the Mixer (if the Mixer is open when reordering tracks it will have to be closed and opened again to reflect the changes). Group channels in the Mixer cannot be reordered, see below.

What channel types can be shown in the Mixer?

- In addition to the aforementioned track based audio, MIDI and group mixer channels, any activated ReWire (see page 688) and VST Instrument (see page 206) channels are also shown in the Mixer.
  These cannot be reordered, and appear to the right of the audio and MIDI channels in the Mixer, ReWire channels first, then VST Instrument (VSTi) channels. Group channels always appear to the right of other channel types in the Mixer.
- Folder, marker and automation tracks are not shown in the Mixer.

View options

The Mixer can be configured in various ways to suit your needs and to save screen space. Here follows a run through of the various view options:
Selecting what channel types to show/hide

You can specify what channel types to show/hide in the Mixer. Proceed as follows:

1. Open the Mixer.
   The leftmost strip is called the Common panel and is always shown in the Mixer. This contains various global settings and options relating to the Mixer.

2. Click the View Options pop-up in the Common panel (the down arrow at the top of the normal Common panel strip).
   A pop-up menu appears and the last five items on the menu are the channel types. By default all channel types are viewable (i.e. ticked).

3. You can now untick the channel type(s) that you wish to hide from view by unticking the corresponding item(s) from the menu.
   Regular audio tracks are named “Disk” channels on the menu.
• This can also be done using the Channel type show/Hide indicators at the bottom of the Common panel. These are lit for visible channel types. Click on the corresponding channel type indicator to hide or show the corresponding channel type in the Mixer.

The Channel type show/hide indicators. From top to bottom Disk, Group, VSTi, ReWire and MIDI channels.

**Selecting individual channels to show/hide**

You can also select to show/hide individual channels in the Mixer. Proceed as follows:

1. Open the View Options pop-up for a channel that you wish to hide by clicking on the down arrow at the top of the channel strip.

2. Activate the “Hideable“ item from the menu. The menu item is now ticked, but the channel strip is still visible.

3. Repeat steps 1-2 for each channel that you wish to hide.
4. When you have activated “Hideable” status for all channels you wish to hide, pull down the Global View Options pop-up for the Common panel and deactivate (untick) the “Hideable” item.

When the “Hideable” item is deactivated (unticked) on the Common panel View Options pop-up, all individual channel strips that are set to “Hideable” status will be hidden in the Mixer.

5. To make hidden channels visible again, activate Hideable on the Common panel View Options menu.
You can store different configurations of the show/hide status for channels by using the Channel View Sets function, see page 144.
Normal vs. Extended channel strips (Cubase SX only)

Also on the Common panel View Options pop-up, you have the option of selecting Normal or Extended channel strips. Alternatively, click the button directly below the down arrow symbol of the pop-up menu. Normal channel strips only show the fader panels with the associated vertical row of buttons. Extended channel strips will show an extra panel above the fader panel.

Selecting what to display in the extended channel strip (Cubase SX only)

You can select what to display in the extended channel strip individually for each channel from the View Options pop-up at the top of each channel strip, or globally from the View Options pop-up on the Common panel.

- See page 156 for a description of the various options for audio channels.
- See page 169 for a description of the various options for MIDI channels.
Setting the width of channel strips

Each channel strip’s width can be sized to either “Wide” or “Narrow” mode from the View Options pop-up at the top of each channel strip.

- Narrow channel strips contain a narrow fader, miniature buttons, plus the View Options pop-up. Only a blank panel is shown in the extended section for narrow channel strips. If you select to show parameters in the extended section of a narrow strip, the channel strip will automatically be resized to wide.

Wide and narrow channel strips.

- When selecting wide or narrow channel strips from the Common panel View Options pop-up, all channel strips are affected.
Channel View Sets

Channel View Sets are user definable configurations of the Mixer windows. If you are working with a large number of channels, it may be convenient to be able to hide certain channels (or channel types). Proceed as follows:

1. Set up the Mixer the way you wish to store it as a View Set.

The following settings will be stored:

- Settings for individual channel strips (e.g. narrow or wide mode and whether the channel strip is hidden or not).
- The hide/show status for channel types and for the Master section.
- Settings for what is shown in the extended view of the Mixer (Cubase SX only).

The Mixers’ display status (whether Normal or Extended mode is selected - Cubase SX only) is not saved with the View Set.
2. When you have set up the Mixer as you want it, click the “Create/Select Channel View Sets” button at the bottom of the Common Panel, and select “Add” from the pop-up menu that appears. By selecting from the items on this menu, you can create, load and delete View Sets. If no View Sets have been stored there will only be two items on the menu; Add and Remove.

The items at the top of the menu in the picture to the right are previously stored Channel View Sets.

3. A dialog appears, allowing you to type in a name for the View Set. Do so and click OK to store the current Mixer View Set.

- You can now return to this saved configuration at any time, by clicking the Channel View Sets button and selecting it from the pop-up menu.

- To remove a stored Channel View Set, select it from pop-up so that the View Set is active, then pull down the pop-up again and select Remove.

- Some remote control devices (such as Steinberg’s Houston) feature this function, which means that you can use the remote device to switch between the Channel View Sets.
The audio channel strips

The Mixer in normal mode (no extended channel strips), showing (from left to right) the Common panel, a stereo audio channel, a VST Instrument channel, and a group channel strip.

All audio related channel types (audio, group, VST Instrument or ReWire) basically have the same channel strip layout. Only audio track (disk) channels have an Input source pop-up, a Record Enable and Monitor button (since audio inputs are never routed to group or VST Instrument channels). VST Instrument channels have an additional Edit button for opening the instrument’s control panel.
About the Insert/EQ/Send indicators and bypass buttons

The three indicator buttons in each audio channel strip have the following functionality:

• If an Insert or Send effect or EQ module is activated for a channel, the corresponding button is lit. The effect indicators will be blue, the EQ indicator will be green.

• By clicking these buttons when lit, the corresponding EQ or effects section will be bypassed. Bypass is indicated by yellow buttons. Clicking the button again deactivates bypass.
The MIDI channel strips allow you to control volume and pan in your MIDI instrument (provided that they are set up to receive the corresponding MIDI messages). The settings here are also available in the Inspector for MIDI tracks (see page 423).
The Common panel

The Common panel appears to the left in the Mixer and Channel settings windows and contains settings for changing the look and behavior of the Mixer, as well as global settings for all channels.

- The View Option buttons for setting what to display in the extended channel strip (Cubase SX only). Not visible in Normal mode.
- View Options pop-up.
- Toggle between normal/extended Mixer display (Cubase SX only).
- Show Master bus fader (not shown in Channel Settings Common panel, only in the Mixer).
- Global Solo/Mute On/Off, see page 154.
- Global automation Read/Write buttons, see the “Automation” chapter.
- Channel Settings Copy/Paste, see page 163.
- Channel Select pop-up.
- These 5 buttons select what channel types are shown/hidden in the Mixer.
- This button allows you to save, load and delete Mixer View Sets, see page 144.
The Master section

The Master section allows you to control the output level of the Master bus (the main output bus). With the Mixer in extended mode (Cubase SX only), the Master section will also contain the Master effect slots. This section can be shown or hidden in the Mixer by clicking the Show Master button in the Common panel.
The VST Outputs window

This is a separate window, opened from the Devices menu. If your audio hardware has several outputs (more than a single stereo pair), the VST Outputs window will show one stereo bus for each stereo output pair. Use the settings in the window to activate or deactivate buses, route each bus to the desired output on your audio hardware and control the bus volumes.
Basic mixing procedures

Setting volume in the Mixer

In the Mixer, each channel strip has a fader for volume control.

• For audio channels, the faders control the volume of the channels before they are routed directly or via a group channel to a stereo output bus, with separate faders for the left and right outputs. The Master Gain fader in the Mixer determines the output level of the Master bus.

• MIDI channels handle fader volume changes in the Mixer by sending out MIDI volume messages to the connected instrument(s). Connected instruments must be set to respond to MIDI messages (such as MIDI volume in this case) for this to function properly.

• The fader settings are displayed numerically below the faders, in dB for audio channels and in the MIDI volume 0 to 127 value range for MIDI channels. You can click in the fader value fields and enter a volume setting by typing.

• To make fine volume adjustments, hold down [Shift] when you move the faders.

• If you hold down [Ctrl]/[Command] and click on a fader, it will automatically be set to position 0.0 dB for audio channels, or MIDI volume 100 for MIDI channels.

• Audio Output bus faders normally move together (move one and the other follows), but if you deactivate the Fader Link switch you can change either independently. You can also hold down [Alt]/[Option] and move faders separately.

You can use the faders to set up a volume balance between the audio and MIDI channels and perform a manual mix, by moving the faders and other controls while playing back. By using the Write function (see page 258), you can automate the levels and most Mixer actions.

 ifstream It is also possible to adjust the volume of a selected audio event in the Project window or Audio Part Editor, by making volume settings on the info line, or by using the volume handle (see page 123).
About MIDI tracks set to the same MIDI channel

If you have several MIDI tracks/Mixer channels set to the same MIDI channel (and routed to the same MIDI output), making volume settings for one of these MIDI tracks/Mixer channels will also affect all other Mixer channels set to the same MIDI channel/output combination. This also applies to pan settings.

About the level meters for audio channels

When playing back audio in Cubase SX/SL, the level meters in the Mixer show the level of each audio channel. If the peak level of the audio goes above 0dB, the numerical level indicator will then show a positive value (i.e. a value above 0dB).

Cubase SX/SL uses 32 bit floating point processing internally, so there is virtually limitless headroom – signals can go way beyond 0dB without introducing distortion. Therefore:

- Having higher levels than 0 dB for individual channels and groups is not a problem in itself. The audio quality will not be degraded by this.

This is however not the case for the buses in the VST Outputs window (including the Master bus, which can be shown in the Mixer as well)! In the output buses, the floating point audio is converted to the resolution of the audio hardware. In the audio domain, the maximum level is 0dB. Levels higher than 0 dB will cause the clip indicators above the meters for each bus to light up. If the clip indicators light up for a bus, this indicates actual clipping – digital distortion which should be avoided.

- If the Clip indicator lights up for the Master bus or any other output bus, reset the clip indicator by clicking on it, and lower the level until the indicator doesn’t light up.
About level meters for MIDI channels

The level meters for MIDI channels do not show volume levels. Instead, they indicate the *velocity* values of the notes played back on MIDI tracks.

- Therefore, if you pull down a fader for a MIDI channel that is playing, the meter will still show the same “level”, although the actual volume will change (given that the connected MIDI device is set to respond to MIDI volume).

Using Solo and Mute

The Mute (top) and Solo buttons.

You can use the Mute and Solo buttons to silence one or several audio or MIDI channels. The following applies:

- The Mute button silences the selected channel. Clicking the Mute button again un-mutes the channel. Several channels can be muted simultaneously. A muted channel is indicated by a lit Mute button, and also by the lit Global Mute indicator on the Common panel.

- Clicking the Solo button for a channel mutes all other channels. A soloed channel is indicated by a lit Solo button, and also by the lit Global Solo indicator on the Common panel. Click the Solo button again to turn off Solo.

  - Several channels can be soloed at the same time. However, if you press [Ctrl]/[Command] and click the Solo button for a channel, any other soloed channels will automatically be un-soloed (i.e. this Solo mode is exclusive).

  - [Alt]/[Option]-clicking a Solo button activates “Solo Defeat” for that channel. In this mode (indicated by a red solo button without any other channels being muted) the channel will not be muted if you solo another channel (see page 194 for a practical use of this). To turn off Solo Defeat, [Alt]/[Option]-click the Solo button again.

  - You can un-mute or un-solo all channels by clicking the Mute or Solo indicator on the Common panel.
Setting pan in the Mixer

The pan control

The Pan controls in the Mixer are used to position a channel between the left and right side of the stereo spectrum. For stereo audio channels, Pan controls the balance between the left and right channels.

- To make fine pan adjustments, hold down [Shift] when you move the pan control.
- To select center pan position, hold down [Ctrl]/[Command] and click on the pan control.

For audio channels, the output bus faders determine the levels of each “side” in the stereo output. There are no pan controls for VST output buses or the Master bus.

- For MIDI channels, the Pan control sends out MIDI Pan messages. The result depends on how your MIDI instrument is set to respond to pan – check your documentation for details.

About the “Stereo Pan Law” Preference (audio channels only)

In the Project Setup dialog there is a pop-up menu named “Stereo Pan Law”, on which you can select one of three pan modes. This is all related to the fact that without power compensation, the power of the sum of the left and right side will be higher (louder) if a channel is panned center than if it’s panned left or right.

To remedy this, the Stereo Pan Law setting allows you to attenuate signals panned center, by -6 or -3dB (default). Selecting the 0dB option effectively turns off “constant-power panning”. Experiment with the modes to see which fits best in a given situation.
Audio specific procedures

This section describes basic procedures for audio channels in the Mixer.

Selecting what to show in the extended audio channel strip (Cubase SX only)

When using the extended channel strip view option (see page 138), the upper panel can be set to show different views for each audio channel strip. You select what to display for each channel by using the View Options pop-up menu at the top of each channel strip. The following views are possible:

- The 8 insert effect slots.
  The inserts can also be found in the Inspector and the Channel Settings window, see page 158.

  ![Insert Effect Slots](image)

- The 8 effect sends, either with parameter dials ("Sends +" menu item) or pop-ups and send level value sliders.
  These two views have exactly the same controls but different graphic layouts. The sends can also be found in the Inspector and the Channel Settings window, see page 158.

  ![Effect Sends](image)

Send dials and Send level sliders.
• The EQ section, either with parameter dials ("EQ +" menu item) or value sliders. These two views have exactly the same controls but different graphic layouts. The EQ section is also available in the Channel Settings window. For EQ parameter descriptions, see page 160.

The outer ring of the dial controls the frequency, while the inner controls gain. The small dial sets the Q parameter.

The top value slider controls the gain, the middle controls frequency and the lower sets the Q parameter for each EQ band.

EQ dials and EQ value fields.

• Selecting either Wide or Narrow from the View Options pop-up menu will display a blank panel in the upper section for the channel strip.

• By selecting from the View Options pop-up in the Common panel, you can set the view for all channels in the Mixer. Selecting EQ will not change the view for MIDI channels.

• If the Common panel is extended, you can also set the view for all channels in the Mixer by clicking the corresponding button in the upper half of the Common panel strip.
Using Channel Settings

For each audio channel strip in the Mixer (and in the Inspector for each audio track) there is an edit button ("E").

Clicking this opens the VST Channel Settings window. This window contains the Common panel, a duplicate of the Mixer channel strip, a section with eight insert effect slots (only five slots in Cubase SL), see page 185, 4 EQ modules and an associated EQ curve display (see page 160) and a section with eight effect sends (see page 182). Every channel has its own channel settings (although you can view each in the same window if you like – see below).

Click the Edit button to open the Channel Settings window:

The Channel Settings window is used for the following operations:

- Apply Equalization, see page 160.
- Apply Send Effects, see page 180.
- Apply Insert Effects, see page 185.
- Copy Channel Settings and apply them to another channel, see page 163.

☐ All channel settings are applied to both sides of a stereo channel.
Changing channels in the Channel Settings window

You can view any channel’s settings from a single window.

If the option “Mixer Selection Follows Project” is activated in the Preferences (Editing page), this can be done “automatically”:

- Open the Channel Settings window for a track and position it so that you can see both the Project window and the Channel Settings window.

Selecting a track in the Project window automatically selects the corresponding channel in the Mixer (and vice versa). If a Channel Settings window is open, this will immediately switch to show the settings for the selected channel. This allows you to have a single Channel Settings window open in a convenient position on the screen, and use this for all your EQ and channel effect settings.

You can also select a channel manually (thereby changing what is shown in the open Channel Settings window). Proceed as follows:

1. Open the Channel Settings window for any channel.
2. Open the Channel Select pop-up on the Common panel.

3. Selecting a channel from the pop-up replaces the previous Channel Settings in the window with the selected channel’s settings.

You can also open channel settings in separate windows should you so wish:

- If you have a Channel Settings window open, you can open another Channel Settings window by [Alt]/[Option]-clicking the Edit button for another channel.
Making EQ settings

You can set EQ for a channel through the extended channel strip in the Mixer (SX only) or via the Channel Settings window. The parameters are the same in both cases, but there are no EQ presets nor a Reset function in the Mixer.

1. Click the Edit button for the channel you want to apply EQ to.
   The Channel Settings window opens.

2. Activate as many EQ modules as you need (up to four).
   This can be done in two ways:
   - By clicking on their “On” buttons.
   - By double-clicking (or clicking and dragging) in the EQ curve display.
     Each time you double-click (or click and drag) a new point is added (up to four). The preset frequency ranges (Lo, Hi Mid etc.) are taken into account when you click in the EQ curve display, i.e. clicking in the 10 to 20kHz area activates the “Hi” EQ module and so on.

As soon as any of the EQ modules are activated, the “EQ” button indicator in the channel strip is lit, and there will be a point added in the EQ curve display for each activated module.

![EQ section with three modules activated.](image)
3. Set the parameters for the activated EQ module(s).
   This can be done in several ways:

   • By using the dials.
     The outer ring of the Frequency/Gain dials sets the frequency, and the inner sets the
     gain.

   • By clicking and entering values numerically.

   • By using the mouse to drag points in the EQ curve display window.
     By using this method, you control both the Gain and Frequency parameters simulta-
     neously. The knobs turn accordingly when you drag points.

   • If you press [Ctrl]/[Command] while dragging, only the Gain parameter will be
     set.

   • If you press [Alt]/[Option] while dragging, only the Frequency parameter will
     be set.

   • If you press [Shift] while dragging, only the “Q” parameter will be set.

   Each EQ module contains a fully parametric one band equalizer, with
   the following parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gain</td>
<td>Governs the amount of boost or attenuation around the set frequency. The range is ± 24dB.</td>
</tr>
<tr>
<td>Frequency</td>
<td>The center frequency for the equalization. Around this frequency, the sound will be boosted or attenuated according to the Gain setting. The range is 20Hz to 20kHz.</td>
</tr>
</tbody>
</table>
   | Q         | Determines the width of the frequency band around the center frequency to be affected. The narrower the frequency band, the more drastic the effect of the boost or attenuation. For the leftmost and rightmost EQ modules, the following special modes are available:
   |           | • If the Q-value for the leftmost EQ module is set to minimum, it will act as a low shelving filter. |
   |           | • If the Q-value for the leftmost EQ module is set to maximum, it will act as a high-pass filter. |
   |           | • If the Q-value for the rightmost EQ module is set to minimum, it will act as a high shelving filter. |
   |           | • If the Q-value for the rightmost EQ module is set to maximum, it will act as a low-pass filter. |

   • To deactivate an EQ module, click its “On” button, double click its point in the EQ curve display or drag its point outside the display.
**EQ bypass**

By clicking the EQ button for a channel in the Mixer or in the Track list you can momentarily turn the EQ for a channel on and off, to compare the sound with and without EQ.

When the EQ is in Bypass mode, the EQ button is yellow.

**EQ reset**

The Reset button in the lower left corner of the EQ section will reset all EQ parameters to their default values.

**Using EQ presets**

Some useful basic presets are included with the program. You can use them as they are, or as a starting point for further “tweaking”. To call up a preset, pull down the presets pop-up menu, and select one of the available presets.

**Storing and removing EQ presets**

If you have made EQ settings you wish to store for use elsewhere in a project, you can store them in a preset. Proceed as follows:

1. After making settings, click on the store button (plus sign) to the right of the presets field.
   The settings are stored with the default name “Preset” and a number.
2. Double click in the preset pop-up field and type in a new name if you wish.
   • To remove a preset, simply select it and click the remove (minus sign) button.
Copying settings between audio channels

It is possible to copy all channel settings for an audio channel and paste them onto another channel. This applies to all audio channel types. For example, you can copy EQ settings from an audio channel and apply these to a group or VST Instrument channel, if you want them to have the same sound. Proceed as follows:

1. Select the channel you want to copy settings from by clicking its channel name field (a highlighted name indicates a selected channel). You can also select channels with the Channel Select pop-up menu – see page 159.

2. Click the “Copy” button in the Common panel.

3. Select the channel you want to copy the settings to and click the Paste button.
   The settings are applied to the selected channel.

4. To copy the same settings to several channels, repeat step 3.
   The copied settings are retained in memory until you copy new channel settings, or close the project.

渠 Channel settings can be copied from stereo channels and pasted to mono channels and vice versa.
Initialize Channel

The Initialize Channel button can be found at the bottom of the Channel Settings Common panel. It resets the selected channel to the default setting. Default settings are:

- All EQ, Insert and Send effect settings are deactivated and reset.
- Solo/Mute is deactivated.
- The fader is set to 0dB.
- Pan is set to center position.

Changing the meter characteristics

You can change the Mixer’s level meters characteristics for audio channels: right-click anywhere on the Mixer panel to bring up the Mixer context menu. On the menu there are two options for Meter characteristics: “VU-Meter Fast” and “VU-Meter Hold”.

- If “Fast” is activated (ticked), the meters respond very quickly to level peaks.
  If “Fast” is deactivated, the meters respond more like standard VU meters.

- If “Hold” is activated (ticked), the highest registered peak levels are “held” and are shown as static horizontal lines in the meter.
  You can specify for how long the peak levels will be held. This is done with the parameter “VU-Meter Peak’s Hold Time” in the Preferences dialog (VST page). The peak hold time can be between 500 and 30000ms.
Using group channels

You can route the outputs from multiple audio channels to a group. This enables you to control the channel levels using one fader, apply the same effects and equalization to all of them etc. To create a group channel, proceed as follows:

1. Select Add Track from the Project menu and select “Group Channel” from the submenu that appears.
   A group channel track is added to the Track list and a corresponding group channel strip is added to the Mixer, identical to an audio channel strip except for the lack of an Input pop-up, Record Enable and Monitor buttons. By default the first group channel strip is labeled “Group 01”, but you can rename it just like any channel in the Mixer.

2. Pull down the Output routing pop-up for a channel you want to route to a group channel, and select the group channel option.
   The output of the audio channel is now redirected to the selected group.

3. Repeat the previous step for the other channels you wish to route to a group.

Settings for group channels

The group channel strips are (almost) identical to audio channel strips in the Mixer. The descriptions of the mixer features earlier in this chapter apply to group channels as well. Some things to note:

- Group channels are always stereo.
- You can route the output of a group to an output bus or to another group with a higher number.
  You cannot route a group to itself or to groups to the left of it in the Mixer. Routing is done with the pop-up menu at the bottom of each channel strip.
- There are no Monitoring or Record Enable buttons for group channels.
  This is because inputs are never connected directly to a group.
- Solo and Mute functionality is automatically linked for a channel routed to a group and the group channel itself, in the following way:
  If you mute or solo a group channel, all channels routed to the group are automatically muted or soloed as well.
**Activating and routing buses**

The number of buses shown in the VST Outputs window depends on the number of physical outputs you have on your audio hardware. As with inputs, you need to activate the buses you want to use, and assign each bus to an output pair on your audio hardware. This is done in the VST Outputs window:

1. Pull down the Devices Menu and select VST Outputs.
   The window will contain a number of stereo “channel strips”, one for each bus:

   ![VST Outputs window](image)

2. Activate the buses you need by clicking on their “On” buttons.
   The indicator in the button lights up to show that the bus is active.
   To conserve processor power, you should avoid activating buses that you don’t need to use.

- The Master bus (Bus 1) is always available and activated. This is why it doesn’t have an “On” button. By default, all audio channels are assigned to the Master bus.

- The bus settings are saved with the project. However, if you select another ASIO Device and then open the project, you will be alerted that the bus settings saved will be ignored.
3. Use the pop-up menus at the bottom of the window to route each active bus to an output pair on your audio hardware.

4. To rename a bus, click on its label and type in a new name.

5. Set the output levels for each active bus.
   Dragging one of the faders for a bus will automatically move the other fader as well. To move the left or right fader for a bus independently, hold down [Alt]/[Option] and drag, or deactivate the stereo link switch for the fader pair.

Routing audio channels to buses

To route the output of an audio (or group/VST Instrument/ReWire) channel to one of the active buses, proceed as follows:

1. Open the Mixer.

2. Pull down the output routing pop-up menu, at the bottom of the channel strip and select one of the buses.
   This pop-up menu contains the activated output buses, as well as the available group channels.

- A group channel cannot be routed to itself.

- On the output routing pop-up you also have the option to route the output to various surround channels (SX only). See page 235.
Routing an effect send to a bus or group

The eight effect sends for each audio channel or group can be routed directly to one of the buses, for use with external effects, etc. This is determined by the send routing pop-up menus in the Channel Settings window:

1. Open the Channel Settings window.
2. Activate a send.
3. Click in the name field to pull down the send routing pop-up menu.
4. Select the bus or group to which you want to route the send.

If you route a send from a stereo channel to a bus or group, the send will be stereo. See page 194 for a practical example covering how this function can be used for setting up a flexible effect routing system.

Using the Master Gain fader

The Master Gain fader in the Master Section (to the right in the Mixer) controls the output level of the Master bus. The Master bus may be in stereo or have several channels, depending on the configuration chosen in the VST Master Setup (Cubase SX only), see page 237. It is connected to the corresponding number of VST Output buses.

• You can hide or show the Master Section with the Show Master button on the Common panel.
• Up to eight Master insert effects can be applied to the Master bus. See page 187.
MIDI specific procedures

This section describes basic procedures for MIDI channels in the Mixer.

Selecting what to show in the extended MIDI channel strip
(Cubase SX only)

When using the extended channel strip view option (see page 138), the upper panel can be set to show different views for each MIDI channel strip. You select what to display for each channel by using the View Options pop-up menu at the top of each channel strip. The following views are possible:

- The MIDI insert effects.
  The MIDI inserts can also be found in the Inspector and the Channel Settings window for MIDI channels. How to use MIDI insert effects is described in the chapter “MIDI realtime parameters and effects” – see page 430.

- The MIDI send effects.
  The sends can also be found in the Inspector and the Channel Settings window for MIDI channels. How to use MIDI send effects is described in the chapter “MIDI realtime parameters and effects” – see page 430.

  Selecting either Wide or Narrow from the View Options pop-up menu will display a blank panel in the upper section for the channel strip.

- By selecting from the View Options pop-up in the Common panel, you can set the view for all channels in the Mixer.
  Selecting EQ (which applies to audio channels only) will not change the view for MIDI channels. Selecting Inserts or Send effects from the Common panel will change the view for all channel types.
Using Channel Settings

For each MIDI channel strip in the Mixer (and MIDI track in the Track list or the Inspector) there is an Edit (“E”) button.

Clicking this opens the MIDI Channel Settings window. This window contains a duplicate of the Mixer channel strip, a section with four MIDI inserts and a section with four MIDI send effects. Every MIDI channel has its own channel settings.
Utilities

Link/Unlink channels

This function is used to “link” selected channels in the Mixer so that any change applied to one channel will be mirrored by all channels in that link group. You can link as many channels as you like, and you can also create as many groups of linked channels as you like. To link channels in the Mixer, proceed as follows:

1. Press [Shift] and click on the channel name field for all the channels that you want to Link.
   Selected channels are indicated by highlighted name fields.

2. Right-click (Win) or [Ctrl]-click (Mac) somewhere on the grey Mixer panel.
   The Mixer context menu appears.

3. Select “Link Channels” from the context menu.
What will be linked?

The following rules apply for linked channels:

- **Fader levels will be "ganged".**  
  The relative level offset between channels will be kept if you move a linked channel fader.

  ![Linked channels in CUBASE SX/SL](image)

  The three channels shown are linked. Pulling down one fader changes the levels for all three channels, but keeps the relative level mix.

- **Any individual channel settings you have made before linking will remain until you alter the same setting for any of the linked channels.**  
  For example, if you link three channels, and one of them was muted at the time you applied the Link Channel function, this channel will remain muted after linking. However, if you mute another channel then all linked channels will be muted. Thus, the individual setting for one channel is lost as soon as you change the same parameter setting for any of the linked channels.

- **Channel settings you make after linking the channels will affect all linked channels of the same channel type.**  
  This does not apply to settings between linked MIDI and audio channels.

- **Only Level, Mute, Solo, Select, Monitor and Record Enable will be linked between MIDI channels or MIDI and audio channels.**

- **By holding down [Alt]/[Option], you can change parameter settings separately for channels that are linked.**

  The above applies to all "linkable" functions. The following settings are not affected by the Link Channel function (i.e. they remain individual for each channel):

  - Insert effect settings
  - Pan
  - Input and output routing for audio and MIDI channels

- **Linked channels can also have individual Automation subtracks. These are completely independent, and are not affected by the Link function.**
Unlinking channels

- To unlink channels, simply click the channel name field for any linked Channel to select it, and select "Unlink Channels" from the Mixer context menu.

The channels are unlinked. Note that you do not need to select all the channels that are linked, only one of them.

- It is not possible to remove individual channels from Link status. If you want to make individual settings to a linked channel, press [Alt]/[Option] when changing the setting.

Saving Mixer settings

- Saving/Loading Mixer settings does not apply to MIDI channels in the Mixer – only audio related channels (group, disk, VSTi and ReWire) are saved with this function!

It is possible to save complete Mixer settings for selected or all audio channels in the Mixer. These can then later be loaded into any project. Channel settings are saved as Mixer settings files. These have the Windows file extension ".vmx".

Right-clicking (Win) or [Ctrl]-clicking (Mac) somewhere on the Mixer panel or in the Channel Settings window brings up the Mixer context menu where four Save/Load items can be found. The following options are available:
• “Save Selected Channels” will save all channel settings and the output bus routing for the selected channels. Effects loaded in the VST Send Effects panel will not be saved. Thus, the send routing assigned for the selected channel(s) will not be saved, although the send levels, pre/post and on/off settings are. Insert effects settings are saved.

• "Save Master, Sends and VSTi" will save the Master setup, VST output bus levels and active status, Master mix level, and all assignments and settings in the VST send effects, VST Instruments and Master effects panels. You do not have to select channels for this operation.

• “Save Master Fx” will save the current Master effects configuration and settings.

• “Save All Mixer Settings” saves everything. This is the same as using “Save Selected Channels” with all channels selected, and using "Save Master, Sends and VSTi" and “Save Master Fx”, all in one go.

When you select any of the above options, a standard file dialog opens where you can select a name and storage location on your disk for the file.

Loading Mixer settings

Load Selected Channels

To load Mixer settings saved for selected channels, proceed as follows:

1. Select the same number of channels in the new project to match the number of channels you saved settings for in the previous project.
   For example, if you saved settings for six channels, then select six channels in the Mixer.

2. Mixer settings will be applied in the same order as they appear in the Mixer, when saved.
   Thus, if you save settings from channels 4, 6 and 8 and apply these settings to channels 1, 2 and 3, the settings saved for channel 4 would be applied to channel 1, the settings saved for channel 6 to channel 2 and so on.

2. Right-click (Win) or [Ctrl]-click (Mac) the mixer panel to open the context menu, and select “Load Selected Channels”.
   A standard file dialog appears, where you can locate the saved file.

CUBASE SX/SL
7 – 174 The Mixer
3. Select the file and click “Open”.
   The channel settings and their corresponding output bus routing is applied to the selected channels.

If you select to apply Mixer settings to fewer channels than you saved, the order of the saved channels in the Mixer applies – i.e. the saved channels that are "left over" and not applied will be the channels with the highest channel numbers (or furthest to the right in the Mixer).

Load Master, Sends and VSTi
As these settings are global for the whole Mixer, no channels need to be selected.

1. Right-click (Win) or [Ctrl]-click (Mac) the mixer panel to open the context menu and select "Load Master, Sends and VSTi".
   A standard file dialog appears, where you can locate the saved file.

2. Select the file and click “Open”.
   The Master setup, Master mix level, VST output levels, VST instruments and all send and Master effect assignments and settings are applied to the project.

Load Master Fx
This item allows you to load Master effect combinations and settings.

1. Right-click (Win) or [Ctrl]-click (Mac) the mixer panel to pull down the context menu, and select “Load Master Fx”.
   A standard file dialog appears, where you can locate the saved file.

2. Click “Open” to recall the saved Master Effects.

Load All Mixer Settings
Selecting “Load All Mixer Settings” from the context menu allows you to open a saved Mixer Settings file, and have the stored settings applied to all channels for which there is information included in the file. All channels, master settings, VST Instruments, sends and master effects will be affected.

- Please note that if the saved Mixer settings were 24 channels, and the Mixer you apply it to currently contains 16 Channels, only the settings for channels 1 to 16 will be applied – this function will not automatically add channels.
About the VST Performance Window

The VST Performance window is opened by selecting it from the Devices menu. It indicates the current load on the CPU and the hard disk transfer rate. It is recommended that you check this from time to time, or keep it open always. Even though you have been able to activate a number of audio channels in the project without getting any warning, you may possibly run into performance problems when adding EQ or effects.

- The upper bar graph shows the CPU (processor) load. If the red Overload indicator lights up, you need to decrease the number of EQ modules, active effects and/or audio channels playing back simultaneously.
- The lower bar graph shows the hard disk transfer load. If the red overload indicator lights up, the hard disk is not supplying data fast enough to the computer. You might then try going into the Device Setup and VST Multitrack dialog, and raise the number of disk buffers and the disk block buffer size. If this doesn’t help, you need a faster hard disk. The overload indicator may occasionally blink. This is normal and nothing to worry about.
8

Audio effects
Background

Cubase SX/SL comes with a number of effect plug-ins included. This chapter contains general details about how to assign, use and organize effect plug-ins. In addition, there are links to descriptions of all included effects.

This chapter describes audio effects, i.e. effects that are used to process audio, group, VST Instrument and ReWire channels. MIDI effects are described in the chapter “MIDI realtime parameters and effects”.

About VST 2.0 and tempo sync

Version 2.0 of the VST plug-in standard (and later) allows plug-ins to receive MIDI from the host application (in this case, Cubase SX/SL). A typical use for this feature is tempo-based effects (such as delays, auto-panning, etc.), but it is also used in other ways for certain plug-ins.

- MIDI Timing information is automatically provided to any VST 2.0 plug-in that “requests it”.
  You don’t need to make any special settings for this.

- In many cases you set up tempo sync by specifying a base note value and a multiplier. The resulting timing interval is the base note value multiplied with the multiplier value.
  For example, if you set the base note value to 1/16 (a sixteenth note) and the multiplier to 3, the resulting timing is 3/16. In the case of a delay effect, this means the interval between each delay repeat will be three sixteenth notes.

- When MIDI receive is available (or necessary) for other purposes than timing, the setting up and operation is described in the documentation for the corresponding effect.
The three effect types

In addition to the EQ, Cubase SX/SL provides three effect types:

- **Send effects**
  Up to eight send effects can be used. When you use send effects, audio is routed through the effect processors via independent effect sends for each channel, just like on a "real" physical mixer. The output from each effect processor is then routed to one of the buses or the master fader, where it is mixed with the "dry" signal, if any. Send effects are mono in - stereo out.

- **Insert effects**
  An insert effect is inserted into the signal chain of an audio channel, which means that the whole channel signal passes through the effect. This makes inserts suitable for effects for which you don’t need to mix dry (direct) and wet (processed) sound, e.g. distortion, filters or other effects that change the tonal or dynamic characteristics of the sound. You can have up to eight different insert effects per channel (five in Cubase SL).

- **Master effects**
  Up to eight effect processors (four in Cubase SL) can be added to the signal on the Master bus, the final mix. Please note that there is no mixing of the dry/fx signals as there is with the send effects (except if included in the parameters of the individual effects). Typical uses for master effects would be compressor/limiter effects, noise suppression units, etc.

The last two Master effect slots are post-master gain (Cubase SL only has one post-master gain slot - slot 4). Dithering for example, should always be assigned to a post-master gain effect slot, see page 188.
Using effects

Using send effects

This procedure is divided into three steps: Activating effects, setting up the send section and making effect settings.

Note that it’s also possible to route sends to groups, and use the insert effects for the groups as additional effect racks. See page 193.

Activating send effects

1. Pull down the Devices menu and select VST Send Effects.
   The VST Send Effects panel opens. You can have up to eight separate “processors” arranged on top of each other. If no effect is selected for a slot, it will be labeled “No Effect”.

2. Pull down the pop-up menu by clicking in the “No Effect” slot.

The pop-up menu will list all effects included with Cubase SX/SL (see page 196) as well as effects installed separately. By default the included effects are sorted in hierarchical submenus according to effect type, but you can rearrange them as you see fit (see page 198).
3. Select an effect from the list.
   When you select an effect, an effect panel opens in the slot.

4. By default, the effect processor is activated when selected. This is indicated by the On button. Make sure this is lit.

5. Make sure the effect output is routed to the desired output bus, by checking the Bus pop-up (below the File pop-up).

6. If you wish to activate more effects, repeat steps 2 to 5.
   Remember that the effects rely heavily on the CPU power in your computer. The more activated effect units, the more computer power will be used for effects.

   • To turn off an effect completely, pull down the effect type pop-up menu and select “No Effect”.
   You should do this for all effects that you don’t intend to use, to minimize unnecessary CPU load.
Setting up the sends

This can be done in the Mixer (in extended mode – SX only), in the Channel Settings window or in the Inspector for the audio track. The figures below show the Channel Settings window, but the procedures are similar for all three sections:

1. Bring up the Channel Settings window, the “Sends” or “Sends+” pane in the extended Mixer (SX only) or the Sends section in the Inspector. Each of the eight sends has the following controls and options:
   - A send on/off switch
   - A send level slider
   - A pre/post fader switch (not available in the Sends+ Mixer pane)
   - An Edit button (not available in the Sends+ Mixer pane)

2. Click the on button for one of the effect sends and set the corresponding send level slider (or dial) to a moderate value.

3. Pull down the pop-up menu for the send.
   This is the Send Routing pop-up menu, used for routing the send to the desired effect processor.

4. Select an effect from the pop-up menu.
5. If you want the signal to be sent to the effects before the fader, click on the Pre/Post button for the send. With pre-fader effect sends, the amount of effect for the channel is not affected by the volume fader. With post-fader effect sends (Pre/Post button not pressed), the amount of effect is proportional to the channel volume, and will change with the volume fader movements.

6. If you want to use several effects for this audio channel, repeat steps 3 to 6 above for the other effect sends.

- When one or several sends are activated for a channel, the Send Effects buttons light up in blue in the Mixer and Track list. Click the button for a channel to bypass (disable) all its effect sends. When the sends are bypassed, the buttons are yellow. Click the button again to enable the sends.
Making settings for the effects

1. Open the VST Send Effects window and use the Effects Master slider to the left on the processor panel to set the input level to an effect processor.

2. Use the send level slider in the Channel Settings, Inspector, or the extended part of the Mixer (Cubase SX only) to control the amount of effect for the audio channel.

3. You can switch between different effect program presets by pulling down the Program pop-up in the VST Send effects panel. The number of program locations depends on the selected effect type.

4. If you have several effects activated, repeat steps 1 to 3 for these.
   • You can also edit the effect parameters. See page 191.
Using insert effects

- You can apply up to eight (five in Cubase SL) different insert effects per channel.

- The signal passes through the effects in series from the top downwards.

- Each audio, group, VST Instrument and ReWire channel has its own set of insert effects.
  Each audio channel can have up to eight (five in Cubase SL) insert effects which are totally independent of the other channels.

Insert effects require the same processing power as any other effect type. This means that applying insert effects on many channels uses up far more processing power than the send effects (eight in total for the whole program). Remember that you can use the VST Performance window to keep an eye on the CPU load.

Which effect plug-ins can I use as insert effects?

Most effect plug-ins will work fine as insert effects. In general, the only restrictions are with the number of inputs and outputs in the effects:

- For a plug-in to be usable as an insert effect, it has to have 1 or 2 inputs and 1 or 2 outputs.
  The number of inputs and outputs is determined by whether you use the insert effects on a single (mono) audio channel or on a stereo channel pair:

- For stereo audio channels, you need to use an effect with stereo inputs. It is possible to use a mono-input effect with a stereo channel pair, but then only the left channel in the pair will be processed, which is probably not what you want.

- For mono audio channels, you can use mono- or stereo-input effects. However, since the audio channel is in mono, the output of the effect will also be in mono. For stereo output effects, the left channel will then be used.
Routing an audio channel through insert effects

Insert effect settings are available in the Mixer (in extended mode - Cubase SX only), the Channel Settings window and the Inspector. The figures below show the Channel Settings window, but the procedures are similar for all three send sections:

1. Bring up the Channel Settings window, the “Inserts” pane in the extended Mixer or the Inserts section in the Inspector. In the Channel Settings, the inserts are located to the right of the channel strip.

2. Pull down the effect type pop-up for one of the insert slots, and select an effect.

- If you hold down [Ctrl]/[Command] while selecting an insert effect, this effect will be selected in the same insert slot for all Mixer channels.

3. Make sure that the effect is activated (the on button for the insert slot should be lit).

4. If required, open the effect’s control panel by clicking the Edit button and use the Mix parameter (if available) to adjust the balance between dry and effect signal. See page 191 for details about editing effects.

- When one or several insert effects are activated for a channel, the Insert Effects buttons light up in blue in the Mixer and Track list. Click the button for a channel to bypass (disable) all its inserts. When the inserts are bypassed, the buttons are yellow. Click the button again to enable the inserts.

- To turn off an effect completely, pull down the effect type pop-up menu and select “No Effect.” You should do this for all effects that you don’t intend to use, to minimize unnecessary CPU load.
Using Master effects

There are eight Master effect slots (four in Cubase SL), available in a separate window or in the Master section in the extended Mixer (Cubase SX only). To select and activate Master effects, proceed as follows:

1. Either select the “Extended” mode for the Mixer (Cubase SX only) and show the Master section, or pull down the Devices menu and select “VST Master Effects” to bring up the Master effect window.

2. Pull down the pop-up menu for one of the Master effect slots and select an effect.

   • Note that the two last Master effect slots are “post master gain fader” (Cubase SL has one such slot - slot 4), i.e. they appear after the Master Gain fader in the signal path. These are typically used for effects such as dithering – see page 188.

3. To make settings for the effect, click the Edit button to bring up its control panel.
   See page 191.

   • To turn off a Master effect, select “No Effect” for the corresponding slot.

   Master effect plug-ins must be at least stereo in/out. If you have a plug-in in your VST Plug-ins folder that you can’t assign as a master effect, the reason is probably that it is a mono plug-in.
Dithering

- Cubase SX and Cubase SL come with different versions of the Apogee dithering plug-in; “UV22HR” for SX, and “UV22” for SL.

Dithering is a method for controlling the noise produced by quantization errors in digital recordings. The theory behind this is that during low level passages, only a few bits are used to represent the signal, which leads to quantization errors and hence distortion.

For example, when “truncating bits”, as a result of moving from 24- to 16-bit resolution, quantization errors are added to an otherwise immaculate recording. By adding a special kind of noise at an extremely low level, the effect of these errors is minimized. The added noise could be perceived as a very low-level hiss under exacting listening conditions. However, this is hardly noticeable and much preferred to the distortion that otherwise occurs.

- The Apogee UV22HR dither plug-in included with SX offers very high quality dithering with support for multiple resolutions.

- The Apogee UV22 dither included with SL has the same high quality, but always dithers to 16 bit resolution.

When should I use dither?

- When converting files to a lower bit resolution.

- When processing using Master effects during Export Audio Mixdown.

   Internally Cubase SX/SL uses 32-bit float resolution. Whenever you are exporting to a lower bit resolution than this, you should use dither, especially when exporting/converting to 16-bit resolution for audio CD-burning.
Applying dithering

1. Bring up the Master Effects window of the effect slots in the Master section in the Mixer.

2. Pull down the pop-up menu in slot 7 or 8 (or slot 4 in Cubase SL).

3. Select the UV22 / UV22HR plug-in from the pop-up menu. By default, this is placed on the “Other” submenu. If you have another dithering plug-in that you prefer, you can select this instead.

4. Click the On button for the slot to activate the dithering effect.

5. Click the Edit button for the slot to bring up the control panel for the dithering effect and adjust its settings to your liking.

- These two last Master effect slots are post-fader (Cubase SL has one post-fader slot - slot 4), which is crucial for a dithering plug-in. The reason is that any master gain change applied after dithering would bring the signal back to the internal 32 bit float domain, thus rendering the dithering settings useless.
Apogee UV22HR/UV22 parameters

The UV22 / UV22HR are dithering plug-ins based on an advanced algorithm developed by Apogee. You can use the UV22 / UV22HR plug-in for all dithering situations.

The following options can be set in the control panel (the parameters are identical for UV22 / UV22HR apart from the Bit Resolution parameter):

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>Try this first, it is the most “all-round” setting.</td>
</tr>
<tr>
<td>Low</td>
<td>This applies a lower level of dither noise.</td>
</tr>
<tr>
<td>Autoblack</td>
<td>When this is activated, the dither noise is gated (muted) during silent passages in the material.</td>
</tr>
<tr>
<td>Bit resolution</td>
<td>Specifies the resulting bit resolution of the dithering process. Make sure to set this according to the selected resolution when you export audio (as set in the Export Audio Mixdown dialog – see page 627).</td>
</tr>
</tbody>
</table>

UV22 included with Cubase SL always dithers to 16 bits.
Editing effects

All inserts, master effect slots and effect sends (except in the “Sends+” pane in the extended Mixer - Cubase SX only) have an Edit (“E”) button. Clicking this opens the selected effect’s control panel in which you can make parameter settings.

The contents, design and layout of the control panel depends on the selected effect. However, all effect control panels have a On/Off button, Read/Write automation buttons (for automating effect parameter changes – see page 265), a program selection pop-up menu and a File pop-up menu for saving or loading programs. In Cubase SX/SL for Mac OS X these are located at the bottom of the control panel, whereas it is at the top of the control panel in Cubase SX/SL under Windows.

The Rotary effect control panel.

- Please note that all effects can be edited using a simplified control panel (horizontal sliders only, no graphics) if you prefer this. To edit effects using this “basic” control panel instead, press [Ctrl]/[Command]+[Shift] and click on the Edit button for the effect send or slot.

Making settings

Effect control panels may have any combination of knobs, sliders, buttons and graphic curves. For specifics about the included effects, please refer to page 196.
Naming effects

If you edit the parameters for an effect, these settings are saved automatically in the project. If you want to name the current settings, the following points apply:

• The basis for the current settings may have been a preset effect program, in which case there is a name in the Program Name field.

• The basis for the current settings may have been a default setting program location in which case “Init” is displayed in the Program Name field.

In both cases, if you have changed any effect parameter settings, these are already saved! To name the current settings, click the Name field, type in a new name and press [Return]. The new name replaces the previous name on the Program pop-up menu.

Saving effects

You can save your edited effects for further use (e.g. in other projects) by using the File pop-up menu to the right of the Name field.

1. Pull down the File pop-up menu.

• If you want to save the current program only, select “Save Effect”. Effect Programs have the Windows file extension “fxp”.

• If you want to save all programs for the effect type, select “Save Bank”. Effect Banks have the Windows file extension “fxb”.

2. In the file dialog that appears, select a name and location for the file and click Save.

It might be a good idea to prepare a special folder for your effects.

Loading effects

1. Pull down the File pop-up menu.

2. Select “Load Effect” or “Load Bank”.

3. In the file dialog that opens, locate the file and click Open.

If you loaded a Bank, it will replace the current set of all effect programs. If you loaded a single effect, it will replace the currently selected effect program only.
Effect routing – a few tips

A note about stereo effects

Several of the VST plug-in effects affect the stereo image, in the form of panning, stereo enhancement or stereo ambience. However, for this to be heard, the output of the effect must be routed to a stereo channel or bus (since otherwise, the output will be mixed to mono). In short: Stereo image effects will not be heard if the effect is used as an insert effect for a mono audio channel.

- For example, if you want to apply auto-panning to a mono audio channel, there are two ways to do this:
  1) Use a send effect (you would probably want to activate the Pre-fader Send switch and turn down the volume fader for the audio channel).
  Or
  2) Route the mono audio channel to a group channel and apply the effect as an insert effect for the group channel.

About group channels and effects

There are certain factors to consider when using send effects from channels routed to groups. If a channel routed to a group uses send effects, the effect return signal will still be audible if you mute or pull down the fader for the group channel, which might be undesirable. There is a method you can use to remedy this:

- You can remove the send routing from the channels being routed to a group, and apply the effects to the group channel instead.
  This works well if you want all channels routed to the group processed by the same effect(s) and by the same amount. See below for a practical example on how you can set up a more flexible effects routing system using groups.
Using stereo sends and insert effects

Send effects are practical because you can control the dry/effect balance individually for each channel. Insert effects offer the advantage of “chaining” effects, meaning that the output of an effect can be further processed by another effect. If you route a channel send directly to a group channel, this allows you to use insert effects (applied to the group channel) much like “send effects”.

This method has several advantages:

• You can take advantage of effects with stereo inputs, since the sends will be stereo. If you route a stereo channel send to an effect, as opposed to a group, the send will be mono, regardless of the chosen effect.
• You can set up insert effect chains for a group, and then control how much the individual channels are processed by this effect chain. For example, you could have the output of a reverb sent to an EQ and then on to a compressor. If you simply routed several channel outputs to a group and then applied insert effects (to the group), you would have no way of controlling the dry/effect balance for the individual channels, only for the group as a whole.

An example

The following example describes how to route a stereo send to a group with an insert effect.

The example assumes that you have access to a stereo audio channel, some audio events to play through it, and an unused group channel in the Mixer. Proceed as follows:

1. Open the Channel Settings for the stereo audio channel, and route one of the sends directly to the group channel. As it is a stereo channel, the send will be stereo. Note that the channel itself should not be routed to this group, only one of its sends (see page 182). The channel output routing could be any bus, or another group – it doesn’t matter.

2. Activate the send, and drag the corresponding Send level slider to a moderate value. The send’s “Pre/Post” button should not be activated.

3. Activate an insert effect for the group channel. Choose a typical “send effect” like reverb for this example.
4. Open the effect’s control panel by clicking the Edit button and use the Mix parameter to adjust the balance between “dry” and effect signal, to 100% effect.

This is because the effect/dry balance can now be controlled using a combination of send level and the group channel fader – see below.

5. Press [Alt]/[Option] and click on the Solo button for the group channel to activate Solo Group.

In this mode, the group channel will not be muted if you solo another channel in the mixer (see below).

6. Play back a recording via the audio channel.

The following is now possible:

- By adjusting the send level you will control the amount of channel signal sent to the "effect" (or to be accurate, the group channel).

- The level fader for the group channel now serves as effect return level control, allowing you to set the dry/effect balance.

  If you pull down the group channel fader, you should now hear the recorded signal with no effect.

- Since Solo Group is activated for the group channel, you can solo any of the audio channels without having the effect return (the group) muted.

  If you need to turn off Solo Group, [Alt]/[Option]-click the Solo button for the group channel again.

- Adding more insert effects to the group allows you to process the effect output further.

- Simply repeat steps 1-2 for all (stereo) channels you wish to process using this method.

- You can of course add more group channels for a project, set up different Insert effect chains for these, and assign other sends to them.

Automating effect parameters

Effects parameters can be automated. This is described on page 265.
The included effects

The list below shows the effects sorted according to category, as is the default arrangement when you install Cubase SX/SL – click on an effect to get a description of its parameters:

Delay
- DoubleDelay
- ModDelay

Distortion
- Datube
- Overdrive
- Quadrafuzz

Dynamics
- SPL DeEsser (Cubase SX only)
- Dynamics
- VST Dynamics

Filter
- StepFilter

Modulation
- Chorus
- Flanger
- Metalizer
- Phaser
- Ringmodulator
- Rotary
- Symphonic
- Tranceformer

Other
- Bitcrusher
- Chopper
- Grungelizer
- Vocoder
- SMPTE Generator (Cubase SX only)

The UV22 HR/UV22 dither plug-in is described separately – see page 190.

Reverb
- Reverb A
- Reverb B

Surround
- Mix6To2 (Cubase SX only)

During the installation process you also had the option of installing effects that were part of Cubase 5.1 and previous versions – see page 199.
Installing and managing effect plug-ins

There is a wide range of additional effect plug-ins available in the two formats supported by Cubase SX/SL (VST and DirectX). The two formats are handled differently when it comes to installation and organizing:

VST plug-ins

Mac OS X

If you acquire additional VST plug-ins, make sure they are created specifically for Mac OS X! Plug-ins in Mac OS 9.X format cannot be used.

There is a large number of VST plug-ins available for purchase or download. To install a VST plug-in under Mac OS X, quit Cubase SX/SL and drag the plug-in file to one of the following folders:

• /Library/Audio/Plug-Ins/VST/
  This is only possible if you are the system administrator. Plug-ins installed in this folder will be available to all users, for all programs that support them.

• Users/Username/Library/Audio/Plug-Ins/VST/
  “Username” above is the name you use to log on to the computer (the easiest way to open this folder is to go to your “Home” folder and use the path /Library/Audio/Plug-Ins/VST/ from there). Plug-ins installed in this folder are only available to you.

When you launch Cubase SX/SL again, the new effects will appear on the effect pop-up menus.

• An effect plug-in may also come with its own installation application, in which case you should use this.
  Generally, always read the documentation or readme files before installing new plug-ins.

Windows

Under Windows, VST plug-ins are usually installed simply by dragging the files (with the extension “.dll”) into the Vstplugins folder in the Cubase SX/SL application folder, or into the Shared VST Plug-in folder – see below. When you launch Cubase SX/SL again, the new effects will appear on the Effect pop-up menus.
• If the effect plug-in comes with its own installation application, you should use this.
Generally, always read the documentation or readme files before installing new plug-ins.

• If you want to install and use plug-ins from the manufacturer Waves Ltd. you should activate the option Preload Waves Plugins on Startup (Windows only) in the Preferences - VST page.
These plug-ins are really DirectX plug-ins being used as VST plug-ins by means of a dll file called Waveshell. Activating the Preload option allows you to choose a Waves VST plug-in directly from any effect menu, instead of having to load the Waveshell first and then pick the desired plug-in.
For more information, please refer to http://www.waves.com/

Organizing VST plug-ins
If you have a large number of VST plug-ins, having them all on a single pop-up menu in the program may become unmanageable. For this reason, the plug-ins installed with Cubase SX/SL are placed in appropriate subfolders according to the effect type.

• Under Windows, you can rearrange this by moving, adding or renaming subfolders within the Vstplugins folder if you like.
When you launch the program and pull down an Effects pop-up menu, the subfolders will be represented by hierarchical submenus, each listing the plug-ins in the corresponding subfolder.

• Under Mac OS X, you cannot change the hierarchic arrangement of the “built-in” VST plug-ins.
You can however arrange any additional plug-ins you have installed (in the /Library/Audio/Plug-Ins/VST/ folders, see above) by placing them in subfolders. In the program, the subfolders will be represented by hierarchical submenus, each listing the plug-ins in the corresponding subfolder.

About shared VST plug-ins (Windows only)
While Cubase SX/SL’s own plug-ins reside in the Vstplugins folder within the Cubase SX/SL program folder, the program can also access plug-ins in an additional location, called the shared VST plug-ins folder. This lets you use plug-ins installed by other VST compatible applications, etc. You can change what folder is considered the “shared” vst-plugin folder at any time in the Plug-In Information window, see page 200.
About the “Earlier VST Plug-ins” and “Cubase 5 Plug-ins” subfolders.

When installing Cubase SX/SL, you were asked whether you wanted to install the effects from previous versions of Cubase. If you chose to do so, the Cubase 5 effects will appear on a submenu to the effect pop-up menus. If you chose to install the earlier (pre-Cubase 5) plug-ins as well, these will appear on a submenu to the “Cubase 5 Plug-ins” submenu.

The foremost reason for installing these earlier plug-ins is backwards compatibility, allowing you to import old Cubase Songs and get the correct effect settings. For descriptions of these older effects, click the links below.

- Mac users should read the disclaimer regarding the functionality of these effects under Mac OS X.

Cubase 5 Plug-ins
Earlier VST Plug-ins

DirectX plug-ins (Windows only)

To be able to use DirectX plug-ins, you must have Microsoft DirectX installed on your computer (Version 8.1 recommended and included on the Cubase SX/SL CD).

DirectX plug-ins should not be placed in the Vstplugins folder, as these are installed under the operating system rather than for Cubase SX/SL exclusively. Rather, you should follow the installation instructions included with the plug-ins. See also page 203.

- On the effect menus, all DirectX plug-ins are listed on the DirectX submenu at the bottom.
Selecting, activating and editing them are done as with VST effects.
The Plug-in Information window

On the Devices menu, you will find an item called “Plug-in Information”. Selecting this opens a dialog listing all the available VST and DirectX compatible plug-ins in your system (including VST Instruments), along with all MIDI plug-ins (see page 460).

Managing and selecting VST plug-ins

To see which VST plug-ins are available in your system, click the “VST Plug-ins” tab at the top of the window. The window now displays all plug-ins in the Cubase SX/SL and the shared vstplugins folder.

- To enable a plug-in (make it available for selection), click in the left column. Only the currently enabled plug-ins (shown with a check sign in the left column) will appear on the Effect menus.

- The second column indicates how many instances of the plug-in are currently used in Cubase SX/SL. Clicking in this column for a plug-in which is already in use produces a pop-up showing exactly where each use occurs.

Please note that a plug-in may be in use even if it isn’t enabled in the left column. You might for example have opened a Song containing effects that currently are disabled on the menu. The left column purely determines whether or not the plug-in will be visible on the Effect menus.

- All columns can be resized by using the divider in the column header.
The rest of the columns show the following information about each plug-in:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the plug-in.</td>
</tr>
<tr>
<td>Nb I/O</td>
<td>This column shows the number of inputs and outputs for each plug-in.</td>
</tr>
<tr>
<td>Category</td>
<td>This indicates the category of each plug-in (such as VST Instruments,</td>
</tr>
<tr>
<td></td>
<td>Surround Effects, etc.).</td>
</tr>
<tr>
<td>Vendor</td>
<td>The manufacturer of the plug-in.</td>
</tr>
<tr>
<td>VST Version</td>
<td>Indicates with which version of the VST protocol each plug-in is compatible.</td>
</tr>
<tr>
<td>Delay (sample)</td>
<td>This shows the delay (in samples) that will be introduced if the effect is</td>
</tr>
<tr>
<td></td>
<td>used as an Insert. This is however automatically compensated for by</td>
</tr>
<tr>
<td></td>
<td>Cubase SX/SL.</td>
</tr>
<tr>
<td>Nb Params</td>
<td>The number of parameters for the plug-in.</td>
</tr>
<tr>
<td>Nb Programs</td>
<td>The number of programs for the plug-in.</td>
</tr>
<tr>
<td>Modified</td>
<td>The last modification date of the plug-in file.</td>
</tr>
<tr>
<td>Folder</td>
<td>The path and name of the folder in which the plug-in file is located.</td>
</tr>
</tbody>
</table>

**Update Button**

Pressing this button will make Cubase SX/SL re-scan the designated Vstplugins folders for updated information about the plug-ins.
Changing the Shared Plug-ins Folder (Windows only)

If you like, you can change what folder is to be the “shared” Vstplugins folder. For example, if you have Steinberg’s Cubase VST 5.0 installed on your computer, you can get access to the Cubase VST 5.0-specific plug-ins in Cubase SX/SL by switching to the Vstplugins folder within the Cubase VST 5.0 folder.

The currently selected Shared Folder is displayed in the text field at the top of the window. Clicking the “Choose...” button opens a file dialog where you can browse to another Vstplugins folder on your hard drive. Clicking OK selects the new folder as the shared VST plug-ins folder.

- After selecting a new shared plug-ins folder, you need to restart Cubase SX/SL for the effects in the new folder to become available.
Managing and selecting DirectX plug-ins (Windows only)

To see which DirectX plug-ins are available in your system, click the “DirectX Plug-ins” tab at the top of the window.

- To enable a plug-in (make it available for selection), click in the left column. Only the currently enabled plug-ins (shown with a check sign in the left column) will appear on the Effect menus.

  The idea here is that there could be a variety of DirectX plug-ins in your system, many of which are not intended for musical audio processing. Disabling these helps you keep the Effect menus in Cubase SX/SL more manageable.

- The second column indicates how many instances of the plug-in are currently used in Cubase SX/SL. Clicking in this column for a plug-in which is already in use produces a pop-up showing exactly where each use occurs.

  Please note that a plug-in may be in use even if it isn’t enabled in the left column. You might for example have opened a Song containing effects that currently are disabled on the menu. The left column purely determines whether or not the plug-in will be visible on the Effect menus.
9

VST Instruments
Introduction

VST Instruments are software synthesizers (or other sound sources) that are contained within Cubase SX/SL. They are played internally via MIDI, and their audio outputs appear on separate channels in the Mixer, allowing you to add effects or EQ, just as with audio tracks.

Some VST Instruments are included with Cubase SX/SL, others can be purchased separately from Steinberg and other manufacturers. This chapter describes the general procedures for using VST Instruments, along with descriptions of the included VST Instruments.

The following VST Instruments are included and installed with Cubase SX/SL:

- A1 – a software synthesizer powered by Waldorf. See page 211.
- VB-1 – a virtual bass instrument built on real-time physical modelling principles. See page 225.

During the installation process you also had the option of installing VST instruments that were part of Cubase 5.1 and previous versions. These are described in a separate document – click here for details.
Activating and using VST instruments

1. Pull down the Devices menu and select VST Instruments.
   The VST Instruments panel appears with 32 slots (Cubase SL has 16 slots).

2. Pull down the pop-up menu for an empty slot in the panel and select the desired instrument.

3. Select an unused MIDI track in the Project window.

4. Pull down the Output pop-up menu for the MIDI track in the Track list or in the Inspector.
   The pop-up menu will now contain an additional item, with the name of the activated VST Instrument.

5. Select the VST Instrument on the MIDI Output pop-up menu.
   The MIDI Output from the track is now routed to the selected Instrument.

6. Depending on the selected Instrument, you may also need to select a MIDI channel for the track.
   Check the Instrument’s documentation for details on its MIDI implementation. For example, multi-timbral VST Instruments are able to play back different sounds on different MIDI channels.

7. Make sure the option “MIDI Thru Active” is activated in the Preferences dialog (MIDI page).
8. Click the Monitor button for the MIDI track (in the Track list, Inspector or Mixer).
   When this is activated (or when the track is Record Enabled, see page 37) incoming MIDI is passed on to the selected MIDI Output (in this case the VST Instrument).

9. Open the Mixer.
   You will find an additional channel strip for the instrument’s audio outputs. VST Instrument channel strips have the same features and functionality as group channel strips, with the addition of an Edit button at the bottom of the strip for opening the VST Instrument control panel.

10. Use the pop-ups at the bottom of the channel strips to route the Instrument audio to the desired output or group.

11. Play the Instrument from your MIDI keyboard.
   You can use the Mixer settings to adjust the sound, add EQ or effects, etc. — just as with regular audio channels. Of course, you can also record or manually create MIDI parts that play back sounds from the VST Instrument.

   ❑ You can have up to 32 VST Instruments activated at the same time (16 in Cubase SL), different models or several instances of the same instrument. However, software synthesizers can consume quite a lot of CPU power — keep an eye on the VST Performance window to avoid running out of processor power.

About latency

Depending on your audio hardware and its ASIO driver, the latency (the time it takes for the Instrument to produce a sound when you press a key on your MIDI controller) may simply be too high to allow comfortable real-time VST Instrument playback from a keyboard.

If this is the case, a workaround is to play and record your parts with another MIDI Sound Source selected, and then switch to the VST Instrument for playback.
Selecting patches and making settings

- To select a patch for a VST Instrument, use its patch pop-up menu in the VST Instruments window.
  The available patches depends on the VST Instrument. Not all VST Instruments come with pre-made patches.

- To access the parameters for the VST Instrument, click the Edit button in the VST Instruments window or in its channel strip (at the bottom of the fader strip) in the Mixer.
  This opens a “control panel” for the VST Instrument.

Selecting patches from the Project window

When a VST Instrument is selected as MIDI output for a track, you can also select patches by name, using the Program pop-up menu in the track list or Inspector. Although this is set up automatically and transparently, there are a couple of things to note:

- If the VST Instrument supports the VST 2.1 standard (or later), selecting a patch will cause Cubase SX/SL to send MIDI Program Change and Bank Select messages to the VST Instrument, just as with “real” physical MIDI instruments.
  A consequence of this is that you can enter Program Change events in MIDI parts anywhere on the track, having the VST Instrument change patch at the desired locations (“automating” the patch selection).

- If the VST Instrument supports the original VST 2.0 standard only, only limited support of patch selection is offered.
  In this case, selecting a patch will actually ask the VST Instrument to change “Plug-in Program”, which is not the same as selecting a “Patch” by sending MIDI Program Change and Bank Select messages.
Automating a VST Instrument

- Automation of the VST Instrument channel settings is done in the same way as automating regular channels.

- Automation of the specific parameters for a VST Instrument is done in the same way as automating VST effect parameters.

See page 250.
A1 Synthesizer

The A1 is a dual oscillator software synthesizer with the following main features:

- The A1 is polyphonic with up to 16 voices.
- Multimode filter. Lowpass, bandpass, highpass and notch filter types are available.
- PWM (Pulse Width Modulation).
- FM (Frequency Modulation).
- Ring Modulator.
- Built-in stereo chorus/flanger effect.
- The A1 receives MIDI in Omni mode (on all MIDI channels). You don’t need to select a MIDI channel to direct MIDI to the A1.
- The A1 responds to MIDI Controller messages. See page 224.
A1 Parameters

Oscillator 1 and 2 section

This section contains parameters affecting the oscillators.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Octave</td>
<td>128’ to 1/2’ (feet)</td>
<td>Clicking on the outer ring of the dial allows you to tune the oscillator in octave steps.</td>
</tr>
<tr>
<td>Semitone</td>
<td>+/- 12 Semitones</td>
<td>Clicking on the inner ring of the dial allows you to tune the oscillator in semitone steps.</td>
</tr>
<tr>
<td>Detune</td>
<td>-100/+100 Cent</td>
<td>Tunes the oscillator in cent (100th of a semitone) steps.</td>
</tr>
<tr>
<td>Shape</td>
<td>Sine, triangle, sawtooth or pulse.</td>
<td>This sets the waveform for the oscillator.</td>
</tr>
<tr>
<td>PW</td>
<td>50% - 100%</td>
<td>Sets the width of the waveform when a Pulse waveform is selected. Turning the dial clockwise gradually produces a narrower pulse waveform. Note that a PW setting of 100% will lead to complete cancellation of the waveform (i.e. silence), if no modulation (see PW Mod) is applied.</td>
</tr>
<tr>
<td>PW Mod</td>
<td>-100 to 100</td>
<td>This parameter determines the amount of Pulse Width Modulation (PWM) by the LFO. Positive and negative values can be set. A Pulse waveform must be selected for PW Mod to function.</td>
</tr>
<tr>
<td>Pitch Mod</td>
<td>-100 to 100</td>
<td>This parameter determines the amount of oscillator 1 pitch modulation (or vibrato) by the LFO. Positive and negative values can be set.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Values</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>FM (Oscillator 1 only)</td>
<td>0 - 100%</td>
<td>Governs the amount of frequency modulation. See page 224.</td>
</tr>
<tr>
<td>FM Env (Oscillator 1 only)</td>
<td>-100 to 100</td>
<td>This governs how much the Filter Envelope parameters affects the FM amount. Positive and negative values can be set. See page 224.</td>
</tr>
</tbody>
</table>
## LFO section

![LFO](image)

This section contains the LFO (Low Frequency Oscillator) parameters. LFOs are used to modulate parameters like pitch (vibrato) or the filter cutoff.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LFO Wave</td>
<td>Sine/Saw/S&amp;H/Triangle/Square/Random</td>
<td>This sets the LFO waveform for modulating parameters:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Sine and triangle waves have a smooth waveform, suitable for normal vibrato.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Saw produces a ramp up or down cycle.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S&amp;H produces stepped random modulation.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Square waves produce cycles that abruptly change between two values.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Random produces smooth random modulation.</td>
</tr>
<tr>
<td>LFO Sync</td>
<td>On/Off</td>
<td>If this is activated, the LFO rate will be synchronized to the sequencer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>tempo in various bar/beat divisions that can be set with the LFO Speed</td>
</tr>
<tr>
<td></td>
<td></td>
<td>parameter.</td>
</tr>
<tr>
<td>LFO Speed</td>
<td>0.010-1000 Hz</td>
<td>Governs the modulation rate of the LFO.</td>
</tr>
<tr>
<td>LFO Speed</td>
<td>8 Bars to 1/64T</td>
<td>If the “LFO Sync” parameter is activated, the LFO rate will be</td>
</tr>
<tr>
<td>(tempo sync on)</td>
<td></td>
<td>synchronized to the sequencer tempo, according to the different beat</td>
</tr>
<tr>
<td></td>
<td></td>
<td>divisions that can be specified here.</td>
</tr>
</tbody>
</table>
Filter section

This section contains the filter parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter type</td>
<td>Lowpass/Highpass/Bandpass/Notch</td>
<td>Sets the filter type to either lowpass, highpass, bandpass or notch. The filter types are described on page 223.</td>
</tr>
<tr>
<td>Cutoff</td>
<td>10.91Hz - 17740Hz</td>
<td>Controls the filter frequency or “cutoff”. If a lowpass filter is used, it could be said to control the opening and closing of the filter, producing the classic “sweeping” synthesizer sound. How this parameter operates is governed by the filter mode (see page 223).</td>
</tr>
<tr>
<td>Resonance</td>
<td>0-100%</td>
<td>The Resonance control for the filter. Raise this for a more pronounced filter sweep effect.</td>
</tr>
<tr>
<td>Drive</td>
<td>0-100%</td>
<td>This parameter can overdrive the filter to produce distortion effects.</td>
</tr>
<tr>
<td>Filter Envelope</td>
<td>-100/+100</td>
<td>Controls how much the filter cutoff should be affected by the Filter Envelope parameters. Negative values will invert the filter envelope settings.</td>
</tr>
</tbody>
</table>
Filter Velocity -100/+100 Determines how the filter cutoff will be affected by velocity, i.e. how hard or soft you strike a key. Positive values will increase the cutoff frequency the harder you strike a key. Negative values will invert this relationship.

Filter Envelope Attack/Decay/Sustain/Release 0-60s (Attack/Decay/Release) and 0-100% (Sustain) The Filter Envelope Attack, Decay, Sustain and Release parameters. Use these parameters to determine how the filter cutoff should open and close with time, when a note is played. Values can be changed using the dials or by dragging the breakpoints in the graphic display.

Cutoff Mod -100/+100 This controls how much the filter cutoff is modulated by the LFO (low frequency oscillator).

Keytrack -100/+100 If this parameter is set to values over 0, the filter cutoff frequency will increase the further up on the keyboard you play. Negative values invert this relationship.
## Amplifier section

This section contains the Amplifier parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amplifier Attack/</td>
<td>0-60s (Attack/Decay/Release parameters) and 0-100% (Sustain parameter)</td>
<td>The Amplifier Attack, Decay, Sustain and Release parameters. Use these parameters to determine how the volume should change with time, when a note is played. Values can be changed using the dials or by dragging the breakpoints in the graphic display.</td>
</tr>
<tr>
<td>Decay/Sustain/Release</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Velocity</td>
<td>0-100%</td>
<td>This determines how much the Amplifier Envelope should be affected by velocity, i.e. by how hard or soft you strike a note on the keyboard.</td>
</tr>
<tr>
<td>Mono</td>
<td>On/Off</td>
<td>When this is activated, the A1 will be monophonic, i.e. only play one voice at a time.</td>
</tr>
</tbody>
</table>
The Chorus/Flanger section

Adding chorus will introduce a wide stereo effect and generally “fatten” sounds. With higher Feedback settings, more metallic sounding flanging effects are produced. The section contains the following parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Speed</td>
<td>0-100</td>
<td>Controls the modulation rate of the effect.</td>
</tr>
<tr>
<td>Feedback</td>
<td>-100/+100</td>
<td>Increasing the Feedback parameter value results in a more pronounced sweeping metallic sound. Positive and negative feedback values can be set.</td>
</tr>
<tr>
<td>Depth</td>
<td>0-100</td>
<td>Controls the depth of the modulation.</td>
</tr>
<tr>
<td>Quad</td>
<td>On/Off</td>
<td>Adds more delay taps, producing richer chorus/flanger effects.</td>
</tr>
<tr>
<td>On</td>
<td>On/Off</td>
<td>This turns the chorus/flanger effect on or off.</td>
</tr>
</tbody>
</table>
The Glide section

This section contains the glide parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>On/Off</td>
<td>If set to “On” the pitch will glide up or down between notes played.</td>
</tr>
<tr>
<td>Speed</td>
<td>0-60s</td>
<td>Controls the time it takes for the pitch to glide from one note to the next when using Glide.</td>
</tr>
</tbody>
</table>
The Mixer section

This section controls the relative levels of Oscillator 1 and 2. Here you also set the levels of the Ring Modulator and Noise Generator outputs.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Osc 1</td>
<td>0-100%</td>
<td>Sets the volume of oscillator 1.</td>
</tr>
<tr>
<td>Ring Mod</td>
<td>0-100%</td>
<td>Controls the level of the ring modulator. See page 223.</td>
</tr>
<tr>
<td>Osc 2</td>
<td>0-100%</td>
<td>Sets the volume of oscillator 2.</td>
</tr>
<tr>
<td>Noise</td>
<td>0-100%</td>
<td>Noise is commonly used to create wind and percussion type sounds. To hear the noise generator output on its own, turn down the osc 1 and 2 output in the Mixer.</td>
</tr>
</tbody>
</table>
Mod Wheel section

This section controls how the modulation wheel affects certain parameters. Positive and negative values can be set. For example, this can be used to set up so that moving the mod wheel gradually removes Filter Cutoff LFO modulation and instead introduces vibrato.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pitch Mod</td>
<td>-100/+100</td>
<td>Governs the amount of LFO modulation of the oscillator frequency (vibrato) using the mod wheel.</td>
</tr>
<tr>
<td>Cutoff Mod</td>
<td>-100/+100</td>
<td>Governs the amount of LFO modulation of the Filter Cutoff parameter using the mod wheel.</td>
</tr>
<tr>
<td>Cutoff</td>
<td>-100/+100</td>
<td>Governs how much the mod wheel affects the Filter Cutoff frequency. Positive values raise the cutoff frequency when moving the mod wheel forward. Negative values invert this relationship.</td>
</tr>
</tbody>
</table>
The Parameter display

The Parameter display is located in the middle of the A1 panel. The Parameter display shows information about any A1 parameter control when you point at it with the mouse. The information is presented in the following way (from left to right):

• “Section” shows what A1 section the parameter belongs to.
• “Parameter” shows the name of the parameter.
• “Value” shows the current value of the parameter.
• “Ctrl” shows the MIDI Controller number assigned to the parameter, see page 224.

Setting the number of voices

A1 can have up to 16 voices, but you can freely set the number of voices for each program by changing the value in the “Voices” field.

Keyboard section

The keyboard shows incoming MIDI note data as played by “invisible hands”. The keyboard can be “played” by clicking on it with mouse. Note that the velocity produced will be fixed and that you cannot record anything by clicking the keyboard.

• “Bend Range” is the only parameter that can be set in this section. A value of “1” equals a semitone bend range, “2” equals a range of two semitones etc.
About the Filter types

The A1 features a multimode filter. The various filter modes are selected with the Filter Type buttons, and are as follows:

- **Lowpass**
  Lowpass filters let low frequencies pass and cuts out the high frequencies. This is the most commonly used filter type in analog synthesizers.

- **Bandpass**
  A bandpass filter cuts frequencies above and below the cutoff frequency, allowing a specific range of frequencies to pass while attenuating all others.

- **Highpass**
  A highpass filter is the opposite of a lowpass filter, cutting out the lower frequencies and letting the high frequencies pass.

- **Notch**
  A notch filter cuts out frequencies in a narrow midrange band, letting the frequencies below and above through.

Filter Slope

You can also select between 12 or 24 dB filter slopes for all filter types. A 12 dB Lowpass filter leaves more of the harmonics in the filtered sound compared to a 24 dB Lowpass filter.

Ring Modulator

Ring modulators basically multiply two audio signals together. In the A1, Oscillator 1 is multiplied with Oscillator 2 to produce sum and difference frequencies. Ring modulation can be used to create complex, bell-like sounds.

- To hear the output of Ring Modulator on its own, turn down the osc 1 and 2 output in the Mixer.

- If the oscillators are tuned to the same frequency, and no modulation is applied to either the oscillator 1 or 2 frequency, the ring modulated output will sound fairly similar to the “normal” sound of the oscillators. It is when the frequencies of osc 1 and osc 2 differ, that you get the more complex timbres associated with ring modulation.
About FM

Frequency Modulation, or FM, is when the frequency of one oscillator (called the "carrier") is modulated by the frequency of another oscillator (called the "modulator"). Using FM can produce a wide range of harmonic and non-harmonic timbres.

• In the A1, Oscillator 1 is the carrier and Oscillator 2 the modulator. When using FM, you should turn the master volume for Oscillator 2 down to zero in the Mixer to hear the "pure" sound of FM. The output of oscillator 2 is internally routed to oscillator 1 anyway when using FM.

• Changing the frequency of Oscillator 2 also changes the timbre of the FM sound. The waveform selected for both oscillators also affects the timbre.

MIDI Controller Messages

The A1 responds to MIDI Controller Messages. All A1 parameters are assigned controller numbers. To find out what controller number is assigned to a parameter, simply point at the parameter and you can see the associated controller number assigned to it in the Parameter display (see page 222).
VB-1 Bass Synth

The VB-1 is a virtual bass instrument built on real-time physical modeling principles. It has the following properties:

• VB-1 is polyphonic with up to 4 voices.

• VB-1 receives MIDI In Omni mode (on all MIDI channels). You don’t need to select a MIDI channel to direct MIDI to the VB-1.

• VB-1 responds to the following MIDI messages: MIDI Note On/Off (velocity governs volume), Volume and Pan.
### VB-1 Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pick-up</td>
<td>To change the Pick-up position, click and drag the lower end of the Pick-up. Positioning the pick-up position towards the left produces a hollow sound that emphasizes the upper harmonics of the plucked string. When placed towards the right position, the tone is fuller and warmer.</td>
</tr>
<tr>
<td>Pick</td>
<td>This determines where along the length of the string the initial pluck is made. This controls the “roundness” of the tone, just like on a real bass. Click-drag the Pick to change position.</td>
</tr>
<tr>
<td>Shape</td>
<td>This knob selects the basic waveform used to drive the plucked string model. This parameter can drastically change the sound character. The control smoothly morphs through the waves. It is possible to create sounds that have no relation to a bass guitar with this control.</td>
</tr>
<tr>
<td>Volume</td>
<td>This knob regulates the VB-1 volume.</td>
</tr>
<tr>
<td>Damper</td>
<td>This parameter controls the length of time the string vibrates after being plucked.</td>
</tr>
</tbody>
</table>
**LM-7 Drum Machine**

- Volume and Tune faders (for each drum sound).
- Pad (one for each drum sound). Press to audition the drum sound assigned to the Pad, or to select a sound for adjusting pan.

The LM-7 is a 24-bit drum machine. It has the following properties:

- **LM-7** is polyphonic with up to 12 voices.
- **LM-7 receives MIDI in Omni mode** (on all MIDI channels). You don’t need to select a MIDI channel to direct MIDI to LM-7.
- **LM-7 responds to the following MIDI messages:**
  - MIDI Note On/Off (velocity governs volume).
LM-7 Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Velocity</td>
<td>This sets the global velocity sensitivity for LM-7. The higher the value, the more sensitive LM-7 will be to incoming velocity data. If set to &quot;0&quot;, the sounds will play back with a fixed velocity value.</td>
</tr>
<tr>
<td>Volume sliders</td>
<td>The volume sliders are used to adjust the volume for each individual drum sound.</td>
</tr>
<tr>
<td>Tune sliders</td>
<td>The tune sliders are used to tune each individual drum sound, up or down 1 octave.</td>
</tr>
<tr>
<td>Pad</td>
<td>The Pads are used for two things: To audition the individual drum sounds, and to select a sound for adjusting pan.</td>
</tr>
<tr>
<td>Panorama</td>
<td>This is used to position an individual sound in the stereo image. The setting applies to the currently selected sound, indicated by a lit yellow LED over the Pad button.</td>
</tr>
</tbody>
</table>

Drum sounds

LM-7 comes with six sets of drum sounds. “Compressor”, “909” and “Percussion” are loaded as the default sounds when launching LM-7. “Modulation”, “Fusion” and “DrumNbass” can be loaded by selecting “Load Bank” from the File menu and opening the lm7_second_set.fxb file (which is located in the Vstplugins/Drums subfolder). Compressor features samples of an acoustic drum kit, 909 features classic analog drum machine sounds and Percussion not surprisingly features various percussion sounds. The table below shows how the drum sounds are assigned to note values on your MIDI keyboard. The mapping is GM compatible:

<table>
<thead>
<tr>
<th>Drum sound</th>
<th>Note value</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bd</td>
<td>C1</td>
<td></td>
</tr>
<tr>
<td>Rim</td>
<td>C#1</td>
<td>Compressor only.</td>
</tr>
<tr>
<td>Snare</td>
<td>D1</td>
<td></td>
</tr>
<tr>
<td>Clap</td>
<td>D#1</td>
<td>909 only.</td>
</tr>
<tr>
<td>Hi-Hat</td>
<td>F#1</td>
<td></td>
</tr>
<tr>
<td>O-Hi-Hat</td>
<td>A#1</td>
<td></td>
</tr>
</tbody>
</table>
Switching the sets

Use the pop-up menu to switch between the three supplied drum sets, just like you switch between effect programs.

<table>
<thead>
<tr>
<th>Drum sound</th>
<th>Note value</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tom 1</td>
<td>A1</td>
<td></td>
</tr>
<tr>
<td>Tom 2</td>
<td>B2</td>
<td></td>
</tr>
<tr>
<td>Tom 3</td>
<td>D2</td>
<td></td>
</tr>
<tr>
<td>Crash</td>
<td>C#2</td>
<td></td>
</tr>
<tr>
<td>Ride</td>
<td>D#2</td>
<td>Compressor only.</td>
</tr>
<tr>
<td>Tambourine</td>
<td>F#2</td>
<td>Percussion only.</td>
</tr>
<tr>
<td>Cowbell</td>
<td>G#2</td>
<td>Percussion only.</td>
</tr>
<tr>
<td>Hi Bongo</td>
<td>C3</td>
<td>Percussion only.</td>
</tr>
<tr>
<td>Lo Bongo</td>
<td>C3#</td>
<td>Percussion only.</td>
</tr>
<tr>
<td>Conga Mute</td>
<td>D3</td>
<td>Percussion only.</td>
</tr>
<tr>
<td>Conga Open</td>
<td>D#3</td>
<td>Percussion only.</td>
</tr>
<tr>
<td>Conga Lo</td>
<td>E3</td>
<td>Percussion only.</td>
</tr>
<tr>
<td>Timbale Lo</td>
<td>G3</td>
<td>Percussion only.</td>
</tr>
<tr>
<td>Timbale Hi</td>
<td>G#3</td>
<td>Percussion only.</td>
</tr>
<tr>
<td>Cabasa</td>
<td>A3</td>
<td>Percussion only.</td>
</tr>
</tbody>
</table>

10

Surround sound
(Cubase SX only)
Background

What is Surround sound?

Surround is a common name for various techniques for positioning audio in reference to the listener. Whereas regular stereo is limited to left/right positioning, within a relatively narrow field, surround sound opens possibilities of positioning an audio source anywhere around the listener.

Surround sound comes in many flavors, from the ill-fated Quadraphonic format for vinyl discs launched in the 70s, to today’s more successful incarnations.

The differences between the formats are in two areas:

• The number of speakers. This varies from two speakers up to six.

• The intended final coding format. This depends on the media the audio will be "stored" on: film, broadcast video or DVD, for example.

Surround sound is a large topic, there are entire books and regular publications devoted to the subject. This chapter will not provide an in-depth introduction to surround sound as such. Instead it will concentrate on the specific implementation in Cubase SX.

Surround sound in Cubase SX

Cubase SX has integrated surround sound features with support for several formats. This support goes all the way through the audio path:

• Audio Mixer channels can be routed freely to surround channels.

• The special SurroundPanner function in the Mixer allows you to graphically position channels in the surround field.

• Cubase SX is ready for surround specific plug-ins, that is plug-ins with multi-channel support specifically designed for surround sound mixing tasks (the included "Mix6to2" plug-in is an example of this).

There are also surround aware plug-ins, which are not designed specifically for Surround but which due to their multi-channel support work well in a Surround configuration. An example of such a plug-in is the UV22 HR dithering plug-in.

• The VST Master Setup window allows you to select and define surround speaker configurations and to map surround channels to physical outputs.
Requirements for using Surround

The following additional equipment is required for taking advantage of Cubase SX’s surround sound implementation:

- An audio card with more than two outputs.
  The card must have as many outputs as the surround format you plan to select.
- A matching amplifier/speaker configuration.

Encoding

The result of a surround mix in Cubase SX is either a number of audio channels in the project, or (if you use the Export audio feature) a number of related audio files on your hard disk. These are technically not different from regular stereo mixes (except they contain more channels).

To get from this step to the final product (surround sound on DVD disc, DTS etc.) requires special software and possibly hardware. This equipment will encode the signal into the desired format, possibly compress the audio (for example using MPEG encoding) and store it on the final media.

Exactly what type of software and/or hardware you need depends on what kind of format you are mixing for and is not dependent on Cubase SX in any way.
Window overview

VST Master Setup

In this window you can select a surround sound configuration. Apart from the “Label” and “Name” entries, the configurations cannot be edited.

Label and Name represent the channel names as they will appear in the SurroundPan and the bus output pop-up in the Mixer, respectively.
Surround in the Mixer

There are two ways to route audio to surround channels in the mixer:

Here, the SurroundPan plug-in is used for positioning the sound "dynamically" in the surround field.

If you instead use the surround items on this pop-up, the sound is routed directly to one surround channel only.
The VST Output Section

In the VST Outputs window you can adjust master levels for surround channels and route the surround channels to physical outputs on your audio card.

Here, three stereo buses are activated, in a 5.1 surround sound configuration.
Operations

Choosing a type of surround

To select your preferred surround configuration, open the VST Master Setup window and select a preset from the Presets pop-up.

The following surround configurations are included:

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stereo</td>
<td>Not a surround format but rather standard stereo (Left/Right).</td>
</tr>
<tr>
<td>Quadro</td>
<td>The original Quadraphonic format for music, with one speaker in each corner. This format was intended for vinyl record players.</td>
</tr>
<tr>
<td>LRCS</td>
<td>LRCS refers to Left Center Right Surround, where the surround speaker is center-rear positioned. This is the original surround format that first appeared as Dolby Stereo in cinema and later as the home cinema format Dolby ProLogic.</td>
</tr>
<tr>
<td>Standard 3/2</td>
<td>This is the same as 5.1 (see below) but without the LFE channel. The LFE channel is optional in 5.1 and if you don’t plan to use it, you might find this option more convenient.</td>
</tr>
<tr>
<td>5.1 Surround</td>
<td>This format is one of the most popular in cinema and DVD. In its various cinema and DVD encoding implementations (established by different manufacturers) it is referred to as Dolby Digital, AC-3, DTS and MPEG 2 Multichannel. 5.1 has one center speaker (mainly used for speech) and four surround speakers (for music and sound effects). Additionally a subchannel (LFE – Low Frequency Emitter) with lower bandwidth is used for special low frequency effects.</td>
</tr>
<tr>
<td>5.1 SMPTE/ITU</td>
<td>These are alternative versions of 5.1 Surround, in which the order of the speakers is changed.</td>
</tr>
</tbody>
</table>
• The graph shows you how the speakers are positioned in the “room”. The graph indicates a room, where the listener is facing the upper quadrants.

• The Output column indicates to which bus each channel will be routed. When you are done, click OK to close the dialog.

**Mapping surround outputs to audio outputs**

As indicated in the list in the VST Master Setup window, the surround channels are routed to the outputs/buses in the VST Outputs window, in pairs of two. In order to use the outputs they need to be activated and mapped to a physical output (pair) on your audio card.

• To activate a bus, open the VST Outputs window and click the Active buttons for the channels you need to use. The exact number of output buses required depends on the surround format chosen, for example 5.1 (a six channel format) requires three (stereo) buses.

• To map a bus to an output pair, use the pop-up menu at the bottom of the window. Read more about the VST Outputs window on page 166.
Positioning channels in the Surround field

There are basically two ways you can route a mixer audio channel to a surround channel:

Using the Surround Pan plug-in

Cubase SX has a special feature for graphically positioning a sound source in a surround field. This is actually a special plug-in which distributes the audio from the channel in various proportions to the surround channels.

1. Open the Mixer and locate the channel.

2. From the output routing pop-up menu, select SurroundPan.
   A miniature graph of the surround plug-in interface appears at the top of the channel strip.

3. Click and drag directly in the miniature image to move the sound in the surround field.
   To move the sound to the front center position, hold down [Ctrl]/[Command] and click.
   - You can double click on the miniature image to open the full plug-in interface in a separate window, where the sound source can be positioned just as in the miniature.
   The exact controls in this window are described below.
Routing channels directly to surround buses

Sometimes you may want to route a channel directly to a surround channel. This may for example be true for pre-mixed material or multi-channel recordings that don’t require panning.

Also please note that LFE channels are not shown in the Surround-Pan. To route low frequency effect sounds to the LFE channel you must use the method described below:

1. Open the Mixer and locate the channel.
   Please note that this may very well be a group channel, that is a mix of a number of channels that should all be routed to a special surround channel.

2. From the output routing pop-up menu, select the corresponding surround channel, from the section just above the SurroundPan option.
   The names of the channels, as they appear here, are defined in the VST Master Setup window, see page 234.

The lower section of the Output routing pop-up contains the surround outputs.
The SurroundPan controls

The SurroundPan plug-in interface.

The SurroundPan plug-in allows you to position your audio in the surround field. It consists of an image of the speaker arrangement, as defined in the VST Master Setup window, with the sound source indicated as a grey ball.

The following options and methods are available:

Speakers

The speakers in the panel represent the speakers defined in the VST Master Setup window.

- The speakers in the front are aligned, as they would normally be in a cinema-type situation.
  This means that the front speakers are at a varying distance from the center, allowing you to move sources between speakers without level attenuation.
- The LFE channel will not be visible.
- You can turn speakers on and off by clicking them with [Alt]/[Option] pressed. When a speaker is turned off, no audio will be routed to that surround channel.
Positioning and levels

The text below assumes mono/stereo pop-up is set to “Mono Mix”. For more information on the other modes, see below.

A sound source is positioned either by clicking or dragging the grey “ball” around in the panel (or by using key commands, see below). By dragging during playback you can record automation, see page 258.

Exactly how levels are handled may require some explanation:

• When you move a source around, a number will indicate the loudness in each speaker. This is a value in dB (decibel) and is relative to the nominal level of the source. In other words, 0.0 (dB) represents full level.

• If you position the source far enough away from a speaker, its level will drop to zero (indicated by an infinity symbol).

• The signal levels from the individual speakers are indicated by colored lines from the speakers to the center of display.

• You can use modifier keys to restrict movement in various ways:

<table>
<thead>
<tr>
<th>Key</th>
<th>Movement restriction</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Shift]</td>
<td>Horizontally only</td>
</tr>
<tr>
<td>[Ctrl]/[Command]</td>
<td>Vertically only</td>
</tr>
<tr>
<td>[Alt]/[Option]</td>
<td>Diagonally (up left, down right)</td>
</tr>
<tr>
<td>[Ctrl]/[Command]+[Alt]/[Option]</td>
<td>Diagonally (up right, down left)</td>
</tr>
</tbody>
</table>

There is also a special set of key commands for working in the SurroundPan window.

For a complete list of the available key commands, click on the “Panner” logo in the lower right corner and then click again!
The LFE slider

If the selected Master Setup includes an LFE (Low Frequency Emitter) channel, a separate LFE level slider will be available at the bottom of the SurroundPan window. Use this to set the signal amount sent to the LFE channel.

Mono/stereo pop-up

If you have a mono channel this is by default set to Mono Mix. The panner will then behave as described above.

If you have a stereo channel, you have the option of using one of the three Mirror modes. Two grey balls will then appear, one for each channel (L/R). This will allow you to move the two channels symmetrically, by just dragging one of them. The three modes allow you to select which axis should be used for mirroring.

• The default mode for stereo channels is the Y-Mirror mode.
• If you run a stereo signal through the panner in Mono Mix mode, the two channels will be mixed together before entering the plug-in.
• If you run a mono signal through the plug-in in one of the stereo modes, the signal will be split before entering the plug-in.
Additional Parameters

- **Center Level.**
  This determines how center source signals should be reproduced by the front speakers. With a value of 100%, the center speaker will provide the center source. With a value of 0%, the center source will be provided by the ghost image created by the left and right speakers. Other values will produce a mix between these two methods.

- **Divergence Controls.**
  The three divergence controls determine the attenuation curves used when positioning sound sources, for X-axis front, X-axis back and Y-axis, respectively. If all three Divergence values are 0% (default), positioning a sound source on a speaker will set all other speakers to zero level (−∞) (except for the center speaker which depends on the center level). With higher values, the other speakers will receive a percentage of the sound source.

**Automation**

All parameters in the SurroundPan plug-in can be automated, just as with any other plug-in. See page 258.
Exporting a Surround mix

A surround mix can be exported to audio files, just as any other mix. There are special features on the Channels pop-up in the Export Audio Mixdown dialog for this purpose. See page 630.

Using Master plug-ins in Surround configurations

- For general instructions on how to use Master plug-ins, see page 187. The following text only describes the specifics of using master plug-ins in surround configurations.

Cubase SX introduces a special surround format for VST plug-ins, that is plug-ins that can process more than two channels. An example of such a plug-in is the included Mix6to2.

Still, many stereo plug-ins might be useful as master effects even in a surround configuration.

In the upper left corner of the plug-in panel in the Master Effects window you will see a miniature signal diagram displaying graphics corresponding to the number of master channels in the current configuration, see below.

Applying a Surround-aware Master plug-in

This is not different from applying a regular plug-in. The only difference is that the plug-in panel may have controls for more than two channels.

Using a Stereo plug-in in a Surround Configuration

Normally, when you apply a stereo plug-in to a surround sound configuration, the first two channels (often L and R) are routed through the plug-in’s two channels, and other channels are left unprocessed. This is indicated by the signal diagram in the upper left corner of the Master Effects window.
However, you may want to use the plug-in on other channels. To do so, click on the small signal diagram to open up an editor window.

- **Changes you make in this window do not take effect until you click OK!**

- The columns in the diagram represent the channels in the current surround configuration.
- At the top are audio channels from the Mixer. In the middle is the plug-in itself. At the bottom is the output to the output buses (or to the input of the next Master Insert plug-in). Audio flows from top to bottom.
- The square brackets on the in- and outputs to the plug-in represent just that, the in- and outputs to the plug-ins.
- An arrow that ends at a plug-in input indicates that the audio from this surround channel arrives at that plug-in’s input.
- An arrow that starts at the output of a plug-in indicates that audio from this plug-in channel is routed to that output channel.
- An arrow that passes above the plug-in indicates a bypass connection (audio passes to the output bus without passing through the effect).

A plug-in input. A “broken connection”. No audio from the “S” channel will be sent into the plug-in.

This channel includes both a direct and a bypass connection.

In this case, the output from the Symphonic plug-in will be routed to the “C” and “S” Output Buses, or (if you have another Master plug-in below this one), to the “C” and “S” inputs of the next plug-in.
Operations

- You can drag arrows that are connected to the plug-in inputs and outputs sideways to route the audio to/from other audio channels than the standard configuration.

- By dragging both the upper and lower arrows to another channel, you route the audio from that channel right through the plug-in. Any other combination will make the audio from an input appear on another output channel.

- For channels with a “broken connection” (see illustration above), you can click on the plug-in to add a bypass connection. Click again to remove.

- You can set things up so that you both have a bypass connection and an input or output connection for a channel.

- Clicking Reset gets you back to the original standard connection.
CUBASE SX/SL
10 – 248 Surround sound (Cubase SX only)
Automation
Background

Cubase SX/SL has very comprehensive automation features. Virtually every Mixer and effect parameter can be automated.

There are two main methods you can use to automate parameter settings:

- By manually drawing curves on automation subtracks in the Project window. See page 262.

![Automation subtracks](image1)

- By using the Write/Read function and adjusting parameters in the Mixer. See page 258.

![Mixer automation](image2)

The methods are not different in terms of how the automation data is applied – they only differ in the way the automation events are created, either by manually drawing them or recording them. Any applied automation data will be reflected in both the Mixer (a fader will move for example) and in a corresponding automation track curve (although this may be hidden).
What can be automated?

Mixing in Cubase SX/SL can be completely automated. The following parameter settings can be recorded automatically – or manually drawn in – on automation subtracks:

For each audio and group track:
- Volume
- Pan Left - Right
- Pan Front - Rear
- Mute
- EQ Master Bypass
- FX Send Bypass
- Settings for 4 EQ modules (Enable/Freq/Quality/Gain)
- 8 x effect Send on/off switches
- 8 x effect Send levels
- 8 x effect Send pre/post switches
- SurroundPan parameters (if used - Cubase SX only)
- 8 x (5 x in Cubase SL) Insert effect program selection and effect parameters (if insert effects are used)

Global for all audio and group tracks

- From the Master automation track:
  - Master Gain
  - L and R levels for all output buses
  - Send effects “master” input levels

For each Plug-in automation track (if audio effects are used):
- Send effect program selection and effect parameters
- Master effect program selection and effect parameters
- VST Instrument program selection and parameters

- There is one Plug-in automation track for each automated Send effect, Master effect and VST Instrument.
For each MIDI track

- Volume
- Pan
- Mute
- Track Parameters on/off switch
- Transpose
- Vel. shift
- Random 1-2 Min/Max/Target
- Range 1-2 Min/Max/Target
- 4 x Insert effect on/off switches
- 4 x Send effect on/off switches
- 4 x MIDI Insert effect parameters (if used)
- 4 x MIDI Send effect parameters (if used)

About automation tracks

There are three types of automation tracks available:

- **Channel automation tracks**
  There is one automation track for every audio, group, and MIDI track, and also for each activated ReWire and VST Instrument channel. This automation track has a number of automation subtracks, one for each channel setting available. Each channel’s insert effect program selection and effect parameter settings are handled by the Channel automation track. For MIDI tracks, all Track parameters, MIDI send and insert effect parameter settings (if used) are also handled by the Channel automation track.

- **Plug-in automation tracks**
  There is one Plug-in automation track for each automated Send and Master effect, and for each automated VST Instrument. These tracks have a number of automation subtracks, one for every parameter of each automated effect and VST Instrument.

- **Master automation track**
  There is only one Master automation track for a project. This track can, just like for a single audio track, have any number of automation subtracks, for the Master Gain parameter, all the bus output levels and the send effects “master” input levels.

**Automation subtracks are not separate tracks, but rather separate “views” of the same automation track, showing one automation parameter at a time.**
Automation subtrack operations

Opening automation subtracks

Opening a Channel automation subtrack

Every track/channel has its own automation track, and each automation subtrack shows one automation parameter. There are two ways you can open a Channel automation subtrack:

- By right-clicking (Win) or [Ctrl]-clicking (Mac) the track in the Track list and selecting “Show Automation” from the pop-up that appears.
- By clicking on the “Show/Hide Automation” button (the plus sign) in the Track list for the channel.

An automation subtrack opens in the Track list, and a straight black horizontal line is shown as well as a greyed out mirror image of the audio events’ waveform (or MIDI events for MIDI tracks) in the event display. By default, the first subtrack is assigned the Volume parameter.

Click the plus button to open an automation subtrack.

- If you click on the “Show/Hide Automation” button (the plus sign) for an automation subtrack, the next parameter in the Add Parameter list (see page 254) is shown in a separate subtrack.

Opening a Plug-in automation subtrack

- Plug-in automation tracks are automatically created when the Write button is activated on an effect (Send/Master) or VST instrument control panel.

There is one Plug-in automation track for each automated effect or VST Instrument, containing subtracks for all parameters for the effect or VST Instrument.
Opening a Master automation subtrack

- Select “Add Track” from the Project menu, and select “Master Automation” from the submenu.
  A Master automation subtrack is added to the Track list. By default, the Master Gain parameter is assigned.

Assigning a parameter to an automation subtrack

All parameters are actually already “assigned” to the automation track. To select what parameter an open subtrack should display, proceed as follows:

1. If none exists, open a Channel automation subtrack using one of the methods described previously.
2. Click in the parameter display for the automation subtrack.
   A pop-up list is shown containing some of the automation parameters plus the item “More...” at the bottom of the list.

   - If the parameter you wish to automate is on the pop-up you can select it directly.
     The parameter will then replace the current parameter in the automation subtrack.
   - If you wish to add several items or to view all parameters that can be automated, go on to the next step.
3. Select “More...”.  
The Add Parameter dialog appears. This list contains all parameters that can be automated for the selected channel, including the parameters for any assigned insert effects. The available parameters are identical for all audio related channel types. MIDI tracks have different parameters.

![Add Parameter dialog for an audio track.](image)

4. Select a parameter from the list, and click OK.  
The parameter will then replace the current parameter in the automation subtrack.

- **Note that the “replacing” of the parameter displayed in the subtrack is completely non-destructive.**  
  For example, if the replaced subtrack had contained any automation data, this data would still be there, although it would not be visible in the current subtrack. If you click in the parameter display you can switch back to the replaced parameter. All automated parameters are indicated with an asterisk (*) after the parameter name on the pop-up menu.

![The Volume parameter is automated.](image)
• You can select any number of parameters at the same time from the Add Parameter dialog using standard selection methods. The parameters selected in the dialog will then appear on the parameter display popup menu.

Before selecting parameters in the dialog, the pop-up shows the first number of parameters, in the order they appear in the Add Parameter list. By selecting parameters you can temporarily "reorder" the list so that they become available on the pop-up.

• If you click on the plus sign for the first subtrack (and then for each following subtrack), all the parameter subtrack(s) you added will appear, in the order that they originally appeared in the Add Parameter list.

• Automation subtracks that contain automation events are indicated by an asterisk after the name on the parameter display pop-up menu.

Removing automation subtracks

To remove automation subtracks from the Track list, proceed as follows:

• To remove a single parameter, click in the parameter display on a subtrack and select “Remove Parameter” from the pop-up menu. Note that this will also delete any automation events on the subtrack, and the subtrack will be closed.

• To remove all currently unused subtracks from a track in the Track list, select “Remove Unused Parameters” from a subtrack. All subtracks that do not contain automation events will be closed for the selected track.

Hiding automation subtracks

• To hide a single automation subtrack, click the “Hide Automation” button (the minus sign) in the Track list.

• To hide all automation subtracks for a track, right-click (Win) or [Ctrl]-click (Mac) the track for which you wish to hide the automation subtracks, and select “Hide Automation” from the pop-up menu that appears.

• To hide all automation subtracks for all tracks in the Track list, right-click (Win) or [Ctrl]-click (Mac) any track and select “Hide All Automation” from the pop-up menu that appears. This option is also available on the Project menu.
Showing only used automation subtracks

If a lot of automation subtracks are used, it may be impractical to have them all open in the Track list. If you want to bring back all hidden automation tracks that are currently used (e.g., there are automation events on the subtrack), this can be done using the following methods:

- Right-clicking (Win) or [Ctrl]-clicking (Mac) any audio or MIDI track in the Track list allows you to select the option “Show Used Automation for All Tracks” from the pop-up menu. This will open all automation subtracks that contain automation events for all tracks. This option is also available on the Project menu.

- Right-clicking (Win) or [Ctrl]-clicking (Mac) a specific track allows you to select the option “Show Used Automation” from the pop-up menu. This will open all automation subtracks that contain automation events for the selected track.

Muting automation subtracks

You can Mute individual automation subtracks by clicking their Mute buttons in the Track list. While clicking the Read (R) button (see page 258) for an automation subtrack will activate or deactivate Read mode for all automated parameters of the track, using the Mute button allows you to turn off automation for a single parameter.
Using Write/Read automation

Write (W) and Read (R) buttons can be found for each channel in the Mixer, for each MIDI, audio and group track (including subtracks) in the Track list, on the control panels for all plug-in effects and VST Instruments and for the Master fader.

The Write and Read buttons for a channel in the Mixer, and for an automation subtrack in the Track list.

- If you activate Write for a channel, all mixer parameters you adjust during playback for that specific channel will be recorded as automation events.
- If you activate Read for a channel, all your recorded mixer actions for that channel will be performed during playback, just like you performed them in Write mode.
- The W and R buttons for a track in the Track list are mirrors of the W and R buttons in the corresponding channel strip in the Mixer.
- The first time you activate the Write button on the control panel for a send effect or master effect, a plug-in automation track is created for the effect plug-in. You can then proceed with automating the parameters of the plug-in (by editing the automation subtracks or by writing, as described below). To play back the plug-in automation, make sure the Read button for the plug-in is activated.

There are also global Read All and Write All buttons in the Mixer’s Common panel:

- When Read All is activated, all your recorded mixer actions for all channels will be performed during playback.
- When Write All is activated, all Mixer actions you perform during playback (for all channels) will be recorded as automation events.
About the three automation modes (Cubase SX only)

- In Cubase SL the automation mode is always “Touch Fader”.

When recording automation, you can choose one of three automation modes (available on the Project window toolbar):

- **When Touch Fader mode is selected, the program starts writing the automation as soon as you click the control and stops writing when you release the mouse button.**

- **When Autolatch mode is selected, the program starts writing the automation as soon as you click the control and stops writing when you turn off the Write function.**
  
  This means that the last automation value will be continuously written until you turn off Write.

  The Autolatch mode is useful if you want to overwrite a long section of previous automation, and also when you are recording automation from a remote device (because then there is no way for the program to know when you “release” the control). However, make sure you only touch the desired control(s) when recording automation in Autolatch mode – and remember to stop playback when you’re done!

- **X-Over mode works like Autolatch mode, but with one difference: As soon as you “cross” any existing (previous) automation curve, the writing is automatically turned off.**
Recording your actions - an example

If the settings in your current project are crucial, you may not want to “experiment” with automation until you know more about how it all fits together. If so, you can open up a new project for the following example. It doesn’t even have to contain any audio events, just a few audio tracks. Proceed as follows:

1. Open the Mixer.

2. Click the “Write All” button in the Mixer Common Panel.
   Cubase SX/SL is now in Global Write mode.

3. Start playback, and adjust some volume faders and/or other parameter settings in the Mixer or perhaps in a Channel Settings window.
   Stop playback when you are done, and return to the position where playback was activated.

4. Deactivate Write mode, and click the “Read All” button in the Mixer Common panel.
   Cubase SX/SL is now in Global Read mode.

5. Start playback, and watch the Mixer window.
   All your actions performed during the previous playback will be reproduced exactly.

6. If you wish to redo anything that was recorded, activate Write mode again, and start playback from the same position.
   - You may have Write and Read activated simultaneously, if you want to watch and listen to your recorded mixer actions while you’re recording fader movements for another mixer channel, etc.

Where did the automation data I recorded end up?

When using “Write All” automation, you can write automation data on all channels’ automation tracks. In the previous Write operation, you probably added automation events for many different channels and parameters.

- To view all the automation events you recorded during the operation, select “Show Used Automation” from the Project menu.
  Now the automation data for every channel parameter that you adjusted in the Mixer during Write mode is shown on corresponding subtracks in the Project window. The automation events recorded are shown as points in the automation curves.
Working with automation curves

About automation curves

There are two kinds of automation curves, “Ramp” and “Jump”:

- Jump curves are created for any parameter that only has on/off values, like a Mute button, for example.
- Ramp curves are created for any parameter that generates continuous multiple values, such as fader or dial movements etc.

Examples of Jump (top subtrack) and Ramp automation curves shown in the event display.

About the static value line

When you first open an automation subtrack for a parameter, it doesn’t contain any automation events (unless you have previously adjusted that parameter with Write automation activated), and this is reflected in the event display as a straight horizontal black line, the “static value” line. This line represents the current parameter setting.

In the following description it is assumed that you have a Volume subtrack open showing a static value line with neither Read nor Write automation activated.

- If you click and hold the static value line with the Arrow tool, you can drag it up or down. The corresponding fader in the mixer moves with the static value line and vice versa.
- If you have manually added any automation events or used Write automation for the corresponding parameter, and then deactivate Read mode, the automation curve will be greyed-out in the automation subtrack event display and the static value will be used instead. As soon as Read mode is activated the greyed-out automation curve will become active.
Editing automation events

Drawing automation events

By using Write automation in the Mixer, you generate automation events by moving parameter dials and fader settings in the Mixer. You can also add them manually, by drawing automation curves on an automation subtrack. Proceed as follows:

1. Open a Channel Volume automation subtrack for an audio track by clicking the plus sign. The static value line is shown in the event display.

2. Select the Pencil tool.

   You could also use the Pencil tool in other modes for drawing curves, see below.

3. If you click on the static value Line, an automation event is added, Read automation mode is automatically activated, and the static value line changes to a blue automation curve.

4. If you click and hold, you can draw a curve, by adding a multitude of single automation events.
5. When you release the mouse button, the number of automation events are reduced to a few events, but the basic shape of the curve still remains. This “thinning” of events is governed by the Reduction setting in the Preferences, see page 269.

6. If you now activate playback, the Volume will change with the automation curve. In the Mixer the corresponding fader moves accordingly.

7. Simply redo the operation if you are not happy with the result. If you draw over existing events, a new curve is created.
   - If the automation subtrack is in Read mode already, you can also add automation events by clicking with the Arrow tool. If you are trying to add a point between two existing points and the new point doesn’t deviate from the existing curve, it will be removed by Reduction (see page 269) as soon as you release the mouse button.

**Using the Pencil tool in other modes to draw automation curves**

Other Pencil tool modes can be very useful for drawing automation events. The various modes are accessed by clicking on the Pencil tool on the toolbar and selecting from the pop-up that appears.

- Clicking and dragging with the Pencil tool in Line mode shows a line in the automation subtrack, and creates automation events aligned with this line. This is a quick way to create linear fades, etc.

- The Parabola mode works in the same way, but aligns the automation events with a parable curve instead, giving more “natural” curves and fades. Note that the result depends on from which direction you draw the parable.
The Sine, Triangle and Square modes create automation events aligned with continuous curves. If snap is activated and set to Grid, the period of the curve (the length of one curve “cycle”) is determined by the grid setting. If you press [Shift] and drag, you can set the period length manually, in multiples of the grid value.

Selecting automation event points

- To select a single automation event point, click on it with the Arrow tool. The point turns red, and you can drag it in any horizontal or vertical direction between two points.

- To select multiple curve points, you can either [Shift]-click or drag a selection rectangle with the Arrow tool. All events inside the selection rectangle will become selected.

Draw a selection rectangle around some points to select them.

When selected, several points can be moved in all directions as “one”, i.e. the curve shape formed by the selected event points remains intact.

- To select all automation events on a subtrack, right-click (Win) or [Ctrl]-click (Mac) the automation subtrack in the Track list and choose “Select All Events” from the context menu.
Removing automation events

There are several ways to remove event points:

- By selecting points and pressing [Backspace] or [Delete].
- By clicking on a point with the Eraser tool.
- By clicking in the parameter display on a subtrack and selecting “Remove Parameter” from the pop-up.
  This will remove all automation events from the subtrack, and the subtrack will be closed.

Editing automation events

You can cut/copy automation events and paste them in at the current project cursor position. However, most items on the Edit menu are not applicable to automation events.

Using Plug-in automation

Each parameter for every assigned effect or VST Instrument can be automated. Proceed as follows:

- Channel Insert Effects are automated using the respective Channel automation track.

Using Write/Read automation

All effects have Write/Read buttons on their control panels. These work exactly like the corresponding buttons in the Mixer or in the Inspector, but the recorded data ends up on separate Plug-in automation tracks, one for each automated effect.

Opening Plug-in automation subtracks

Plug-in automation tracks are created automatically when a Write button is activated for a Send or Master effect or an VST Instrument. Each automated effect or VST Instrument will have its own Plug-in automation track, containing subtracks for all parameters for that effect or VST Instrument. The track will get the same name as the effect or VST Instrument.
Assigning a parameter to a Plug-in automation subtrack

To select which parameter is currently shown in the Plug-in automation track, proceed as follows:

1. Click in the parameter display for a Plug-in automation subtrack.
   The parameter display pop-up list is shown containing the automation parameters for the plug-in. The automated parameter(s) are indicated by an asterisk after the parameter name in the list. If there are more parameters than can fit on the pop-up menu, the item “More...” is shown at the bottom of the list. Selecting “More” opens the Add Parameter dialog window for the Plug-in automation track, showing all the parameters for the selected effect or VST Instrument.

   ![Parameter display pop-up list example]

   The Phaser parameters.

2. Select the parameter you wish to view directly from the parameter display pop-up or from the Add Parameter dialog.

   All procedures for editing Plug-In automation events is identical to Channel automation tracks.

Using Master automation

The procedure for using Master automation is as follows:

- To open a subtrack for the Master automation track, select “Master Automation” from the Project menu’s “Add Track” submenu.
  A subtrack named “Mixer” is added to the Track list, with the first parameter by default being the Master Gain Parameter.
Editing automation events in the Project Browser

You can also edit automation events in the Project Browser. Proceed as follows:

1. Open the Project Browser by selecting it from the Project menu.
   The Browser window opens. The window is divided into two sections, the Structure list to the left, and the event display to the right.

2. Click on the plus sign for a track in the Structure list.
   Tracks have two subitems: Track data and automation. The automation item corresponds to the automation subtrack in the Project window, and contains the track’s automation events.

3. Click on the plus sign for the Automation item.
   All automated parameters for the track are shown in the Structure list.

4. Clicking on a parameter in the Structure list, brings up the automation events in the event display.

   The following parameters are available for all automation tracks and subtracks, including the group channel tracks:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>The position of the automation event.</td>
</tr>
<tr>
<td>Value</td>
<td>The value (0.000 – 1.000) of the automation event.</td>
</tr>
</tbody>
</table>
Tips and common methods

There are no hard and fast rules when it comes to describing which automation method you should use. You could for example never even open an automation subtrack, and stick with Write automation throughout a project. On the other hand, you could stick to drawing automation curves to automate settings in a project. Both methods have their advantages, but it is of course up to you to decide what to use and when.

• Editing curves on automation subtracks offers a graphical overview in relation to the track contents and the time position. This makes it easy to quickly change parameter values at specific points, without having to activate playback. For example, this method gives you a good overview if you have a voice-over or a dialog on one track and a music bed on another track, the level of which needs to be lowered with a specific amount every time the dialog occurs.

• By using Write automation in the Mixer you don’t have to manually select parameter subtracks from the Add Parameter list. You can work much like you would using a “real” physical mixer. Every action you perform is automatically recorded on subtracks for the parameters you change which you can later open for viewing and editing.

These are just two examples of advantages for each method. Generally, editing curves and using Write automation are two methods that complement each other, and depending on the nature of your projects you will probably work out what method works best for a given situation.
Options and Settings

About the “Reduction” Preference

This item can be found on the Editing page in the Preferences dialog. Reduction reduces the number of automation events after you have used Write automation or added automation events manually. When you Write (or draw with the Pencil tool) automation events, these are added as a continuous stream of densely packed events. This is necessary because the program cannot “guess” what you will be doing next! However, when you are done, the Reduction function will remove all superfluous event points and the automation curve now contains only the event points necessary to reproduce your actions.

For example, all event points that might exist between two other points, but do not deviate from the curve, will be automatically removed by reduction.

If you try to add an event that doesn’t deviate from the existing curve between two existing points...

...it will be removed when the mouse is released. If you had moved the selected event by any amount so that the resulting curve wouldn’t be a straight line, the event would of course be added.

• If you feel you need a lower (or higher) reduction level of events than the default setting of roughly 75% reduction, you can change it, but normally the default setting works well.

• A minimum reduction level setting is not recommended as this will simply retain a lot of unnecessary events.
Remote Controlling the Mixer
Background

It is possible to control the Cubase SX/SL Mixer via MIDI. Currently, the following MIDI control devices are supported:

- Steinberg Houston (see page 276)
- Mackie Control (see page 276)
- CM Automation Motor Mix (see page 277)
- JL Cooper CS-10 (see page 278)
- JL Cooper MCS-3000 (see page 279)
- Radikal SAC-2k (see page 281)
- Roland MCR8 (see page 280)
- Tascam US-428 (see page 283)
- Yamaha 01V (see page 286)
- Yamaha DM2000 (see page 276)

There is also a Generic Remote Device, allowing you to use any MIDI controller to remote control Cubase SX/SL.

Operations

Selecting a remote device

1. Make sure the MIDI control device is connected to your MIDI interface. You need to connect the MIDI Out on the remote unit to a MIDI In on your MIDI interface. Depending on the remote unit model, you may also need to connect a MIDI Out on the interface to a MIDI In on the remote unit (this is necessary if the remote unit features “feedback devices” such as indicators, motorized faders, etc.). See the MIDI control device specifications on the following pages for details.

2. Pull down the Devices menu and select Device Setup. A dialog window opens with a list of devices shown in the left part of the window.

3. If you can’t find the remote device you are looking for, click on the Add/Remove tab and select it from the Device Classes menu. Click “Add” to add it to the Devices list.

- Note that it is possible to select more than one remote device of the same type. If you have more than one remote device of the same type, these will be numbered in the Device list.
4. Now click the Setup tab and select your MIDI control device model from the Devices list. Depending on the selected device, either a list of programmable function commands or a blank panel is shown in the right half of the dialog window.

![Device Setup](image)

A JL Cooper MCS-3000 selected as remote control device.

5. Select the correct MIDI input from the pop-up menu.

6. If necessary, select the correct MIDI output from the pop-up menu.

7. Click OK to close the dialog. You can now use the MIDI control device to move faders and knobs, activate mute and solo, etc. The exact parameter configuration depends on which external MIDI control device you are using.
Writing automation using remote controls

Automating the Mixer using a remote control device is basically done in the same way as when you operate on-screen controls in Write mode. However, when it comes to replacing existing automation data, there is one important difference:

- If you activate Write mode and move a control on the remote control device, all data for the corresponding parameter is replaced from the position where you moved the control, up until the position where playback is stopped!

  In other words, as soon as you have moved a control in Write mode, it remains “active” until you stop playback. The reason for this is explained below.

  As a consequence, an additional precaution must be taken:

- Make sure you move only the controller you want to replace!

  In order to replace existing automation data for a control, the computer needs to know how long the user actually “grabbed” or used the control. When doing this “on screen”, the program simply detects when the mouse button is pressed and released. When you are using an external remote control device, however, there is no mouse button involved, and Cubase SX/SL cannot tell whether you “grab and hold” a fader, or simply move it and release it. Instead, you have to indicate that you have “released” the control by stopping playback.

- The above does not apply to the MCS 3000. This device has touch sensitive faders, which means that it stops writing as soon as you release the fader.

- This is only relevant when you are using a remote control device and Write mode is activated in the Mixer.
Assigning remote key commands

For some of the supported remote devices, you can assign any Cubase SX/SL function (that can be assigned a key command) to generic buttons, wheels or other controls. As of this writing, these devices are:

- JL Cooper MCS 3000
- JL Cooper CS-10
- CM Automation Motor Mix

Proceed as follows:

1. Open the Device Setup and select one of the remote devices that support this feature.
   On the right side of the window there are three columns. This is where you assign commands.

2. Use the “Button” column to locate a Remote device control or button to which you wish to assign a Cubase SX/SL function.

3. Click in the “Category” column for the control, and select one of the Cubase SX/SL function categories from the pop-up menu that appears.

4. Click in the “Command” column, and select the desired Cubase SX/SL function from the pop-up menu that appears.
The available items on the pop-up menu depend on the selected category.
   Click “Apply” when you are done. The selected function is now assigned to the button or control on the remote device.

A note about remote controlling MIDI tracks

While most remote control devices will be able to control both MIDI and audio track channels in Cubase SX/SL, the parameter setup may be different. For example, audio-specific controls (such as EQ) will be disregarded when controlling MIDI channels.
Remote control device specifics

Steinberg Houston

Houston is a MIDI/USB remote control device designed especially for use with VST audio applications such as Cubase SX/SL. With clearly laid out controls (including touch sensitive motorized faders, rotary knobs, transport controls and a jog/shuttle wheel) Houston allows you to control virtually every Mixer parameter in Cubase SX/SL, without having to use the computer keyboard or mouse.

- For details about parameters and hands-on mixing techniques, please see the Houston documentation.

Mackie Control

Mackie Control is an automated touch-sensitive control surface. It is a nine-fader (eight channels and master) MIDI controller that provides in-depth mixing, editing, automation and navigational control for any supported digital audio workstation. A special Lexan overlay is available to customize the controller for Cubase SX/SL. Both Cubase SX/SL and Nuendo use the same Steinberg overlay.

- For details about parameters and hands-on mixing techniques, please see the separate pdf documentation describing the use of Mackie Control with Cubase SX/SL.

Yamaha DM2000

The Yamaha DM2000 is a digital mixing console that provides full automation of virtually all console parameters. It is designed to integrate effectively with digital audio workstations such as Cubase SX/SL.

- For detailed information about features, parameters, etc., please see the documentation which comes with the Yamaha DM2000.
CM Automation Motor Mix

The CM Motor Mix can control any number of channels in groups of 8.

- Fader level, mute, solo control the equivalent Cubase SX/SL functions.
- Left and right View buttons: select channels 1-8, 9-16 etc.
- Top button row (above the rotary knobs) selects channel.
- The two rows of buttons on each side of the faders can be assigned functions in the Device Setup dialog. All except the Shift button, which acts like [Shift] on your computer keyboard.
- The rotary knobs are multi-functional, depending on the selected Rotary setting.

The following parameters can be remote controlled with the 8 rotary knobs:

- Pan
- Effect sends 1-8
- EQ Enable
- EQ Freq
- EQ Gain
- EQ Q

- The first two rows of buttons below the rotary knobs are also multi-functional, depending on the status of the buttons to the left and right of these two rows. Note that the “Group” button is not assigned any parameter.

The following parameters can be remote controlled with the 8 buttons on the first row below the rotary knobs:

- EQ Master Bypass
- Insert On

The following parameters can be remote controlled with the 8 buttons on the second row below the rotary knobs:

- Record Enable
- Monitor
- Write Automation
- Read Automation
JL Cooper CS-10

The CS-10 can remote control 32 channels (in groups of 8). The following CS-10 controls will remote control the following parameter for each channel strip:

- Fader: volume
- Solo and Mute: solo and mute
- Sel: select channel for editing

The following parameters can be remote controlled for each selected channel using the six rotary knobs on the CS-10:

<table>
<thead>
<tr>
<th>Dial</th>
<th>Parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send 1</td>
<td>Effect send 1</td>
</tr>
<tr>
<td>Send 2</td>
<td>Effect send 2</td>
</tr>
<tr>
<td>Pan</td>
<td>Pan</td>
</tr>
<tr>
<td>Boost/cut</td>
<td>EQ 1 Gain</td>
</tr>
<tr>
<td>Frequency</td>
<td>EQ 1 Frequency</td>
</tr>
<tr>
<td>Bandwidth</td>
<td>EQ 1 Q Factor</td>
</tr>
</tbody>
</table>

- The CS-10 function keys 1 - 4 are used to select channels 1 - 32 in groups of 8. Function key 1 selects channels 1 - 8, function key 2 selects channels 9 - 16, and so on.

- If you hold down the function key “Shift” and then move a fader, the two indicators beside the fader will indicate whether the fader position is below or above the current fader level in Cubase SX/SL. If the upper indicator is lit, the fader position on the panel is above the fader level in Cubase SX/SL and vice versa. When both indicators are dark, the fader positions are matched for that channel.

- The CS-10 Play, Stop, Record, Rewind and Fast Forward transport controls will have the equivalent functionality in Cubase SX/SL.

- The CS-10 supports “MIDI Feedback”, allowing the mute, solo and selection status of the channels in Cubase SX/SL to be indicated on the panel. For this (and the fader position indication described above) to work, you need a two-way MIDI connection between the CS-10 and Cubase SX/SL.
JL Cooper MCS-3000

The MCS-3000 can control 32 Mixer channels remotely (in groups of 8). The following MCS-3000 controls will remote control the following Mixer parameter for each channel strip:

- Fader: volume
- Solo and Mute: solo and mute
- Sel: Select channel for editing

These parameters can be remote controlled for each selected channel using the dials on the MCS-3000 and switching between Pages 1 - 4:

<table>
<thead>
<tr>
<th>Page 1</th>
<th>Page 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dial</td>
<td>Parameter</td>
</tr>
<tr>
<td>1</td>
<td>Pan</td>
</tr>
<tr>
<td>2</td>
<td>Effect send 1</td>
</tr>
<tr>
<td>3</td>
<td>Effect send 2</td>
</tr>
<tr>
<td>4</td>
<td>Effect send 3</td>
</tr>
<tr>
<td>5</td>
<td>Effect send 4</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Page 3</th>
<th>Page 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dial</td>
<td>Parameter</td>
</tr>
<tr>
<td>1</td>
<td>EQ 2 Gain</td>
</tr>
<tr>
<td>2</td>
<td>EQ 2 Freq</td>
</tr>
<tr>
<td>3</td>
<td>EQ 2 “Q”</td>
</tr>
<tr>
<td>4</td>
<td>EQ 2 Low Limit</td>
</tr>
<tr>
<td>5</td>
<td>EQ 2 High Limit</td>
</tr>
</tbody>
</table>

- The MCS-3000 bank keys 1 - 4 are used to select channels 1 - 32 in groups of 8. Bank key 1 selects channels 1 - 8, bank key 2 selects channels 9 - 16 and so on.
- You can create markers by pressing the “Set Locate” key on the MCS-3000, typing in a marker ID and pressing [Return].
• To locate to a marker, press “Locate”, type in a marker ID and press [Return].

• The MCS-3000 Play, Stop, Record, Rewind and Fast Forward transport controls will have the equivalent functionality in Cubase SX/SL.

❐ The MCS-3000 supports “MIDI Feedback”, allowing fader settings and channel mute, solo and selection status to be indicated on the panel. For this to work, you need a two-way MIDI connection between the MCS-3000 and Cubase SX/SL.

Roland MCR-8

❐ Before you can initiate remote control operation, the MCR-8 “Mode” switch must be set to “4”.

The Roland MCR-8 can control 16 Mixer channels, plus transport control. The “A/B switch” is used to switch between controlling channels 1 - 8 and 9 - 16. The following MCR-8 parameters control the equivalent parameters for each channel strip:

• Fader level, mute, solo and pan.

The following MCR-8 transport controls control the equivalent Cubase SX/SL functions:

• Play, Stop, Record, Rewind, Fast Forward.

❐ The MCR-8 does not support “MIDI feedback”, that is, the current status of parameters in Cubase SX/SL is not indicated on the MCR-8. Therefore, you only need a one-way MIDI connection between the MCR-8 and Cubase SX/SL.
Radikal Technologies SAC-2K

The SAC-2K can control 32 channels (in groups of 8). The following SAC-2K parameters control the equivalent parameters for each channel strip:

- Fader: volume
- Solo and Mute: solo and mute (depending on the solo/mute state switch)
- Select: select channel for editing in Channel Strip mode

Encoder operation modes and display layout

The SAC-2K supports two operation modes for the encoder dials and the display. Mixer Mode will assign the same parameter for each channel strip to the encoder dials, e.g. EQ1-Gain for each channel. Channel Strip mode will assign a parameter set for one selected channel to the encoder dials, e.g. all 8 send levels for the selected channel.

The first row of the displays above the channel strips will display the name of the channels. The second row will display the value of the parameter assigned to the encoder dials. The first row of the rightmost display will show the name of the selected channel, the assignment for the encoder dials and the channel range. The second row will display any value of the parameter assigned to the encoder dials in Channel Strip mode:

- Display for encoder operation in Mixer mode “Pan”:

<table>
<thead>
<tr>
<th>Chn1</th>
<th>Chn2</th>
<th>Chn3</th>
<th>Chn4</th>
<th>Chn5</th>
<th>Chn6</th>
<th>Chn7</th>
<th>Chn8</th>
<th>Chn1</th>
<th>Pan</th>
<th>VST 1-8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pan</td>
<td>Pan</td>
<td>Pan</td>
<td>Pan</td>
<td>Pan</td>
<td>Pan</td>
<td>Pan</td>
<td>Pan</td>
<td>Pan</td>
<td>Pan</td>
<td></td>
</tr>
</tbody>
</table>

- Display for encoder operation in Channel Strip mode “EQs”:

<table>
<thead>
<tr>
<th>Chn1</th>
<th>Chn2</th>
<th>Chn3</th>
<th>Chn4</th>
<th>Chn5</th>
<th>Chn6</th>
<th>Chn7</th>
<th>Chn8</th>
<th>Chn1</th>
<th>EQ</th>
<th>VST 1-8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Freq1</td>
<td>Freq2</td>
<td>Freq3</td>
<td>Freq4</td>
<td>Freq5</td>
<td>Freq6</td>
<td>Freq7</td>
<td>Freq8</td>
<td>Q1</td>
<td>Q2</td>
<td>Q3</td>
</tr>
</tbody>
</table>

In order to access all parameters of a parameter set with the encoder dials, the parameter set buttons need to be pressed repeatedly to cycle through the parameter assignments.
When pressing an encoder dial the currently selected band of EQ or FX-Send will be activated or deactivated.

Assignment mapping for the Mixer mode buttons:

<table>
<thead>
<tr>
<th>Mode</th>
<th>Assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pan</td>
<td>Pan</td>
</tr>
<tr>
<td>High</td>
<td>EQ4 Gain, EQ4 Freq, EQ4 On, EQ4 Q</td>
</tr>
<tr>
<td>HiMid</td>
<td>EQ3 Gain, EQ3 Freq, EQ3 On, EQ3 Q</td>
</tr>
<tr>
<td>LowMid</td>
<td>EQ2 Gain, EQ2 Freq, EQ2 On, EQ2 Q</td>
</tr>
<tr>
<td>Low</td>
<td>EQ1 Gain, EQ1 Freq, EQ1 On, EQ1 Q</td>
</tr>
<tr>
<td>Snd/Ins1</td>
<td>Send1 Level, Send1 On, Send1 Pre, Send1 Bus</td>
</tr>
<tr>
<td>Snd/Ins2</td>
<td>Send2 Level, Send2 On, Send2 Pre, Send2 Bus</td>
</tr>
<tr>
<td>Snd/Ins3</td>
<td>Send3 Level, Send3 On, Send3 Pre, Send3 Bus</td>
</tr>
<tr>
<td>Snd/Ins4</td>
<td>Send4 Level, Send4 On, Send4 Pre, Send4 Bus</td>
</tr>
</tbody>
</table>

Assignment mapping for the Channel Strip buttons:

<table>
<thead>
<tr>
<th>Mode</th>
<th>Assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>EQs</td>
<td>EQs</td>
</tr>
<tr>
<td>Inserts/Sends</td>
<td>Send Level, Send On, Send Pre, Send Bus</td>
</tr>
</tbody>
</table>

- The buttons “1-8”, “9-16”, “17-24” and “25-31” will switch to the according channels.
- You can create Markers by pressing the “Store Marker” key on the SAC-2K and pressing a number key between “1” and “9” or “To” and “From”.
- To locate to a Marker, press “Recall Marker” and press a number key between “1” and “9” or “To” and “From”.
- The SAC-2K Play, Stop, Record, Rewind and Fast Forward transport controls control the equivalent functions in Cubase SX/SL.
- The following buttons of the Mixer-Mode section have no assignment: “Snd/Ins”, “MIDI”, “Input”, “Inst”, “Group” and “Bus”.

CUBASE SX/SL
12 – 282 Remote Controlling the Mixer
• The following buttons of the Channel Strip section have no assignment: “Dynamics”, “MIDI” and “Instruments”.

تأكيد SAC-2K supports “MIDI Feedback”, allowing fader settings and channel mute, solo and selection status to be indicated on the panel. For this to work, you need a two-way MIDI connection between the SAC-2K and Cubase SX/SL.

Tascam US-428

The US-428 can remote control up to 64 Mixer channels and 1 or 2 DSP Factory cards, if installed (Windows version only).

• When the Tascam US-428 device is added in the Device Setup dialog, you can open the Remote Status window by selecting “Tascam US-428” from the Devices menu. This indicates which bank (group of eight channels in Cubase SX/SL) is currently being controlled by the remote device. To select another bank, use the pop-up menu in the window or use the Bank Left/Right buttons on the remote device.

The Remote Status window

• The US-428 Transport keys will have the equivalent functionality in Cubase SX/SL.

• To set markers, hold down “Set” while pressing a locator key.

• If you hold down the function key [Null] and then move a fader, the Select and Rec indicators above the fader will indicate whether the fader position is below or above the current fader level in Cubase SX/SL. If the upper indicator is lit, the fader position on the panel is above the fader level in Cubase SX/SL and vice versa. When both indicators are dark, fader positions are matched for that channel.

• The US-428 supports “MIDI Feedback”, allowing for mute/solo, channel selection, EQ band, Aux 1 to 4 and Transport status to be indicated on the panel. For this (and the fader position indication described above) to work, you need to select the “US-428 Control” port as input and output.
Cubase SX/SL Mixer

The following US-428 controls will remote control the following Mixer parameter for each channel strip:

- Fader: volume
- Mute/Solo: mute and solo (selected via the Solo switch)
- Select: selects channel for editing
- Pan-Dial: pan
- EQ-Gain
  Controls the EQ gain for each band selected with the Low, LoMid, HiMid and High buttons. These correspond to the four EQ bands in Cubase SX/SL, starting from the leftmost band.
- EQ-Freq
  Controls the EQ frequency for each band selected with the Low, LoMid, HiMid and High buttons. These correspond to the four EQ bands in Cubase SX/SL, starting from the leftmost band.
- EQ-“Q”
  Controls the EQ “Q” for each band selected with the Low, LoMid, HiMid and High buttons. These correspond to the four EQ bands in Cubase SX/SL, starting from the leftmost band.
- Aux 1 to Aux 4 and shuttle wheel:
  The effect send levels for sends 1 to 4.
  The shuttle wheel will act as position shuttle if no Aux send button is selected. Press the activated button to deselect it.
- Holding down the “Asgn” button and pressing the Low, LoMid, HiMid and High EQ buttons switches the corresponding EQ band “On” button status.
- Holding down the “Asgn” button and pressing the Aux1 to Aux4 buttons switches the corresponding Effect Send 1-4 “On” button status.
DSP Factory (Cubase SX/SL for Windows only)

The following US-428 controls will remote control the following DSP Factory parameter for each channel strip:

- **Fader**: volume
- **Mute/Solo**: mute and solo (selected via the Solo switch)
- **Select**: selects channel for editing
- **Pan-Dial**: pan
- **EQ-Gain**: Controls the corresponding EQ gain for each band selected with the Low, LoMid, HiMid and High buttons.
- **EQ-Freq**: Controls the corresponding EQ frequency for each band selected with the Low, LoMid, HiMid and High buttons.
- **EQ-“Q”**: Controls the corresponding EQ “Q” for each band selected with the Low, LoMid, HiMid and High buttons.
- **Aux 1 to Aux 4 and shuttle wheel**: Control the effect send levels for sends 1/2 and 5/6.
- **Holding down the "Asgn" button and pressing the Low, LoMid, HiMid and High EQ buttons switches the corresponding EQ band "Bypass" button status.**
- **Holding down the "Asgn" button and pressing the Aux1 to Aux4 buttons switches the effect sends 1/2 and 5/6 "On" button status.**
Yamaha 01V

The Yamaha 01V can remote control either the Cubase SX/SL Mixer or the Yamaha DSP Factory if installed (Windows only; see the separate "Using Cubase SX/SL with DSP Factory" document for details). Before you can initiate remote control operation, the 01V must be setup in the following way:

- MIDI Parameter Change and Receive must be enabled.
- MIDI Control Change and Receive must be disabled.
- Device ID / MIDI Channel Receive must be set to "1".
- Local Control should be set to "Off".

As soon as Local Control is set to "Off", remote control of the Mixer is enabled.

The 01V remote operation of the Cubase SX/SL Mixer is very straightforward, with (almost) every parameter having the equivalent parameter controller in the 01V mixer. The current status of all controllable parameters is fed back to the 01V and indicated on the panel, using the motorized faders, indicators, etc. (for this to work, you need a two-way MIDI connection between the 01V and Cubase SX/SL).

To facilitate 32 channel remote control, two separate control "Layouts" are used, each controlling 16 Mixer channels. The "Memory" button on the 01V is used to switch between VST layout 1 and 2 (when using Cubase SX/SL for Windows there are also two Layouts for the DSP Factory – see the "Using Cubase SX/SL with DSP Factory" document). Page 1 displays VST Layout 1, page 2 VST Layout 2, page 3 DSP Factory Layout 1 and page 4 DSP Factory Layout 2.

The following parameters are remote controllable for Channels 1-32 in the Mixer:

- The value ranges for the parameters in the 01V may not match the ranges for the corresponding parameters in all cases.
- Fader level, mute and pan.
- 01V controls for these parameters control the equivalent Cubase SX/SL parameters.
- Effect sends 1 - 6.
- 01V Aux 1 · 4 control effect send 1 · 4, 01V effect 1 and 2 control effect send 5 and 6.
• EQ Frequency, Gain and Q (4 Bands).  
  01V controls for these parameters control the equivalent Cubase SX/SL parameters.

• Stereo Master Volume.  
  The 01V control for this parameter controls the equivalent Cubase SX/SL parameter.

• Send effects master volume 1 - 4 are controlled by 01V Aux Master 1 - 4. Send effects master 5 and 6 are controlled by 01V effect master 1 and 2.

  With Layout 1 the 01V controls the following channels:

  • Channel 1 - 12, 13/14 and 15/16 will control channels 1 - 14.

  • 01V Return 1 and 2 will control channels 15 and 16.

  With Layout 2 the 01V controls the following channels:

  • Channel 1 - 12, 13/14 and 15/16 will control channels 17 - 30.

  • 01V Return 1 and 2 will control channels 31 and 32.

**The Generic Remote device**

If you have a generic MIDI controller, you can use this for remote control of Cubase SX/SL by setting up the Generic Remote device:

1. Open the Device Setup dialog on the Devices menu.

   If the Generic Remote device isn’t on the Devices list, you need to add it:

2. Click the “Add/Remove” tab and select the “Generic Remote” device in the list to the right.

3. Click the Add button.

   • When the Generic Remote device is added in the Device Setup dialog, you can open the Remote Status window by selecting “Generic Remote” from the Devices menu.

   ![Generic Remote](image)

   The Remote Status window
4. Click the Setup tab and select the Generic Remote device in the Devices list to the left. The settings for the Generic Remote are displayed, allowing you to specify which control on your device should control which parameter in Cubase SX/SL.

5. Use the MIDI Input and Output pop-up menu to select the MIDI Port(s) to which your remote device is connected.

6. Use the pop-up menu to the right to select a bank. The concept of banks is based on the simple fact that most MIDI devices can control a limited number of channels at a time (often 8 or 16). For example, if your MIDI control device has 16 volume faders, and you are using 32 Mixer channels in Cubase SX/SL, you would need two banks of 16 channels each. When the first bank is selected you control channel 1 to 16; when the second Bank is selected you control channel 17 to 32. Since you can control Transport functions as well, you may need several banks.

7. Set up the upper table according to the controls on your MIDI control device.
The columns have the following functionality:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control Name</td>
<td>Double clicking this field allows you to enter a descriptive name for the control (typically a name written on the console). This name is automatically reflected in the Control Name column in the lower table.</td>
</tr>
<tr>
<td>MIDI Status</td>
<td>Clicking in this column pulls down a pop-up menu, allowing you to specify the type of MIDI message sent by the control. The options are Controller, Program Change, Note On, Note Off, Aftertouch and Polyphonic Pressure. Also available are Continuous Control NRPN and RPN, a way to extend the available control messages. The &quot;Ctrl JLCooper&quot; option is a special version of a Continuous Controller where the 3rd byte of a MIDI message is used as address instead of the 2nd byte (a method supported by various JL-Cooper remote devices).</td>
</tr>
<tr>
<td>Address</td>
<td>The Continuous Controller number, the pitch of a note or the address of a NRPN/RPN Continuous Controller.</td>
</tr>
<tr>
<td>Max. Value</td>
<td>The maximum value the control will transmit. This value is used by the program to &quot;scale&quot; the value range of the MIDI controller to the value range of the program parameter.</td>
</tr>
</tbody>
</table>
| Flags        | Clicking in this column pulls down a pop-up menu, allowing you to activate or deactivate three flags:  
• Receive - activate this if the MIDI message should be processed on reception.  
• Transmit - activate this if a MIDI message should be transmitted when the corresponding value in the program changes.  
• Relative - activate this if the control is an "endless" dial, which reports the number of turns instead of an absolute value. |

- If you find that the upper table holds too many or too few controls, you can add or remove controls with the Add and Delete buttons to the right of the upper table.
- If you are uncertain of which MIDI message a certain controller sends, you can use the Learn function:  
Select the control in the upper table (by clicking in the Control Name column), move the corresponding control on your MIDI device and click the Learn button to the right of the table. The MIDI Status, MIDI Channel and Address values are automatically set to those of the moved control.
8. Use the lower table to specify which Cubase SX/SL parameters you want to control.
   Each row in the table is associated to the controller in the corresponding row in the upper table (as indicated by the Control Name column). The other columns have the following functionality:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device</td>
<td>Clicking in this column pulls down a pop-up menu, used for determining which device in Cubase SX/SL should be controlled. The special option “Command” allows you to perform certain command actions by remote control. One example of this is the selection of remote banks. If you have a Yamaha DSP Factory card installed (Windows version only), this will also appear as an option on the Device pop-up menu.</td>
</tr>
<tr>
<td>Channel/Category</td>
<td>This is where you select the channel to be controlled or, if the “Command” Device option is selected, the Command category.</td>
</tr>
<tr>
<td>Value/Action</td>
<td>Clicking in this column pulls down a pop-up menu, allowing you to select the parameter of the channel to be controlled (typically, if the “VST Mixer” Device option is selected you can choose between volume, pan, send levels, EQ, etc.). If the “Command” Device option is selected, this is where you specify the “Action” of the category.</td>
</tr>
</tbody>
</table>
| Flags           | Clicking in this column pulls down a pop-up menu, allowing you to activate or deactivate three flags:  
  • Push Button - When activated, the parameter is only changed if the received MIDI message shows a value unequal to 0.  
  • Toggle - When activated, the parameter value is switched between minimum and maximum value each time a MIDI message is received. The combination of Push Button and Toggle is useful for remote controls which do not latch the state of a button. One example is controlling mute status with a device on which pressing the Mute button turns it on, and releasing the Mute button turns it off. If Push Button and Toggle are activated, the Mute status will change between on and off whenever the button is pressed on the console.  
  • Not Automated - When activated, the parameter will not be automated. |

9. If needed, select another bank and make settings for this.
   Note that you only need to make settings in the lower table for this – the upper table is already set up according to the MIDI remote device.
If you need, you can add banks by clicking the Add button below the Bank pop-up. Clicking the Rename button allows you to assign a new name to the currently selected bank, and you can remove an unneeded bank by selecting it and clicking the Delete button.

10. When you are finished, close the Generic Remote Setup window. Now, you can control the specified Cubase SX/SL parameters from the MIDI remote device. To select another bank, use the pop-up menu in the Remote Status window (or use a control on the MIDI remote device, if you have assigned one for this).

**Importing and Exporting Remote Setups**

The Export button in the upper right corner of the Generic Remote Setup window allows you to export the current setup, including the Control configuration (the upper table) and all banks. The setup is saved as a file (with the Windows file extension “.xml”). Clicking the Import button allows you to import saved Remote Setup files.

- The last imported or exported Remote Setup will automatically be loaded when the program starts or the Generic Remote control is added in the Device Setup dialog.
Audio processing and functions
## Background

Audio processing in Cubase SX/SL can be called “non-destructive”, in the sense that you can always undo changes or revert to the original versions. This is possible because processing affects audio clips rather than the actual audio files, and because audio clips can refer to more than one audio file. This is how it works:

1. If you process an event or a selection range, a new audio file is created in the Edits folder, within your project folder. This new file contains the processed audio, while the original file is unaffected.

2. The processed section of the audio clip (the section corresponding to the event or selection range) is then made to refer to the new, processed audio file. The other sections of the clip will still refer to the original file.

...the clip will refer both to the original file and a new file, containing the processed section only.
• Since all edits are available as separate files, it is possible to undo any processing, at any point and in any order! This is done in the Offline Process History dialog, as described on page 317.
• Furthermore, the original, unprocessed audio file can still be used by other clips in the project, by other projects or by other applications.

Audio processing

Basically, you apply processing by making a selection and selecting a function from the Process submenu on the Audio menu. Processing is applied according to the following rules:
• Selecting events in the Project window or the Audio Part Editor will apply processing to the selected events only. Processing will only affect the clip sections that are referenced by the events.
• Selecting an audio clip in the Pool will apply processing to the whole clip.
• Making a selection range will apply processing to the selected range only. Other sections of the clip are not affected.

If you attempt to process an event that is a shared copy (i.e. the event refers to a clip that is used by other events in the project), you are asked whether you want to create a new version of the clip or not.

Select “New Version” if you want the processing to affect the selected event only. Select “Continue” if you want the processing to affect all shared copies.

• If you activate the “Do not show this message again” option, any and all further processing you do will conform to the selected method (“Continue” or “New Version”).
You can change this setting at any time by using the “On Processing Shared Clips” pop-up menu in the Preferences dialog (Audio page).
Common settings and features

If there are any settings for the selected Audio processing function, these will appear when you select the function from the Process sub-menu. While most settings are specific for the function, some features and settings work in the same way for several functions:

The Preview, Process and Cancel buttons

These buttons have the following functionality:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preview</td>
<td>Allows you to listen to the result of the processing with the current settings. Playback will continue repeatedly until you click the button again (the button is labeled “Stop” during Preview playback). You can make adjustments during Preview playback, but the changes are not applied until the start of the next “lap”. Some changes may automatically restart the Preview playback from the beginning.</td>
</tr>
<tr>
<td>Process</td>
<td>Performs the processing and closes the dialog.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Closes the dialog without processing.</td>
</tr>
</tbody>
</table>

The “More...” button

If the dialog has a lot of settings, some options may be hidden when the dialog appears. To reveal these, click the “More...” button.

To hide the settings, click the button again (now labeled “Less...”).

Pre/post crossfade

Some processing functions allow you to gradually mix the effect in or out. This is done with the pre and post crossfade parameters. If you activate Pre-crossfade and specify a value of e.g. 1000 ms, the processing will be applied gradually from the start of selection, reaching full effect 1000 ms after the start. Similarly, if you activate post-crossfade, the processing will gradually be removed, starting at the specified interval before the end of the selection.

- The sum of the pre- and post-crossfade times cannot be larger than the length of the selection.
Envelope

The Envelope function allows you to apply a volume envelope to the selected audio. The dialog contains the following settings:

Curve Kind buttons

These determine whether the envelope curve should consist of spline curve segments (left button) or linear segments (right button).

Fade display

Shows the shape of the envelope curve. The resulting waveform shape is shown in dark grey, with the current waveform shape in light grey. You can click on the curve to add points, and click and drag existing points to change the shape. To remove a point from the curve, drag it outside the display.

Presets

If you have set up an envelope curve that you may want to apply to other events or clips, you can store it as a Preset by clicking the Store button.

- To apply a stored Preset, select it from the pop-up menu.
- To rename the selected Preset, double click on the name and type a new one in the dialog that appears.
- To remove a stored Preset, select it from the pop-up menu and click Remove.
Fade In and Fade Out

These functions are described in the chapter “Fades and Crossfades” (see page 122).

Gain

This allows you to change the gain (level) of the selected audio. The dialog contains the following settings:

Gain

This is where you set the desired gain, between –50 and +20 dB. The setting is also indicated below the Gain display as a percentage.

Clip detection text

If you use the Preview function before applying the processing, the text below the slider indicates whether the current settings result in clipping (audio levels above 0 dB). If that is the case, lower the Gain value and use the Preview function again.

- If you want to increase the level of the audio as much as possible without causing clipping, you should use the Normalize function instead (see page 301).

Pre- and Post-Crossfade

See page 296.
**Merge clipboard**

This functions mixes the audio from the clipboard into the audio selected for processing, starting at the beginning of the selection.

- **For this function to be available, you need to have Cut or Copied a range of audio in the Sample Editor first.**

The dialog contains the following settings:

**Sources mix**

Allows you to specify a mix ratio between the Original (the audio selected for processing) and the Copy (the audio on the clipboard).

**Pre- and Post-Crossfade**

See page 296.
Noise Gate

Scans the audio for sections weaker than a specified threshold level, and replaces them with silence. The dialog contains the following settings:

**Threshold**

The level below which you want audio to be silenced. Levels below this value will close the gate.

**Attack Time**

The time it takes for the gate to open fully after the audio level has exceeded the threshold level.

**Min. Opening Time**

This is the shortest time the gate will remain open. If you find that the gate opens and closes too often when processing material that varies rapidly in level, you should try raising this value.

**Release Time**

The time it takes for the gate to close fully after the audio level has dropped below the threshold level.
Linked Channels

This is available for stereo audio only. When it is activated, the Noise Gate is opened for both channels as soon as one or both channels exceed the Threshold level. When Linked Channels is deactivated, the Noise Gate works independently for the left and right channel.

Dry/Wet mix

Allows you to specify a mix ratio between “dry” and processed sound.

Pre- and Post-Crossfade

See page 296.

Normalize

The Normalize function allows you to specify the desired maximum level of the audio. It then analyzes the selected audio and finds the current maximum level. Finally it subtracts the current maximum level from the specified level, and raises the gain of the audio by the resulting amount (if the specified maximum level is lower than the current maximum, the gain will be lowered instead). A common use for Normalizing is to raise the level of audio that was recorded at too low an input level. The dialog contains the following settings:

Maximum

The desired maximum level for the audio, between –50 and 0dB. The setting is also indicated below the Gain display as a percentage.

Pre- and Post-Crossfade

See page 296.
Phase Reverse

Reverses the phase of the selected audio, turning the waveform “up-side down”. The dialog contains the following settings:

Phase Reverse on

When processing stereo audio, this pop-up menu allows you to specify which channel(s) should be phase reversed.

Pre- and Post-Crossfade

See page 296.

Pitch Shift

![Pitch Shift dialog]

This function allows you to change the pitch of the audio with or without affecting its length. You can also create “harmonies” by specifying several pitches, or apply pitch shift based on a user specified envelope curve.
When the “Transpose” tab is selected, the dialog contains the following parameters:

**Keyboard display**

This offers a way to specify the transpose interval in semitones, and gives a graphic overview of the transposition setting.

• The “root note” is indicated in red. This has nothing to do with the actual key or pitch of the original audio, it just provides a way to display transpose intervals. If you like, you can change the root note by using the settings to the right below the keyboard display, or by pressing [Alt]/[Option] and clicking in the keyboard display.

• To specify a transpose interval, click on one of the keys. The key is indicated in blue, and the program plays test tones in the base pitch and transpose pitch, to give you an audible confirmation.

• If “Multi Shift” is activated (see below), you can click on several keys to create “chords”. Clicking on a blue (activated) key removes it.

**Transpose settings**

The “Semitones” and “Fine tune” settings allow you to specify the amount of pitch shift. You can transpose the audio ±16 semitones, and fine tune it by ±200 cents (hundredths of semitones).

**Volume**

Allows you to lower the volume of the pitch shifted sound.

**Multi Shift**

When this is activated, you can add more than one transpose value, creating multi-part harmonies. This is done by adding intervals in the keyboard display, as described above.

• If the intervals you add make up a standard chord, this chord is displayed to the right. Note however, that to include the base pitch (the original, untransposed sound) in the processed result, you need to click the base key in the keyboard display as well, so that it is displayed in blue.
Listen Key/Chord button

Clicking this button plays a test tone, pitched according to the activated interval key on the keyboard display. If “Multi Shift” is activated, this button is called “Listen Chord”, and plays all activated intervals, as a chord.

Pitch Shift Base

This allows you to set the root note (the red key in the keyboard display). This has no actual relation to the pitch of the audio material, but should be viewed as an aid for easily setting up intervals and chords.

Accuracy

Set this parameter according to whether the rhythmic feel of the audio material has a high priority or not. If you set this to a high value (drag the slider to the right), the timing and rhythmic feel will be preserved as accurately as possible. If you set it to a low value, the tonal quality gets priority, allowing slight changes in timing. This parameter is not available if the MPEX algorithm is used (only Cubase SX for Windows, see below).

Algorithm

Allows you to select one of four Quality modes: Quick, Standard, High and MPEX (only Cubase SX for Windows, see below). Generally, the higher the quality, the slower the processing.

• About the MPEX mode (only Cubase SX for Windows):
The MPEX Quality mode is based on Prosoniq’s proprietary MPEX (Minimum Perceived Loss Time Compression/Expansion) algorithm. This algorithm (which is also used in Prosoniq’s TimeFactory™ application) uses an artificial neural network for time series prediction in the scale space domain to achieve high end time and pitch scaling. This gives the best possible audio quality result.
Note that the Accuracy parameter isn’t available in MPEX mode. Furthermore, you should not use the Preview function in MPEX Quality mode, since the MPEX algorithm isn’t designed for real time processing.

Formant Mode

If you are processing vocal material, you should activate this option in order to preserve the vocal characteristics of the pitch shifted audio.
**Time Correction**

When this is activated, the pitch shift process will not affect the length of the audio. When this is deactivated, raising the pitch will shorten the audio section and vice versa, much like changing the playback speed on a tape recorder.

**Using envelope based Pitch Shift**

When the "Envelope" tab is selected, you can specify an envelope curve on which the pitch shift should be based. This allows you to create pitch bend effects, pitch shift different sections of the audio by different amounts, etc.
**Envelope display**

Shows the shape of the envelope curve, over the waveform image of the audio selected for processing. Envelope curve points above the center line indicate positive pitch shift, while curve points below the center line indicate negative pitch shift. Initially, the envelope curve will be a horizontal, centered line, indicating zero pitch shift.

- You can click on the curve to add points, and click and drag existing points to change the shape. To remove a point from the curve, drag it outside the display.

**Curve Kind**

These buttons determine whether the envelope curve should consist of spline curve segments (left button) or linear segments (right button).

![Linear segment envelope.](image)

![The same envelope with spline curve segments selected.](image)
Range

This parameter determines the vertical pitch range of the envelope. If this is set to “4”, moving a curve point to the top of the display corresponds to pitch shifting by + 4 semitones. The maximum range is +/- 16 Semitones.

Transpose and Fine Tune

Allows you to adjust the value of a curve point numerically:

1. Click on a curve point to select it.
   The selected point is shown in red.
2. Adjust the Transpose and Fine Tune parameters to change the pitch of the curve point in semitones and cents, respectively.

Pitch Shift Mode

These are the same parameters as on the Transpose tab, see page 304.
Example

Let’s say that you wish to create a pitch bend effect, so that the pitch is raised linearly by exactly 2 semitones in a specific part of the selected audio.

1. Remove all curve points by clicking the Reset button.

2. Select a linear curve by clicking the right Curve Kind button.

3. Create a point where you want the pitch bend to start by clicking on the envelope line.
   Since this is the starting point for the pitch bend, you want its pitch to be zero (the envelope line should still be straight). If necessary, use the Fine Tune parameter to set the curve point to 0 cents, because this point governs the start point, where you want the pitch transition to begin.

4. Create a new curve point at the horizontal position where you want the pitch bend to reach the full value.
   This curve point determines the rise time of the pitch bend effect, i.e. the further away from the starting point the new point is positioned, the longer it will take for the pitch bend to reach the full value, and vice versa.

5. Make sure the Range parameter is set to 2 semitones or higher.

6. With the second point still selected, use the Transpose and Fine Tune parameters to set the pitch to exactly 2 semitones.

7. Create a new curve point to set the duration of the pitch bend, i.e. the time the pitch should remain transposed by 2 semitones.

8. Finally, create a point where you want the pitch bend to end.
   You don’t need to create a new point if this should be the end of the audio file being processed. There is always an end point at the right side of the waveform display.

9. If necessary, make additional settings in the Pitch Shift Mode section.

10. Click Process.
    The pitch bend is applied according to the specified settings.
Remove DC Offset

This function will remove any DC offset in the audio selection. A DC offset is when there is too large a DC (direct current) component in the signal, sometimes visible as the signal not being visually centered around the “zero level axis”. DC offsets do not affect what you actually hear, but they affect zero crossing detection and certain processing, and it is recommended that you remove them.

It is recommended that this function is applied to complete audio clips, since the DC offset (if any) is normally present throughout the entire recording.

There are no parameters for this function. Note that you can check for DC Offset in an audio clip using the Statistics function (see page 326).

Reverse

Reverses the audio selection, as when playing a tape backwards. There are no parameters for this function.

Silence

Replaces the selection with silence. There are no parameters for this function.
Stereo Flip

This function works with stereo audio selections only. It allows you to manipulate the left and right channel in various ways. The dialog contains the following parameters:

**Mode**

This pop-up menu determines what the function does:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flip Left-Right</td>
<td>Swaps the left and right channel.</td>
</tr>
<tr>
<td>Left to Stereo</td>
<td>Copies the left channel sound to the right channel.</td>
</tr>
<tr>
<td>Right to Stereo</td>
<td>Copies the right channel sound to the left channel.</td>
</tr>
<tr>
<td>Merge</td>
<td>Merges both channels on each side, for mono sound.</td>
</tr>
<tr>
<td>Subtract</td>
<td>Subtracts the left channel information from the right and vice versa. This is typically used as a &quot;Karaoke effect&quot;, for removing centered mono material from a stereo signal.</td>
</tr>
</tbody>
</table>
Time Stretch

This function allows you to change the length and “tempo” of the selected audio, without affecting the pitch. The dialog contains the following parameters:

**Input section**

This section contains information and settings regarding the “input”, the audio selected for processing:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length in Samples</td>
<td>The length of the selected audio, in samples.</td>
</tr>
<tr>
<td>Length in Seconds</td>
<td>The length of the selected audio, in seconds.</td>
</tr>
<tr>
<td>Tempo in BPM</td>
<td>If you are processing music, and know the actual tempo of the audio, you can enter it here as beats per minute. This makes it possible to time stretch the audio to another tempo, without having to compute the actual time stretch amount.</td>
</tr>
<tr>
<td>Bars</td>
<td>If you use the tempo setting, you need to specify the length of the selected audio here, as bars, beats, 1/16-notes and ticks (with 120 ticks per 1/16-note).</td>
</tr>
<tr>
<td>Time Signature</td>
<td>If you use the tempo setting, you need to specify the time signature here.</td>
</tr>
</tbody>
</table>
Output section

These settings are used if you want to stretch the audio to fit within a specific time span or tempo. The values will change automatically if you adjust the Timestretch amount (see below).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Samples</td>
<td>The desired length in samples.</td>
</tr>
<tr>
<td>Seconds</td>
<td>The desired length in seconds.</td>
</tr>
<tr>
<td>BPM</td>
<td>The desired tempo (beats per minute). For this to work, you have to know the actual tempo of the audio, and specify this (along with time signature and length in bars) in the Input section to the left.</td>
</tr>
<tr>
<td>Range</td>
<td>Allows you to specify the desired length as a range between two time positions.</td>
</tr>
<tr>
<td>Set to Locators Range</td>
<td>Clicking this button sets the Range values to the length of the Cycle.</td>
</tr>
</tbody>
</table>

Timestretch

The Timestretch parameter determines the amount of timestretch, as a percentage of the original length. If you use the settings in the Output section to specify the amount of timestretch, this value will change automatically.

The possible timestretch range depends on the “Effect” option:

- If the “Effect” checkbox is deactivated, the range is 75-125%.
  This is the preferred mode if you want to preserve the character of the sound.

- If the “Effect” checkbox is activated, you can specify values between 10 and 1000%.
  This mode is mainly useful for special effects, etc.
Accuracy

Set this parameter according to whether the rhythmic feel of the audio material has a high priority or not. If you set this to a high value (drag the slider to the right), the timing and rhythmic feel will be preserved as accurately as possible. If you set it to a low value, the tonal quality gets priority, allowing slight changes in timing. This parameter is not available if the MPEX algorithm is used (only Cubase SX for Windows, see below).

Algorithm

Allows you to select one of four Quality modes: Quick, Standard, High and MPEX (only Cubase SX for Windows, see below). Generally, the higher the Quality, the slower the processing.

- About the MPEX mode (only Cubase SX for Windows):
The MPEX Quality mode is based on Prosoniq’s proprietary MPEX (Minimum Perceived Loss Time Compression/Expansion) algorithm. This algorithm (which is also used in Prosoniq’s TimeFactory™ application) uses an artificial neural network for time series prediction in the scale space domain to achieve high end time and pitch scaling. This gives the best possible audio quality result.

Note that the Accuracy parameter isn’t available in MPEX mode. Furthermore, you should not use the Preview function in MPEX Quality mode, since the MPEX algorithm isn’t designed for real time processing.

- Drum mode:
This is special algorithm developed by Spectral Design, optimized for processing rhythmic material. By default, the Close Gaps function (see page 377) uses this algorithm. The Accuracy parameter and Preview function are not available in Drum mode.
Applying plug-ins (Cubase SX only)

As described in the chapter “Audio effects”, you can add plug-in effects in real-time during playback. However, sometimes it’s useful to “permanently” apply effects processing to one or several selected events. This is done in the following way:

1. Make a selection in the Project window, the Pool or an editor.
   Effects are applied according to the same rules as Processing (see page 296).

2. Select “Plugins” from the Audio menu.

3. Select the desired effect from the submenu that appears.
   The Process Plug-in dialog appears.

About stereo and mono

If you are applying an effect to mono audio material, only the left side of the effect’s stereo output will be applied.

The Process Plug-in dialog

![The Process Plug-in dialog for the Chorus effect.](image)
The upper section of the Process Plug-in dialog contains the actual effect parameters of the selected plug-in. For details on the included plug-ins’ parameters, see page 196.

The lower section of the dialog contains settings for the actual processing. These are common to all plug-ins.

- If the lower section is hidden, click the “More...” button to display it. Clicking the button again (now labeled “Less...”) will hide the lower section.

The following settings and functions are available in the common, lower section of the dialog:

Wet mix/Dry mix

These two sliders allow you to specify the balance between wet (processed) and dry (original) signal in the resulting clip. Normally the two sliders are “reverse-ganged”, so that raising the Wet mix slider lowers the Dry mix slider by the same amount. However, if you press [Alt]/[Option] and drag a slider, you can move it independently. This allows you to set e.g. 80% dry and 80% wet signal. Be careful to avoid distortion.

Tail

This parameter is useful if you are applying an effect that adds material after the end of original audio (such as reverb and delay effects). When the checkbox is activated, you can specify a tail length using the slider. The tail time is included when playing back with the Preview function, allowing you to find the appropriate tail length.

Pre/Post Crossfade

These settings allow you to gradually mix the effect in or out. If you activate Pre-Crossfade and specify a value of e.g. 1000 ms, the effect will be applied gradually from the start of selection, reaching full effect 1000 ms after the start. Similarly, if you activate Post-Crossfade, the processing will gradually be removed starting at the specified interval before the end of the selection.

- The sum of the Pre- and Post-Crossfade times cannot be larger than the length of the selection.
**Preview button**

Allows you to listen to the result of the processing with the current settings. Playback will continue repeatedly until you click the button again (the button is labeled “Stop” during Preview playback). You can change the effect settings during Preview playback if needed.

**Process button**

Applies the effect and closes the dialog.

**Cancel button**

Closes the dialog without applying the effect.
The Offline Process History dialog

Procedures

If you find you want to remove some or all processing from a clip, this can be done in the Offline Process History dialog. Processing that can be modified in the Offline Process History dialog includes the functions on the Process menu, any applied plug-in effects, and Sample Editor operations such as Cut, Paste, Delete and drawing with the Pencil tool.

Due to the clip-file relationship (see page 294), it is even possible to modify or remove some processing “in the middle” of the Process History, while keeping later processing! This feature depends on the type of processing performed (see page 318).

Proceed as follows:

1. Select the clip in the Pool or one of its events in the Project window. You can see which clips have been processed by checking the Status column in the Pool – the waveform symbol indicates that processing or effects have been applied to the clip (see page 318).

2. Select “Offline Process History...” from the Audio menu. The Offline Process History dialog appears.

The left part of the dialog contains a list of all processing you have added to the clip, with the most recent operations at the bottom of the list. The “Start” and “Length” columns indicate which section of the clip was affected by each operation. The “Status” column indicates if the operation can be modified or removed.
3. Locate the operation you want to edit and select it by clicking on it in the list.

• To modify the settings of the selected processing, click the “Modify” button.
  This opens the dialog for the processing function or applied effect, allowing you to change the settings. This works just as when you applied the processing or effect the first time.

• To replace the selected operation with another processing function or effect, select the desired function from the pop-up menu and click the “Replace by” button.
  If the selected function has settings, a dialog will appear as usual. The original operation will then be removed and the new processing will be inserted in the Offline Process History.

• To remove the selected operation, click the “Remove” button.
  The processing is removed from the clip.

4. Click “Close” to close the dialog.

Restrictions

- If there are no settings for the processing function, you can’t modify it.

- If you have applied processing that changes the length of the clip (such as Cut, Insert or Time Stretch), you can only remove this if it is the most recent processing in the Offline Process History (at the bottom of the list in the dialog). If an operation can not be removed or modified, this is indicated by an icon in the “Status” column. Also, the corresponding buttons will be greyed out.
Freeze Edits

The Freeze Edits function on the Audio menu allows you to make all processing and applied effects permanent for a clip:

1. Select the clip in the Pool or one of its events in the Project window.
2. Select “Freeze Edits…” from the Audio menu.

- If there is only one edit version of the clip (no other clips refer to the same audio file), the following dialog will appear:

![Replace original or create new file?](image)

If you select “Replace”, all edits will be applied to the original audio file (the one listed in the clip’s Path column in the Pool). If you select “New File”, the Freeze Edits operation will create a new file in the Audio folder within the project folder (leaving the original audio file unaffected).

- If the selected clip (or the clip played by the selected event) has several edit versions (i.e. there are other clips referring to the same audio file), the following alert will appear:

![You selected clips that have more than one version! Those files can not be replaced but new files will be created!](image)

As you can see, you don’t have the option to Replace the original audio file in this case. This is because that audio file is used by other clips. Select “New File” to have a new file created in the Audio folder within the project folder.

- Now, the clip refers to a new, single audio file. If you open the Offline Process History dialog for the clip, the list will be empty.
Detect Silence

The Detect Silence function on the Audio menu isn’t really a processing function, since it doesn't actually affect the audio clip. Instead, it searches for silent sections in an event, and either splits the event, removing the silent parts from the project, or creates regions corresponding to the non-silent sections. Proceed as follows:

1. Select the event in the Project window or the Audio Part Editor. You can select several events if you like, in which case you will be allowed to make separate settings for each selected event.

2. Select “Detect Silence” from the Audio menu. The Detect Silence dialog appears.

![Detect Silence dialog](image)

- **Regions Detected**
- **Open Threshold**
- **Close Threshold**

Settings:
- Min. Opening Time
- Min. Closing Time
- Pre-Roll
- Post-Roll

Options:
- Add as Regions
- Strip Silence

Help, Preview, Process, Cancel
3. Adjust the settings in the area below the waveform display. They have the following functionality:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Threshold</td>
<td>When the audio level exceeds this value, the function will “open”, i.e. let the sound through. Set this low enough to open when a sound starts, but high enough to remove unwanted noise during “silent” sections.</td>
</tr>
<tr>
<td>Close Threshold</td>
<td>When the audio level drops below this value, the function will “close”. This value cannot be higher than the Open Threshold value. Set this high enough to remove unwanted noise during “silent” sections.</td>
</tr>
<tr>
<td>Linked</td>
<td>If this checkbox is ticked, Open and Close Threshold will have the same value.</td>
</tr>
<tr>
<td>Min. Opening Time</td>
<td>Determines the minimum time that the function will remain “open” after the audio level has exceeded the Open Threshold value. If the audio contains repeated short sounds, and you find that this results in too many short “open” sections, try raising this value.</td>
</tr>
<tr>
<td>Min. Closing Time</td>
<td>Determines the minimum time that the function will remain “closed” after the audio level has dropped below the Close Threshold value. Usually you would want to set this to a low value, to avoid removing sounds.</td>
</tr>
<tr>
<td>Pre-Roll</td>
<td>Allows you to have the function “open” slightly before the audio level exceeds the Open Threshold value. In other words, the start of each “open” section is moved to the left according to the time you set here. This is useful to avoid removing the attack of sounds.</td>
</tr>
<tr>
<td>Post-Roll</td>
<td>Allows you to have the function “close” slightly after the audio level drops below the Close Threshold value. This is useful to avoid removing the natural decay of sounds.</td>
</tr>
</tbody>
</table>
4. Click the “Compute” button.
The audio event is analyzed, and the waveform display is redrawn to indicate which sections will be considered “silent”, according to your settings.

![Image of waveform analysis]

- If you like, you can use the Preview function to listen to the result. The event is played back repeatedly in its entire length, but with the “closed” sections silenced.

5. Repeat steps 3 and 4 until you are satisfied with the result.

6. Select what you want the function to do, by activating either the “Add as Regions” checkbox, the “Strip Silence” checkbox, or both. “Add as Regions” will create regions according to the non-silent sections. “Strip Silence” will split the event at the start and end of each non-silent section, and remove the silent sections in between.

7. If you activated “Add as Regions”, you can specify a name for the Regions in the Regions Name field. In addition to the name, the regions will be numbered, starting with the number specified in the Auto Number Start field.

8. Click “Process”.
The event is split and/or regions are added.

![Image of processed waveform]

- If you selected more than one event in step 1 above, the dialog will appear again, allowing you to make separate settings for each selected event.
The Spectrum Analyzer (Cubase SX only)

This function analyzes the selected audio, computes the average “spectrum” (level distribution over the frequency range) and displays this as a two-dimensional graph, with frequency on the x-axis and level on the y-axis.

1. Make an audio selection (a clip, an event or a range selection).

2. Select “Spectrum Analyzer” from the Audio menu.

   A dialog with settings for the analysis appears.

The default values are chosen to give good results in most situations, but you can adjust the settings if you like:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size in Samples</td>
<td>The function divides the audio into “analysis blocks”, the size of which is set here. The larger this value, the higher the frequency resolution of the resulting spectrum.</td>
</tr>
<tr>
<td>Size of Overlap</td>
<td>The overlap between each analysis block.</td>
</tr>
<tr>
<td>Window used</td>
<td>Allows you to select which window type should be used for the FFT (Fast Fourier Transform, the mathematical method used for computing the spectrum).</td>
</tr>
<tr>
<td>Normalized values</td>
<td>When this is activated, the resulting level values are scaled, so that the highest level is displayed as “1” (0 dB).</td>
</tr>
</tbody>
</table>
3. Click the “Process” button.
The spectrum is computed and displayed as a graph.

4. You can adjust the display with the settings in the display window:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>dB</td>
<td>When this is activated, the vertical axis shows dB values. When it is deactivated, values between 0 and 1 are shown.</td>
</tr>
<tr>
<td>Freq. log</td>
<td>When this is activated, frequencies (on the horizontal axis) are displayed on a logarithmic scale. When it is deactivated, the frequency axis is linear.</td>
</tr>
<tr>
<td>Precision</td>
<td>Indicates the frequency resolution of the graph. This value cannot be changed here, but is governed by the Size in Samples setting in the previous dialog.</td>
</tr>
<tr>
<td>Frequency/Note</td>
<td>Allows you to select whether you want the frequencies to be displayed in Hertz or with note names.</td>
</tr>
</tbody>
</table>
5. If you move the mouse pointer over the graph, a crosshair cursor follows the graph curve and the display in the upper right corner shows the frequency/note and level at the current position. To compare the level between two frequencies, move the pointer to one of the frequencies, right-click (Win) or [Ctrl]-click (Mac) once and move the pointer to the second frequency. The delta value (the difference in level between the current position and the right/\[Ctrl\]-click position) is displayed in the upper right corner (labeled “D”).

- If you analyzed stereo audio and selected the “Stereo” option in the first dialog, the graphs for the left and right channel are superimposed in the display, with the left channel graph in white and the right channel graph in yellow. The display in the upper right corner shows the values for the left channel – to see the right channel values, hold down [Shift]. An “L” or “R” is displayed to indicate which channel values are shown.

6. You can leave the window open or close it by clicking the “Close” button. If you leave it open and the “Active” checkbox is ticked, the result of the next Spectrum Analysis will be displayed in the same window.

### Setting | Description
--- | ---
Min. | Sets the lowest frequency shown in the graph.
Max. | Sets the highest frequency shown in the graph. By adjusting the Min and Max values, you can take a closer look at a smaller frequency range.
Active | When this is activated, the next Spectrum Analysis will appear in the same window. When deactivated, new Spectrum Analysis results will appear in separate windows.

Min. | Sets the lowest frequency shown in the graph.
Max. | Sets the highest frequency shown in the graph. By adjusting the Min and Max values, you can take a closer look at a smaller frequency range.
Active | When this is activated, the next Spectrum Analysis will appear in the same window. When deactivated, new Spectrum Analysis results will appear in separate windows.
Statistics (Cubase SX only)

The Statistics function on the Audio menu analyzes the selected audio (events, clips or range selections) and displays a window with the following information:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Min. Sample Value</td>
<td>The lowest sample value in the selection, as a value between -1 and 1 and in dB.</td>
</tr>
<tr>
<td>Max. Sample Value</td>
<td>The highest sample value in the selection, as a value between -1 and 1 and in dB.</td>
</tr>
<tr>
<td>Peak Amplitude</td>
<td>The largest sample value (in absolute numbers) in the selection, in dB.</td>
</tr>
<tr>
<td>DC Offset</td>
<td>The amount of DC Offset (see page 309) in the selection, as a percentage and in dB.</td>
</tr>
<tr>
<td>Estimated Resolution</td>
<td>Even though an audio file is in 16 or 24 bits, it may have been converted from a lower resolution. The Estimated Resolution value makes an educated guess about the actual resolution of the audio selection, by computing the smallest level difference between two samples.</td>
</tr>
<tr>
<td>Sample Rate</td>
<td>The sample rate of the audio selection.</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Min. RMS Power</td>
<td>The lowest loudness (RMS) measured in the selection.</td>
</tr>
<tr>
<td>Max. RMS Power</td>
<td>The highest loudness (RMS) measured in the selection.</td>
</tr>
<tr>
<td>Average</td>
<td>The average loudness over the whole selection.</td>
</tr>
</tbody>
</table>
14

The Sample Editor
Background

The Sample Editor allows you to view and manipulate audio at the audio clip level, by cutting and pasting, removing or drawing audio data or applying effects. This editing can be called "non-destructive", in the sense that you can undo changes or revert to the original versions at any point, using the Offline Process History.

For details, see the section about non-destructive processing on page 294 and the description of the Offline Process History on page 317.

Opening the Sample Editor

You open the Sample Editor by double clicking an audio event in the Project window or the Audio Part Editor, or by double clicking an audio clip in the Pool. You can have more than one Sample Editor open at the same time.

- Note that double clicking on an audio part in the Project window will open the Audio Part Editor, even if the part only contains a single audio event.
  See page 352.
Window overview

The Elements menu

If you Right-click (Win) or [Ctrl]-click (Mac) in the Sample Editor to bring up the Quick menu, you will find a sub-menu called “Elements”. By activating or deactivating options on this submenu, you can decide what you want shown in the Editor window. Some of these options are also available as icons on the toolbar.
The toolbar

The toolbar contains tools and various settings:

The Sample Editor tools.  Auto Scroll.  Snap to Zero Crossing.

The thumbnail display provides an overview of the whole clip. The section currently shown in the Sample Editor’s main Waveform display is indicated by a blue rectangle in the thumbnail, while the current selection range is shown in blue-grey.

- You can move the blue rectangle in the thumbnail to view other sections of the clip. This is done by clicking in the lower half of the rectangle and dragging it to the left or right.
- You can resize the blue rectangle (by dragging its left or right edge) to zoom in or out, horizontally.
- You can define a new viewing area by clicking in the upper half of the overview and dragging a rectangle with the pointer.
The ruler

The Sample Editor ruler is located between the thumbnail and the Waveform display. It shows the timeline in the display format specified in the Project Setup dialog (see page 62). If you like, you can select an independent display format for the ruler by clicking on the arrow button to the right of it and selecting an option from the pop-up menu that appears (this affects the values in the info line too). For a list of the display format options, see page 61.

The Waveform display and the level scale

The Waveform display shows the waveform image of the edited audio clip – in the style selected in the Preferences dialog (Event Display–Audio page), see page 68. To the left of it, a level scale can be shown, indicating the amplitude of the audio.
• When the level scale is shown, you can select whether the level should be shown as a percentage or in dB. This is done by right-clicking the level scale and selecting an option from the pop-up menu that appears. This also allows you to hide the level scale.

• To display the level scale after hiding it, right-click (Win) or [Ctrl]-click (Mac) to bring up the Quick menu and activate “Level Scale” on the Elements submenu. This submenu also allows you to select whether you want the zero axis and/or the half level axis indicated in the Waveform display.
The info line

The info line at the bottom of the window shows information about the edited audio clip. You cannot edit the values on the info line.

- To hide or show the info line, click the “i” icon on the toolbar.
- Initially, length and position values are displayed in the format specified in the Project Setup dialog (see page 62), but you can change this by clicking in the middle field of the info line and selecting another display format from a pop-up menu.

This selection affects the Sample Editor ruler as well.
## Operations

### Zooming

Zooming in the Sample Editor is done according to the standard zoom procedures, with the following special notes:

- The vertical zoom slider changes the vertical scale relative to the height of the Editor window, in a way similar to the waveform zooming in the Project window (see page 64).
- The following options relevant to the Sample Editor are available on the Zoom submenu on the Edit menu:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom In</td>
<td>Zooms in one step, centering on the position cursor.</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Zooms out one step, centering on the position cursor.</td>
</tr>
<tr>
<td>Zoom Full</td>
<td>Zooms out so that the whole clip is visible in the editor.</td>
</tr>
<tr>
<td>Zoom to Selection</td>
<td>Zooms in so that the current selection fills the screen.</td>
</tr>
<tr>
<td>Zoom to Event</td>
<td>Zooms in so that the editor shows the section of the clip corresponding to the edited audio event. This is not available if you opened the Sample Editor from the Pool (in which case the whole clip is opened for editing, not an event).</td>
</tr>
</tbody>
</table>

- You can also zoom by resizing the blue rectangle in the thumbnail display. See page 332.
- The current zoom setting is shown in the info line, as a "samples per screen pixel" value.
- Note that you can zoom in horizontally to a scale with less than one sample per pixel! This is required for drawing with the Pencil tool (see page 347).
- If you have zoomed in to one sample per pixel or less, the appearance of the samples depend on the option “Interpolate Audio Images” in the Preferences dialog (Event Display–Audio page). If the option is deactivated, single sample values are drawn as "steps". If the option is activated they are interpolated to "curves" form.
Auditioning

While you can use the regular play commands to play back audio when the Sample Editor is open, it is often useful to listen to the edited material only. This can be done in the following ways:

- When auditioning, audio will be routed directly to Bus 1, bypassing the audio channel’s settings, effects and EQs.

By using the Speaker tool

If you click somewhere in the Waveform display with the Speaker tool and keep the mouse button pressed, the clip will be played back from the position at which you clicked. Playback will continue until you release the mouse button.

By using the Play icon

Clicking the Play icon on the toolbar plays back the edited audio, according to the following rules:

- If you have made a selection, this selection will be played back.
- If there is no selection, but the option “Show Event” is activated (see page 348), the section of the clip corresponding to the event will be played back.
- If there is no selection, and “Show Event” is deactivated, the playback will start at the cursor position (if the cursor is outside the display, the whole clip is played back).
- If the Loop icon is activated, playback will continue repeatedly until you deactivated the Play icon. Otherwise, the section will be played back once.
Scrubbing

The Scrub tool allows you to locate positions in the audio by playing back, forwards or backwards, at any speed:

1. Select the Scrub tool.
2. Click in the Waveform display and keep the mouse button pressed. The project cursor is moved to the position at which you click.
3. Drag to the left or right. The project cursor follows the mouse pointer and the audio is played back. The speed and pitch of the playback depends on how fast you move the pointer.
**Adjusting the Snap point**

The snap point is a marker within an audio event (or clip – see below). This is used as a reference position when you are moving events with snap activated, so that the snap point is “magnetic” to whatever snap positions you have selected.

By default, the snap point is set at the beginning of the audio event, but often it is useful to move the snap point to a “relevant” position in the event, such as a downbeat, etc.:

1. Activate the “Audio Event” option so that the event is displayed in the editor.
2. Scroll so that the event is visible, and locate the “S” flag in the event. If you haven’t adjusted this previously, it will be located at the beginning of the event.
3. Click on the “S” flag and drag it to the desired position.

You can also adjust the snap point by setting the project cursor:

1. Place the cursor at the desired position (intersecting the event). You may want to do this by scrubbing, to spot the right position exactly.
2. Pull down the Audio menu and select “Snap Point To Cursor”. The snap point will be set to the position of the cursor. This method can also be used in the Project window and the Audio Part Editor.

- It is also possible to define a snap point for a clip (for which there is no event yet).
  To open a clip in the Sample Editor, double click it in the Pool (or drag it from the Pool to the Sample Editor). After having set the snap point using the procedure described above, you can insert the clip into the project from the Pool or the Sample Editor, taking the snap point position into account.
Making Selections

To select an audio section in the Sample Editor, you click and drag with the Range Selection tool.

- If Snap to Zero Crossing is activated on the toolbar, the start and end of the selection will always be at zero crossings (see page 349).
- You can resize the selection by dragging its left and right edge or by [Shift]-clicking.
- The current selection is indicated to the right on the toolbar.
  You can fine-tune the selection by changing these values numerically. Note that the values are relative to the start of the clip, rather than to the project timeline.
Using the Select Menu

The Select submenu on the Edit menu contains the following selection functions:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Selects the whole clip.</td>
</tr>
<tr>
<td>None</td>
<td>Selects no audio (the selection length is set to “0”).</td>
</tr>
<tr>
<td>In Loop</td>
<td>Selects all audio between the left and right locator.</td>
</tr>
<tr>
<td>From Start to Cursor</td>
<td>Selects all audio between the start of the clip and the project cursor.</td>
</tr>
<tr>
<td>From Cursor to End</td>
<td>Selects all audio between the project cursor and the end of the clip. For this to work, the project cursor must be within the clip boundaries.</td>
</tr>
<tr>
<td>Select Event</td>
<td>Selects the audio that is included in the edited event only. This is not available if you opened the Sample Editor from the Pool (in which case the whole clip is opened for editing, not an event).</td>
</tr>
<tr>
<td>Left Selection Side to Cursor</td>
<td>Moves the left side of the current selection range to the project cursor position. For this to work, the cursor must be within the clip boundaries.</td>
</tr>
<tr>
<td>Right Selection Side to Cursor</td>
<td>Moves the right side of the current selection range to the project cursor position (or the end of the clip, if the cursor is to the right of the clip).</td>
</tr>
</tbody>
</table>

Editing Selection Ranges

Selections in the Sample Editor can be manipulated in several ways. Please note:

- If you attempt to edit an event that is a shared copy (i.e. the event refers to a clip that is used by other events in the project), you are asked whether you want to create a new version of the clip or not (if you haven’t made a “permanent” choice already – see below). Select “New Version” if you want the editing to affect the selected event only. Select “Continue” if you want the editing to affect all shared copies.
  Note: If you activate the option “Do not show this message again” in the dialog, any and all further editing you do will conform to the selected method (“Continue” or “New Version”). You can change this setting at any time with the “On Processing Shared Clips” pop-up menu in the Preferences dialog (Audio page).
- Any changes to the clip will appear in the Offline Process History, making it possible to undo them at a later point (see page 317).
Cut, Copy and Paste

The cut, copy and paste commands on the Edit menu work according to the following rules:

• Selecting copy copies the selection to the clipboard.

• Selecting cut removes the selection from the clip and moves it to the clipboard.
The section to the right of the selection is moved to the left to fill out the gap.

• Selecting paste copies the data on the clipboard into the clip.
If there is a selection in the editor, this will be replaced by the pasted data. If there is no selection (if the selection length is “0”), the pasted data will be inserted starting at the selection line. The section to the right of the line will be moved to make room for the pasted material.

The pasted data will be inserted at the selection line.
**Insert Silence**

Selecting "Insert Silence" from the Range submenu on the Edit menu will insert a silent section with the same length as the current selection, at the selection start.

- The selection will not be replaced, but moved to the right to make room. If you want to replace the selection, use the "Silence" function instead (see page 309).

**Delete**

Selecting Delete from the Edit menu (or pressing [Backspace]) removes the selection from the clip. The section to the right of the selection is moved to the left to fill out the gap.

**Processing**

The functions on the Process submenu on the Audio menu can be applied to selections in the Sample Editor, as can the effects on the Plug-ins submenu. See the chapter “Audio processing and functions”.

**Creating a new event from the selection**

You can create a new event that plays only the selected range, using the following method:

1. Make a selection range.
2. Press [Ctrl]/[Command] and drag the selection range to the desired audio track in the Project window.

**Creating a new clip or audio file from the selection**

You can extract a selection from an event and either create a new clip or a new audio file, in the following way:

1. Make a selection range.
2. Select “Bounce Selection” from the Audio menu.
   
   You are asked whether you want to create a new edit version (clip) or a new audio file.

   - If you select “Edit Version”, a new clip is created and added to the Pool. The new clip will refer to the same audio file as the original clip, but will only contain the audio corresponding to the selection range.

   - If you select “File”, a new file is created, containing the selected audio. A new clip will also be added to the Pool, referring to the new audio file. Regardless of which option you choose, a new Sample Editor opens with the new clip.
Working with regions

Regions are sections within a clip. One of the main uses for regions is Cycle recording, in which the different “takes” are stored as regions (see page 34). You can also use this feature for marking important sections in the audio clip. Regions can be dragged into the Project window from the Editor or the Pool, to create new audio events. You can also export a region to disk as a new audio file, from the Pool.

Regions are best created, edited and managed in the Sample Editor:

Creating a region

1. Select the range you want to convert to a region.

2. Click the “Show Regions” icon on the toolbar, or activate the “Regions” option on the Elements submenu on the Quick menu. The regions list is displayed to the right in the Sample Editor window.

3. Click the Add button above the Regions list (or select “Create Region(s)” from the Audio menu). A region is created, corresponding to the selected range.

4. To name the region, click on it in the list and type in a new name. Regions can be renamed at any time, using this procedure.

   • When a region is selected in the Region list, it is instantly displayed and selected in the Sample Editor.
Editing regions

The region selected in the list is displayed in grey in the Waveform display and thumbnail.

There are two ways to edit the start and end position of a region:

- Click and drag its start and end handles in the Waveform display (with any tool).
  When you move the pointer over the handles, it will automatically change to an arrow pointer, to indicate that you can drag the handles.

- Edit the Start and End positions numerically in the Regions list.
  The positions are shown in the display format selected for the ruler and info line, but are relative to the start of the audio clip, rather than the project timeline.

Auditioning regions

You can listen to a region by selecting it in the list and clicking the Play button. The region will play back once or repeatedly, depending on whether the Loop icon on the toolbar is activated or not.
Making Selections from regions

If you select a region in the list and click the Select button above, the corresponding section of the audio clip is selected (as if you had selected it with the Range Selection tool). This is useful if you want to apply processing to the region only, etc.

- Note that you can also double click a region in the Pool, to have its audio clip open in the Sample Editor with the area of the region automatically selected.

Creating new events from regions

You can create new audio events from regions, using the following method:

1. Click in the Region's leftmost column in the list and keep the mouse button pressed.
2. Move the pointer to the desired audio track and position in the Project window.
3. Release the mouse button.
   A new event is created.

- You can also use the function “Events from Regions” for this (see page 96).

Removing regions

To remove a region from a clip, select it in the list and click the Remove button.

Exporting regions as audio files

If you create a region in the Sample Editor, the region can then be exported to disk as a new audio file. This is done from the Pool, and is described on page 398.
**Drawing in the Sample Editor**

It is possible to edit the audio clip at sample level, by drawing with the Pencil tool. This can be useful if you need to manually edit out a spike or click, etc.

1. Zoom in to a zoom value lower than 1.  
   This means that there is more than one screen pixel per sample.

2. Select the Pencil tool.

3. Click and draw at the desired position in the Waveform display.  
   When you release the mouse button, the edited section is automatically selected.

- Any changes created by drawing will appear in the Offline Process History, making it possible to undo them at a later stage (see page 317).
Options and settings

Show audio event

This is only available if you opened the Sample Editor by double clicking on an audio event in the Project window or the Audio Part Editor.

When the option "Audio Event" is activated on the Elements submenu on the Quick menu (or the Show Audio Event button is activated on the toolbar), the section corresponding to the edited event is shown with a white background in the Waveform display and Thumbnail. The sections of the audio clip that are "outside" the event are shown with a grey background.

In this mode, you can adjust the start and end of the event in the clip, by dragging the event handles in the Waveform display. When you move the pointer over the event handles (no matter what tool may be selected), it takes on the shape of an arrow, to indicate that you can click and drag.
Snap to Zero Crossing

Snap to Zero Crossing activated.

When this option is activated, all audio edits are done at zero crossings (positions in the audio where the amplitude is zero). This helps you avoid pops and clicks which might otherwise be caused by sudden amplitude changes.

- This setting is global for the project, which means that if you activate it in the Sample Editor, it will also be activated in the Project window and Audio Part Editor (and vice versa).

Auto Scroll

Auto Scroll activated.

When this option is activated, the Waveform display will scroll during playback, keeping the project cursor visible in the editor.
15

The Audio Part Editor
Background

The Audio Part Editor allows you to view and edit the events inside an audio part. Essentially, this is the same type of editing that you do in the Project window, which means that this chapter contains a lot of references to the chapter “The Project Window”.

Audio parts are created in the Project window, in one of the following ways:

• By selecting one or several audio events on the same track, and selecting “Events to Part” from the Audio menu.

• By gluing together two or more audio events on the same track with the Glue Tube tool.

• By drawing an empty part with the Pencil tool.

• By double clicking between the left and right locator on an audio track. With the last two methods, an empty part is created. You can then add events to the part by pasting, or by using drag and drop from the Pool.

Opening the Audio Part Editor

You open the Audio Part Editor by double clicking on an audio part in the Project window. You can have more than one Audio Part Editor open at the same time.

• If the part you double click on is a shared copy (i.e. you have previously copied the part by [Alt]/[Option]-dragging), any editing you perform will affect all shared copies of this part.

To indicate that it is a shared copy the part name is in italics and an icon is displayed in the lower right corner of the part in the Project window. (see page 82).

• Note that double clicking on an audio event in the Project window will open the Sample Editor (see page 330).
Window overview

The toolbar

The tools, settings and icons on the toolbar have the same functionality as in the Project window, with the following differences:

- A Solo button (see page 356).
- Separate tools for audition (Speaker) and scrubbing (see page 357).
- No Pencil or Glue Tube tool.
- Play and Loop icons (see page 356).

The ruler and info line

These have the same functionality and appearance as their counterparts in the Project window.

- Note that you can select a separate display format for the Audio Part Editor ruler by clicking on the arrow button to the right of it and selecting an option from the pop-up menu that appears. For a list of the available formats, see page 61.
About lanes

If you make the Editor window larger, this will reveal additional space below the edited events. This is because an audio part is divided vertically in lanes.

Lanes can make it easier to work with several audio events in a part:

In the left figure it is unnecessarily hard to discern, select and edit the separate events. In the right figure, some of the events have been moved to a lower lane, making selection and editing much easier.

- To move an event to another lane without accidentally moving it horizontally, press [Ctrl]/[Command] and drag it up or down.
  This is the default modifier key for this – you can adjust this in the Preferences if you like.
Overlapping events

Only one event per track can be played back at the same time! This means that if you have overlapping events, on the same lane or different lanes, these will cut each other off, according to the following rules:

- For events on the same lane, the ones that are on top (visible) will be played.
To move overlapping events to the front or back, use the Move to Front and Move to Back functions on the Edit menu.

- For events on different lanes, the event on the lowest lane gets playback priority.

The “greyed-out” sections of the upper event will not be played since the event on the lower lane has playback priority! Note that in the actual program, playback priority between lanes is not indicated by event sections being greyed out.
Operations

- Zooming, selecting and editing in the Audio Part Editor is done just as in the Project window (see page 62).

Auditioning

There are three ways to listen to the events in the Audio Part Editor:

**By using regular playback**

You can of course use the regular playback controls while in the Audio Part Editor. Furthermore, if you activate the Solo button on the Toolbar, only the events in the edited part will be played back.

**By using the Speaker tool**

If you click somewhere in the editor’s event display with the Speaker tool and keep the mouse button pressed, the part will be played back from the position at which you clicked. Playback will continue until you release the mouse button.

- With the Speaker tool, audio will be routed directly to Bus 1, bypassing the audio channel’s settings, effects and EQs.
By using the Play Icon

The Play and Loop icons.

Clicking the Play icon on the toolbar plays back the edited audio, according to the following rules:

- If you have selected events in the part, only the section between the first and last selected event will be played back.
- If you have made a range selection, only this section will be played back.
- If there is no selection, the whole part will be played back. Note that if the project cursor is within the part, playback starts from the current cursor position. If the project cursor is outside the part, playback starts from the beginning of the part.
- If the Loop icon is activated, playback will continue until you deactivate the Play icon. Otherwise, the section will be played back once.

Scrubbing

In the Audio Part Editor, the Scrub tool has a separate icon on the toolbar. Apart from that, scrubbing works exactly as in the Project window (see page 79).
Common methods

Assembling a “perfect take”

When you record audio in Cycle mode, either an event or a Region (or both) is created for each recorded lap (see page 34). These events and Regions are named “Take X”, where “X” is the number of the take. You can create a perfect take by putting together sections of the different takes in the Audio Part Editor. First, you have to create an audio part from the takes.

Creating an audio part

This procedure is slightly different depending on whether you choose to create events or Regions.

From events

1. In the Project window, use the Object Selection tool to draw a rectangle around the recorded events.
   This is necessary, since clicking on the event may just select the event on top (the last take). If in doubt, check the Info line – it should say “Multiple Objects Selected”.

2. Pull down the Audio menu and select “Events to Part”.
   The events are converted to an audio part.

   • Note that the events cycle record mode also makes it easy to combine different takes in the Project Window – see page 34.

From regions

1. In the Project window, select the event you recorded in Cycle mode. After recording, this will play the last take.

2. Pull down the Audio menu and select “Events to Part”. You are asked whether you want to “Create Part using Regions”.

3. Click “Regions”.
   The regions are converted to an audio part.
Assembling a take

1. Double click the part to open the Audio Part Editor.
   Now, the different takes will be placed on different lanes, with the last take at the bottom.

2. Use the tools to cut out pieces of the takes and assemble the final result.
   This could include splitting with the Scissors tool, resizing events with the Arrow tool, muting events with the Mute tool or deleting with the Eraser tool.

   - Remember that the events on the lowest lane have playback priority.
   Use the Play icon to audition the result.

3. Close the Audio Part Editor.
   You have now assembled a “perfect take”!
Options and Settings

The following options and settings are available in the Audio Part Editor:

• Snap
  You can specify an independent Snap mode (and snap value for the Grid mode) in the editor. The functionality is exactly the same as in the Project window.

• Snap to Zero Crossing
  The Snap to Zero Crossing setting is global for the project, which means that if you activate it in the Audio Part Editor, it will also be activated in the Project window and Sample Editor (and vice versa). For a description of this setting, see page 100.

• Auto Scroll
  When Auto Scroll is activated on the toolbar, the window will scroll during playback, keeping the project cursor visible in the Editor. This setting can be activated or deactivated individually for each window.
Working with hitpoints and slices
Background

Hitpoint detection is a special feature of the Sample Editor. It automatically detects attack transients in an audio file, and then adds a type of marker, a “hitpoint”, at each transient. These hitpoints allow you to create “slices”, where each slice ideally represents each individual sound or “beat” in a loop (drum or other rhythmic loops work best with this feature). When you have successfully sliced the audio file, you can do a number of useful things with it:

- Change the tempo without affecting pitch.
- Extract the timing (a groove map) from a drum loop. This can then be applied to quantize other events.
- Replace individual sounds in a drum loop.
- Edit the actual playing in the drum loop without affecting the basic feel.
- Extract sounds from loops.

Note that the term “loop” is used throughout this chapter. Loops in this context usually means an audio file with a musical timebase, i.e. the length of the loop represents a certain number of bars and/or beats at a certain tempo. Playing the loop back at the right tempo in a cycle set to the correct length will produce a continuous loop, without gaps.
Using Hitpoints

The basic functionality of using hitpoints to slice up a loop is to make a loop fit the tempo of a song, or alternatively to create a situation that allows the song tempo to be changed whilst retaining the timing of a rhythmic audio loop, just like when using MIDI files.

What audio files can be used?

Here are some guidelines to what type of audio files will render the best results when slicing files using hitpoints:

• Each individual sound in the loop should have some kind of noticeable attack.
  Slow attacks, legato playing etc. may not produce the desired result.
• Poorly recorded audio might be difficult to slice correctly.
  Normalizing a file first can improve the performance.
• There may be problems with sounds drowned in smearing effects, like short delays.

Calculating hitpoints and slicing a loop – a quick tutorial

Before proceeding, find a suitable loop using the above mentioned criteria. At this point it doesn’t matter whether you know the original tempo of the loop, as this will be automatically detected. Proceed as follows:

1. Create a new empty project.
2. Create an audio track.
3. Place a suitable audio file at the start of a measure on the audio track.
   Any type of drumloop should work well.
4. Select the audio event and select “Locators to Selection” from the Transport menu.
   This sets the left and right locators to encompass the selection.
5. Double click the event to open the Sample Editor.
   Here you can check if you need to adjust the event start and end points to make the file loop seamlessly, by activating Cycle mode in the editor, and playing it back using the Play button in the Sample Editor.
6. Click the Hitpoint Mode button on the Sample Editor toolbar. The program calculates the hitpoints in the event.

7. As you now can see, hitpoints have been set at the beginning of each sound in the loop (or at least at most sounds), and the right half of the toolbar now shows the Sensitivity slider and additional pop-ups. Make sure that the “Use” pop-up is set to “Sense”.

8. If you now move the Hitpoint Sensitivity slider to the left, this gradually hides the hitpoints. Moving the slider to the right increases the sensitivity to reveal additional hitpoints detected during the calculate process. The basic aim is to add, remove or in various other ways edit the hitpoints so that one individual sound is played between each hitpoint. This is described in detail starting on page 366.
9. Once the hitpoints have been set correctly, enter the length of the loop (using the Bars and/or Beats value fields) and the time signature. The “original” tempo of the loop is now displayed to the right on the Sample Editor toolbar. This tempo is based on the length specified for the loop. Note however that the loop will adapt to the tempo set in Cubase SX/SL in the next step.

10. Pull down the Audio menu, and select “Create Slices” from the Hitpoints submenu.
Now the following happens:

• The Sample Editor closes.
• The audio event is “sliced” so that there is a separate event for each hitpoint.
• The audio event is replaced by an audio part, containing the slices (double click the part to view the slices in the Audio Part Editor).
• The loop is automatically adapted to the set tempo in Cubase SX/SL

11. If you activate cycle playback on the transport, the loop should now play back seamlessly at the tempo set in the program!
If the loop was two bars long, the loop will be adapted to this length in the Project window, whatever the tempo setting.

12. To make the loop follow any further tempo changes, make sure it’s set to “Musical time base” by using the toggle button in the Track list or Inspector (the button should show a note symbol – see page 72).

• Note that if the tempo in Cubase SX/SL is lower than the loop’s original tempo, there may be audible gaps between each slice event in the part. This can be remedied by using the Close Gaps function on the Audio menu – see page 377.
Editing hitpoints

In this section, we go back a bit and look at what can be done with hitpoints in the Sample Editor. There are three ways to invoke the hitpoint calculation:

- Select Calculate from the Hitpoints submenu on the Audio menu.
- Click the Hitpoint Mode button in the Sample Editor toolbar.
- Select the Hitpoint Edit tool from the toolbar or Quick menu.

The last two methods will calculate hitpoints if they haven’t already been calculated.

As outlined in the previous section, this makes the program calculate (or detect) hitpoints in the audio event, and you can use the Sensitivity slider to change how many hitpoints are shown.

For some loops, this may be all that is needed to set the hitpoints so that each slice to be created will contain a single “hit” or sound. However, there will almost certainly be cases when the automatic calculation may add a hitpoint where there shouldn’t be one, and fail to add a hitpoint where one is needed, even if the Sensitivity slider is set to maximum. If there are too many or too few hitpoints in a loop, it will most probably not play back properly.

When this occurs, you have to edit the hitpoints manually in the Sample Editor.
Auditioning slices

A slice is a section of the waveform, from one hitpoint to the next.

The first thing you should do before editing hitpoints is to listen to each slice in the Sample Editor, to determine what they contain. The aim is basically to avoid “double hits”, like a snare hit being followed by a hi-hat hit within the same slice. You also want to determine whether any hitpoints have been added that should be removed:

1. Open a loop in the Sample Editor.
   If you have already created slices you can open them in the Sample Editor by double-clicking any event in the Audio Part Editor. If it is a new loop, follow the instructions in the tutorial.

2. Select the Speaker tool.

3. Now you can simply point and click on any slice and it will be played back.
   Listen for “double hits” and slices that contain parts of a single sound.

   If you find hitpoints that need to be removed or instances where a hitpoint needs to be added, the first thing to try is to change the sensitivity setting – see the following section.
Setting the sensitivity

The loop is first analyzed to determine where hitpoints should appear (where the individual “beats” in the loop are), then you manually set the sensitivity with the Sensitivity slider to determine how many hitpoints there should be.

- Try raising the sensitivity to add “missing” hitpoints, and lowering it to remove unwanted hitpoints. This may or may not work, depending on the situation, but as a general rule you should try this first.
- Audition the slices again to determine if changing the sensitivity has improved matters.

How many slices do I need?

If your main reason for slicing the loop is to change the tempo, you generally need as many slices as you can get, but never more than one per individual “beat” in the loop.

If you want to create a groove (see page 376), you should try to get approximately one slice per eighth note, sixteenth note or whatever the loop requires.
Setting hitpoints according to note values

The “Use” pop-up menu on the Sample Editor toolbar also features different note values for setting hitpoints. 1/4, 1/8, 1/16 and 1/32 notes can be selected. Only hitpoints that are close to the selected note value positions within the loop (e.g. close to exact sixteenth note positions, if you have selected the 1/16 option) will be shown – all other hitpoints will be disabled.

• For this to work properly, you must have specified the correct length (bars and beats) and time signature of the loop in the toolbar.

This is useful if you know the loop consists of exact note values with no timing variations (e.g. a loop from a drum machine) or if you’re only interested in hits around certain note values (e.g. if you’re creating grooves – see page 376).
Disabling slices

You might run into situations where there are too many slices – a single sound may have been split into two slices for example. You could of course reduce the sensitivity to get rid of the hitpoints you don’t want, but then other hitpoints could disappear too, which may be undesirable. What you need to do in a situation like this is to disable an individual slice, using the Hitpoint Edit tool in Disable mode:

1. Select the Hitpoint Edit tool and click the tool icon on the toolbar again. A pop-up menu appears, listing the three modes of the Hitpoint Edit tool.

2. Select the Disable mode. The pointer turns into a cross in the Sample Editor window.

3. Click on the handle (the triangle) of the hitpoint you wish to disable. The hitpoint handle is diminished and its line disappears to indicate that it is disabled.

4. Now, the hitpoint won’t be taken into account when you create slices.

5. To reactivate a disabled hitpoint, click on the hitpoint handle with the Disable tool.
Locking slices

If you lock a hitpoint, by clicking on its handle with the Hitpoints Edit tool in Lock mode, it will stay even if you drag the Sensitivity slider all the way to zero. This can be used in situations where one or several slices contain double hits, but raising the sensitivity adds a lot of unwanted slices.

1. Find the place where you hear double hits when auditioning.
2. Remember the current slider setting.
3. Raise the sensitivity slider to a higher value so that a hitpoint appears, separating the two sounds. Most likely this will add a lot of other unwanted hitpoints as well.
4. Audition to make sure you got what you wanted.
5. Select the Hitpoint Edit tool and click the tool icon again to select Lock mode.
   A lock icon is shown beside the pointer in the Sample Editor window.
6. Lock the new slice by clicking on its handle.
7. Drag the sensitivity slider to the original setting.
   The locked hitpoint will remain shown.

• You can unlock a locked hitpoint by clicking it again with the Hitpoint Edit tool in Lock mode.
Setting hitpoints manually

If you cannot get the desired result by adjusting sensitivity, disabling or locking, you can add, move and delete hitpoints manually.

Note that you should always try to use the hitpoints found by the Calculate function before manually moving or adding hitpoints.

Adding hitpoints

Manually adding hitpoints can be done in situations where a hitpoint is missing at a specific point, but doesn’t appear even if the sensitivity is set to full.

1. Zoom in on the waveform at the point where you wish to add a hitpoint.
2. Audition the area with the Speaker tool to make sure that the start of the sound is in view.
3. Activate Snap to Zero Crossing on the Sample Editor toolbar. By finding zero crossings in the waveform (positions where the amplitude is close to zero), manually added slices won’t introduce any clicks or pops. All hitpoints found by the Calculate function are automatically placed at zero crossings.
4. Select the Pencil tool from the Sample Editor toolbar and click just before the start of the sound. A new hitpoint appears. Manually added hitpoints are locked by default.

- If you click and keep the mouse button pressed, you can adjust the position of the new hitpoint by dragging. Releasing the mouse button adds the hitpoint.

5. Audition the new slice with the Play tool to make sure you got what you wanted.
Moving hitpoints

If you manually added a hitpoint, and it was either placed too far away from the start of the sound, or too far into the sound, you can manually move the hitpoint.

1. Make sure Snap to Zero Crossing is activated on the Sample Editor toolbar.
2. Select the Hitpoint Edit tool and click the tool icon again to select the Move mode.
3. Click on the tool handle and drag it to the new position.

Deleting hitpoints

To delete a hitpoint, select the Move tool and drag it out of the Sample Editor window.

• Don’t delete hitpoints that were found by the Calculate function – it is better to disable them.
Creating slices

After you have specified the correct loop length and time signature and worked on the hitpoints in the Sample Editor so that one sound per slice is heard, it is time to actually slice the file. This is done by selecting “Create Audio Slices” from the Hitpoints submenu on the Audio menu.

Now the following happens:

• The Sample Editor closes.

• The audio event is “sliced” so that there is a separate event for each hitpoint. In other words, the sections between the hitpoints become separate events, all referring to the same original file.

• The audio event is replaced by an audio part, containing the slices.

• The loop is automatically adapted to the tempo set in Cubase SX/SL. This takes the loop length settings you made into account: if the loop was e.g. one bar long, the part is resized to fit exactly one bar in the Cubase SX/SL tempo, and the slices are moved accordingly – keeping their relative positions intact within the part.

Now, you can change the tempo and have the loop automatically follow (provided that the track is set to musical time base – see page 72). Furthermore, you can double click the part to edit the slices in the Audio Part Editor:

• Remove or mute slices.
• Change the loop by reordering, replacing or quantizing slices.
• Apply processing or effects to individual slices.
• Create new files from individual slices using the “Bounce Selected” function on the Audio menu.
Creating Groove Quantize maps

You can generate groove quantize maps based on the hitpoints you have created in the Sample Editor. Groove quantizing is not meant for correcting errors, but for creating rhythmic feels. This is done by comparing your recorded music with a “groove” (a timing grid generated from the file) and moving the appropriate notes so that their timing matches the one of the groove. In other words, you can extract the timing from an audio loop and use it for quantizing MIDI parts (or other audio loops, after slicing them).

Proceed as follows:

1. Create and edit hitpoints as described earlier in this chapter.
   You don’t have to create slices – just set up the hitpoints.
   • You should try to get approximately one slice per eighth note, sixteenth note or whatever the loop requires when setting hitpoints for extracting a groove. Therefore it can make sense to use note value-based hitpoints.
     Pull down the “Use” pop-up menu in the Sample Editor toolbar and instead of the regular “Sense” option, select the note value that is most suited as a base for quantizing. 1/4, 1/8, 1/16 and 1/32 notes can be selected. What to choose depends on the loop; typically, rock, pop and dance loops are based on 1/16 or 1/8 notes.

2. When you have finished setting the hitpoints, select “Create Groove Quantize” from the Hitpoints submenu on the Audio menu.
   The groove is extracted.

3. If you now pull down the Quantize pop-up in the Project window you will find an additional item at the bottom of the list, with the same name as the file from which you extracted the groove.
   This groove can now be selected as a base for quantizing, just like any other quantize value. See page 467.
Divide audio events

This Hitpoints submenu item can be used when you simply wish to create separate events according to the hitpoints for a file. This means that you do not have to make the same considerations as when slicing for tempo changes. You can use any method you like to set hitpoints, use sensitivity, note values, manually or any combination.

- The slices created will appear in the Project window as separate events.

Using the Close Gaps function

If you have sliced a loop for tempo changes, lowering the tempo below the loop’s original tempo will create gaps between the slices. The lower the tempo in relation to the original tempo, the wider the gaps will be. This can be fixed using the “Close Gaps” function on the Audio menu:

1. Set the desired tempo.
2. Select the part in the Project window.
3. Pull down the Audio menu and select “Close Gaps”.
   Now time stretch is applied on each slice to close the gaps. Depending on the length of the part, this can take a little while.
4. The waveform is redrawn and the gaps are now closed!
- Note that this feature creates new clips in the Pool, one for each slice.

Close Gaps should only be used when you are certain that you wish to permanently adapt the loop to a lower tempo. If you decide to raise the tempo again, you should start over again, using the original unstretched file.
The Pool
Background

What is the Pool?

Every time you record on an audio track, a file is created on your hard disk. A reference to this file – a clip – is also added to the Pool. Two general rules apply to the Pool:

• All clips, Audio or Video, that belong to a project are listed in the Pool.
• There is a separate Pool for every project.

The way the Pool displays folders and their contents is similar to the way the Mac OS X Finder and the Windows Explorer displays folders and lists of files.

What can you do in the Pool?

In the Pool you can, amongst other things, perform the following operations:

Operations that affect files on disk

• Import clips (audio files can automatically be copied and/or converted).
• Convert file formats.
• Rename clips (this will also rename the referred files on disk).
• Delete clips (if you select the "Move to Trash" option and empty the Trash folder – see page 388).
• Prepare File Archives for backup.
• Minimize Files.

Operations that only affect clips

• Copy clips.
• Audition clips.
• Organize clips.
• Apply audio processing to clips.
• Save or import complete Pool files.
Opening the Pool

You open the Pool in any of the following ways:

- By clicking the Pool icon in the Project window.
- By selecting “Pool” on the Project menu.
- By using a key command (by default [Ctrl]/[Command]-[P]).

The content of the Pool is divided into three main folders:

- The Audio folder
  This contains all audio clips and regions currently in the project.

- The Video folder
  This contains all video clips currently in the project.

- The Trash folder
  Unused clips can be moved to the Trash folder for later permanent removal from the hard disk.
  These folders cannot be renamed or deleted from the Pool, but any number of subfolders can be added (see page 400).
Window Overview

Audio folder
Audio clip name
Region name
Toolbar
Column Headings
Trash folder
Video folder
Waveform image

Toolbar overview

Play Button
View Pop-up
Open/Close all Folders
Import Button
Project Folder Path
Loop Button
Search Button
Pool Record Folder Path
The info line

Click the “i” button on the toolbar to show or hide the info line at the bottom of the Pool window. It shows the following information:

- Number of audio files in the Pool
- Number of audio files in use
- Total size of all audio files in the Pool
- Number of files in the Pool that are not in the project folder (e.g. video files)
- Number of audio files in use
- Total Size: 37.03 MB
- External Files: 39

How clips and regions are displayed in the Pool

- Audio clips are represented by a waveform icon followed by the clip name.

- Audio regions are represented by a region icon followed by the region name.

- Video clips are represented by a camera icon followed by the clip name.
The Pool window columns

Various information about the clips and regions can be viewed in the Pool window columns. The columns contain the following information:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Media</td>
<td>This column contains the Audio, Video and Trash folders. If the folders are opened, the clip or region names are shown and can be edited. This column is always shown.</td>
</tr>
<tr>
<td>Used</td>
<td>This column displays the number of times a clip is used in the project. If a column row is empty, the corresponding clip is not used.</td>
</tr>
<tr>
<td>Image</td>
<td>This column displays waveform images of audio clips or regions.</td>
</tr>
<tr>
<td>Status</td>
<td>This column displays various icons that relate to the current Pool and clip status. See page 385 for a description of the icons.</td>
</tr>
<tr>
<td>Info</td>
<td>This column shows the following information for audio clips: The sample rate, bit resolution, number of channels and the length in seconds. For regions, it displays start and end times in frames, and for video clips the frame rate, number of frames, and length in seconds.</td>
</tr>
<tr>
<td>Type</td>
<td>This column shows the file format of the clip.</td>
</tr>
<tr>
<td>Date</td>
<td>This column shows the date when the clip was created.</td>
</tr>
<tr>
<td>Origin Time</td>
<td>This column shows the original start position where a clip was recorded in the project. As this value can be used as a basis for the “Insert into Project” Pool menu item (and other functions), you can change it if the Origin Time value is redundant. This can either be done by editing the value in the column, or by selecting the corresponding clip in the Pool, moving the project cursor to the new desired position and selecting “Update Origin” from the Pool menu.</td>
</tr>
<tr>
<td>Path</td>
<td>This column shows the path to the location of a clip on the hard disk.</td>
</tr>
</tbody>
</table>
About the Status column symbols

The Status column can display various symbols that relate to the clips status. The following symbols can be shown:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Record" /></td>
<td>This indicates the current Pool Record folder (see page 399).</td>
</tr>
<tr>
<td><img src="image" alt="Process" /></td>
<td>This symbol is shown if a clip has been processed.</td>
</tr>
<tr>
<td><img src="image" alt="Question Mark" /></td>
<td>The question mark indicates that a clip is referenced to the project but is missing from the Pool (see page 392).</td>
</tr>
<tr>
<td><img src="image" alt="External" /></td>
<td>This indicates that the clip file is external, i.e. located outside the current Project Audio folder.</td>
</tr>
<tr>
<td><img src="image" alt="Recorded" /></td>
<td>This indicates that the clip has been recorded in the currently open version of the project. This is useful for finding recently recorded clips quickly.</td>
</tr>
</tbody>
</table>

Sorting the Pool contents

You can sort the clips in the Pool by name, date etc. This is done by clicking on the corresponding column heading. Clicking again on the same heading switches between ascending and descending sort order.

The arrow indicates the sort column and sort order.
Operations

Renaming clips in the Pool

Renaming a clip in the Pool is done in the following way:

- Select and click on the existing name, type in a new name and press [Return].

Renaming a clip in the Pool is much preferred to renaming it outside Cubase SX/SL (for example on the computer desktop). This way Cubase SX/SL already "knows" about the change, and won't lose track of the clip the next time you open the project. See page 392 for details about lost files.

Copying clips in the Pool

To make a duplicate clip, proceed as follows:

1. Select the clip you wish to copy.

A new version of the clip appears in the same Pool folder, with the same name but with a "version number" after it, to indicate that the new clip is a duplicate. The first copy made of a clip will logically get the version number “2” and so on.

Copying a clip does not create a new file on disk, but just a new edit version of the clip (referring to the same original file).

Inserting clips into a project

Using menus

1. Select the clip(s) you want to insert into the project.
2. Pull down the Pool menu and select one of the “Insert into Project” options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>At Cursor</td>
<td>The clip(s) will be inserted at the current project cursor position.</td>
</tr>
<tr>
<td>At Origin</td>
<td>The clip(s) will be inserted at their Origin Time position.</td>
</tr>
</tbody>
</table>
• Note that the clip will be positioned so that its Snap point is aligned with the selected insert position.
You can also open the Sample Editor for a clip by double clicking it, and perform the insert operation from there. This allows you to set the Snap point for a clip before inserting it.

3. The clip is inserted on a new audio track, created automatically, or on a selected track.
   If several tracks are selected, the clip will be inserted on the first selected track.

By drag and drop

You can use drag and drop to insert clips into the Project window. You can also use drag and drop from the Sample Editor for a clip by making a selection range and pressing [Ctrl]/[Command] while dragging. Note:

• Snap is taken into account if activated.

• While you drag the clip in the Project window, its position will be indicated by a marker line and a numerical position box.
   Note that these indicate the position of the Snap point in the clip. For example, if you drop the clip at the position 22.00, this will be where the Snap point ends up. See page 339 for info about how to set the Snap point.

• If the destination track is empty, it is automatically set to stereo or mono depending on the clip.
   This works just as when importing audio files from disk into the Project window (see page 74).

• You can position it in an empty area in the event display (i.e below existing tracks), and a new track is created for the inserted event.
Deleting clips

Removing clips from the Pool
To remove a clip from the Pool without deleting it from the hard disk, proceed as follows:

1. Select the file(s) and select “Delete” from the Edit menu (or press [Backspace] or [Delete]).

   - If you try to delete a clip that is used by one or more events, the program will ask you if you want to remove these events from the project.

   - Canceling this operation means that neither the clip nor the associated events are deleted.

2. Click Remove.
   A new prompt asks whether you want to move the clip to the Trash or remove it from the Pool.

3. Select “Remove from Pool”.
   The clip is no longer associated with the project, but still exists on the hard disk, and can be used in other projects etc. This operation can be undone.

Deleting from the hard disk
To delete a file permanently from the hard disk, it must first be moved to the Trash folder:

- Follow the instructions for deleting clips (see above), and select “Trash”.
  When clips are in the Trash folder they can be removed permanently.

- Select “Empty Trash” on the Pool menu.
  A dialog box asks you if you are sure you want to follow through. Remember that this operation cannot be undone!

Before you permanently delete audio files from the hard disk, you should make sure that these aren’t used by another project!
Removing unused clips from the Pool

This function finds all clips in the Pool that are not used in the project, and either moves them to the Pool Trash folder where they can be permanently deleted, or removes them from the Pool:

1. Select “Remove Unused Media” on the Pool menu.
   A prompt appears with the text “Move to Trash or Remove From Pool?”
2. Make your selection.

Locating events referring to a clip in the Pool

If you want to find out which events in the project refer to a particular clip in the Pool, proceed as follows:

1. Select the clip in the Pool.
2. Select “Select in Project” on the Pool menu.
   All events that refer to the selected clip are now selected in the Project window.

Locating clips or regions in the Pool

You can perform a search of the Pool to locate particular clips or regions, in the following way:

1. Select “Find in Pool” from the Pool menu.
   This opens the Find Media window, in which you can specify various criteria to match. You can search by any one (or a combination) of the following properties:
   • Name.
   • Size (in seconds, minutes, frames or bytes).
   • Bitsize.
   • Channels (stereo or mono).
2. Tick the box beside the property you would like to search by, and enter the desired name or value.
   For the “Size” property, you can search for sizes smaller or greater than a value, or between two values. This is determined by the second pop-up menu.
3. Press Start.
   The search result appears in the lower half of the window.
• To select the found clips or regions in the Pool, click the “Select in Pool” button.

• To insert a found clip or region directly into the project, select it in the list in the dialog and select one of the “Insert into Project” options from the Pool menu. The options are described on page 386.

☐ The “Find in Pool” command is also accessible from the Project window – the Pool window does not have to be open.

Locating selected events

If you quickly want to find the clip for an event in the Project window, you can also use the following method:

1. Select one or several events in the Project window.

2. Pull down the Audio menu and select “Find Selected in Pool”. The corresponding clip(s) will be located and highlighted in the Pool. If the Pool window isn’t already open it will be opened.
Searching for audio files on disk

The Pool can help you locate audio files on your hard disk or other media. This works much like the regular file search, but with a couple of extra features:

1. Click the Search button in the toolbar.
   A lower pane appears in the window, displaying the search functions.

2. Use the Folder pop-up menu to specify where to search.
   The pop-up menu will list all your local drives and removable media.
   • If you want to limit the search to certain folders, choose “Select Search Path” and select the desired folder in the dialog that appears.
     The search will include the selected folder and all subfolders. Note also that folders you have recently selected using the “Select Search Path” function will appear on the pop-up menu, allowing you to quickly select any of them.

3. Specify the name of the file(s) to search for in the Name field.
   You can use partial names or wildcards (*), if you like. Note however, that the function only searches for audio files of the supported formats.

4. Click the Search button in the search pane.
   The search is started and the Search button is labeled Stop – click this to cancel the search if needed.
   When the search is finished, the found files are listed to the right.
   • To audition a file, select it in the list and use the playback controls to the left.
     If Auto Play is activated, selected files will automatically be played back.
   • To import a found file into the Pool, select it in the list and click the Import button in the search pane.

5. To close the search pane, click the Search button in the toolbar again.
About missing files

When you open a project, you may get a warning that one or more files are "missing". If you click Close in the warning dialog, the project will open anyway, without the missing files. In the Pool you can check which files are considered missing. This is indicated by a question mark in the Status column.

A file is considered missing under one of the following conditions:

- The file has been moved or renamed outside the program since the last time you worked with the project, and you ignored the Resolve Missing files dialog when you opened the project for the current session.
- You have moved or renamed the file outside the program during the current session.
- You have moved or renamed the folder in which the missing files are located.

Locate missing files

1. Select “Find Missing Files” from the Pool menu.
   The Resolve Missing Files dialog opens.

2. In the dialog that appears, decide if you want the program to try to find the file for you (Search), if you want to do it yourself (Locate) or if you want to specify in which directory the program should search for the file (Folder).

   - If you select Locate, a file dialog opens, allowing you to locate the file manually.
     Click "Open" when you have located the file.

   - If you select Folder, a dialog opens to let you specify the directory in which the missing file can be found.
     This might be the preferred method if you have renamed or moved the folder containing the missing file, but the file still has the same name. Once you select the correct folder, the program finds the file and you can close the dialog.
• If you select Search, the program will scan your hard disks for a file with the proper name and display them in a list.
  The dialog allows you to specify which folder or disk should be scanned. Click the Search Folder button, select a directory or a disk and then click the Start button. If found, select the file from the list and click “Accept”. Afterwards Cubase SX/SL tries to map all other missing files automatically.

Reconstructing missing edit files

If a missing file cannot be found (e.g. if you have accidentally deleted it from the hard disk) it will normally be indicated with a question mark in the Status column in the Pool. However, if the missing file is an edit file (a file created when you process audio, stored in the Edits folder within the project folder), it may be possible for the program to reconstruct it by recreating the editing to the original audio file:

1. Open the Pool and locate the clip(s) for which files are missing.
2. Check the Status column – if this says “Reconstructible”, the file can be reconstructed by Cubase SX/SL.
3. Select the reconstructible clips and select “Reconstruct” from the Pool menu.
   The editing is performed and the edit files are recreated.

Removing missing files from the Pool

If the Pool contains audio files that cannot be found or reconstructed, you may want to remove these:

• Select “Remove Missing Files” from the Pool menu to remove all missing files from the Pool (and remove their corresponding events from the Project window).
**Auditioning clips in the Pool**

There are two methods you can use to audition clips in the Pool:

- By selecting a clip and activating the Play button. The whole clip will play back, unless you stop playback by clicking the Play button again.

- By clicking somewhere in the waveform image for a clip. The clip will play from the position in the waveform you click until the end of the clip, unless you stop playback by clicking the Play button, or by clicking anywhere else in the pool window.

If you have activated the Loop button before you audition, the following will happen:

- If you activate the Play button to audition a clip, the clip will repeat indefinitely, until you stop playback by clicking the Play or Loop button again.

- If you click in the waveform image to audition, the section from the point you clicked to the end of the clip will repeat indefinitely until you stop playback.
Opening clips in the Sample Editor

The Sample Editor allows you to perform detailed editing on the clip (see the Sample Editor chapter for details). You can open clips in the Sample Editor directly from the Pool in the following ways:

- If you double click on a clip waveform icon, the clip will open in the Sample Editor.
- If you double click on a region in the Pool, its clip will open in the Sample Editor with the region selected.

One practical use for this is to set a Snap point for a clip (see page 339). When you later insert the clip from the Pool into the project, you can have it properly aligned according to the set Snap point.
Import Medium...

The Import Medium dialog is used for importing files directly into the Pool. It is opened by using the Pool menu or by using the Import button in the Pool window.

The Import Medium dialog is a standard file dialog, where you can navigate to other folders, audition files etc. The following audio file formats can be imported:

- Wave (Normal or Broadcast, see page 639)
- AIFF
- AIFC (Compressed AIFF)
- REX or REX 2 (see page 709)
- Sound Designer II
- MPEG Layer 2 and Layer 3 (mp2 and mp3 files – see page 710)
- Ogg Vorbis (ogg files – see page 710)
- Windows Media Audio (Windows only – see page 710)
- Stereo or mono
- Any sample rate (although files with another sample rate than the one used in the project will play back at the wrong speed and pitch – see below).
- 8, 16, 24 bit or 32 bit float resolution

In addition, AVI, QuickTime and MPEG video files can be imported into the Pool.

- It is also possible to use the commands on the Import submenu on the File menu to import audio or video files into the Pool.
When you select a file in the Import Medium dialog and click Open, the Import Options dialog will appear.

It contains the following options:

- **Copy File to Working Directory.**
  Activate this if you want a copy of the file to be made in the Project Audio folder, and have the clip refer to this copy. If the option is deactivated, the clip will refer to the original file in the original location (and will thus be marked as “external” in the Pool – see page 385).

- **Convert to Project.**
  Here you can choose to convert the sample rate and/or the sample size (resolution) to the current format used in the project. The options will only be available if necessary (if the sample rate is different than the one set for the project and/or if the sample size is lower than the record format used in the project).
  Note that if you are importing several audio files in one go, the Import Options dialog will instead contain a “Convert if needed” checkbox. When this is activated, the imported files will be converted only if the sample rate is different or the sample size is lower than the project’s.

- **Do not Ask again.**
  If this is ticked, you will always import files according to the settings you have made, without this dialog appearing. This can be reset again in the Preferences – Audio dialog.

You can always convert later should you so wish, by using the Convert Files (see page 403) or Conform Files (see page 404) options.
**Importing audio CD tracks (Cubase SX only)**

You can import tracks (or sections of tracks) from an audio CD directly into the Pool by using the “Import Audio CD” function on the Pool menu. This opens a dialog in which you can specify which tracks should be grabbed from the CD, converted to audio files and added to the Pool.

For details about the Import Audio CD dialog, see page 706.

**Exporting regions as audio files**

If you have created regions within an audio clip (see page 344) these can be exported as separate audio files. To create a new audio file from a region, proceed as follows:

1. In the Pool, select the region you wish to export.
2. Pull down the Audio menu and select “Bounce Selection”.
   A browser dialog opens.
3. Select the folder in which you want the new file to be created.
   A new audio file is created in the specified folder. The file will have the name of the region and will automatically be added to the Pool.
Changing the Pool Record folder

The Pool Record folder is where all audio clips that you record in the project will end up. The Pool Record folder is indicated by the “Record” symbol shown in the Status column, and by a red dot on the folder itself, as shown in the picture above. By default, this is the main Audio folder. You can, however, at any time create a new Audio subfolder and designate this as your Pool Record folder. Proceed as follows:

1. Select the Audio folder or any audio clip.  
   You cannot designate the Video folder (or a subfolder in it) as the Pool Record folder.

2. Select “Create Folder” on the Pool menu.  
   A new empty audio subfolder appears in the Pool.

3. Select the new folder.

4. Select “Set Pool Record Folder” on the Pool menu, or click in the new folders Status column.  
The new folder now becomes the Pool Record folder, and any audio recorded in the project will from this point on end up in this folder.
Organizing clips and folders

If you accumulate a large number of clips in the Pool, it may sometimes be difficult to quickly find specific items. In such cases, organizing clips in new subfolders with suitable names that reflect the content can be a solution. For example, you could put all sound effects in one folder, all lead vocals in another etc. Proceed as follows:

1. Select the type of folder, audio or video, in which you want to create a subfolder.
   You cannot put audio clips in a video folder and vice versa.
2. Select “Create Folder” on the Pool menu.
   A new empty subfolder named “New Folder” appears in the Pool.
3. Click on the name and type in a new appropriate name for the folder.
4. Select and drag the clips you wish to move to the new folder.
5. Repeat steps 1-4 as necessary.

Applying processing to clips in the Pool

You can apply audio processing to clips from within the Pool, just like you can to events in the Project window. Simply select the clip(s) and select a processing method from the Audio menu. To find out more about audio processing, see page 295.

Freeze Edits

If you have applied processing to a clip, either in the Project window or in the Pool, this is indicated by the red and grey waveform symbol in the Status column. This processing can always be undone using the Offline Process History (see page 317). You can also use the Freeze Edits function to create a new file with processing applied or replace the original with a processed version – see page 319.
Prepare Archive

This Pool menu command should be used when you want to archive a project. It checks that every clip referenced in the project is located in the same folder. To be more precise, it does the following:

- Any files that are located outside the current project folder will be copied to it.
- If any processing has been applied, you will be asked whether you want to Freeze Edits. If you do this, you don’t have to archive the Edit folder. Everything belonging to the project will be contained in the project file and the Audio folder.
- Once you have performed a Prepare Archive, you can copy the project file and the Audio folder to backup disks, etc.

- Video clips are always referenced, and are not stored in the project folder.

Minimize File

This item on the Pool menu allows you to change the size of audio files according to the audio clips referenced in a project. The files produced using this option will only contain the audio file portions actually used in the project, which can significantly reduce the size of the project (given that large portions of the audio files are unused).

- This operation will permanently alter the selected audio files in the Pool (the process is undoable), so be careful with this command! If this is not what you want, you can use the “Save Project to New Folder” File menu item instead. This function also has the option of minimizing files, but copies all files into a new folder, leaving the original project untouched. See page 699.

It is useful for archiving purposes. If you have completed a project and wish to minimize the project size as much as possible, use this function.
Proceed as follows:

1. Select the file(s) you wish to minimize in the Pool.

2. Select “Minimize File” from the Pool menu.
   An alert appears informing you that the entire Edit History will be cleared. You will at this point have the option of cancelling or continuing the operation.

3. After the operation is finished, another alert asks you to save the project, to update the new file references.
   Do so.
   The audio file(s) in the Pool Record folder will now be cropped so that only the audio actually used in the project remains in the corresponding audio file.

Importing Pool files

Steinberg’s Nuendo application can export the Pool as a separate file (file extension “.npl”). Such Pool files can be imported into Cubase SX/SL, by using the Import Pool command on the Pool menu. When you import a Pool file, the file references in it are “added” to the current Pool.

- The audio and video files themselves are not saved in the Pool file, only a reference to them. For there to be any point in importing a Pool file, you need access to all reference files (which preferably should have the same file paths as when the Pool was saved).
Convert Files

Selecting Convert Files on the Pool menu opens the Convert Options dialog which operates on selected files. Use the pop-up menus to specify which audio file attributes you want to keep and which you want to convert. The options are:

- **Sample Rate.**
  Keep the sample rate as is, or convert to a sample rate between 8.000 and 96.000 kHz.

- **Sample Width.**
  Keep the sample width (resolution) as is, or convert to 16 bit, 24 bit or 32 Bit float.

- **Channels.**
  Keep as is, or convert the file to Mono or Stereo Interleaved.

- **File Format.**
  Keep the current format, or convert to AIFF, Sound Designer II, Wave or Broadcast Wave format.
Options

When you convert a file, you can use the Options pop-up to set one of the following options regarding what to do with the new file:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Files</td>
<td>This creates a copy of the file in the audio folder and converts this new file according to the chosen attributes. The new file is added to the Pool, but all clip references will still point to the original, unconverted file.</td>
</tr>
<tr>
<td>Replace Files</td>
<td>This converts the original file, without changing clip references.</td>
</tr>
<tr>
<td>New + Replace in Pool</td>
<td>This creates a new copy with the chosen attributes, replaces the original file with the new one in the Pool and redirects the current clip references from the original file to the new file. This is the option to select if you want your audio clips to refer to the converted file, but still want to keep the original file on disk (e.g. if the file is used in other projects).</td>
</tr>
</tbody>
</table>

Conform Files

By using this Pool menu command, you will change all selected files that have different file attributes to what is specified for the project, to conform to this standard. Proceed as follows:

1. Select all clips in the Pool.
2. Select “Conform Files” on the Pool menu.
   A dialog opens allowing you to choose between keeping or replacing the original unconverted files in the Pool. The following applies:
   • Clip/event references in the pool are always redirected to the conformed files.
   • If any 'keep' option is selected, original files remain in the Project Audio folder and new files are created.
   • If you select the 'Replace' option, files in the Pool and in the Project Audio folder are replaced.
Options and Settings

Customizing the view

• You can specify which of the columns should be shown or hidden by selecting the View pop-up on the toolbar and ticking items on or off.

• You can rearrange the order of the columns by clicking on a column heading and dragging the column to the left or to the right. The mouse pointer changes to a hand when you place it on the column heading.

• The width of a column can also be adjusted by placing the pointer between two column headers and dragging left or right. The pointer changes to a divider when you place it between two column headers.
MIDI devices and patches
About program change and bank select

To instruct a MIDI instrument to select a certain patch (sound), you send a MIDI Program Change message to the instrument. Program Change messages can be recorded or entered in a MIDI part like other events, but you can also enter a value in the Program (prg) field in the Inspector for a MIDI track (see page 424). This way, you can quickly set each MIDI track to play a different sound.

With Program Change messages, you are able to select between 128 different patches in your MIDI device. However, many MIDI instruments contain a larger number of patch locations. To make these available from within Cubase SX/SL, you need to use Bank Select messages, a system in which the programs in a MIDI instrument are divided into banks, each bank containing 128 programs. If your instruments support MIDI Bank Select, you can use the Bank (bnk) field in the Inspector to select a bank, and then the Program field to select a program in this bank.

Unfortunately, different instrument manufacturers use different schemes for how Bank Select messages should be constructed, which can lead to some confusion and make it hard to select the correct sound. Also, selecting patches by numbers this way seems unnecessarily cumbersome, when most instruments use names for their patches nowadays.

To help with this, Cubase SX/SL features the MIDI Device Manager. This allows you to specify which MIDI instruments you have connected, by selecting from a vast list of existing devices or by specifying the details yourself. Once you have specified which MIDI devices you’re using, you can select to which particular device each MIDI track should be routed. It is then possible to select patches by name in the track list or Inspector.
Opening the MIDI Device Manager

Select MIDI Device Manager from the Devices menu to bring up the following window:

This is the list of MIDI devices you have connected. The first time you open the MIDI Device Manager, this list will be empty:

These buttons let you manage the list of installed devices.

Here, you specify to which MIDI output the selected device is connected.

This pop-up menu lets you edit the selected device (provided that "Enable Edit" is ticked).

Here, the patch structure is shown for the device selected above.

This area shows exactly which MIDI messages should be sent out to select the patch highlighted in the list to the left.

When you open the MIDI Device Manager for the first time, it will be empty (because you haven’t installed any devices yet). On the following pages we describe how to add a pre-configured MIDI device to the list, how to edit the settings and how to define a device from scratch (only necessary if a MIDI device isn’t included among the pre-configured devices).
Installing a MIDI Device

In this case “install” means “add to the Installed Devices” list, i.e. specify that a certain device is part of your MIDI system. Proceed as follows:

1. Click the Install Device button.
   A dialog appears listing all pre-configured MIDI devices. For now we assume that your MIDI device is included in this list.

2. Locate and select the device in the list and click OK.
   • If your MIDI device isn’t included in the list but is compatible with the GM (General MIDI) or XG standards, you can select the generic GM or XG Device options at the top of list.
     When you select any of these options, a name dialog will appear. Enter a name for the instrument and click OK.
     Now the device appears in the Installed Devices list to the left.

3. Make sure that the new device is selected in the list and pull down the Output pop-up menu.

4. Select the MIDI output that is connected to the device.
When the device is selected in the Installed Devices list, the Patch Banks list below shows the patch structure of the device. This could simply be a list of patches, but it's usually one or several layers of banks or groups containing the patches (much like a folder structure on a hard disk for example).

- You can rename a device in the Installed Devices list by double clicking and typing. This is useful if you have several devices of the same model, and want to separate them by name instead of by a number.
- To remove a device from the Installed Devices list, select it and click Remove Device.
About Patch Banks

Depending on the selected device, you may find that the Patch Banks list is divided in two or more main banks. Typically, these are called Patches, Performances, Drums etc. The reason for having several patch banks is that different “types” of patches are handled differently in the instruments. For example, while “patches” typically are “regular” programs that you play one at the time, “performances” may be combinations of patches, which could e.g. be split across the keyboard, layered or used for multitimbral playback.

For devices with several banks, you will find an additional button to the right, labeled Bank Assignment. Clicking this opens a dialog in which you can specify for each MIDI channel which bank it should use.

The selection here will affect which bank is displayed when you select programs by name for the device in the track list or Inspector (see below). For example, many instruments use MIDI channel 10 as an exclusive drum channel, in which case you would want to select the “Drums” (or “Rhythm Set”, “Percussion”, etc.) bank for channel 10 in this list. This would then let you select between different drum kits in the track list or Inspector.
Selecting a patch for an installed device

If you return to the Project window at this point, you will find that the installed device has been added to the MIDI Output menus (in the track list and the Inspector). Now you can select patches by name, in the following way:

1. Pull down the Output menu (in the track list or Inspector) for a track that you want to play the installed device, and select the device. This directs the track to the MIDI output specified for the device in the MIDI Device Manager. The bank and program fields in the track list and Inspector are replaced by a single “prg” field.

2. Click the “prg” field to display a pop-up menu, hierarchically listing all the patches in the device. The list is similar to the one displayed in the MIDI Device Manager. You can scroll the list up and down (if required), click the plus/minus signs to show or hide subgroups, etc.

3. Click a patch in the list to select it. This sends the appropriate MIDI message to the device. You can also scroll the program selection up or down, as with any value.
Renaming patches in a device

The pre-configured devices list the factory-preset patches, i.e. the patches included in the device when you first bought it. If you have replaced some of the factory presets with your own patches, you need to modify the device so that the patch name list matches the actual device:

1. In the MIDI Device Manager, select the device in the Installed Devices list.

2. Activate the Enable Edit checkbox.
   When this is turned off (default) you cannot edit the pre-configured devices.

3. Use the Patch Banks display to locate and select the patch you want to rename.
   In many instruments, the user-editable patches are located in a separate group or bank.

4. Click on the selected patch in the Patch Banks list to edit its name.

5. Type in the new name and click OK.

6. Rename the desired patches in this way, and finish by deactivating Enable Edit again (to avoid modifying the device by accident).

• It’s fully possible to make more radical changes to the patch structure in a device as well (adding or deleting patches, groups or banks).
   For example, this would be useful if you expanded your MIDI device by adding extra storage media such as RAM cards, etc. The available editing functions are described in the section “Defining a new device” below.
Defining a new device

If your MIDI device is not included in the list of pre-configured devices (and not a “plain” GM or XG device), you need to define it manually to make it possible to select patches by name:

1. In the MIDI Device Manager, click the Install Device button. The Add MIDI Device dialog appears.
2. Select “Define New...” and click OK. A name dialog appears.
3. Enter the name of the device and click OK. The device appears in the Installed Devices list.
4. Select the device in the list. As you can see, it currently contains only an Empty Bank item.
5. Make sure the Enable Edit checkbox is activated. Now you can use the functions on the Commands pop-up menu to the left to organize the patch structure of the new device.

A patch structure is made out of the following components:

• Banks are the main categories of sounds – typically patches, performances and drums, as described above.
• Each bank can contain any number of groups, represented by folders in the list.
• The individual patches, performances or drum kits are represented by presets in the list.

The Commands pop-up menu contains the following items:

Create Bank

Creates a new bank at the highest hierarchical level of the Patch Banks list. You can rename this by clicking on it and typing a new name.

New Folder

Creates a new subfolder in the selected bank or folder. This could correspond to a group of patches in the MIDI device, or just be a way for you to categorize sounds, etc. When you select this item, a name dialog will appear, allowing you to name the folder. You can also rename the folder afterwards by clicking it and typing in the list.
New Preset

This adds a new preset in the selected bank or folder.

You can rename the preset by clicking it and typing a new name. When the preset is selected, its corresponding MIDI events (Program Change, Bank Select, etc.) are shown in the event display to the right. The default setting for a new preset is Program Change 0 – to change this, use the following procedures:

- For details on which MIDI events are used for selecting patches in the MIDI device, consult its documentation.

- To change which Program Change value should be sent out to select the patch, adjust the number in the Value column for the Program Change event.

- To add another MIDI event (e.g. Bank Select) click immediately below the last event in the list and select a new event from the pop-up menu that appears. After adding a new event, you need to set its value in the Value column, as with Program Change.

- To replace an event, click on it and select another event from the pop-up menu. For example, a MIDI device may require that a Bank Select message is sent first, followed by a Program Change message, in which case you would need to replace the default Program Change message with a Bank Select message and add a new Program Change after that.

- To remove an event, click to select it and press [Del].

- Different devices use different schemes for Bank Select. When you insert a Bank Select event, you should check the device’s documentation to find whether to choose “CC: BankSelect MSB”, “Bank Select 14 Bit”, “Bank Select 14 Bit MSB-LSB Swapped” or possibly some other option.
Add Multiple Presets

This opens a dialog, allowing you to set up a range of presets to be added in the selected bank or folder.

Proceed as follows:

1. Add the event types required for selecting a patch in the MIDI device. This is done just as when editing the settings for a single event: clicking in the event display brings up a pop-up menu from which you can select an event type.

2. Use the Range column to set up either a fixed value or a range of values for each event type in the list. This requires some explanation:
   - If you specify a single value in the Range column (e.g. 3, 15 or 127), all added presets will have an event of this type set to the same value.
   - If you instead specify a value range (a start value and an end value, separated by a dash sign, e.g. 0-63), the first added preset will have an event set to the start value, the next will have this value incremented by one and so on, up to and including the end value.
• The number of added presets depends on the Range setting.

![Add Multiple Presets](image)

This example will generate eight presets, each with a Bank Select event set to 2, but with different Program Change events (ranging from 0 to 7).

3. Specify a Default Name below the event display.
The added events will get this name, followed by a number. You can rename presets manually in the Patch Banks list later.

4. Click OK.
A number of new presets are now added in the selected bank or folder, according to your settings.

**Other editing functions**

• You can move presets between banks and folders by dragging them in the Patch Banks list.
• You can remove a bank, folder or preset by selecting it in the Patch Banks list and pressing [Backspace].
• If you specify more than one bank, a Bank Assignment button will appear to the right above the event display. Use this to assign banks to the different MIDI channels (see page 412).
Exporting and importing device setups

Clicking the Export Setup button allows you to export your complete MIDI device setup as a separate file. The file can then be imported using the Import Setup button. This is useful if you move your instruments to another studio, install the program on a new computer, etc.

- When you import a stored setup with the Import Setup function, a dialog will appear, listing all devices included in the stored setup. Select the device(s) you wish to import and click OK.

- Importing will not overwrite any currently installed devices. If the current list contains a device with the same name as a device to be imported, a number will be added to the name of imported device.
19

MIDI realtime parameters and effects
Introduction

For each MIDI track, you can set up a number of track parameters and MIDI effects. These affect how the MIDI data is played back, “transforming” MIDI events in real time before they are sent to the MIDI outputs.

On the following pages, the available parameters and effects are described. Keep in mind:

• The actual MIDI events will not be affected – the changes happen “on the fly”.
• Since the track parameter settings don’t actually change the MIDI data on the track, they will not be reflected in the MIDI editors. To convert the settings to “real” MIDI events, you need to use the Merge MIDI in Loop function (see page 462).
The Inspector – General handling

The track parameters and effects are set up in the Inspector (although some settings are available in the Mixer as well, see page 148). Here's a brief rundown on how to handle the Inspector:

• To show or hide the Inspector, click the Inspector icon on the Project window’s toolbar.

• The Inspector for a MIDI track is divided into five sections. You can fold or unfold the sections individually by clicking the tabs in their upper right corners.
  Clicking the tab for a hidden section brings it to view and hides the other sections. [Ctrl]/[Command]-clicking the tab allows you to hide or show a section without affecting other sections. Finally, [Alt]/[Option]-clicking a tab shows or hides all sections in the Inspector.

• Folding a section does not affect the functionality but merely hides the section from view.
  In other words, if you have set up a track parameter or activated a MIDI effect, your settings will still be active even if you fold the Inspector settings.
Basic track settings

The topmost Inspector section contains the basic settings for the selected MIDI track. These are settings that either affect the basic functionality for the track (mute, solo, enable record, etc.) or send out additional MIDI data to the connected devices (program change, volume, etc.). The section contains all settings in the track list (see page 55), with the following additional parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toggle Timebase button</td>
<td>Switches between musical (tempo related) and linear (time related) time base for the track. See page 72.</td>
</tr>
<tr>
<td>Edit button</td>
<td>This normally opens the channel settings window for the track (a window showing a channel strip with volume fader and other controls, along with effect settings – see page 170). However, if the MIDI track is routed to a VST instrument, clicking the Edit button opens the control panel for the VST instrument instead. To bring up the channel settings window in that case, [Alt]/[Option]-click the Edit button.</td>
</tr>
<tr>
<td>Volume</td>
<td>Use this to adjust the level for the track. Changing this setting will move the track’s fader in the Mixer window, and vice versa. See page 152 for more about setting levels.</td>
</tr>
<tr>
<td>Delay</td>
<td>This adjusts the playback timing of the MIDI track. Positive values delay the playback while negative values cause the track to play earlier. The values are set in milliseconds.</td>
</tr>
<tr>
<td>Pan</td>
<td>Use this to adjust the panning of the track.</td>
</tr>
<tr>
<td>Input transformer button</td>
<td>Opens the Input Transformer dialog, allowing you to transform incoming MIDI events in real time, see page 585.</td>
</tr>
</tbody>
</table>
• Note that the functionality of the “Programs” settings (used for selecting sounds in the connected MIDI instrument) depends on to which instrument the MIDI output is routed, and how you have set up this in the MIDI Device Manager.
   As described on page 408, the MIDI Device Manager allows you to specify which MIDI instruments and other devices are connected to the various MIDI outputs, thus making it possible to select patches by name.

• Many of the basic track settings are duplicated in “mixer channel strip form”, in the Channel section at the bottom of the Inspector.
   See page 461.
**Track parameters**

The following settings will affect the MIDI events on the track in real time during playback. They will also be in effect if you play “live” with the track selected and record enabled (provided that “MIDI Thru Active” is activated on the Preferences – MIDI page). This makes it possible to e.g. transpose or adjust the velocity of your live playing.

- If you want to compare the result of your track parameters with the "unprocessed" MIDI, you can use the Bypass button in the Track Parameters section.
  When this is activated, the Track Parameter settings will be temporarily disabled. A by-passed section is indicated by its Inspector tab turning yellow.
Transpose

This allows you to transpose all notes on the track in semitones. The available range is -127 to +127 semitones, but remember that the total range of MIDI note numbers is 0 to 127. Furthermore, not all instruments can play back notes over the whole range. Therefore, extreme transpositions can give rather strange and unwanted results.

Velocity Shift

This setting lets you change the dynamics of all notes on the track. The value in this field is added to the velocity of each note message that is sent out (use negative values to lower the velocities). The range is -127 to +127 with 0 representing no change in velocity.

Note that the effects of changing the velocity depends on the sound and instrument.

Velocity Compression

This function multiplies the velocity values with the factor you specify. This factor is set using a numerator (left value) and a denominator (right value), resulting in a fractional number (1/2, 3/4, 3/2 etc.). For example, if you set the factor to 3/4, the velocities will be three quarters of their original values. The point is, that this will also affect the difference in velocity between the notes, thereby compressing or expanding the velocity scale. Typically, you would combine this setting with the Velocity Shift parameter. An example:

Let's say you have three notes with the velocity values 60, 90 and 120, and wish to “even out” the velocity differences somewhat. If you set the Velocity Compression value to 1/2, the notes will play back with the velocities 30, 45 and 60. By adding 60 in the Velocity Shift field, you will have the notes playing back with the velocities 90, 105 and 120, meaning you have in effect compressed the velocity range.

In a similar way, you can use Velocity Compression values greater than 1/1 together with negative values in the Velocity Shift field, to expand the velocity range.

- Remember that the maximum velocity is always 127 no matter how much you try to expand.
Length Compression

This value adjusts the lengths of all notes on the track. As with Velocity Compression, the value is set with a numerator and denominator. For example, the value 2/1 means that all note lengths will be doubled, while 1/4 means all note lengths will be quarter of the actual lengths.

Random

The Random settings let you introduce random variations to various properties of MIDI notes. Anything from very subtle variations to dramatic changes can be applied. There are two separate “Random generators”, each of which are set up in the following way:

1. Pull down the Random pop-up menu and select which note property should be randomized.
   The options are position, pitch, velocity and length.

   • Keep in mind that depending on the content of the track, certain parameter changes might not be immediately noticeable, or have any effect at all (as would be the case if applying random length to a percussion track playing “one-shot” samples for example).

   To best audition the random changes choose a track with clearly defined rhythm and note content, if possible (as opposed to a string pad).

2. Set the desired range of random deviation by entering values in the two number fields.
   The two values govern the limits of the randomization, so that the values will vary between the left value and the right value (you cannot set the left value higher than the right value). The maximum random range for each property is listed in the table below:

<table>
<thead>
<tr>
<th>Property</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>-500 to +500 ticks</td>
</tr>
<tr>
<td>Pitch</td>
<td>-100 to +100 semitones</td>
</tr>
<tr>
<td>Velocity</td>
<td>-100 to +100</td>
</tr>
<tr>
<td>Length</td>
<td>-500 to +500 ticks</td>
</tr>
</tbody>
</table>

Note again that you can make independent settings for the two random generators.

• To deactivate the Random function, pull down the Random pop-up menu(s) and select “OFF”.

CUBASE SX/SL
19 – 428 MIDI realtime parameters and effects
Range

The Range function lets you specify a note (pitch) or velocity range and either force all notes to fit within this range, or exclude all notes outside this range from playback. As with the Random function, there are two separate Range settings. Set them up as follows:

1. Pull down the Range pop-up menu and select one of the following four modes:

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vel. Limit</td>
<td>This function affects all velocity values outside the specified range. Velocity values below the Min setting (the lower limit of the range) are set to the Min value, and velocity values above the Max setting are set to the Max value. Notes with velocity values within the set range are not affected. Use this if you want to force all velocity values to fit within a certain range.</td>
</tr>
<tr>
<td>Vel. Filter</td>
<td>Velocity Filter works by excluding all notes with velocity values outside the specified range. Notes with velocity values below the Min setting or above the Max setting will not be played back. Use this to &quot;isolate&quot; notes with certain velocity values.</td>
</tr>
<tr>
<td>Note Limit</td>
<td>This function allows you to specify a pitch range, and forces all notes to fit within this range. Notes outside the specified range are transposed up or down in octave steps until they fit within the range. Note: If the range is too &quot;narrow&quot;, so that some notes cannot be fit within the range by octave-transposing, these notes will get a pitch in the middle of the range. For example, if you have a note with a pitch of F3, and the range is C4-E4, that note will be transposed to D4.</td>
</tr>
<tr>
<td>Note Filter</td>
<td>Note Filter works by excluding all notes with pitches outside the specified range. Notes lower than the Min setting or higher than the Max setting will not be played back. Use this to &quot;isolate&quot; notes with certain pitches.</td>
</tr>
</tbody>
</table>

2. Use the two fields to the right to set the min and max values. These values will be shown as numbers (0-127) for the velocity modes and as note numbers (C-2 to G8) for the pitch modes.

Note again that you can make independent settings for the two Range functions.

- To deactivate the Range function, pull down the Range pop-up menu(s) and select "OFF".
MIDI effects

Cubase SX/SL comes with a number of MIDI effect plug-ins, capable of transforming the MIDI output from a track in various ways.

Just like the MIDI track parameters, MIDI effects are applied in real time to the MIDI data played back from the track (or to MIDI you play live “thru” the track).

What are MIDI effects?

Although a MIDI effect can be similar to an audio effect, it’s important to remember that you’re not processing the sound resulting from MIDI playback, but the MIDI data (the “instructions” for how the music should be played back).

A MIDI effect will change properties of the MIDI events (e.g. change the pitch of notes) and/or generate new MIDI events (for example, a MIDI delay may add new MIDI notes, “echoing” the original notes).

Insert and send effects

As with audio effects, there are two ways to route the MIDI events on a track to an effect:

• If you add an insert effect, the MIDI events will be sent to the effect, which will process the data and pass it on to the track’s MIDI output (or to another insert effect).
  In other words, the MIDI events will be routed “through” the insert effect.

• If you use a send effect, the MIDI events will be sent both to the track’s MIDI output and to the effect.
  That is, you will get both the unprocessed MIDI events and the output of the MIDI effect. Note that the effect can send its processed MIDI data to any MIDI output – not necessarily to the one used by the track.

There are separate sections in the Inspector for Inserts and Sends:
Inserts section

This allows you to add up to four MIDI insert effects. The section contains the following items:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit button</td>
<td>Opens the Channel Settings window for the MIDI track.</td>
</tr>
<tr>
<td>Bypass button</td>
<td>Click this to temporarily disable all insert effects for the track (useful for comparing with the unprocessed MIDI, etc.).</td>
</tr>
<tr>
<td>Inserts section tab</td>
<td>This lights blue if any insert effect is activated. A yellow tab means that the insert section is bypassed.</td>
</tr>
<tr>
<td>Effect selection</td>
<td>Selecting an effect from this pop-up menu automatically activates it and brings up its control panel (which can be a separate window or a number of settings below the insert slot in the Inspector). To remove an insert effect completely, select “No Effect”.</td>
</tr>
<tr>
<td>On button (x 4)</td>
<td>Allows you to turn the selected effect on or off.</td>
</tr>
<tr>
<td>Edit button (x4)</td>
<td>Click this to bring up the control panel for the selected effect. Depending on the effect, this may appear in a separate window or below the insert slot in the Inspector. Clicking the button again hides the control panel.</td>
</tr>
</tbody>
</table>

- Effects that display their controls in the Inspector can be forced to appear in a separate control panel window by pressing [Alt]/[Option] and double clicking the Edit button.
Sends section

This allows you to add up to four MIDI send effects. Unlike audio send effects, you can select and activate send effects individually for each track. The section contains the following items:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit button</td>
<td>Opens the Channel Settings window for the MIDI track.</td>
</tr>
<tr>
<td>Bypass button</td>
<td>Click this to temporarily disable all send effects for the track (useful for comparing with the unprocessed MIDI, etc.).</td>
</tr>
<tr>
<td>Sends section tab</td>
<td>This lights blue if any send effect is activated. A yellow tab means that the send section is bypassed.</td>
</tr>
<tr>
<td>Effect selection pop-up menu (x 4)</td>
<td>Selecting an effect from this pop-up menu automatically activates it and brings up its control panel (which can be a separate window or a number of settings below the send slot in the Inspector). To remove a send effect completely, select &quot;No Effect&quot;.</td>
</tr>
<tr>
<td>On button (x 4)</td>
<td>Allows you to turn the selected effect on or off.</td>
</tr>
<tr>
<td>Edit button (x4)</td>
<td>Click this to bring up the control panel for the selected effect. Depending on the effect, this may appear in a separate window or below the sends slot in the Inspector. Clicking the button again hides the control panel.</td>
</tr>
</tbody>
</table>
Effects that display their controls in the Inspector can be forced to appear in a separate control panel window by pressing [Alt]/[Option] and double clicking the Edit button.

The available effects

About presets

Several of the MIDI plug-ins come with a number of presets for instant use. The controls for handling presets consist of a Presets pop-up menu along with Store [+] and Remove [-] buttons.

- To load a preset, select it from the Presets pop-up menu.
- To store your current settings as a preset, click the [+] button to the right. A dialog appears, asking you to specify a name for the preset. The stored preset will then be available for selection from the pop-up menu for all instances of that MIDI plug-in, in all projects.
- To remove a stored preset, select it and click the [-] button to the right.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output pop-up menu (x4)</td>
<td>This determines to which MIDI output the effect should send the processed MIDI events.</td>
</tr>
<tr>
<td>Channel setting (x4)</td>
<td>This determines on which MIDI channel the effect should send the processed MIDI events.</td>
</tr>
<tr>
<td>Pre button (x4)</td>
<td>If this is activated, the MIDI signals will be sent to the send effects before the track parameters and insert effects.</td>
</tr>
</tbody>
</table>
A typical arpeggiator accepts a chord (a group of MIDI notes) as input, and plays back each note in the chord separately, with the playback order and speed set by the user. The Arpache 5 arpeggiator does just that, and more. Before describing the parameters, let's look at how to create a simple, typical arpeggio:

1. Select a MIDI track and activate monitoring (or record enable it) so that you can play "thru" the track.
   Check that the track is properly set up for playback to a suitable MIDI instrument.

2. Select and activate the arpeggiator.
   For now, use it as an insert effect for the selected track.

3. In the arpeggiator panel, use the Quantize setting to set the arpeggio speed.
   The speed is set as a note value, relative to the project tempo. For example, setting Quantize to “16” means the arpeggio will be a pattern of sixteenth notes.

4. Use the Length setting to set the length of the arpeggio notes.
   This allows you to create staccato arpeggios (Length smaller than the Quantize setting) or arpeggio notes that overlap each other (Length greater than Quantize).

5. Set the Semi-Range parameter to 12.
   This will make the notes arpeggiate within an octave.

6. Play a chord on your MIDI instrument.
   Now, instead of hearing the chord, you will hear the notes of the chord played one by one, in an arpeggio.

7. Try the different arpeggio modes by clicking the Playmode buttons.
   The symbols on the buttons indicate the playback order for the notes (up, down, up+down, etc.). The Play Order settings are described below.
Parameters

The Arpache 5 has the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Playmode buttons</td>
<td>Allows you to select the playback order for the arpeggiated notes. The options are down+up, up+down, up, down, random (&quot;?&quot;) button and &quot;Order off&quot;, in which case you can set the playback order manually with the Play Order fields below.</td>
</tr>
<tr>
<td>Quantize</td>
<td>Determines the speed of the arpeggio, as a note value related to the project tempo. The range is 32T (1/32 note triplets) to 1. (one and a half bar).</td>
</tr>
<tr>
<td>Length</td>
<td>Sets the length of the arpeggio notes, as a note value related to the project tempo. The range is the same as for the Quantize setting.</td>
</tr>
<tr>
<td>Semi-Range</td>
<td>Determines the arpeggiated note range, in semitones counted from the lowest key you play. This works as follows:</td>
</tr>
<tr>
<td></td>
<td>- Any notes you play that are outside this range will be transposed in octave steps to fit within the range.</td>
</tr>
<tr>
<td></td>
<td>- If the range is more than one octave, octave-transposed copies of the notes you play will be added to the arpeggio (as many octaves as fits within the range).</td>
</tr>
<tr>
<td>Thru</td>
<td>If this is activated, the notes sent to the arpeggiator (i.e. the chord you play) will be passed through the plug-in (sent out together with the arpeggiated notes).</td>
</tr>
<tr>
<td>Play Order</td>
<td>If the “Order on” playmode is selected, you can use these “slots” to specify a custom playback order for the arpeggio notes:</td>
</tr>
<tr>
<td></td>
<td>Each slot corresponds to a position in the arpeggio pattern. For each slot, you specify which note should be played on that position by selecting a number. The numbers correspond to the keys you play, counted from the lowest pressed key.</td>
</tr>
<tr>
<td></td>
<td>So, if you play the notes C3-E3-G3 (a C major chord), “1” would mean C3, “2” would mean E3, and “3” would mean G3. Note that you can use the same number in several slots, creating arpeggio patterns that are not possible using the standard play modes.</td>
</tr>
</tbody>
</table>

![Play Order](image)
AutoPan

This plug-in works a bit like an LFO in a synthesizer, allowing you to send out continuously changing MIDI controller messages. One typical use for this is automatic MIDI panning (hence the name), but you can select any MIDI Continuous Controller event type. The AutoPanner has the following parameters:

Waveform selectors

These determine the shape of the controller curves sent out. The results of most of these waveforms are obvious from looking at the buttons, but a few of them require some extra explanations:

- This generates a “random” controller curve.

- These generate curves with a “periodical envelope”. This means the amplitude of the curve will gradually increase or decrease over a set time, set with the Period parameter (see below).

Density

This determines the density of the controller curves sent out. The value can be set ticks (1/480ths of quarter notes), or as rhythmically exact note values (by clicking the arrow buttons next to the value). The higher the note value, the smoother the controller curve. For example, if you set this to 60 (shown as “32th”) a new controller event will be sent out every 60th tick (at every 1/32 note position).

- You should probably avoid extremely low Density values, as these will generate a very large number of events (which may cause the MIDI instrument to “choke”, delaying notes etc.).
Period
This is where you set the speed of the Autopanner, or rather the length of a single controller curve cycle. The value can be set ticks (1/480ths of quarter notes), or as rhythmically exact note values (by clicking the arrow buttons next to the value). The lower the note value, the slower the speed. For example, if you set this to 240 ("8th") the waveform will be repeated every eighth note.

AmpMod
This is only used for the two waveforms with "periodical envelopes". The period value (set in beats) determines the length of the envelope. In the following figure, Period is set to 4th and the AmpMod is 4 beats. This results in a quarter note-based curve in which the top amplitude decreases gradually, repeated each bar:

Controller
Determines which Continuous Controller type is sent out. Typical choices would include pan, volume and brightness but your MIDI instrument may have controllers mapped to various settings, allowing you to modulate the synth parameter of your choice – check the MIDI implementation chart for your instrument for details!

Min and Max
These determines the minimum and maximum controller values sent out, i.e. the "bottom" and "top" of the controller curves.
Chorder

The Chorder is a MIDI chord processor, allowing you to assign complete chords to single keys in a multitude of variations. There are three main modes of operation: Normal, 1Oct and Global.

Normal mode

In this mode, you can assign a different chord to each single key on the keyboard. Proceed as follows:

1. Select the key to which you want to assign a chord, by clicking in the lower “Trigger Note” keyboard display.
2. Set up the desired chord for that key by clicking in the upper “Chord Setup” keyboard display. Clicking a key adds it to the chord; clicking it again removes it.
3. Repeat the above with any other keys you wish to use.

If you now play the keys you have set up, you will instead hear the assigned chords.
10ct mode

The 1 Octave mode is similar to the Normal mode, but you can only set up one chord for each key in an octave (that is, twelve different chords). When you play a C note (regardless of whether it’s a C3, C4 or any other octave) you will hear the chord set up for the C key.

Global mode

In the Global mode, you only set up a single chord, using the Chord Setup keyboard display (the lower keyboard display is hidden). This chord is then played by all keys on the keyboard, but transposed according to the note you play.
Using switches

The Switch Setup section at the bottom of the panel allows you to set up variations to the defined chords. This works with all three modes and provides a total of eight variations for each assignable key (that is, a maximum of 8 different chords in Global mode, 12x8 chords in 1Oct mode and 128x8 chords in Normal mode).

The variations can be controlled by velocity or note range. Here's how you set it up:

1. Select one of the two switch modes: velocity or note. How to use these is explained below.

![Velocity switch mode selected.](image)

2. Specify how many variations you want to use with the Use value box.

3. Click the first Switch Select button and set up the chord(s) you want for the first variation.

4. Click the next Switch Select button and set up the chord(s) you want for that variation.

5. Repeat this for the number of variations you specified with the Use setting. Each Switch Select button corresponds to a variation.
6. Now you can play the keyboard and control the variations according to the selected switch modes. These work as follows:

<table>
<thead>
<tr>
<th>Switch mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Velocity</td>
<td>The full velocity range (1-127) is divided into &quot;zones&quot;, according to the number of variations you specified. For example, if you're using two variations (Max is set to 2) there will be two velocity &quot;zones&quot;: 1-63 and 64-127. Playing a note with velocity at 64 or higher will trigger the second variation, while playing a softer note will trigger the first variation.</td>
</tr>
<tr>
<td>Note</td>
<td>In this mode, the chorder will play one chord at a time – you cannot play several different chords simultaneously. When the Note switch mode is selected, you play a key to determine the base note for the chord, then press a higher key to select a variation. The variation number will be the difference between the two keys. To select variation 1, press a key one semitone higher than the base note, for variation 2, press a key two semitones higher, and so on.</td>
</tr>
</tbody>
</table>

- To turn the variation switch feature off, select the “No Switch” mode.
Compress

This MIDI Compressor is used for evening out or expanding differences in velocity. Though the result is similar to what you get with the Velocity Compression track parameter, the Compress plug-in presents the controls in a manner more like regular audio compressors. The parameters are:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threshold</td>
<td>Only notes with velocities over this value will be affected by the compression/expansion.</td>
</tr>
<tr>
<td>Ratio</td>
<td>This determines the rate of compression applied to the velocity values above the threshold level. Ratios greater than 1:1 result in compression (i.e. less difference in velocity) while ratios lower than 1:1 result in expansion (i.e. greater difference in velocity). What actually happens is that the part of the velocity value that is above the threshold value is divided by the ratio value.</td>
</tr>
<tr>
<td>Gain</td>
<td>This adds or subtracts a fixed value from the velocities. Since the maximum range for velocity values is 0-127, you may need to use the Gain setting to compensate, keeping the resulting velocities within the range. Typically, you would use negative Gain settings when expanding and positive Gain settings when compressing.</td>
</tr>
</tbody>
</table>
This generic control panel allows you to select up to eight different MIDI controller types, and use the value fields/sliders to set values for these. A typical use for this would be if you’re using a MIDI instrument with parameters that can be controlled by MIDI controller data (e.g. filter cutoff, resonance, levels, etc.). By selecting the correct MIDI controller types, you can use the plug-in as a control panel for adjusting the sound of the instrument from within Cubase SX/SL, at any time.

- To select a controller type, use the pop-up menus to the right.
- To deactivate a controller slider, set it to “Off” (drag the slider all the way to the left).
Density

This affects the “density” of the notes being played from (or thru) the track. When this is set to 100%, the notes are not affected. Lowering the Density setting below 100% will randomly filter out or “mute” notes. Raising the setting above 100% will instead randomly add new notes.

Micro Tuner

The Micro Tuner lets you set up a different microtuning scheme for the instrument, by detuning each key.

• Each Detune field corresponds to a key in an octave (as indicated by the keyboard display). Adjust a Detune field to raise or lower the tuning of that key, in cents (hundreds of a semitone).

• Set the Convert setting according to whether the track is routed to a VST instrument or a “real” standard MIDI instrument (capable of receiving microtuning information).

The Micro Tuner comes with a vast number of presets, including both classical microtuning scales and experimental ones.
MIDIEcho

This is an advanced MIDI Echo, which will generate additional echoing notes based on the MIDI notes it receives. It creates effects similar to a digital delay, but also features MIDI pitch shifting and much more.

As always it is important to remember that the effect doesn't "echo" the actual audio, but the MIDI notes which will eventually produce the sound in the synthesizer.

The following parameters are available:

**Velocity Decay**

This parameter allows you to add or subtract to the velocity values for each repeat so that the echo fades away or increases in volume (provided that the sound you use is velocity sensitive). For no change of velocity, set this to 0 (middle position).

**Pitch Decay**

If you set this to a value other than 0, the repeating (echoing) notes will be raised or lowered in pitch, so that each successive note has a higher or lower pitch than the previous. The value is set in semitones.

For example, setting this to -2 will cause the first echo note to have a pitch two semitones lower than the original note, the second echo note two semitones lower than the first echo note, and so on.

**Repeat Rate**

This is the number of echoes (1 to 12) you get from each incoming note.
Quantize

The echoed notes will be moved in position to a quantizing grid, as set up with this parameter. You can either use the slider or type to set the value in ticks (1/480 ticks of quarter notes) or click the arrow buttons to step between the "rhythmically exact" values (displayed as note values - see the table below). This makes it easy to find rhythmically relevant quantize values, but still allows experimental settings in between.

An example: setting this to “16th” will force all echo notes to be played on exact 16th note positions, regardless of the timing of the original notes and the Echo-Quant. setting.

• To disable quantizing, set this parameter to its lowest value (1).

Length

This sets the length of the echoed notes. This can either be the same length as their respective original notes (parameter set to its lowest value, “Source”) or the length you specify manually. You can either set the length in ticks or click the arrow buttons to step between the "rhythmically exact" lengths (displayed as note values – see the table below).

• The length can also be affected by the Length Decay parameter.

Echo-Quant.

The Echo-Quant. parameter sets the delay time, i.e. the time between a played note and its first echo note. You can either use the slider or type to set the value in ticks (1/480 ticks of quarter notes) or click the arrow buttons to step between the "rhythmically exact" delay times (displayed as note values – see the table below).

For example, setting this to “8th” will cause the echo notes to sound an eighth note after their original notes.

• The echo time can also be affected by the Echo Decay parameter.
Echo Decay

This parameter lets you adjust how the echo time should be changed with each successive repeat. The value is set as a percentage.

- When set to 100% (middle position) the echo time will be the same for all repeats (as set with the Echo-Quant. parameter).
- If you raise the value above 100, the echoing notes will play with gradually longer intervals (i.e. the echo will become slower).
- If you lower the value below 100, the echoing notes will come gradually faster, like the sound of a bouncing ball.

About ticks and note values

The timing- and position-related parameters (Echo-Quant., Length and Quantize) can all be set in ticks. There are 480 ticks to each quarter note. While the parameters allow you to step between the rhythmically relevant values (displayed as note values), the following table can also be of help, showing you the most common note values and their corresponding number of ticks:

<table>
<thead>
<tr>
<th>Note Value</th>
<th>Ticks</th>
</tr>
</thead>
<tbody>
<tr>
<td>1/32 note</td>
<td>60</td>
</tr>
<tr>
<td>1/16 note triplet</td>
<td>90</td>
</tr>
<tr>
<td>1/16 note</td>
<td>120</td>
</tr>
<tr>
<td>1/8 note triplet</td>
<td>160</td>
</tr>
<tr>
<td>1/8 note</td>
<td>240</td>
</tr>
<tr>
<td>Quarter note triplet</td>
<td>320</td>
</tr>
<tr>
<td>Quarter note</td>
<td>480</td>
</tr>
<tr>
<td>Half note</td>
<td>960</td>
</tr>
</tbody>
</table>
Note to CC

This effect will generate a MIDI continuous controller event for each incoming MIDI note. The value of the controller event corresponds to the note number (pitch) and the single parameter allows you to select which MIDI controller should be sent out (by default controller 7, MIDI volume). The incoming MIDI notes pass through the effect unaffected.

For example, if MIDI volume (controller 7) is selected, notes with low note numbers (pitches) will lower the volume in the MIDI instrument, while higher note numbers will raise the volume. This way you can create “keyboard tracking” of volume or other parameters.

- Note that a controller event is sent out each time a new note is played. If high and low notes are played simultaneously, this could lead to somewhat confusing results. Therefore, the Note to CC effect is probably best applied to monophonic tracks (playing one note at the time).
Quantizer

Quantizing is a function that changes the timing of notes by moving them towards a “quantize grid”. This grid may consist of e.g. straight sixteenth notes (in which case the notes would all get perfect sixteenth note timing), but could also be more loosely related to straight note value positions (applying a “swing feel” to the timing, etc.).

- The main Quantize function in Cubase SX/SL is described on page 467.

While the Quantize function on the MIDI menu applies the timing change to the actual notes on a track, the Quantizer effect allows you to apply quantizing “on the fly”, changing the timing of the notes in real time. This makes it easier to experiment with different settings when creating grooves and rhythms. Note however, that the main Quantize function contains settings and features that are not available in the Quantizer.

The Quantizer has the following parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quantize Note</td>
<td>This sets the note value on which the quantize grid is based. Straight notes, triplets and dotted notes are available. For example, “16” means straight sixteenth notes and “8T” means eighth note triplets.</td>
</tr>
<tr>
<td>Swing</td>
<td>The Swing parameter allows you to offset every second position in the grid, creating a swing or shuffle feel. The value is a percentage – the higher you set this, the farther to the right every even grid position is moved. See page 470.</td>
</tr>
<tr>
<td>Strength</td>
<td>This determines how close the notes should be moved to the quantize grid. When set to 100%, all notes will be forced to the closest grid position; lowering the setting will gradually loosen the timing.</td>
</tr>
<tr>
<td>Delay</td>
<td>This delays (positive values) or advances (negative values) the notes in milliseconds. Unlike the Delay setting in the Track Parameters, this delay can be automated.</td>
</tr>
</tbody>
</table>
Step Designer

The Step Designer is a MIDI pattern sequencer, that sends out MIDI notes and additional controller data according to the pattern you set up. It does not make use of the incoming MIDI, other than automation data (such as recorded pattern changes).

Creating a basic pattern

1. Use the Pattern selector to choose which pattern to create.
   Each Step Designer can hold up to 100 different patterns.

2. Use the Quantize setting to specify the “resolution” of the pattern.
   In other words, this setting determines how long each step is. For example, if Quantize is set to “16th” each step will be a sixteenth note.

3. Specify the number of steps in the pattern with the Length setting.
   As you can see in the note display, the maximum number of steps is 32. For example, setting Quantize to 16 and Length to 32 would create a two bar pattern with sixteenth note steps.

4. Click in the note display to insert notes.
   You can insert notes on any of the 32 steps, but the Step Designer will only play back the number of steps set with the Length parameter.
• The display spans one octave (as indicated by the pitch list to the left). You can scroll the displayed octave up or down by clicking in the pitch list and dragging up or down. This way you can insert notes at any pitch. Note though that each step can contain one note only – the Step Designer is monophonic.

• To remove a note from the pattern, click on it again.

5. Select “Velocity” on the Controllers pop-up menu. This pop-up menu determines what is shown in the lower controller display.

6. Adjust the velocity of the notes by dragging the velocity bars in the controller display.

7. To make notes shorter, select “Gate” on the Controllers pop-up menu and lower the bars in the controller display. When a bar is set to its maximum value (fully up), the corresponding note will be the full length of the step (as set with the Quantize parameter).

8. To make notes longer, you can tie two notes together. This is done by inserting two notes and clicking the Tie button below the second note. When the Tie button is lit for a note, it won’t retrigger – instead the previous note will be lengthened. Also, the tied (second) note will automatically get the same pitch as the first note. You can add more notes and tie them in the same way, creating longer notes.

9. If you now start playback in Cubase SX/SL, the pattern will play as well, sending out MIDI notes on the track’s MIDI output and channel (or, if you have activated the Step Designer as a send effect, on the MIDI output and channel selected for the send in the Inspector).
Adding controller curves

The Controllers pop-up menu holds two more items: two controller types.

- You can select which two controller types (filter cutoff, resonance, volume, etc.) should be available on the pop-up menu by clicking the Setup button and selecting controllers from the lists that appears. This selection is global to all patterns.

- To insert controller information in a pattern, select the desired controller from the pop-up menu and click in the controller display to draw events. The MIDI controller events will be sent out during playback along with the notes.

- If you drag a controller event bar all the way down, no controller value will be sent out on that step.
Other pattern functions

The following functions make it easier to edit, manipulate and manage patterns:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift Oct</td>
<td>These buttons allow you to shift the entire pattern up or down in octave steps.</td>
</tr>
<tr>
<td>Shift Time</td>
<td>Moves the pattern one step to the left or right.</td>
</tr>
<tr>
<td>Reverse</td>
<td>Reverses the pattern, so that it plays backwards.</td>
</tr>
<tr>
<td>Copy/Paste</td>
<td>Allows you to copy the current pattern and paste it in another pattern location (in the same Step Designer or another).</td>
</tr>
<tr>
<td>Reset</td>
<td>Clears the pattern, removing all notes and setting controller values to default.</td>
</tr>
<tr>
<td>Random</td>
<td>Generates a completely random pattern – useful for experimenting.</td>
</tr>
<tr>
<td>Swing</td>
<td>The Swing parameter allows you to offset every second step, creating a swing or shuffle feel. The value is a percentage – the higher you set this, the farther to the right every even step is moved.</td>
</tr>
<tr>
<td>Presets</td>
<td>Presets are handled as described on page 433. Note that a stored Preset contains all 100 patterns in the Step Designer.</td>
</tr>
</tbody>
</table>

Automating pattern changes

You can create up to 100 different patterns in each Step Designer – just select a new pattern and add notes and controllers as described above.

Typically, you want the pattern selection to change during the song. You can accomplish this by automating the Pattern selector, either in real time by activating the Write automation and switching patterns during playback or by drawing in the automation subtrack for the Step Designer’s MIDI track.
Track Controls

The Track Control effect contains three ready-made control panels for adjusting parameters on a GS or XG compatible MIDI device. The Roland GS and Yamaha XG protocols are extension of the General MIDI standard, allowing for more sounds and better control of various instrument settings. If your instrument is compatible with GS or XG, the Track Controls effect allows you to adjust sounds and effects in your instrument from within Cubase SX/SL.

Selecting a control panel

At the top of the Track Controls effect window you will find a pop-up menu. This is where you select which of the available control panels to use:

<table>
<thead>
<tr>
<th>Control panel</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GS Basic Controls</td>
<td>Effect sends and various sound control parameters for use with instruments compatible with the Roland GS standard.</td>
</tr>
<tr>
<td>XG Effect + Sends</td>
<td>Effect Sends and various sound control parameters for use with instruments compatible with the Yamaha XG standard.</td>
</tr>
<tr>
<td>XG Global</td>
<td>Global settings (affecting all channels) for instruments compatible with the Yamaha XG standard.</td>
</tr>
</tbody>
</table>
About the Reset and Off buttons

Regardless of the selected mode, you will find two buttons labelled “Off” and “Reset” at the top of the control panel:

- Clicking the Off button will set all controls to their lowest value, without sending out any MIDI messages.
- Clicking the Reset button will set all parameters to their default values, and send out the corresponding MIDI messages.

For most parameters, the default values will be zero or "no adjustment", but there are exceptions to this. For example, the default Reverb Send settings are 64.

GS Basic Controls

The following controls are available when the GS Basic Controls mode is selected:

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send 1</td>
<td>Send level for the reverb effect.</td>
</tr>
<tr>
<td>Send 2</td>
<td>Send level for the chorus effect.</td>
</tr>
<tr>
<td>Send 3</td>
<td>Send level for the “variation” effect.</td>
</tr>
<tr>
<td>Attack</td>
<td>Adjusts the attack time of the sound. Lowering the value shortens the attack, while raising it gives a slower attack. Middle position (64) means no adjustment is made.</td>
</tr>
<tr>
<td>Decay</td>
<td>Adjusts the decay time of the sound. Lowering the value shortens the decay, while raising it makes the decay longer.</td>
</tr>
<tr>
<td>Release</td>
<td>Adjusts the release time of the sound. Lowering the value shortens the release, while raising it makes the release time longer.</td>
</tr>
<tr>
<td>Cutoff</td>
<td>Adjusts the filter cutoff frequency.</td>
</tr>
<tr>
<td>Resonance</td>
<td>Adjusts the filter resonance.</td>
</tr>
<tr>
<td>Express</td>
<td>Allows you to send out expression pedal messages on the track’s MIDI channel.</td>
</tr>
<tr>
<td>Press.</td>
<td>Allows you to send out aftertouch (channel pressure) messages on the track’s MIDI channel. This is useful if your keyboard cannot send aftertouch, but you have sound modules that respond to aftertouch. The default value for this parameter is zero.</td>
</tr>
<tr>
<td>Breath</td>
<td>Allows you to send breath control messages on the track’s MIDI channel.</td>
</tr>
<tr>
<td>Modul.</td>
<td>Allows you to send modulation messages on the track’s MIDI channel (just as you normally do with a modulation wheel on a MIDI keyboard).</td>
</tr>
</tbody>
</table>
**XG Effects + Sends**

The following controls are available when the XG Effects + Sends mode is selected:

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send 1</td>
<td>Send level for the reverb effect.</td>
</tr>
<tr>
<td>Send 2</td>
<td>Send level for the chorus effect.</td>
</tr>
<tr>
<td>Send 3</td>
<td>Send level for the “variation” effect.</td>
</tr>
<tr>
<td>Attack</td>
<td>Adjusts the attack time of the sound. Lowering this value shortens the attack, while raising it gives a slower attack. Middle position means no adjustment is made.</td>
</tr>
<tr>
<td>Release</td>
<td>Adjusts the release time of the sound. Lowering this value shortens the release, while raising it makes the release time longer. Middle position means no adjustment is made.</td>
</tr>
<tr>
<td>Harm.Cont</td>
<td>Adjusts the harmonic content of the sound.</td>
</tr>
<tr>
<td>Bright</td>
<td>Adjusts the brightness of the sound.</td>
</tr>
<tr>
<td>CutOff</td>
<td>Adjusts the filter cutoff frequency.</td>
</tr>
<tr>
<td>Resonance</td>
<td>Adjusts the filter resonance.</td>
</tr>
</tbody>
</table>

**XG Global Settings**

In this mode, the parameters affect global settings in the instrument(s). Changing one of these settings for a track will in fact affect all MIDI instruments connected to the same MIDI Output, regardless of the MIDI Channel setting of the track. Therefore, to avoid confusion it might be a good idea to create an empty track and use this only for these global settings.
The following controls are available:

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Eff. 1</td>
<td>This allows you to select which type of reverb effect should be used: No effect (the reverb turned off), Hall 1-2, Room 1-3, Stage 1-2 or Plate.</td>
</tr>
<tr>
<td>Eff. 2</td>
<td>This allows you to select which type of chorus effect should be used: No effect (the chorus turned off), Chorus 1-3, Celeste 1-3 or Flanger 1-2.</td>
</tr>
<tr>
<td>Eff. 3</td>
<td>This allows you to select one of a large number of “variation” effect types. Selecting “No Effect” is the same as turning off the variation effect.</td>
</tr>
<tr>
<td>Reset</td>
<td>Sends an XG reset message.</td>
</tr>
<tr>
<td>MastVol</td>
<td>This is used to control the Master Volume of an instrument. Normally you should leave this in its highest position and set the volumes individually for each channel (with the volume faders in the Cubase SX/SL mixer or in the Inspector).</td>
</tr>
</tbody>
</table>
Track FX

This plug-in is essentially a duplicate of the Track Parameter section (see page 426). This can be useful if you e.g. need extra Random or Range settings, or if you prefer to have your track parameters in a separate window (to get this, [Alt]/[Option]-click the Edit button for the effect).

The Track FX also includes an additional function that isn’t available among the track parameters:

Scale Transpose

This allows you to transpose each incoming MIDI note, so that it fits within a selected musical scale. The scale is specified by selecting a key (C, C#, D, etc.) and a scale type (major, melodic or harmonic minor, blues, etc.).

- To turn Scale Transpose off, select “No Scale” from the scale type pop-up menu.
Transformer

The Transformer is a real-time version of the Logical Editor. With this you can perform very powerful MIDI processing on the fly, without affecting the actual MIDI events on the track.

The Logical Editor is described in a separate chapter (see page 562). There you will also find the few differences between the Logical Editor and the Transformer clearly stated.
Managing plug-ins

Selecting Plug-in Information from the Devices menu opens a window in which all loaded plug-ins, audio and MIDI, are listed.

- To view the MIDI effect plug-ins, click the MIDI Plug-ins tab.

- The leftmost column allows you to deactivate plug-ins. This is useful if you have plug-ins installed that you don’t want to use in Cubase SX/SL. Only plug-ins that are activated (ticked checkbox) will appear on the MIDI effect pop-up menus.

- The second column shows how many instances of each plug-in are currently used in the project.

- The remaining columns show various information about each plug-in and cannot be edited.
The Channel section

At the bottom of the Inspector, you will find a section labeled “Channel”. This contains a single channel strip, allowing you to set volume, pan, mute/solo and other parameters for the track.

- This is a “mirror” of the track’s channel strip in the Cubase SX/SL mixer – for details see page 148.
Merge MIDI in Loop

As mentioned, the parameters and effects described in this chapter do not change the MIDI events themselves, but work rather like “filters”, affecting the music on playback. However, sometimes you may want to make these settings permanent, i.e. convert them to “real” MIDI events on the track. You might for example want to transpose a track and then edit the transposed notes in a MIDI editor. For this, you need to use the Merge MIDI in Loop function on the MIDI menu. This combines all MIDI events on all unmuted tracks, applies track parameters and effects and generates a new MIDI part, containing all the events as you would hear them play back.

1. Make sure only the desired MIDI track(s) are unmuted.
   If you only want to include events from a single track in the Merge operation, you may want to solo the track.

2. Set up the left and right locator around the area you want to merge.
   Only events starting within this cycle area will be included.

3. Select the track on which you want the new part to be created.
   This could be a new track or an existing track. If there are data in the cycle area on the track, you can choose whether this should be kept or overwritten (see below).

4. Select Merge MIDI in Loop from the MIDI menu.
5. Fill in the dialog that appears. The options in the dialog are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include Inserts</td>
<td>If this is activated, any MIDI insert effects activated for the track(s) will be applied.</td>
</tr>
<tr>
<td>Include Sends</td>
<td>If this is activated, any MIDI send effects activated for the track(s) will be applied.</td>
</tr>
<tr>
<td>Erase Destination</td>
<td>If this is activated, all MIDI data between the left and right locator on the destination track will be deleted.</td>
</tr>
</tbody>
</table>

6. Click OK.
A new part is created between the locators on the destination track, containing the processed MIDI events.

**Applying effects to a single part**

Normally, the MIDI track parameters and effects affect a whole MIDI track. This may not always be what you want – you may want to apply some MIDI effects to a single part for example (without having to create a separate track for that part only). The Merge MIDI in Loop function can help:

1. Set up your track parameters and MIDI effects the way you want them for the part.
This will of course affect the whole track, but focus on the part for now.

2. Set the locators to encompass the part.
This is easiest done by selecting the part and selecting Locators to Selection from the Transport menu (or using the corresponding key command, by default [P]).

3. Make sure the track holding the part is selected in the track list.

4. Select Merge MIDI in Loop.

5. In the dialog that appears, activate the desired effect options, make sure that Erase Destination is activated and click OK.
Now a new part is created on the same track, containing the processed events. The original part is deleted.

6. Turn off or reset all track parameters and effects, so that the track plays back as usual.
MIDI processing and quantizing
Introduction

This chapter describes the various MIDI processing functions available on the MIDI menu. These offer various ways to change MIDI notes and other events, in the Project window or within a MIDI editor.

MIDI functions vs. track parameters

In some cases, the result of a MIDI function can also be obtained by using MIDI track parameters and effects (see page 422). For example, the MIDI functions transpose and quantize are also available as a track parameter and a MIDI effect, respectively. The main difference is that track parameters don’t affect the actual MIDI events on the track in any way, while MIDI functions change the events “permanently” (although recent changes can be undone). Use the following guidelines to decide which path to choose:

• If you want to adjust a few parts or events only, use MIDI functions. The track parameters and effects affect the output of the whole track (although they can be made permanent in a specific area with the Merge MIDI in Loop function).
• If you want to experiment with different settings, track parameters can be the best way to go.
• Track parameter settings are not reflected in the MIDI editors, since the actual MIDI events aren’t affected. This can be potentially confusing; if you’ve e.g. transposed notes using track parameters, the MIDI editors will still show the notes with their original pitch (but they will play back at their transposed pitch). MIDI functions can be a better way in those cases.

Of course, there are also MIDI functions that have no track parameter counterpart, and vice versa.

What is affected by the MIDI functions?

Which events are affected when you use a MIDI function depends on the function, the active window and the current selection:

• A MIDI function may only apply to MIDI events of a certain type.
  For example, quantization affects notes only, while the Delete Controllers function obviously applies to MIDI controller events.
• In the Project window, the MIDI functions apply to all selected parts, affecting all events (of the relevant types) in them.
• In the MIDI editors, the MIDI functions apply to all selected events. If no events are selected, all events in the edited part(s) will be affected.
Quantizing

What is quantizing?

Quantizing in its fundamental form is a function that automatically moves recorded notes, positioning them on exact note values:

For example, if you record a series of eighth notes, some of them may end up slightly beside the exact eighth note positions.

Quantizing the notes with the quantize grid set to eighth notes will move the “misplaced” notes to exact positions.

However, quantizing is not only a method of correcting errors, it can also be used creatively in various ways. For example, the “quantize grid” does not have to consist of perfectly straight notes, some notes can automatically be excluded from quantizing, etc.

- **When quantizing MIDI, only the notes are affected (not other event types).** It is also possible to quantize audio events, which is especially useful when working with Cubase SX/SL’s loop splicing features – see page 362.
Setting Up

At its most basic, setting up quantizing consists of selecting a note value from the Quantize pop-up menu on the toolbar (in the Project window or a MIDI Editor).
By default, this allows you to quantize to exact note values (straight, triplet or dotted notes) only. If you want more options, select “Quantize Setup...” from the MIDI menu (or “Setup...” from the Quantize pop-up menu) to open the Quantize Setup dialog.

Any settings you make in the dialog are immediately reflected in the Quantize pop-up menus. However, if you want your settings permanently available on the Quantize pop-up menus, you have to use the Presets functions (see page 471).

The dialog contains the following settings:

**Grid display**

The grid display shows one bar (four beats), with blue lines indicating the quantize grid (the positions that notes will be moved to).
The Grid and Type pop-ups

These are used to determine the basic note value for the quantizing grid. In other words, these have the same functionality as the Quantize pop-up menu on the Toolbar.

Eighth note triplets selected as quantizing grid.

Swing

The Swing slider is only available when a straight note value is selected for the grid and Tuplet is off (see below). It allows you to offset every second position in the grid, creating a swing or shuffle feel. When you adjust the Swing slider, the result is shown in the grid display below.

A straight eighth note grid compared with a grid with 62% swing.

Tuplet

Allows you to create more rhythmically complex grids, by dividing the grid into smaller steps.
Magnetic Area

This allows you to specify that only notes within a certain distance from the grid lines should be affected by quantizing.

- When the slider is set to 0%, the Magnetic Area function is deactivated, i.e. all notes are affected by quantizing.
If you move the slider gradually to the right, you will note how the magnetic areas are shown around the blue lines in the grid display.

![Magnetic Area](image)

Only notes within the indicated zones will be affected by quantizing.

Presets

The controls in the lower left corner of the dialog allow you to store the current settings as a Preset, available on the Quantize menus in the Toolbars. The usual Preset procedures apply:

- To store the settings as a Preset, click the Store button.
- To “load” a stored Preset, showing the stored settings in the dialog, just select it from the pop-up menu.
  This is useful if you want to modify an existing Preset.
- To rename the selected Preset, double click on the name and type a new one.
- To remove a stored Preset, select it from the pop-up menu and click Remove.
- **You can also create Presets by having the program analyze an audio event and extract the groove in the audio.**
  See page 376.
Auto and Apply

These functions allow you to apply quantizing directly from the dialog, as described below.

☑ If you don't want to apply the quantizing you have set up in the dialog, you can close the window by clicking its standard close box. You can also leave the dialog open while you continue working.

The Non Quantize setting

This is an additional setting that affects the result of the quantizing. It allows you to set a “distance” in ticks (120ths of sixteenth notes).

Events that already are within the specified distance from the quantize grid will not be quantized. This allows you to keep slight variations when you quantize, but still correct notes that are too far from the grid.

The Random Quantize setting

This is an additional setting that affects the result of the quantizing. It allows you to set a “distance” in ticks (120ths of sixteenth notes).

Events will be quantized to random positions within the specified “distance” from the quantize grid, thus creating a more “loose” quantizing. Much like the Non Quantize setting, this allows for slight variations, while at the same time keeping notes from ending up too far from the grid.

The Iterative Strength setting

This affects the results of the Iterative Quantize function, as described below.
Applying quantize

There are several ways to apply the quantize:

- The standard method is to select “Over Quantize” from the MIDI menu (or using a key command, by default [Q]). This quantizes the selected MIDI parts or notes, according to the current Quantize pop-up menu setting.

- You can also apply quantizing directly from the Quantize Setup dialog, by clicking the “Apply” button.

- If you activate the “Auto” checkbox in the Quantize Setup dialog, any change you make in the dialog is immediately applied to the selected MIDI parts or notes. A great way of using this feature is to set up a playback loop, and adjust the settings in the dialog until you get the desired result.

When you apply quantize, the result is based on the original position of the notes. Therefore, you can freely try different quantize settings with no risk of “destroying” anything. See also Undo and Freeze Quantize, below.

The Auto Quantize function

If you activate the AQ button on the Transport panel, all MIDI recordings you make are automatically quantized according to the settings you have made in the Quantize Setup dialog.
Iterative Quantize

Another way to apply “loose” quantization is to use the Iterative Quantize function on the MIDI menu. It works like this:

Instead of moving a note to the closest quantize grid position, Iterative Quantize moves it only part of the way. You specify how much the notes should be moved towards the grid with the Iterative Strength setting in the Quantize Setup dialog.

Iterative Quantize is also different from “regular” quantization, in that the operation is not based on the notes’ original positions but on their current, quantized position. This makes it possible to repeatedly use Iterative Quantize, gradually moving the notes closer to the quantize grid until you’ve find the desired timing.

Quantize Lengths

- This function is only available from within the MIDI editors.

This function (on the Advanced Quantize submenu on the MIDI menu) will quantize the length of the notes, without changing their start positions. At its most basic level, this function will set the length of the notes to the Length Quantize value on the MIDI editors’ toolbar.
However, if you have selected the “Linked to Quantize” option on the Length Quantize pop-up menu, the function will resize the note according to the quantize grid, taking the Swing, Tuplet and Magnetic Area settings into account. An example:

1. Length Quantize set to “Linked to Quantize”.

2. Some notes, all a 1/16th note of length.

3. Here, the quantize value has been set to straight 1/16th notes with Swing at 100%. Since Snap is activated (see page 559), the quantize grid is reflected in the note display’s grid.

4. Selecting Quantize Lengths will adjust the note lengths according to the grid. If you compare the result to the first figure above, you will find that notes that started within the odd sixteenth note “zones” got the longer grid length, and notes in the even zones got the shorter length.
Quantize Ends

The Quantize Ends function on the Advanced Quantize submenu will only affect the end positions of notes. Apart from that, it works just like regular quantizing, taking the Quantize pop-up menu setting into account.

Undo and Freeze Quantize

As mentioned above, the original position of each quantized note is stored. Therefore, you can make the selected MIDI notes revert to their original, unquantized state at any time, by selecting Undo Quantize from the Advanced Quantize submenu. This is independent from the regular Undo History.

However, there may be situations when you want to make the quantized positions “permanent”. For example, you may want to quantize notes a second time, having the results based on the current quantized positions rather than the original positions. To make this possible, select the notes in question and select “Freeze Quantize” from the Advanced Quantize submenu. This makes the quantized positions permanent.

After you have performed a Freeze Quantize for a note, you cannot undo its quantization.
Other MIDI menu functions

The Transpose item and the items on the Functions submenu contain the following functions:

**Transpose**

Opens a dialog with settings for transposing the selected notes:

![Transpose dialog](image)

**Semitones**

This is where you set the amount of transposition.

**Keep Notes in Range**

When this checkbox is activated, transposed notes will remain within the Upper and Lower Barrier values.

- If a note ends up outside the barriers after transposition, it will be shifted to another octave, keeping the correct transposed pitch if possible. If this isn’t possible (if you have set a very narrow range between the Upper and Lower Barrier), the note will be transposed “as far as possible”, i.e. to the Upper or Lower Barrier note. If you set the Upper and Lower Barriers to the same value, all notes will be transposed to this pitch!

**OK and Cancel**

Clicking OK performs the transposition. Clicking Cancel closes the dialog without transposing.
**Legato**

Extends each selected note so that it reaches the next note. You can specify the desired gap or overlap with the “Legato Overlap” setting in the Preferences dialog (MIDI–Function Parameters page).

When using Legato with this setting, each note will be extended to end 5 ticks before the next note.

**Fixed Lengths**

- **This function is only available from within the MIDI editors.**

This function resizes all selected notes to the length set with the Length Quantize pop-up menu on the MIDI editor toolbar.

**Delete Doubles**

This function removes double notes, i.e. notes of the same pitch on the exact same position. Double notes can occur when recording in Cycle mode, after Quantizing, etc.

- **This function always affects whole MIDI parts.**

**Delete Controllers**

This function removes all non-note events from the selected MIDI parts.

- **This function always affects whole MIDI parts.**
Delete Notes

Allows you to delete very short or weak notes. This is useful for automatically removing unwanted “ghost notes” after recording. Selecting “Delete Notes...” opens a dialog in which you set up the criteria for the function:

The parameters have the following functionality:

Minimum Length

When the Minimum Length checkbox is activated, the note length is taken into account, allowing you to remove short notes. You can either specify the minimum length (for notes to be kept) in the value display or by dragging the blue line in the graphical length display below.

- The graphical length display can correspond to 1/4 bar, one bar, two bars or four bars.
  You change this setting by clicking in the field to the right of the display.

Minimum Velocity

When the Minimum Velocity checkbox is activated, the velocity of notes is taken into account, allowing you to remove weak notes. You specify the minimum velocity (for notes to be kept) in the value display.
Remove when under

This setting is only available when both Minimum Length and Minimum Velocity is activated. By clicking the value display, you select whether both length and velocity criteria must be met for notes to be deleted, or whether one of the criteria will suffice.

OK and Cancel

Clicking OK performs the automatic delete according to the rules set up. Clicking Cancel closes the dialog without deleting notes.

Restrict Polyphony

Selecting this item opens a dialog in which you can specify how many “voices” should be used (for the selected notes or parts). Restricting the polyphony this way is useful when you have an instrument with limited polyphony and want to make sure all notes will be played. The effect is achieved by shortening notes as required, so that they end before the next note starts.

Pedals to Note Length

This function scans for Sustain pedal on/off events, lengthens the affected notes to match the Sustain pedal off position, and then removes the Sustain Controller on/off events.

Delete Overlaps (mono)

This function allows you to make sure that no two notes of the same pitch overlap (i.e. that one starts before the other ends). Overlapping notes of the same pitch can confuse some MIDI instruments (a new Note On is transmitted before the Note Off is transmitted). This command can then be used to automatically rectify the problem.

Delete Overlaps (poly)

This function shortens notes when required, so that no note begins before another ends. This happens regardless of which pitch the notes have.
Velocity

This function opens a dialog that allows you to manipulate the velocity of notes in various ways.

![Velocity Dialog](image)

To apply the function, select one of the three processing types from the Type pop-up, adjust the settings and click OK (to close the dialog without applying, click Cancel).

The following types of velocity processing are available:

**Add/Subtract**

This simply adds a fixed number to the existing velocity values. You set the value (positive or negative) with the Amount parameter.

**Compress/Expand**

Compresses or expands the “dynamic range” of MIDI notes by scaling the velocity values according to the Ratio setting (0 - 300%). The principle behind this is that multiplying different velocity values with a factor higher than 1 (over 100%) will also make the differences between velocity values greater, while using a factor lower than 1 (under 100%) will make the differences smaller. In short:

- To compress (“even out” velocity differences), use ratio values below 100%.
  After compression, you would probably want to add a velocity amount (with the Add/Subtract function) to maintain the average velocity level.
- To expand (create greater difference in velocity), use ratio values above 100%.
  Before you expand, you may want to adjust the velocity with the Add/Subtract function, so that the average velocity is somewhere in the middle of the range. If the average velocity is high (near 127) or low (near 0), expansion will not work properly, simply because velocity values can only be between 0 and 127!
Limit
This function allows you to make sure that no velocity values fall outside a given range (the Lower and Upper values). Any velocity values outside this range are raised/lowered to exactly the Lower/Upper values.

Fixed Velocity
This function sets the velocity of all selected notes to the Insert Velocity value on the toolbar in the MIDI editors.

Reverse
This function inverts the order of the selected events (or of all events in the selected parts), causing the MIDI music to play backwards. Note though, that the effect is different from reversing an audio recording. With MIDI, the individual notes will still play as usual in the MIDI instrument – it’s only the order of playback that is changed.
Dissolve Part

The Dissolve Part function on the MIDI menu has two separate uses:

- When you work with MIDI parts (on MIDI channel "Any") containing events on different MIDI channels. Dissolve Part separates the events according to MIDI channel.
- When you want to separate MIDI events according to pitch. A typical example would be drum and percussion tracks, where each pitch usually corresponds to a separate drum sound.

Dissolving parts into separate channels

Setting a track to MIDI channel "Any" will cause each MIDI event to play back on its original MIDI channel, rather than a channel set for the whole track. There are two main situations when "Any" channel tracks are useful:

- When you record several MIDI channels at the same time. You may for example have a MIDI keyboard with several keyboard zones, where each zone sends MIDI on a separate channel. Recording on an "Any" channel track allows you to play back the recording with different sounds for each zone (since the different MIDI notes play back on separate MIDI channels).

- When you have imported a MIDI file of Type 0. MIDI files of Type 0 contain only one track, with notes on up to 16 different MIDI channels. If you were to set this track to a specific MIDI channel, all notes in the MIDI file would be played back with the same sound; setting the track to "Any" will cause the imported file to play back as intended.

The Dissolve Part function scans MIDI parts for events on different MIDI channels, distributes the events into new parts on new tracks, one for each MIDI channel found. This allows you to work with each musical part individually. Proceed as follows:

1. Select the part(s) containing MIDI data on different channels.
2. Select "Dissolve Part" from the MIDI menu.
3. In the dialog that appears, select the “Separate Channels” option. This is only available if the MIDI track was set to channel “Any”.

MIDI processing and quantizing
Now, for each MIDI channel used in the selected part(s), a new MIDI track is created and set to the corresponding MIDI channel. Each event is then copied into the part on the track with the corresponding MIDI channel. Finally, the original part(s) are muted.

An example:

This part contains events on MIDI channel 1, 2 and 3.

Selecting “Dissolve Part” creates new parts on new tracks, set to channel 1, 2 and 3. Each new part contains only the events on the respective MIDI channel.

Dissolving parts into separate pitches

The Dissolve Part function can also scan MIDI parts for events of different pitch, and distribute the events into new parts on new tracks, one for each pitch. This is useful when the different pitches are not used in a regular melodic context, but rather for separating different sounds (e.g. MIDI drum tracks or sampler sound FX tracks). By dissolving such parts, you can work with each sound individually, on a separate track. Proceed as follows:

1. Select the part(s) containing MIDI data.
2. Select “Dissolve Part” from the MIDI menu.
3. In the dialog that appears, select the “Separate Pitches” option.
   A new MIDI track is created for each used pitch in the selected part(s). The events are then copied into the parts on the track for the corresponding pitch. Finally, the original part(s) are muted.
21

The MIDI Editors
About editing MIDI

There are several ways to edit MIDI in Cubase SX/SL. You can use the tools and functions in the Project window for large-scale editing, or use the functions on the MIDI menu to process MIDI parts in various ways (see page 466). For hands-on graphical editing of the contents of MIDI parts, you use the MIDI editors:

- **The Key Editor** is the default MIDI editor, presenting notes graphically in an intuitive piano roll-style grid. The Key Editor also allows for detailed editing of non-note events such as MIDI controllers.

- **The Drum Editor** is similar to the Key Editor, but takes advantage of the fact that with drum parts, each key corresponds to a separate drum sound. This is the editor to use when you’re editing drum or percussion parts.

- **The List Editor** shows all events in a MIDI part as a list, allowing you to view and edit their properties numerically. Unlike the other editors, in the List Editor you can only view and edit one part at a time.

- **The Score Editor** shows MIDI notes as a musical score. If you are using Cubase SL, the Score Editor offers basic score editing and printing - see page 540 for details. Cubase SX comes with advanced tools and functions for notation, layout and printing, all described in the separate pdf document “Score Layout and Printing” opened from the Start menu (Windows) or the Help menu in the program. However, even if your focus is on creating printed scores we recommend that you study this chapter as well, to get a grip on the common MIDI editing procedures.

- **Finally, you can also edit MIDI in the Project Browser.** Like the List Editor, this shows the events in a list and allows you to perform numerical editing. However, you will probably find the List Editor more suited for MIDI editing, since it has various special features and functions for this. The Project Browser is described in its own chapter, on page 603.

About this chapter

This chapter describes how to use the Key, Drum and List Editor. Please note that a lot of features are identical in these editors (especially in the Key and Drum Editors) – they are all described in the Key Editor section. The sections about the Drum Editor (see page 515) and the List Editor (see page 532) describe the specific features of these editors only.
Opening a MIDI editor

There are two ways to open a MIDI editor:

• Select one or several parts and select Open Key Editor, Open Drum Editor or Open List Editor from the MIDI menu (or use the corresponding key command). Note that the List Editor only opens a single part at a time. For details about opening the Score Editor in Cubase SL, see page 543.

• Double click a part.
Which editor opens depends on the settings in the Preferences (Event Display–MIDI page):

![Preferences dialog]

Double clicking will open the editor selected on the Default Edit Action pop-up menu. However, if the option “Edit as Drums when Drum Map is assigned” is activated and a drum map is selected for the edited track (see page 527), the Drum Editor will open. This way you can double click to open the Key Editor (or the Score or List Editor, depending on your preferences) but drum tracks will automatically open in the Drum Editor.

• If the part you open for editing is a shared copy, any editing you perform will affect all shared copies of this part.
Shared copies are created by pressing [Alt]/[Option]+[Shift] and dragging, or by using the Repeat function with the “Shared copies” option activated. In the Project window, shared copies are indicated by the part name in italics and an icon in the lower right corner of the part (see page 82).
The Key Editor – Overview

The toolbar

As in other windows, the toolbar contains tools and various settings.

- Info line on/off
- Key Editor tools
- Mouse pointer display: Current pitch and Current meter position
- Edit Solo button
- AutoScroll on/off
- Snap on/off
- Length Quantize value
- Color pop-up menu
- Quantize value (also used for Snap)
- Velocity value for created notes
- Audition on/off
- Edit via MIDI input on/off
- Edit via MIDI options
- Step input on/off
- Insert mode on/off
The info line

The info line shows information about selected MIDI notes. You can edit all values on the info line using regular value editing (see page 501 for details). Length and position values are displayed in the format currently selected for the ruler (see below).

- To hide or show the info line, click the “i” icon in the toolbar.

The ruler

The ruler shows the time line, by default in the display format selected on the Transport panel. You can select a separate format for a MIDI editor ruler by clicking the arrow button to the right of it and selecting an option from the pop-up menu that appears. For a list of the available formats, see page 61.

At the bottom of the pop-up menu there are two additional items:

- If “Time Linear” is selected, the ruler, note display and controller display will be linear in relation to time. This means that if the ruler shows bars and beats, the distance between the bar lines will vary depending on the tempo.

- If “Bars+Beats Linear” is selected, the ruler, note display and controller display will be linear in relation to tempo. This means that if the ruler shows bars and beats, the distance between beats will be constant.

In most cases, you would probably set the display format to “Bars+Beats” in “Bars+Beats Linear” mode when editing MIDI.
The note display

The note display is the main area in the Key Editor. It contains a grid, in which MIDI notes are shown as boxes. The width of a box corresponds to the note length, and the vertical position of a box corresponds to the note number (pitch), with higher notes higher up in the grid. The piano keyboard to the left serves as a guide for finding the right note number.
The controller display

The area at the bottom of the Key Editor window is the controller display. This consists of one or several controller lanes, each showing one of the following properties or event types:

- Velocity values of the notes.
- Pitch Bend events.
- Aftertouch events.
- Poly Pressure events.
- Program Change events.
- Any type of continuous controller event.

Velocity values are shown as vertical bars in the controller display, with higher bars corresponding to higher velocity values:

Each velocity bar corresponds to a note in the note display.
Events in the controller display (that is, anything other than velocity values) are shown as “blocks”, the heights of which correspond to the “values” of the events. However, events that have been recorded (or drawn with a low quantize value) may appear more like “filled curves”, simply because they are positioned very closely:

Unlike notes, events in the controller display have no length. The value of an event in the display will be “valid” until the start of the next event:

• To change the size of the controller display, drag the divider between the controller display and the note display. This will make the controller display larger and the note display smaller, or vice versa. For a description of editing in the controller display, see page 505.
Key Editor operations

Zooming

Zooming in the Key Editor is done according to the standard zoom procedures, using the zoom sliders, the Magnifying Glass tool or the Zoom submenu on the Edit menu.

Playing back

You can play back your music as usual when working in a MIDI editor. There are a couple of features making it easier to edit during playback:

Solo button

If you activate the Solo button, only the edited MIDI parts will be heard during regular playback.

Autoscroll

As described on page 100, the Autoscroll function makes the window “follow” the project cursor during playback, so that the current play position is visible at all times. However, when you are working in a MIDI editor, you may want to deactivate Autoscroll – this way, the events you are working with will stay visible.

The Autoscroll button on the toolbar of each MIDI editor is independent for the editor. For example, this means you can have Autoscroll deactivated in the Key Editor and activated in the Project window, should you so like.
Auditioning

If the speaker icon on the toolbar is activated, individual notes will automatically be played back (auditioned) when you move or transpose them, or when you create new notes by drawing. This makes it easier to hear what you’re doing.

Creating and editing notes

Drawing notes

To draw new notes in the Key Editor, you use the Pencil tool. In the default “Draw” mode (see below), you insert single notes by clicking with the Pencil tool at the desired time position and pitch (height).

• When you move the pointer in the note display, its bar position is indicated in the toolbar, and its pitch is indicated both in the toolbar and on the piano keyboard to the left. This makes it easy to find the right note and insert position.

• If Snap is activated, this determines the start position of the created note (see page 559).
• If you just click once, the created note will get the length set on the Length Quantize pop-up menu on the toolbar.
  You can create a longer note by clicking and dragging the pointer with the mouse button pressed. The length of the created note will be a multiple of the Length Quantize value.

• The notes will get the Insert Velocity value set on the toolbar.

• Just like the Arrow tool in the Project window, the Pencil tool has several different modes.
  To select one of the modes, click on the Pencil tool icon on the toolbar when the tool is already selected. This opens a pop-up menu from which you can select one of the Pencil modes.

The tool icon will change appearance according to the selected mode.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draw</td>
<td>This inserts single notes, as described above.</td>
</tr>
<tr>
<td>Paint</td>
<td>Allows you to insert multiple notes by dragging with the mouse button pressed. If Snap is activated, the notes will be positioned and sized according to the Quantize and Length Quantize values. If you press [Ctrl]/[Command] while painting, movement will be restricted to horizontal only (i.e. the painted notes will have the same pitch).</td>
</tr>
<tr>
<td>Line</td>
<td>When this mode is selected, you click and drag to create a straight line, in any angle. When you release the mouse button a series of notes will be created, aligned with the line. If Snap is activated, the notes will be spaced and sized according to the Quantize value.</td>
</tr>
<tr>
<td>Parabola, Sine, Triangle, Square</td>
<td>These modes insert events along different curve shapes. While they can be used for creating notes, they're probably best suited for controller editing (see page 509).</td>
</tr>
</tbody>
</table>
Selecting notes

Selecting notes is done using any of the following methods:

- Use the Arrow tool.
  The standard selection techniques apply.
- Use the Select submenu on the Quick menu.
  The options are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Selects all notes in the edited part.</td>
</tr>
<tr>
<td>None</td>
<td>Deselects all events.</td>
</tr>
<tr>
<td>In Loop</td>
<td>Selects all notes that are partially or completely inside the boundaries of the left and right locators.</td>
</tr>
<tr>
<td>From Start to Cursor</td>
<td>Selects all notes that begin to the left of the project cursor.</td>
</tr>
<tr>
<td>From Cursor to End</td>
<td>Selects all notes that end to the right of the project cursor.</td>
</tr>
</tbody>
</table>

- You can also use the left and right arrow keys on the computer keyboard to step from one note to the next or previous.
  If you press [Shift] and use the arrow keys, the current selection will be kept, allowing you to select several notes.
- To select all notes of a certain pitch, press [Ctrl]/[Command] and click on the desired key in the keyboard display to the left.

All notes of the corresponding pitch are selected.

- You can also press [Shift] and double click on a note to select all the following notes of the same pitch.
- If the option “Auto Select Events under Cursor” is activated in the Preferences dialog (Editing page), all notes currently “touched” by the project cursor are automatically selected.
Moving and Transposing notes

To move notes in the editor, use any of the following methods:

• Click and drag to a new position.
  All selected notes will be moved, maintaining their relative positions. If Snap is activated, this determines to which positions you can move the notes, see page 559.

† Note also that you can restrict movement to horizontal or vertical only by holding down [Ctrl]/[Command] while dragging.

• Use the up and down arrow keys on the computer keyboard.
  This method allows you to transpose the selected notes, without risking to move them horizontally. You can also use the Transpose function (see page 477) or the info line (see page 489) for this. Note that pressing [Shift] and using the up and down arrow keys will transpose notes in steps of one octave.

• Use the Move to Cursor function on the Edit menu.
  This moves the selected notes to the project cursor position.

• Select a note and adjust its position or pitch on the info line.
  See page 501.

  You can also adjust the position of notes by quantizing (see page 467).

Duplicating and Repeating notes

Notes are duplicated much in the same way as events in the Project window:

• Hold down [Alt]/[Option] and drag the note(s) to a new position.
  If Snap is activated, this determines to which positions you can copy the notes (see page 559).

• Selecting “Duplicate” from the Edit menu creates a copy of the selected note and places it directly after the original.
  If several notes are selected, all of these are copied “as one unit”, maintaining the relative distance between the notes.

• Selecting “Repeat” from the Edit menu opens a dialog, allowing you to create a number of copies of the selected note(s).
  This works just like the Duplicate function, except that you can specify the number of copies.
Using cut and paste

You can use the Cut, Copy and Paste functions on the Edit menu to move or copy material within a part or between different parts. When you paste copied notes, you can either use the regular Paste function or the Paste Time function on the Edit menu’s Range submenu.

- “Paste” inserts the copied notes at the project cursor position, without affecting existing notes.
- “Paste Time” inserts at the project cursor position, but moves (and if necessary, splits) existing notes to make room for the pasted notes.

Selecting “Paste Time” with this data on the Clipboard and the project cursor here...

...will give you this:
Resizing notes

To resize a note, use one of the following methods:

- Position the arrow tool at the start or end of the note, so that the pointer takes on the shape of a small double arrow. Click and drag to the left or right to resize the note. This method allows you to resize the note from either direction.

- Click with the Pencil tool within the note box and drag to the left or the right (to make the note shorter or longer, respectively).

  With both these methods, the resulting length will be a multiple of the Length Quantize value on the toolbar.

- Select the note and adjust its length on the info line. See page 501 for details on info line editing.

Splitting notes

There are three ways to split notes:

- Clicking on a note with the Scissors tool splits the note at the position you pointed (taking the Snap setting into account if activated). If several notes are selected, they are all split at the same position if applicable.

- If you select “Split at Cursor”, all notes that are intersected by the project cursor are split at the cursor position.

- If you select “Split Loop”, all notes that are intersected by the left or right locator are split at the locator positions.

Gluing notes

Clicking on a note with the Glue tube tool will "glue it together" with the next note of the same pitch. The result will be one long note spanning from the start of the first note to the end of the second note, and with the properties (velocity, etc.) of the first note.
Muting notes

Individual notes can be muted in the Key Editor, as opposed to muting an entire MIDI part in the Project window. This allows you to exclude notes from playback, but keep the option to bring them back again at any time. To mute a note, use one of the following methods:

- Click on it with the Mute tool.
- Select the Mute tool and drag a rectangle, enclosing all notes you want to mute.
- Select the note(s) and choose Mute from the Edit menu.

The default key command for this is [Shift]+[M].

Muted notes are “dimmed” in the note display.

To unmute a note, either click it or enclose it with the Mute tool, or select it and choose Unmute from the Edit menu. The default key command for this is [Shift]+[U].

Deleting notes

To delete notes, either click on them with the Eraser tool or select them and press [Backspace].
Editing on the info line

The info line shows the values and properties of the selected event(s). If a single event is selected, its values are displayed in light blue on the info line. If several events are selected, the info line shows the values of the first of these events, in yellow.

![Several events selected.](image)

You can edit the values on the info line using regular value editing. This allows you to move, resize, transpose or change velocity of events in a very precise manner.

- **If you have several events selected and change a value, all selected events will be changed relatively.**
  In other words, the value will be changed by an equal amount for all selected events.

- **If you have several events selected, hold down [Ctrl]/[Command] and change a value, the change will be absolute.**
  In other words, the value setting will be the same for all selected events.
**Editing Notes via MIDI**

You can change the properties of notes via MIDI. For example, this can be a fast way to get the right velocity value, since you will hear the result even as you edit:

1. Select the note you want to edit.
2. Click on the MIDI connector symbol on the toolbar.

   ![MIDI connector symbol](image)

   The symbol should be lit. This enables editing via MIDI.

3. Use the note buttons on the toolbar to decide which properties should be changed by the MIDI input.
   You can enable editing of pitch, note-on and/or note-off velocity.

   ![Note buttons](image)

   With this setting, the edited notes will get the pitch and velocity values of the notes input via MIDI, but the note-off velocities will be kept as they are.

4. Play a note on your MIDI instrument.
   The note selected in the editor will get the pitch, velocity and/or note-off velocity of the played note.

   The next note in the edited part is automatically selected, making it easy to quickly edit a series of notes.

   - If you want another try, select the note again (easiest by pressing the [←] key on the computer keyboard) and again play a note on your MIDI instrument.
Step input

Step input, or step recording, is when you enter notes one at a time (or one chord at a time) without worrying about the exact timing. This is useful e.g. when you know the part you want to record but are not able to play it exactly as you want it.

Proceed as follows:

1. Click the “foot button” on the toolbar to activate Step input mode.

![Step input mode](image)

2. Use the note buttons to the right to decide which properties should be included when you input the notes.
   For example, you may not want to include the velocity and/or note-off velocity of the played notes. It’s also possible to turn off the pitch property, in which case all notes will get the pitch C3, no matter what you play.

3. Click anywhere in the note display to set the start position (the desired position of the first note or chord).
   The step input position is shown as a blue line in the note display, and in the lower mouse pointer display in the toolbar.

![Step input display](image)

4. Specify the desired note spacing and length with the Quantize and Length Quantize pop-up menus.
   The notes you input will be positioned according to the Quantize value and have the length set with the Length Quantize value. For instance, if you set Quantize to 1/8 notes and Length Quantize to 1/16 note, the notes will be sixteenth notes, appearing on each eighth note position.
5. Play the first note or chord on your MIDI instrument.
The note or chord appears in the editor and the step input position advances one quantize value step.

- If Insert mode is activated, all notes to the right of the step input position will be moved to "make room" for the inserted note or chord.

6. Continue in the same way with the rest of the notes or chords.
You can adjust the Quantize or Length Quantize value as you go along, to change the timing or note lengths. You can also move the step input position manually by clicking anywhere in the note display.

- To insert a "rest", press the right arrow key on the computer keyboard. This advances the step input position one step.

7. When you're done, click the foot button to deactivate step input.
Editing in the controller display

About controller lanes

By default, the controller display has a single lane, showing one event type at a time. However, you can easily add lanes by right-clicking in the display and selecting “Create new controller lane” from the Quick menu. This allows you to view and edit different controllers at the same time.

To remove a lane, right-click in it and select “Remove this Lane” from the Quick menu.
This hides the lane from view – it doesn’t affect the events in any way.

If you remove all lanes, the controller display will be completely hidden.
To bring it back again, select “Create new controller lane” from the Quick menu.
Selecting event type

Each controller lane shows one event type at a time. To select which event type should be displayed, use the pop-up menu to the left of the lane.

- Selecting “Setup...” opens a dialog in which you can specify which Continuous Controller event types you want available on the pop-up menu.

Controller types in this list are already listed on the pop-up menu.

Controller types in this list are not listed on the pop-up menu.

Click this button to remove the Controller type selected in the left list from the pop-up menu.

Click this button to add the selected Controller type to the pop-up menu.
**Editing velocity values**

When “Velocity” is selected for viewing, the lane shows the velocity of each note as a vertical bar.

Velocity values are edited with the Pencil tool. The different Pencil tool modes offer the following possibilities:

- In Draw mode, you can use the Pencil tool to change the velocity of a single note: click on its velocity bar and drag the bar up or down. While you drag, the current velocity value is shown in the display to the left.
- You can use Draw mode or Paint mode to change the velocity values of several notes by painting a “freehand curve”. When editing velocity, these two modes have the same functionality.
• Use Line mode for creating linear velocity ramps. Click where you want the ramp to start and drag the cursor to where you want the ramp to end. When you release the mouse button, the velocity values are aligned with the line between the two points.

• Parabola mode works in the same way, but aligns the velocity values with a Parabola curve instead. Use this for smooth, “natural” velocity fades, etc.

• The remaining three modes align the velocity values with continuous curve shapes (see below).

Note:

• If there is more than one note on the same position (e.g. a chord), their velocity bars will overlap in the controller lane.
  If none of the notes are selected, all notes at the same position will be set to the same velocity value when you draw. To edit the velocity of only one of the notes at the same position, first select the note in the note display. Now, editing will only affect the velocity of the selected note.
  You can also adjust the velocity of a single note by selecting it and changing its velocity value on the info line.
Adding and editing events in the controller display

When any option other than “Velocity” is selected for viewing in a controller lane, you can create new events or edit the values of existing events using the Pencil tool in its various modes:

- Clicking with the Pencil tool in Draw mode or Paint mode creates a new event.
- To modify the value of an event (without creating a new one), press [Alt]/[Option] and use the Pencil tool.

Note that you can click and drag to change or add multiple events, draw controller curves, etc. You can press or release [Alt]/[Option] while drawing, switching dynamically between “edit mode” and “create mode”.

If you want to enter or adjust a single event, click once with the Pencil:

If you want to “paint a curve”, drag the Pencil (with the mouse button pressed):

When you move the pointer in the controller lane, the corresponding value is displayed in this field.

- Clicking and dragging with the Pencil tool in Line mode shows a line in the controller lane, and creates events with values aligned with this line.

This is the best way to draw linear controller ramps. If you press [Alt]/[Option], no new events are created – use this mode for modifying existing controller curves.

Converting a Controller curve to a ramp using the Line tool:
• The Parabola mode works in the same way, but aligns the values with a parabola curve instead, giving more “natural” curves and fades. Note that the result depends on from which direction you draw the parabola:

• In Parabola mode you can use modifier keys to determine the shape of the parabola curve.
  If you press [Ctrl]/[Command] the parabola curve will be reversed, if you press [Alt]+[Ctrl] (Win)/[Option]+ [Command] (Mac) while snap is activated you can change the position of the whole curve (in both cases the snap value for the positioning will be a quarter of the Quantize value). If you press [Shift], the exponent will be increased or decreased.

• For the above modes, the Length Quantize value on the toolbar determines the “density” of created controller curves (if Snap is activated).
  For very smooth curves, you should use a small Length Quantize value or turn off Snap. However, please note that this creates a very large number of MIDI events, which can cause MIDI playback to “stutter” in some situations. A medium-low density is often sufficient.

• The Sine, Triangle and Square modes create events with values aligned to continuous curves.
  In these modes, the Quantize value determines the period of the curve (the length of one curve “cycle”) and the Length Quantize value determines the density of the events (the lower the Length Quantize note value, the smoother the curve).
• In Sine, Triangle and Square mode you can also use modifier keys to determine the shape of the curve. If you press [Ctrl]/[Command] you can change the phase of the beginning of the curve, if you press [Alt]+[Ctrl] (Win)/[Option]+[Command] (Mac) while snap is activated you can change the position of the whole curve (in both cases the snap value for the positioning will be a quarter of the Quantize value).

![Image](image1.png)

• You can also set the curve period freely by holding down [Shift] when you insert events in Sine, Triangle or Square mode. Activate Snap, [Shift]-click and drag to set the length of one period. The period length will be a multiple of the Quantize value.

• In Triangle and Square mode you can press [Shift]+[Ctrl]/[Command] to change the maximum position of the triangle curve (to create sawtooth curves) or the pulse of the square curve. As in other modes, you can press [Alt]/[Option] if you want to change the existing events rather than creating new ones. Again, the snap value for the positioning will be a quarter of the Quantize value.

![Image](image2.png)
Moving and copying events

You can move or duplicate events in a controller lane, much like you can with notes:

1. Use the Arrow tool to select the events you want to cut or copy.
   To select more than one event, [Shift]-click or drag a selection rectangle, according to the standard selection procedures.

2. Click and drag the events to move them.
   If Snap is activated, this determines to which positions you can move the events (see page 559).
   • If you hold down [Alt]/[Option] and drag, the events will be copied rather than moved.

☐ If there already is an event of the same type at the exact same position, this will be replaced by the moved event.

☐ Remember that a non-note event doesn’t have a length – it’s "valid" until the next event (see page 492).

Using Cut, Copy and Paste

You can use the standard Cut, Copy and Paste functions on the Edit menu to move or copy events in the controller display:

1. Select the notes you want to cut or copy.

2. Select Cut or Copy from the Edit menu.

3. If you want to paste the events into another MIDI part, open that part in a Key Editor.

4. Position the project cursor where you want to paste the events.

5. Select Paste from the Edit menu.
   The events on the Clipboard are added, starting at the project cursor position, maintaining their relative positions. If a pasted event ends up at the same position as an existing event of the same type, the old event is replaced.
Deleting events in the controller display

You delete events by clicking with the Eraser tool or by selecting them and pressing [Backspace]. Please note:

- Deleting a controller event makes the last event before this valid up until the next event. It does not "zero" any Controller changes. See page 492.
- You can delete notes by deleting their velocity bars in the controller display.
  Please be aware that if there is more than one note on the same position, there may still only be one velocity bar visible – make sure you delete only the desired notes!

Adding and Editing Poly Pressure events

Poly Pressure events are special, in that they “belong to” a specific note number (key). That is, each Poly Pressure event has two editable values: the note number and the amount of pressure. Therefore, when Poly Pressure is selected on the event Type pop-up menu, there are two value fields to the left of the controller display, one for the note number and one for the amount:
To add a new Poly Pressure event, proceed as follows:

1. Select Poly Pressure on the event type pop-up menu.

2. Set the note number by clicking on the keyboard display.
   Note that this only works for the topmost lane. If you have selected "Poly Pressure" for several controller lanes, you have to type in the desired note number directly in the lower value field to the left of each lane. The selected note number is displayed in the lower value field to the left of the controller display.

3. Use the Pencil tool to add a new event, just as when adding regular Controller events.

To view and edit existing Poly Pressure events, proceed as follows:

1. Select Poly Pressure on the event type pop-up menu.

2. Click on the arrow button next to the note number field to the left of the controller lane.
   A pop-up menu appears, listing all note numbers for which there already are Poly Pressure events.

3. Select a note number from the pop-up menu.
   The Poly Pressure events for the selected note number are shown in the controller lane.

4. Use the Pencil tool to edit the events as usual.
   Press [Alt]/[Option] to edit existing events without adding any new ones.

- Poly Pressure events can also be added and edited in List Edit.
The Drum Editor – Overview

The toolbar and info line

These are much the same as the toolbar and info line in the Key Editor, with the following differences:

- The Drum Editor has no Pencil tool – instead there is a Drumstick tool (for inputting and removing notes) and a Paint tool with various line and curve modes (for painting several notes in one go or editing controller events).
- There are no Scissors and Glue Tube tools in the Drum Editor.
- As in the Key Editor, the mouse pointer display in the toolbar shows the pitch and position of the pointer, but the pitch is shown as a drum sound name rather than a note number.
- The Global Quantize button allows you to select which value should be used when Snap is on – the global quantize value on the toolbar or the individual quantize values for the drum sounds.
- Instead of a Length Quantize setting, there is an Insert Length pop-up menu. It is used in much the same way, as described on the following pages.
The drum sound list

<table>
<thead>
<tr>
<th>Pitch</th>
<th>Instrument</th>
<th>Chan</th>
<th>Quantize</th>
<th>Midi</th>
<th>Octave</th>
<th>Note</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>C#1</td>
<td>Side Stick</td>
<td>19</td>
<td>1/16 Note</td>
<td>C#1</td>
<td>C#1</td>
<td>1</td>
<td>Default</td>
</tr>
<tr>
<td>D1</td>
<td>Acoustic Snare</td>
<td>19</td>
<td>1/16 Note</td>
<td>D1</td>
<td>D1</td>
<td>1</td>
<td>Default</td>
</tr>
<tr>
<td>E1</td>
<td>Electric Snare</td>
<td>19</td>
<td>1/16 Note</td>
<td>E1</td>
<td>E1</td>
<td>1</td>
<td>Default</td>
</tr>
<tr>
<td>F1</td>
<td>Low Floor Tom</td>
<td>19</td>
<td>1/16 Note</td>
<td>F1</td>
<td>F1</td>
<td>1</td>
<td>Default</td>
</tr>
<tr>
<td>G1</td>
<td>Bass Drum</td>
<td>19</td>
<td>1/16 Note</td>
<td>G1</td>
<td>G1</td>
<td>1</td>
<td>Default</td>
</tr>
<tr>
<td>C#1</td>
<td>High Floor Tom</td>
<td>19</td>
<td>1/16 Note</td>
<td>C#1</td>
<td>C#1</td>
<td>1</td>
<td>Default</td>
</tr>
<tr>
<td>G#1</td>
<td>Pedal Hi-Hat</td>
<td>19</td>
<td>1/16 Note</td>
<td>G#1</td>
<td>G#1</td>
<td>1</td>
<td>Default</td>
</tr>
<tr>
<td>A1</td>
<td>Low Tom</td>
<td>19</td>
<td>1/16 Note</td>
<td>A1</td>
<td>A1</td>
<td>1</td>
<td>Default</td>
</tr>
<tr>
<td>B1</td>
<td>Low Middle Tom</td>
<td>19</td>
<td>1/16 Note</td>
<td>B1</td>
<td>B1</td>
<td>1</td>
<td>Default</td>
</tr>
</tbody>
</table>

The purpose of the Drum Editor is to edit MIDI tracks where each note (pitch) plays a separate sound, as is typically the case with a MIDI drum kit. The drum sound list to the left lists all drum sounds by name (according to the selected drum map or name list — see below), and lets you adjust and manipulate the drum sound setup in various ways.

Note:

- The number of columns in the list depends on whether there's a drum map selected for the track or not. See page 521.
- You can reorder the columns by dragging the column headings, and resize the columns by dragging the dividers between the column headings.
The note display

The Drum Editor’s note display displays notes as diamond symbols. The vertical position of the notes corresponds to the drum sound list to the left, while the horizontal position corresponds to the note’s position in time, just as in the Key Editor. Note however, that the diamond symbols don’t indicate the length of the notes. This makes sense, since drum sounds most often are “one-shot” samples that play to their end regardless of the note lengths.

Drum map and name pop-up menus

Below the drum sound list you will find two pop-up menus, used for selecting a drum map for the edited track or (if no drum map is selected) a list of drum sound names. For an explanation of drum maps, see page 521.

Controller display

The controller display in the Drum Editor is exactly the same as in the Key Editor. You can add or remove controller lanes from the Quick menu, and create and edit events as described on page 505.
Drum Editor operations

The basic handling (zooming, playback, auditioning, etc.) is the same as in the Key Editor (see page 493). The following sections describe the procedures and features that are specific to the Drum Editor.

Creating and editing notes

The standard way of entering notes in the Drum Editor is to click with the Drumstick tool.

When you move the pointer in the note display, its bar position and drum sound is indicated in the toolbar, making it easy to find the right sound and position.

The position of the created note depends on the following factors:

• If Snap is deactivated on the toolbar, the note will appear exactly where you clicked.
  In this mode, notes can be positioned freely.

• If Snap is activated and Global Quantize is deactivated on the toolbar, the note will snap to positions according to the Quantize value set for the sound in the drum sound list.
  You can set up different Quantize values for different drum sounds. You may for example want hi-hat notes snap to sixteenth notes, but snare and bass drum snap to eighth notes.

• If both Snap and Global Quantize are activated, the note will snap to positions according to the Quantize value on the toolbar (below the Global Quantize button).

  The length of the inserted note is determined by the Insert Length setting on the toolbar. However, if this is set to “Linked to drum map”, the note will get the length of the Quantize value for the drum sound.

  The notes will get the Insert Velocity value set on the toolbar.
• You can quickly audition the drum sounds by clicking in the leftmost column in the drum sound list. This plays the corresponding note.

• Clicking with the Drumstick tool on an existing note will remove it. This makes drum pattern editing very quick and intuitive.

Selecting notes
Selecting notes is done by any of the following methods:

• Use the Arrow tool. The standard selection techniques apply.
• Use the Select submenu on the Quick menu (see page 496).
• Use the left and right arrow keys on the computer keyboard to step from one note to the next or previous note. If you press [Shift] and use the arrow keys, the current selection will be kept, allowing you to select several notes.
• You can also press [Shift] and double click on a note to select all the following notes for the same drum sound.
• If the option “Auto Select Events under Cursor” is activated in the Preferences dialog (Editing page), all notes currently “touched” by the project cursor are automatically selected.

Moving, duplicating or repeating notes
To move or copy notes in the editor (to other positions or other drum sounds), you use the same methods as in the Key Editor: click and drag, use the arrow keys or Edit menu functions, etc. – see page 497. There is one thing to note:

When you are moving or copying several selected notes by dragging them and Snap is activated but Global Quantize turned off, the notes will snap to positions according to the quantize values for the drum sounds. If the moved/copied notes have different quantize values, the largest value will determine snapping. For example, if you are moving two notes, with the quantize values 1/16 and 1/4 respectively, the notes will snap to quarter notes (1/4).

• You can also adjust the position of notes by quantizing (see page 467). Again, which quantize value is used depends on whether Global Quantize is on or off.
Muting notes and drum sounds

You can mute individual notes by clicking or enclosing them with the Mute tool or by using the Mute function on the Edit menu (see page 500).

Furthermore, if a drum map is selected (see page 527), the drum sound list will have a Mute column. Click in the Mute column for a drum sound to mute that sound. Finally, clicking the Drum Solo button will mute all drum sounds other than the selected one.

<table>
<thead>
<tr>
<th>Pitch</th>
<th>Instrument</th>
<th>Mute</th>
<th>Quantize</th>
<th>Channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>C1</td>
<td>Side Stick</td>
<td></td>
<td>1/16 Note</td>
<td>10</td>
</tr>
<tr>
<td>D1</td>
<td>Acoustic Snare</td>
<td>●</td>
<td>1/16 Note</td>
<td>10</td>
</tr>
<tr>
<td>E1</td>
<td>Electric Snare</td>
<td>●</td>
<td>1/16 Note</td>
<td>10</td>
</tr>
<tr>
<td>F1</td>
<td>Low Floor Tom</td>
<td></td>
<td>1/16 Note</td>
<td>10</td>
</tr>
<tr>
<td>G1</td>
<td>Bass Drum</td>
<td></td>
<td>1/16 Note</td>
<td>10</td>
</tr>
<tr>
<td>C#1</td>
<td>Hi-Hat</td>
<td></td>
<td>1/16 Note</td>
<td>10</td>
</tr>
<tr>
<td>D#1</td>
<td>Ride Cymbal</td>
<td></td>
<td>1/16 Note</td>
<td>10</td>
</tr>
</tbody>
</table>

Muted drum sounds

Please note that the mute state for drum sounds is part of the drum map, so any other tracks using the same map will also be affected.

Deleting notes

To delete notes, click on them with the Drumstick tool or Eraser tool or select them and press [Backspace].

Other editing methods

As in the Key Editor, you can edit notes on the info line or via MIDI, and enter notes using step input. Please refer to page 501.
Working with drum maps

Background

As discussed earlier, a drum kit in a MIDI instrument is most often a set of different drum sounds with each sound placed on a separate key (i.e. the different sounds are assigned to different MIDI note numbers). One key plays a bass drum sound, another a snare and so on.

Unfortunately, different MIDI instruments often use different key assignments. This can be troublesome if you have made a drum pattern using one MIDI device, and then want to try it on another. When you switch device, it is very likely that your snare drum becomes a ride cymbal, or your hi-hat becomes a tom, etc. – just because the drum sounds are distributed differently in the two instruments.

To solve this problem, and simplify several aspects of MIDI drum kits (like using drum sounds from different instruments in the same "drum kit"), Cubase SX/SL features so-called drum maps. A drum map is basically a list of drum sounds, with a number of settings for each sound. When you play back a MIDI track for which you have selected a drum map, the MIDI notes are “filtered” through the drum map before being sent to the MIDI instrument. Among other things, the map determines which MIDI note number is sent out for each drum sound, and so which sound is played in the receiving MIDI device.

A solution to the problem above would therefore be to make up drum maps for all your instruments. When you want to try your drum pattern on another instrument, you simply switch to the corresponding drum map and your snare drum sound will remain a snare drum sound.
Drum map settings

A drum map consists of settings for 128 drum sounds (one for each MIDI note number). To get an overview of these settings, open the Drum Editor and use the Map pop-up menu below the drum sound list to select the "GM Map" drum map.

This drum map is set up according to the General MIDI standard. For information on how to load, create and select other drum maps, see page 527.

Now, take a look at the drum sound list (you may have to drag the divider between the list and the note display to the right to see all columns). The columns show the settings of the drum map for each sound.
Here's a brief description (details follow below):

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pitch</td>
<td>The actual note number of the drum sound. This is what links notes on a</td>
</tr>
<tr>
<td></td>
<td>MIDI track to drum sounds. For example, with the above drum map, all</td>
</tr>
<tr>
<td></td>
<td>MIDI notes with the pitch C1 would be mapped to the Bass Drum sound. More</td>
</tr>
<tr>
<td></td>
<td>on this below.</td>
</tr>
<tr>
<td>Instrument</td>
<td>The name of the drum sound.</td>
</tr>
<tr>
<td>Quantize</td>
<td>This value is used when entering and editing notes as described on</td>
</tr>
<tr>
<td></td>
<td>page 518 and page 519.</td>
</tr>
<tr>
<td>Mute</td>
<td>Allows you to mute a drum sound, excluding it from playback. See page</td>
</tr>
<tr>
<td></td>
<td>520.</td>
</tr>
<tr>
<td>I-note</td>
<td>This is the “input note” for the drum sound. When this MIDI note is sent</td>
</tr>
<tr>
<td></td>
<td>into Cubase SX/SL, (i.e. played by you), the note will be mapped to the</td>
</tr>
<tr>
<td></td>
<td>corresponding drum sound (and automatically transposed according to the</td>
</tr>
<tr>
<td></td>
<td>Pitch setting for the sound). See below.</td>
</tr>
<tr>
<td>O-note</td>
<td>This is the “output note”, i.e. the MIDI note number that is sent out every</td>
</tr>
<tr>
<td></td>
<td>time the drum sound is played back. See below.</td>
</tr>
<tr>
<td>Channel</td>
<td>The drum sound will be played back on this MIDI channel.</td>
</tr>
<tr>
<td>Output</td>
<td>The drum sound will be played back on this MIDI output. If you set this to</td>
</tr>
<tr>
<td></td>
<td>“Default”, the MIDI output selected for the track will be used.</td>
</tr>
</tbody>
</table>

- All settings in a drum map (except the Pitch setting) can be changed directly in the drum sound list, or in the Drum Map Setup dialog (see page 528).

Note that the changes you make will affect all tracks that use the drum map.
About Pitch, I-note and O-note

This can be a somewhat confusing area, but once you’ve grasped how it all works it’s not very complicated. Going through the following “theory” will help you make the most out of the drum map concept – especially if you want to create your own drum maps.

As we said earlier, a drum map is a kind of “filter”, transforming notes according to the settings in the map. It does this transformation twice; once when it receives an incoming note (i.e. when you play a note on your MIDI controller) and once when a note is sent from the program to the MIDI sound device.

In the following example, we have modified the drum map, so that the Bass Drum sound has different Pitch, I-note and O-note values.

<table>
<thead>
<tr>
<th></th>
<th>Instrument</th>
<th>Channel</th>
<th>Quantize</th>
<th>I-Note</th>
<th>O-Note</th>
<th>Mn</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1</td>
<td>Low Floor Tom</td>
<td>10</td>
<td>1/16 Note</td>
<td>F1</td>
<td>F1</td>
<td></td>
</tr>
<tr>
<td>C1</td>
<td>Bass Drum</td>
<td>10</td>
<td>1/16 Note</td>
<td>A1</td>
<td>B0</td>
<td></td>
</tr>
<tr>
<td>D#1</td>
<td>Hand Clap</td>
<td>10</td>
<td>1/16 Note</td>
<td>D#1</td>
<td>D#1</td>
<td></td>
</tr>
</tbody>
</table>

I-notes

Let’s look at what happens on input: When you play a note on your MIDI instrument, the program will look for this note number among the I-notes in the drum map. In our case, if you play the note A1, the program will find that this is the I-note of the Bass Drum sound.

This is where the first transformation happens: the note will get a new note number according to the Pitch setting for the drum sound. In our case, the note will be transformed to a C1 note, because that is the Pitch of the Bass Drum sound. If you record the note, it will be recorded as a C1 note.
O-notes

The next step is the output. This is what happens when you play back the recorded note, or when the note you play is sent back out to a MIDI instrument in real time (MIDI Thru):

The program checks the drum map and finds the drum sound with the Pitch of the note. In our case, this is a C1 note and the drum sound is the Bass Drum. Before the note is sent to the MIDI output, the second transformation takes place: the note number is changed to that of the O-note for the sound. In our example, the note sent to the MIDI instrument will be a B0 note.

Usage

So, what's the point of all this? Again, the purposes are different for I-notes and O-notes:

• Changing the I-note settings allows you to choose which keys will play which drum sounds, when playing or recording from a MIDI instrument. For example, you may want to place some drum sounds near each other on the keyboard so that they can be easily played together, move sounds so that the most important sounds can be played from a short keyboard, play a sound from a black key instead of a white, and so on. If you never play your drum parts from a MIDI controller (but draw them in the editor) you don't need to care about the I-note setting.

• The O-note settings let you set things up so that the “Bass Drum” sound really plays a bass drum. If you're using a MIDI instrument in which the bass drum sound is on the C2 key, you set the O-note for the “Bass Drum” sound to C2. When you switch to another instrument (in which the bass drum is on C1) you want the Bass Drum O-note set to C1. Once you have set up drum maps for all your MIDI instruments, you don't have to care about this anymore – you just select another drum map when you want to use another MIDI instrument for drum sounds.
The channel and output settings

You can set separate MIDI channels and/or MIDI outputs for each sound in a drum map. The following rules apply:

• When a drum map is selected for a track, the MIDI channel settings in the drum map override the MIDI channel setting for the track. In other words, the MIDI channel setting you make in the Track list or Inspector for the track is normally disregarded. If you want a drum sound to use the channel of the track, set it to channel “Any” in the drum map.

• If the MIDI output is set to “default” for a sound in a drum map, the sound will use the MIDI output selected for the track. Selecting any other option allows you to direct the sound to a specific MIDI output.

By making specific MIDI channel and output settings for all sounds in a drum map, you can direct your drum tracks directly to another MIDI instrument simply by selecting another drum map – you don’t need to make any channel or output changes for the actual track.

• To select the same MIDI channel for all sounds in a drum map, click the Channel column, press [Ctrl]/[Command] and select the desired channel.

All drum sounds will be set to this MIDI channel. The same procedure can be used for selecting the same MIDI output for all sounds as well.

It can also be useful to select different channels and/or outputs for different sounds. This allows you to construct drum kits with sounds from several different MIDI devices, etc.
Managing drum maps

Selecting a drum map for a track

To select a drum map for a MIDI track, use the Map pop-up menu in the Inspector or in the Drum Editor:

![Map pop-up menu](image)

Selecting “No Drum Map” turns off the drum map functionality in the Drum Editor. Even if you don’t use a drum map, you can still separate sounds by name using a name list (see page 530).

Initially, the Map pop-up menu will only contain one map: “GM Map”. However, you will find a number of drum maps included on the program CD – how to load these is described below.
The Drum Map Setup dialog

To set up and manage your drum maps, select “Drum Map Setup” from the Map pop-up menus or the MIDI menu. This opens the following dialog:

![Drum Map Setup dialog]

This is where you load, create, modify and save drum maps. The list to the left shows the currently loaded drum maps; selecting a drum map in the list displays its sounds and settings to the right.

- **The settings for the drum sounds are exactly the same as in the Drum Editor (see page 522).**

As in the Drum Editor, you can click the leftmost column to audition a drum sound. Note: if you audition a sound in the Drummap Setup dialog, and the sound is set to MIDI output “Default”, the output selected on the Default pop-up menu in the lower left corner will be used. When auditioning a Default output sound in the Drum Editor, the MIDI output selected for the track will be used, as described on page 526.
Below the drum sound list you will find a number of buttons, with the following functionality:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Map</td>
<td>Click this to add a new drum map to the project. The drum sounds will be named “Sound 1, Sound 2” and so on, and have all parameters set to default values. The map will be named “Empty Map”, but you can rename it by clicking and typing in the list.</td>
</tr>
<tr>
<td>New Copy</td>
<td>Adds a copy of the currently selected drum map. This is probably the quickest way to create a new drum map: select the map that is similar to what you want, create a copy, change the desired drum sound settings and rename the map in the list.</td>
</tr>
<tr>
<td>Remove</td>
<td>Removes the selected drum map from the project.</td>
</tr>
<tr>
<td>Load</td>
<td>Opens a file dialog, allowing you to load drum maps from disk. On the Cubase SX/SL CD you will find a number of drum maps for different MIDI instruments – use this function to load the desired maps into your project.</td>
</tr>
<tr>
<td>Save</td>
<td>Opens a file dialog for saving the drum map selected in the list. If you have created or modified a drum map, you should use this function to save it as a file on disk – this allows you to load it into other projects. Drum map files have the extension <em>.drm</em>.</td>
</tr>
<tr>
<td>Assign</td>
<td>Click this button to assign the selected drum map to the current MIDI track (only available if a MIDI track was selected when you opened the Drum Map Setup dialog). This is the same as selecting the drum map from the Map pop-up menu.</td>
</tr>
<tr>
<td>OK</td>
<td>Closes the dialog.</td>
</tr>
</tbody>
</table>

- Drum maps are saved with the project files. If you have created or modified a drum map, you should use the Save function to store it as a separate file, available for loading into other projects. If you always want to have the same drum map(s) included in your projects, you may want to load these into the default project – see page 698.
O-Note Conversion

This function on the MIDI menu goes through the selected MIDI part(s) and sets the actual pitch of each note according to its O-note setting. This is useful if you want to convert the track to a “regular” MIDI track (with no drum map) and still have the notes play back the correct drum sound. A typical application is if you want to export your MIDI recording as a standard MIDI file (see page 702) – by first performing an O-Note Conversion you make sure that your drum tracks play back as they should when they are exported.

Using drum name lists

Even if no drum map is selected for the edited MIDI track, you can still use the Drum Editor if needed. As previously mentioned, the drum sound list will then only have four columns: Audition, Pitch, Instrument (drum sound names) and Quantize. There will be no I-note and O-note functionality.
In this mode, the names shown in the Instrument column depend on the selection on the Names pop-up menu, just below the Map pop-up in the Drum Editor.

<table>
<thead>
<tr>
<th>Note</th>
<th>Name</th>
<th>Velocity</th>
</tr>
</thead>
<tbody>
<tr>
<td>C#2</td>
<td>Drum Fill</td>
<td>1/16 Note</td>
</tr>
<tr>
<td>F2</td>
<td>Ride Bell</td>
<td>1/16 Note</td>
</tr>
<tr>
<td>F#2</td>
<td>Tombouning</td>
<td>1/16 Note</td>
</tr>
</tbody>
</table>

The options on this pop-up menu are the currently loaded drum maps plus a “GM Default” item which is always available. This means you can use the drum sound names in any loaded drum map without using I-notes and O-notes, should you so like.
The List Editor – Overview

The toolbar

The toolbar contains several items that are the same as in the Key Editor (edit solo, Snap, Quantize settings, etc.). These are described earlier in this chapter. The following toolbar items are unique to the List Editor:

- The Insert pop-up menu is used when creating new events. This is where you determine what type of event to add (see page 534).
- The Mask pop-up menu and Filter bar (F button) allow you to hide events from view, based on their type and other properties. See page 537.

The List Editor has no info line (numerical editing is available in the list instead).

The list

This lists all events in the currently selected MIDI part, in the order (from top to bottom) they are played back. You can edit the event properties by using regular value editing, as described on page 535.
The event display

This shows the events graphically. The vertical position of an event in the display corresponds to its entry in the list (i.e. to the playback order), while the horizontal position corresponds to its actual position in the project. This is where you add new parts or events, drag to move them, etc.

The value display

This display shows the “value” of each event, allowing for easy viewing and graphical editing. Typically, the value shown is the “Data 2” or “Value 2” property (amounts for MIDI controller events, velocity for notes, etc.).
List Editor operations

Customizing the view

You can click and drag the divider between the list and the event display to make one area wider and the other narrower. Furthermore, the list can be customized in the following ways:

- You can change the order of the columns by dragging the column headings.
- You can resize columns by dragging the dividers between the column headings.

Setting the display format

Just like in the Project window, you set the display format (bars+beats, seconds, etc.) by right-clicking in the ruler and selecting an option from the pop-up menu. This setting affects both the ruler and all start, end and length values shown in the list.

Zooming

You can change the horizontal magnification in the event display by using the zoom slider below the display or the Magnification glass tool.

Adding events

To add a new event to the edited part, proceed as follows:

1. Use the Insert pop-up menu on the toolbar to select the event type.

2. Select the Pencil tool and click in the event display, at the desired position (relative to the ruler).
   If you are creating note events, you can click and drag to set the length of the note.
   The new event appears in the list and in the display. Its properties will be set to default values, but can easily be adjusted in the list.
Editing in the list

The list allows you to perform detailed numerical editing of the events’ properties. The columns have the following functionality:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>The event type. This cannot be changed.</td>
</tr>
<tr>
<td>Start</td>
<td>The start position of the event, shown in the format selected for the ruler. Changing this is the same as moving the event. Note that moving the event past any other event in the list will re-sort the list (the list always shows the events in the order they are played back).</td>
</tr>
<tr>
<td>End</td>
<td>This is only used for note events, allowing you to view and edit the end position of a note (thereby resizing it).</td>
</tr>
<tr>
<td>Length</td>
<td>This is only used for note events. It shows the length of the note – changing this resizes the note and automatically changes the End value as well.</td>
</tr>
<tr>
<td>Data 1</td>
<td>This is the “data 1” or “value 1” property of the event. The content of this depends on the event type – for notes, this is the pitch, for example. Where applicable, the values are shown in the most relevant form. For instance, the Data 1 value for notes is shown as a note number in the format selected in the Preferences dialog (Event Display–MIDI page). See also the table on page 539.</td>
</tr>
<tr>
<td>Data 2</td>
<td>This is the “data 2” or “value 2” property of the event. The content of this depends on the event type – for notes, this is the velocity value, for example. See the table on page 539.</td>
</tr>
<tr>
<td>Channel</td>
<td>The MIDI channel of the event. Note that this setting is normally overridden by the channel setting for the track. To make a MIDI event play back on “its own” channel, set its track to channel “Any” in the Project window.</td>
</tr>
<tr>
<td>Comment</td>
<td>This column is used for some event types only, providing an additional comment about the event.</td>
</tr>
</tbody>
</table>

- For SysEx (system exclusive) events, you can only edit the position (Start) in the list.

However, clicking the Comment column opens the SysEx Editor, in which you can perform detailed editing of system exclusive events. This and other aspects of working with system exclusive messages are described in a separate chapter – see page 622.
**Editing in the event display**

The event display allows you to edit the events graphically using the tools on the toolbar.

- To move an event, click and drag it to a new position.
  Note that moving the event past any other event in the display will re-sort the list (the list always shows the events in the order they are played back). As a result, the vertical position of the event in the display will change as well.

- To make a copy of an event, press [Alt]/[Option] and drag it to a new position.

- To resize a note, select it and drag its end points with the Arrow tool as in the Project window.
  This only works with notes.

- To mute or unmute an event, click on it with the Mute tool.
  You can mute or unmute several events in one go by enclosing them in a selection rectangle with the Mute tool.

- You can select a color scheme for the events with the Colors pop-up menu on the toolbar.
  This affects how all MIDI events are shown in the Project Browser and works as in the other MIDI editors – see page 559.

- To delete an event, select it and press [Backspace] or [Delete], or click on it with the Eraser tool in the event display.
Filtering

Clicking the F button on the toolbar makes an additional filter bar appear. This allows you to hide some event types from view. For example, it may be hard to find note events if the part contains a lot of controller events – by hiding these the list becomes more manageable.

To hide an event type, tick its checkbox on the filter bar.

- **The event types remain hidden even if you close the filter bar.**
  To make sure you see all events, open the filter bar and check that all checkboxes are deactivated.

- **The filter bar does not remove, mute or in any other way change the events.**
Masking

The Mask function is similar to the filter bar but allows you to hide events based on some other criteria as well. Proceed as follows:

1. Select an event of the type you want to view.
2. Pull down the Mask pop-up menu on the toolbar and select one of the options.

The results are as follows:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Types</td>
<td>Only events with the type of the selected event will be shown. This does the same as the filter bar but is quicker if you only want to view a single event type.</td>
</tr>
<tr>
<td>Controller and Event Types</td>
<td>Only events with the type of the selected event will be shown. Furthermore, if the selected event is a controller, only controllers of the same type (with the same “Data 1” value) will be shown.</td>
</tr>
<tr>
<td>Event Channels</td>
<td>Only events with the same channel as the selected event will be shown.</td>
</tr>
</tbody>
</table>

- To deactivate the Mask function, select “Nothing” from the Mask pop-up menu.

The most typical usage of the Mask function is to view a certain type of controller only (e.g. Modulation, Breath Control, etc.). Since these are all the same event types (controller), this would not be possible with the filter bar. With the “Controllers and Event Types” option on the Mask pop-up menu, it is!
**Editing in the value display**

The value display to the right of the event display is a tool for quick viewing and editing of multiple values, e.g. velocities or controller amounts. The values are shown as horizontal bars, with the bar length corresponding to the value.

![A velocity ramp in the value display.](image)

You edit the values by clicking and dragging. Note that the pointer automatically takes on the shape of the Pencil tool when you move it into the value display – you don’t have to select the Pencil tool for this.

Exactly which value is shown for an event depends on the event type. The following table shows what is displayed and edited in the Data columns and the value display:

<table>
<thead>
<tr>
<th>Event type</th>
<th>Data 1</th>
<th>Data 2</th>
<th>Value display</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note</td>
<td>Pitch (note number)</td>
<td>Velocity</td>
<td>Velocity</td>
</tr>
<tr>
<td>Controller</td>
<td>Controller type</td>
<td>Controller amount</td>
<td>Controller amount</td>
</tr>
<tr>
<td>Program Change</td>
<td>Program number</td>
<td>Not used</td>
<td>Program number</td>
</tr>
<tr>
<td>Aftertouch</td>
<td>Aftertouch amount</td>
<td>Not used</td>
<td>Aftertouch amount</td>
</tr>
<tr>
<td>Pitch Bend</td>
<td>Bend amount</td>
<td>Not used</td>
<td>Bend amount</td>
</tr>
<tr>
<td>SysEx</td>
<td>Not used</td>
<td>Not used</td>
<td>Not used</td>
</tr>
</tbody>
</table>
The Score Editor – Overview (Cubase SL only)

This section describes the Score Editor in Cubase SL. If you are using Cubase SX, please refer to the separate pdf document “Score Layout and Printing” opened from the Start menu (Windows) or the Help menu in the program.

The Score Editor shows the MIDI notes as a musical score. The window contains the following sections and items:

**The toolbar**

- Info line on/off
- Edit Solo button
- Score Editor tools
- Mouse pointer display: Current pitch and current meter position
- Show/hide extended toolbar
- AutoScroll on/off
- Length (note value) setting
- Step input on/off
- Insert mode on/off
- Audition on/off
- Quantize value
- Edit via MIDI input on/off
- Edit via MIDI options (see page 502).

The Score Editor toolbar is similar to the toolbar in the Key Editor, with the addition of a button for showing or hiding the extended toolbar (see below).
The info line

The info line shows information about selected MIDI notes, just like in the Key and Drum Editors. You can edit all values on the info line using regular value editing (see page 501 for details).

- To hide or show the info line, click the “i” icon in the toolbar.

The extended toolbar

![Extended Toolbar Image]

The extended toolbar (shown or hidden by clicking the T button on the main toolbar) contains the following items:

Note value buttons

Click one of these to select a note value for input. The “T” and “.” options are for triplet and dotted note values. You can also press [Ctrl]/[Command] and click one of the note value buttons - this will resize all selected notes to the note value you choose.

Enharmonic shift

Allows you to manually select whether a note should be shown with flat or sharp accidentals. See page 555.
The score display

The main area of the Score Editor window shows the notes in the edited parts on one or several staves.

- If you are editing one or several parts on the same track, as much of them as possible is shown on several staves - one above the other - just as with a score on paper.
- If you are editing parts on several tracks, they are put on a grand staff (multiple staves, tied together by bar lines).
- The number of measures across the screen depends on the size of the window and the number of notes in each measure.
  The maximum number of bars across the page is four.
- The end of the last part is indicated by a double bar line.
- Unlike the other MIDI editors, the Score Editor does not have a ruler.
  A conventional ruler would not make sense, since there is no exact relationship between a note's horizontal position in the score and its musical position in the Project.
Score Editor operations (Cubase SL only)

Opening the Score Editor

To open one or several parts in the Score editor you proceed much as with the other editors: select the parts (on the same or different tracks), and select “Open Score Editor” from the Scores submenu on the MIDI menu. The default key command for this is [Ctrl]/[Command]-[R].

- You can also select the Score editor as your default editor, allowing you to open it by double clicking parts. This is done with the Default Edit Action pop-up menu in the Preferences dialog (event Display - MIDI page).

About editing parts on different tracks

If you have selected parts on two or more tracks and open the Score editor, you will get one staff for each track (although you can split a staff in two, e.g. when scoring for piano). The staves are tied together by bar lines and placed in the order of the tracks in the Project window.

- If you need to rearrange the staves: close the editor, go back into the Project window, drag the tracks to the order you want them, and open the Score Editor again.

The Active Staff

Just as in the other editors, all MIDI input (as when recording from your instrument) is directed to one of the tracks, here called the Active staff. The Active staff is indicated by a black rectangle in the left part of the first visible bar.

To change Active staff, click in the staff you want to activate.
Getting the score displayed correctly

When you open the Score Editor for a part recorded in real time, the score may not look as legible as you would first expect. The Score Editor can ignore the minor time variances in performance and make a neater score almost instantly. To achieve this, there are a number of Staff Settings that determine how the program displays the music.

- Note that the time signature follows the time signature(s) on the Tempo track and are common to all tracks/staves in the score.

There are two ways to open the Staff Settings dialog:

- Double click in the white area to the left of the staff.
- Activate a staff by clicking in it, and select “Staff Settings” from the Scores submenu on the MIDI menu.

The Staff Settings dialog appears.

The settings you make in this dialog are independent for each staff (track), but common for a piano staff which you have created by choosing the “Split” Staff Mode option (see below).
Staff Mode

This pop-up determines how the staff should be shown:

- When set to “Single”, all notes in the part are shown in the same staff.
- When set to “Split”, the part is split on the screen into a bass and treble clef, as in a piano score.

You use the Splitpoint value field to set the note where you want the split to occur. Notes above and including the split note will appear on the upper staff, and notes below the split note will appear on the lower staff.

Display Quantize

Notes are not an absolute language, and you must give the program a few hints on how the score should be displayed. This is done using the Display Quantize section of the Staff Settings dialog.
These are only display values used for the graphics in the Score Editor. They do not affect the actual playback in any way.

Here is a description of the functions:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notes</td>
<td>Determines the smallest note value to be displayed and the “smallest position” to be recognized and properly displayed. Set this to the smallest significant note position used in your music. For example, if you have notes on odd sixteenth note positions, you should set this value to 16. The “T” values are for triplet note values. This setting is partly overridden by Auto Quantize (see below).</td>
</tr>
<tr>
<td>Rests</td>
<td>This value is used as a “recommendation” - the program will not display rests smaller than this value, except where necessary. In effect, this setting also determines how the length of notes should be displayed. Set this value according to the smallest note value (length) you want to be displayed for a single note, positioned on a beat.</td>
</tr>
<tr>
<td>Auto Quantize</td>
<td>Generally, if your music contains mixed triplets and straight notes, try activating this checkbox. Otherwise, make sure it is deactivated. Auto Quantize uses involved methods to make your score look as legible as possible. Auto Quantize allows you to mix straight notes with tuplets (triplets) in a part. But, Auto Quantize also uses the (display) Quantize value. If it can’t find an appropriate note value for a certain note or group of notes, it will use the set Quantize value to display it. If the part is imprecisely played and/or complex, Auto Quantize may have a problem “figuring out” exactly what you “mean”.</td>
</tr>
<tr>
<td>Dev</td>
<td>This option is only available if Auto Quantize is on. When Dev (Deviation) is activated, triplets/straight notes will be detected even if they are not exactly “on the beat”. However, if you know your triplets/straight notes are perfectly recorded (quantized or entered by hand), turn this off.</td>
</tr>
<tr>
<td>Adapt</td>
<td>This option is only available if Auto Quantize is on. When Adapt is activated, the program “guesses” that when one triplet is found, there are probably more triplets surrounding it. Turn this on if not all of your triplets are detected.</td>
</tr>
</tbody>
</table>
Key and Clef

The correct Key and Clef are set using the two scroll bars in the Key & Clef section.

If you activate the “Auto Clef” checkbox, the program attempts to guess the correct clef, judging from the pitch of the music.

- To set the clef and key for the lower staff, activate the “Lower Staff” checkbox in the Key/Clef section.

Display Transpose

Some instruments, for example a lot of brass instruments, are scored transposed. For this purpose, the Staff Settings dialog allows you to specify a separate Display Transpose setting for each staff (track). This transposes the notes in the score (i.e. how they are displayed) without affecting how the notes play back. This allows you to record and play back a multi staff arrangement, and still score each instrument according to its own transposition.

- Use the pop-up menu to select the instrument for which you are scoring.
  You can also manually set a display transpose value with the Semitones box above.
## Flags

These provide additional options for how the score should be displayed:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Clean Lengths</strong></td>
<td>When this is activated, notes that are considered to be chords will be shown with identical lengths. This is done by showing the longer notes as shorter than they are. When Clean Lengths is turned on, notes with very short overlaps are also cut off; a bit as with No Overlap (see below), but with a more subtle effect.</td>
</tr>
<tr>
<td><strong>No Overlap</strong></td>
<td>When this is activated one note will never be shown as overlapping another, lengthwise. This allows long and short notes starting at the same point to be displayed without ties; the long notes are cut off in the display. This will make the music more legible.</td>
</tr>
</tbody>
</table>

An example measure with No Overlap deactivated...

...and with No Overlap activated.

<table>
<thead>
<tr>
<th><strong>Syncopation</strong></th>
<th>When this function is activated, syncopated notes are shown in a more legible way.</th>
</tr>
</thead>
</table>

This is a dotted quarter at the end of a bar when Syncopation is Off...

...and when it is On.

<table>
<thead>
<tr>
<th><strong>Shuffle</strong></th>
<th>Activate this function when you have played a shuffle beat and want it displayed as straight notes (not triplets). This is very common in jazz notation.</th>
</tr>
</thead>
</table>
Applying your settings

After you’ve made your settings, click Apply to apply them to the active staff. You can select another staff in the score and make settings for that, without having to close the Staff Settings dialog first - just remember to click Apply before you change staff, otherwise your changes will be lost.

- As in many other dialogs and property windows in Cubase SX/SL, you can store your settings as presets. This is done according to the usual procedures: click Store to store the current settings as a preset, select a preset from the pop-up menu to load it into the dialog or use the Remove button to remove the currently selected preset.
Entering notes with the mouse

To enter notes into a part in the Score Editor, you use the Note tool. However, first you need to set the note value (length) and spacing:

Selecting a note value for input

This can be done in two ways:

• By clicking the note symbols on the extended toolbar.
  You can select any note value from 1/1 to 1/64th and turn on and off the dotted and triplet options by clicking the two buttons to the right. The selected note value is displayed in the Length value field on the toolbar and in the Note tool cursor shape.

• By selecting an option from the Length pop-up menu on the toolbar.

Selecting a Quantize Value

When you move the mouse pointer over the score, you will see that the position box on the toolbar tracks your movement and shows the current position in bars, beats, sixteenth notes and ticks.

Positioning on screen is controlled by the current Quantize value. If you for example set this to “1/8 Note” you can only insert and move notes to eighth note positions, at quarter notes, at half bars or at bar positions. It is a good strategy to set the Quantize value to the smallest note value in the piece. This doesn’t stop you from inputting notes at “coarser” positions. However, if you set the Quantize value to too small a note value, it is easier to make mistakes.

The Quantize value is set with the Quantize pop-up menu on the toolbar.

• You can also assign key commands to the different Quantize values. This is done in the Key Commands dialog on the File menu, under the heading “MIDI Quantize”.

• Just like in the other MIDI editors, you can use the Quantize Setup dialog to create other quantize values, irregular grids, etc. However, this is not often used when entering score notes.
Entering a note
To add a note to the score, proceed as follows:

1. Make the staff active.
   Notes are always put in on the active staff.

2. Select the type of note by selecting a note value.
   This is described in detail above.

3. If you selected the note value by clicking on a symbol on the extended toolbar, the Note tool was automatically selected - otherwise select the Note tool from the toolbar or Quick menu.

4. Select a Quantize value.
   As described above, the Quantize value will determine the spacing between notes. If you have Quantize set to "1/1 Note" you will only be able to add notes at downbeats. If you set Quantize to "1/8 Note" you will be able to add notes at all eighth note positions etc.

5. Click in the staff and keep the mouse button pressed.
   A note appears under the mouse pointer.

6. Move the mouse horizontally to find the correct position.
   Check the lower mouse position box on the toolbar - the position is "magnetically" attracted to the grid defined by the current Quantize value. This allows you to easily find the correct position.

7. Move the mouse vertically to find the correct pitch.
   The upper mouse position box shows the pitch at the pointer position, making it easy to find the right pitch.

8. Release the mouse button.
   The note appears in the score.

Selecting notes
There are several ways to select notes in the Score Editor:

By clicking
To select a note, click on its note head with the Arrow tool. The note head gets inverted to indicate that it is selected.

- To select more notes, hold down [Shift] and click on them.
- To deselect notes, hold [Shift] down and click on them again.
- If you hold down [Shift] and double click on a note, this note and all the following notes in the same staff are selected.
Using a selection rectangle

1. Press the mouse button with the Arrow tool in some free (white) space in the score.
2. Drag the mouse pointer.
   A rectangle appears. You can drag to select voices on several voices or staves if you wish.
3. Release the mouse button.
   All notes with their note heads inside the rectangle get selected.
   If you want to deselect one or more of the notes, hold down [Shift] and click as described above.

Using the keyboard

By default, you can step through the notes in the staff using the left and right arrow keys. If you press [Shift], you will select the notes as you step through them.

• If you want to use other keys for selecting notes, you can customize the settings in the Key Commands dialog on the File menu (in the Navigate category).

Deselecting everything

To deselect everything, simply click with the Arrow tool in some “free” (white) space in the score.

Deleting notes

Notes can be deleted in two ways:

Using the Eraser tool

1. Select the Eraser tool from the toolbar or Quick menu.
2. Click on the Note(s) you want to erase, one at a time or drag over them with the mouse button pressed.
Using the keyboard or delete menu item

1. Select the notes you want to delete.

2. Select Delete from the Edit menu, or press [Delete] or [Backspace] on the computer keyboard.

Moving notes

To move or transpose notes, proceed as follows:

1. Set the Quantize value.
   The Quantize value will restrict your movement in time. You can not place the notes on positions smaller than the Quantize value. If Quantize for example is set to “1/8 Note”, you will not be able to move the notes to a sixteenth note position. However, you will be able to put them on any eighth note, quarter note, half note or whole note position.

2. If you want to hear the pitch of the note while moving, activate the speaker icon on the toolbar.
   When it is on, you will hear the current pitch of the “dragged” note.

3. Select the note(s) you plan to move.

4. Click one of the selected notes and drag it to a new position and/or pitch.
   The horizontal movement of the note is “magnetically attracted” to the current Quantize value. The position boxes on the toolbar show what the new position and pitch for the dragged note will be.

5. Release the mouse.
   The notes appear at their new position.

• If you press [Ctrl]/[Command] and drag, movement is restricted to vertical or horizontal only (depending on in which direction you drag).

• You can also move selected notes by using key commands, as assigned in the Nudge category in the Key Commands dialog.
   When moving notes to the left or right using key commands, the notes will be moved in steps according to the current Quantize value. The keys assigned for up/down nudging will transpose notes in semitones steps.
Duplicating notes

1. Set the Quantize value and select the notes, as for moving.
2. Press [Alt]/[Option] and drag the notes to their new position.

- If you want to restrict movements to one direction only, press [Ctrl]/[Command].
  This works just as for moving, as described above.
- [Alt]/[Option] is the default modifier key for copying/duplicating. If you like, you can change this in the Preferences dialog (Editing–Tool Modifiers page).
  The entry for this is found in the Drag & Drop category ("Copy").

Changing the length of notes

As described earlier in this section (see page 544), the displayed length of a note isn’t necessarily the actual note length, but also depends on the Note and Rest Display Quantize settings in the Staff Settings dialog. This is important to remember when you change the length of a note, since it can give rise to confusing results.

There are several ways to change the length of a note in the Score Editor:

By using the Note tool

1. Select a Note value that you wish to apply to the Note.
   This can be done by clicking a note value icon in the extended toolbar or by selecting a new Length value.
2. Select the Note tool if it isn’t already selected.
3. Hold down [Alt]/[Option] and click on the notes you wish to set to this length.
By using the note value icons on the extended toolbar

Using the extended toolbar is another quick way to set a number of notes to the same length:

1. Select the notes you want to change.
2. Hold down [Ctrl]/[Command] and click on one of the note icons on the extended toolbar.
   All the selected notes are now given the length of the clicked note.

By using the info line

You can also edit length values numerically on the info line, just like in the Key and Drum Editors (see page 501).

Splitting and Gluing notes

- If you have two notes strung together by a tie, and click on the “tied” note head with the Scissors tool, the note will be divided into two, with the respective length of the “main” and the tied note.

- Conversely, if you click on a note with the Glue Tube tool it will be joined to the next note with the same pitch.

Enharmonic Shift

The buttons to the right on the extended toolbar allow you to shift the display of selected notes so that for example an F# (F sharp) is instead shown as a Gb (G flat) and vice versa:

1. Select the note(s) you want to affect.
2. Click on one of the buttons to display the selected note(s) a certain way.

![Enharmonic Shift Buttons]

The “off” button resets the notes to original display. The other five options are double flats, flats, No, sharps and double sharps.
Flip Stems

Normally the direction of the note stems is automatically selected according to the note pitches, but you can change this manually if you like:

1. Select the notes for which you want to change (flip) the stem direction.
2. Pull down the MIDI menu and select Flip Stems from the Scores submenu.

Working with text

You can use the Text tool to add comments, articulation or instrumentation advice and other text strings anywhere in the score:

Adding a text string

1. Select the Text tool from the toolbar or Quick menu.
2. Click anywhere in the score. A text input line dialog box appears.
3. Enter the text and press [Return].

Editing text

To edit an already added text string, double click it with the Arrow tool. This opens the text for editing, and you can use the arrow keys to move the cursor, delete characters with the [Delete] or [Backspace] keys and type new text as usual. Finish by pressing [Return].

- To delete a text block, select it with the Arrow tool and press [Backspace] or [Delete].

- You can move or duplicate text blocks by dragging (or [Alt]/[Option]-dragging) them, just as with notes.
Changing the text font, size and style

To change the font settings for the text you have added, proceed as follows:

1. Select the text block by clicking it with the Arrow tool.

2. Pull down the MIDI menu and select “Set Font” from the Scores submenu.
   A Font Settings dialog appears, containing the following settings:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font</td>
<td>This is where you specify the font for the text. Which fonts are available on the pop-up menu depends on which fonts you have installed on your computer. You probably don’t want to use the &quot;Steinberg&quot; fonts - these are special fonts used by the program (e.g. for score symbols) and not suited for common text.</td>
</tr>
<tr>
<td>Size</td>
<td>Sets the size of the text.</td>
</tr>
<tr>
<td>Frame</td>
<td>Allows you to encase the text in a rectangular (box) or oval frame.</td>
</tr>
<tr>
<td>Text style options</td>
<td>These checkboxes determine whether the text should be bold, italic, and/or underlined.</td>
</tr>
</tbody>
</table>

3. When you’ve made your settings, click Apply.
   If you like, you can leave the Font Settings dialog open, select another text block and adjust the settings for that - just remember to click Apply before you select a new text block.

- If you make settings in the Font Settings dialog with no text block selected, the settings will be used as default for all new text.
  In other words, all text you enter from then on will get the settings you have specified (although you can of course change this manually for each text block as usual).
Printing

To print your score, proceed as follows:

1. Open the parts you want to print in the Score Editor. Printing is only available from within the Score Editor.

2. Select Page Setup from the File menu and make sure all your Printer settings are correct. This includes paper size and margins.

3. Close the Page Setup dialog and select Print from the File menu.

4. The standard Print dialog appears. Fill out the options as desired.

5. Click Print.
Common MIDI editor options and settings

Snap

Snap activated on the toolbar.

The Snap function helps you to find exact positions when editing in a MIDI editor. It does this by restricting horizontal movement and positioning to certain positions. Operations affected by Snap include moving, duplicating, drawing, sizing, etc.

- When the “Bars+Beats” display format is selected in the ruler, the Quantize value on the toolbar determines the Snap value. This makes it possible to Snap not only to straight note values but also to Swing grids set up in the Quantize Setup dialog (see page 467).

- When any time-based display format is selected in the ruler, editing snaps to whole seconds.

Coloring notes and events

By using the Colors pop-up menu on the toolbar, you can select a color scheme for the events in the editor. The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Velocity</td>
<td>The notes get different colors depending on their velocity values.</td>
</tr>
<tr>
<td>Pitch</td>
<td>The notes get different colors depending on their pitch.</td>
</tr>
<tr>
<td>Channel</td>
<td>The notes get different colors depending on their individual MIDI channel values.</td>
</tr>
<tr>
<td>Part</td>
<td>The notes get the same color as their respective part in the Project window. Use this option when you are working with two or more tracks in an editor, to see better which notes belong to which track.</td>
</tr>
</tbody>
</table>

When any of the first three options is selected, you can select “Setup” from the Colors pop-up menu. This opens a dialog in which you can specify which colors should be associated with which velocities, pitches or channels, respectively.
The Logical Editor, Transformer and Input Transformer
Introduction

Most of the time you will probably perform your MIDI editing graphically, from one of the main graphic editors. But there are times when you want more of a "search and replace" function on MIDI data, and that's where the Logical Editor comes in.

The principle for the Logical Editor is this:

- **You set up filter conditions to find certain events.**
  This could be events of a certain type, with certain attributes or values or on certain positions, in any combination. You can combine any number of filter conditions and make composite conditions using AND/OR operators.

- **You select the basic function to be performed.**
  The options include Transform (changing properties of the found events), Delete (removing the events), Insert (adding new events based on the found events' positions) and more.

- **You set up a list of actions, which specify exactly what should be done.**
  This is not necessary for all functions. For example, the Delete function does not require any additional action specifications – it simply removes all found events. The Transform function on the other hand, requires that you specify which properties should be changed and in which way (transpose notes by a certain amount, adjust velocity values, etc.).

By combining filter conditions, functions and the specific actions, you can perform very powerful processing.

To master the Logical Editor you need some knowledge about how MIDI messages are built up. However, the Logical Editor also comes with a rich selection of presets, allowing you to access its processing powers without delving into its more complicated aspects, see page 565.

Studying the included presets is an excellent way to learn the workings of the Logical Editor! Many of them can also be used as starting points when you set up your own Logical editing tasks.
About the Transformer MIDI effect

The Transformer effect is a real-time version of the Logical Editor, allowing you to apply logical editing to the events played back from a track “on the fly”. The Transformer contains virtually the same settings and functions as the Logical Editor – where there are differences between the two, this is clearly stated on the following pages.

About the Input Transformer

Again, this is very similar to the Logical Editor. Just like the Transformer effect, the Input Transformer works in real time. However, the Input Transformer filters out and transforms MIDI data as it is recorded. In other words, the settings you make in the Input Transformer will affect the actual MIDI events you record.

The Input Transformer is described on page 585. However, we recommend that you make yourself familiar with the Logical Editor first, since they share many features and principles.
Opening the Logical Editor

1. Select the desired parts or events.
   What will be affected by the operation depends on the current selection:
   - In the Project window, Logical editing is applied to all selected parts, affecting all events (of the relevant types) in them.
   - In the MIDI editors, Logical editing is applied to all selected events. If no events are selected, all events in the edited part(s) will be affected.
   You can change the selection while the Logical Editor window is open, if needed.

2. Select “Logical Editor…” from the MIDI menu.
   - For details on how to open the Transformer (and other MIDI effects) see page 430.

Window overview

This is the filter condition list, specifying which events to look for.

This is where you select a function (Transform, Delete, etc.). The field to the right shows an additional explanation of the selected function.

This is the action list, specifying e.g. how to change the found events.

This is where you load, store and handle presets. See page 584.

The “Do It” button performs the task you have set up (not available in the Transformer).
Selecting a preset

To come to terms with the Logical Editor, it might be a good idea to start with exploring the included presets. These are found on the pop-up menu at the bottom of the window, to the right.

- To load a preset, select it from the Presets pop-up menu.
  The window will show the settings stored in the preset. As the preset is not applied to the MIDI events yet, you can load different presets just to study them without affecting any events. You can also edit the preset before performing the Logical editing, if needed.

- To apply the loaded preset (perform the Logical editing), click Do It.

- You can also select Logical Presets directly from the MIDI menu.
  This allows you to apply a preset to the selected MIDI part directly, without having to open the Logical Editor.
  For information on how to create and handle your own presets, see page 584.
# Setting up filter conditions

## General procedure

<table>
<thead>
<tr>
<th>Filter Target</th>
<th>Condition</th>
<th>Parameter 1</th>
<th>Parameter 2</th>
<th>Bar Range</th>
<th>Bool</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pitch</td>
<td>Bigger or Equal</td>
<td>C-2</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The upper list is where you set up the filter conditions, determining which events to find. The list contains one or several conditions, each on a separate line.

- If you want to start from scratch (as opposed to basing your settings on an existing preset) you may want to initialize the settings by selecting the Init option from the Presets pop-up menu.

- To add a new line (condition) click the Add Line button to the right. The new line is added at the bottom of the list. If there are many lines, you may need to use the scrollbar to the right to view them.

- To remove a line, click anywhere on it to select it and click the Delete Line button to the right.
You set up a filter condition line by clicking in the columns and selecting options from the pop-up menus that appear. Here is a brief description of the columns:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left bracket</td>
<td>This is used for “bracketing” several lines together when creating conditions with multiple lines and the boolean operators And/Or. See page 574.</td>
</tr>
<tr>
<td>Filter Target</td>
<td>Here you select which property to look for when finding events. Your choice here affects the available options in the other columns as well, see below!</td>
</tr>
<tr>
<td>Condition</td>
<td>This determines how the Logical Editor should compare the property in the Filter Target column to the values in the Parameter columns (Equal, Unequal, Bigger, etc. – see the separate table below). The available options depend on the Filter Target setting.</td>
</tr>
<tr>
<td>Parameter 1</td>
<td>Here you set which value the event properties should be compared to (a numeric value, a position or a choice from a pop-up menu, depending on the Filter Target). For example, if the Filter Target is “Position” and Condition is “Equal”, the Logical Editor will look for all events starting at the position you specify in the Parameter 1 column.</td>
</tr>
<tr>
<td>Parameter 2</td>
<td>This column is only used if you have selected one of the “Range” options in the Condition column. Typically, this allows you to find all events with values within (or outside) the range between Parameter 1 and Parameter 2.</td>
</tr>
<tr>
<td>Bar Range</td>
<td>This column is only used if the Filter Target is “Position” and one of the “Bar Range” options is selected in the Condition column. In these cases, you use the Bar Range column to specify “zones” within each bar (allowing you to find e.g. all events on or around the first beat of every bar). See page 569.</td>
</tr>
<tr>
<td>Right bracket</td>
<td>This is used for “bracketing” several lines together. See page 574.</td>
</tr>
<tr>
<td>bool</td>
<td>This allows you to insert the boolean operators And/Or, when creating conditions with multiple lines. See page 574.</td>
</tr>
</tbody>
</table>
## Conditions

The options in the Condition column have the following meaning (please note that the available Condition options depend on the Filter Target setting):

<table>
<thead>
<tr>
<th>Condition</th>
<th>Events will be found if their Filter Target property...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equal</td>
<td>...has the exact same value as set up in the Parameter 1 column.</td>
</tr>
<tr>
<td>Unequal</td>
<td>...has any value other than the one set up in the Parameter 1 column.</td>
</tr>
<tr>
<td>Bigger</td>
<td>...has a value higher than the one set up in the Parameter 1 column.</td>
</tr>
<tr>
<td>Bigger or Equal</td>
<td>...has a value that is the same as or higher than the one set up in the Parameter 1 column.</td>
</tr>
<tr>
<td>Less</td>
<td>...has a value lower than the one set up in the Parameter 1 column.</td>
</tr>
<tr>
<td>Less or Equal</td>
<td>...has a value that is the same as or lower than the one set up in the Parameter 1 column.</td>
</tr>
<tr>
<td>Inside Range</td>
<td>...has a value that is between the values set up in the Parameter 1 and Parameter 2 columns. Note that Parameter 1 should be the lower value and Parameter 2 the higher.</td>
</tr>
<tr>
<td>Outside Range</td>
<td>...has a value that is not between the values set up in the Parameter 1 and Parameter 2 columns.</td>
</tr>
<tr>
<td>Inside Bar Range</td>
<td>...is within the “zone” set up in the Bar Range column (Position only), in each bar within the current selection.</td>
</tr>
<tr>
<td>Outside Bar Range</td>
<td>...is outside the “zone” set up in the Bar Range column (Position only), in each bar within the current selection.</td>
</tr>
<tr>
<td>Note is equal to</td>
<td>...is the note specified in the Parameter 1 column, regardless of octave (Pitch only). Lets you find e.g. all C notes, in all octaves.</td>
</tr>
</tbody>
</table>

- The Conditions for the “Property” filter target are different, see page 573.

Below, the different Filter Targets (and their corresponding Condition and Parameter options) are described in more detail.
**Searching for events at certain positions**

Selecting Position in the Filter Target column lets you find events starting at certain positions, either relative to the start of the song or within each bar.

- If you select any Condition other than the Range or Bar Range options, you set up a specific position (in bars, beats, sixteenth notes and ticks) in the Parameter 1 column.

  ![Example of Position 5.1.1](image)

  Here, the Logical Editor will find all events at 5.1.1 in the project.

- If you select the Inside or Outside Range option in the Condition column, you set the start position of the range in the Parameter 1 column and the end position in the Parameter 2 column.

  ![Example of Inside or Outside Range](image)

  The Logical Editor will then find all events inside or outside this position range.

- If you select one of the Bar Range options in the Condition column, the Bar Range column will show a graphic bar display. You specify the range within the bar by clicking and dragging in the bar display (the specified Bar Range is indicated in blue).

  ![Example of Bar Range](image)

  The Logical Editor will then find all events starting inside or outside this Bar Range, in all bars (within the current selection).

  ![Example of Position in Bar Range](image)

  Here, the Logical Editor will find events starting around the second beat in each bar.
Searching for notes of certain lengths

Only note events have lengths (actually, a note is made up of separate note-on and note-off events but in Cubase SX/SL it’s considered as a single event with a length). Therefore, the “Length” Filter Target is only valid if you’re specifically searching for notes – there has to be another condition line with the Filter Target “Type”, Condition “Equal” and Parameter 1 set to “Note”. See page 574 for more about using multiple filter conditions.

Searching for Value 1 or Value 2

A MIDI event is composed of several values. The meanings of value 1 and 2 depend on the type of event:

<table>
<thead>
<tr>
<th>Event type</th>
<th>Value 1</th>
<th>Value 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notes</td>
<td>The Note Number/Pitch.</td>
<td>The velocity of the note.</td>
</tr>
<tr>
<td>PolyPressure</td>
<td>The key that was pressed.</td>
<td>The amount of pressure for the key.</td>
</tr>
<tr>
<td>Controller</td>
<td>The type of Controller, displayed as a number.</td>
<td>The amount of Control Change.</td>
</tr>
<tr>
<td>Program Change</td>
<td>The Program Change number.</td>
<td>Not used.</td>
</tr>
<tr>
<td>Aftertouch</td>
<td>The amount of pressure.</td>
<td>Not used.</td>
</tr>
<tr>
<td>Pitchbend</td>
<td>The “fine tune” of the bend.</td>
<td>The coarse amount of bend.</td>
</tr>
</tbody>
</table>

• System Exclusive events are not included in the table above, since they don’t use value 1 and 2.

Since value 1 and 2 have different meanings for different events, searching for e.g. value 2 = 64 would both find notes with the velocity 64 and controllers with the amount 64, etc. If this is not what you want, you can add an additional filter condition line with the Filter Target “Type”, specifying which type of events to find (see below).

❑ This is particularly useful when searching for note pitch or velocity values, as described below.
The general procedures when searching for value 1 or 2 are:

- If you select any Condition other than the Range options, you set up a specific value in the Parameter 1 column.

Here, the Logical Editor will find all events with a value 2 less than 80.

- If you select the Inside or Outside Range option in the Condition column, the range consists of the values between Parameter 1 and Parameter 2. Note that Parameter 1 should have the lower value.

### Searching for note pitch or velocity

If you add another condition line with the Filter Target “Type”, Condition “Equal” and Parameter 1 set to “Note”, the Logical Editor will “know” you are searching for pitch or velocity. This has the following benefits:

- The Filter Targets Value 1 and Value 2 will be displayed as “Pitch” and “Velocity” respectively, making it easier to grasp the function of the filter condition.
- Pitch values in the Parameter columns will be displayed as note names (C3, D#4, etc.). When entering pitch values you can either type a note name or a MIDI note number (0-127).
- When Value 1 (pitch) is selected as Filter Target, an additional option appears in the Condition column: “Note is equal to”. When this is selected, you specify a note name in the Parameter 1 column but without any octave number (C, C#, D, D#, etc.). The Logical Editor can then find all notes of a certain key, in all octaves.

See page 574 for more info on working with multiple filter condition lines.
Searching for controllers

There is similar extended functionality when searching for controllers: If you've added an additional "Type = Controller" condition line, the Logical Editor will "know" you are searching for controllers. The Parameter 1 column will then show the names of the MIDI controllers (Modulation, Volume, etc.) when Value 1 is selected as Filter Target.

Searching for MIDI channels

Each MIDI event contains a MIDI channel setting (1-16). Normally, these settings are not used, since the MIDI event plays back on the MIDI channel set for its track. However, you can come across MIDI parts with events set to different channels in the following scenarios for example:

• If you have recorded MIDI from an instrument sending on several different channels (e.g. a master keyboard with different key zones).
• If you have imported a MIDI file of type 0 (with a single track, containing MIDI events with different channel settings).

Searching for MIDI channel values is straightforward; you select a Condition and enter a MIDI channel (1-16) in the Parameter 1 column (and, if you've selected one of the Range Conditions, a higher channel in the Parameter 2 column, creating a value range).

Searching for event types

Selecting the Filter Target Type allows you to find events of a certain type only.

• The Condition column contains three options only: Equal, Unequal and All Type.
• Clicking the Parameter 1 column displays a pop-up menu, listing the available event types (Note, PolyPressure, Controller, etc.).

The Logical Editor will find all events matching or not matching the selected type (depending on the Condition).

As mentioned above, selecting Type = Note or Type = Controller adds some additional functionality to the Logical Editor. You should make it a habit to add a Type condition when applicable.
Searching for properties

On the Filter Target pop-up menu you will find an option called Property. This allows you to search for properties that are not part of the MIDI standard but rather event-specific Cubase SX/SL settings.

When the Property option is selected, the Condition column has two options: “Property is set” and “Property is not set”. Which property to look for is selected in the Parameter 1 column. The options are “muted”, “selected” and “locked”. Two examples:

Here, the Logical Editor will find all muted events.

Here, the Logical Editor will find all events that are selected but not muted.
Combining multiple condition lines

As described above, you can add condition lines by clicking the Add Line button to the right of the list. The result of combining condition lines depends on the boolean And/Or operators and the brackets.

The bool column

By clicking in the boolean column to the right in the list, you can select a boolean operator: And or Or. A bool operator separates two condition lines and determines the result in the following way:

- If two condition lines are separated by a boolean And, both conditions must be fulfilled for an event to be found.

  The Logical Editor will only find events that are notes and start at the beginning of the third bar.

- If two condition lines are separated by a boolean Or, one of the conditions (or both) must be fulfilled for an event to be found.

  The Logical Editor will find all events that are notes (regardless of their position) and all events starting at the beginning of the third bar (regardless of their type).

When you add a new condition line, the boolean setting defaults to And. Therefore, if all you want to do is set up two or more conditions that all must be met for an event to be found, you don’t have to think about the boolean column – just add the required lines and make the usual filter settings.
Using brackets

The bracket (parenthesis) columns let you enclose two or more condition lines, dividing the conditional expression into smaller units. This is only relevant when you have three or more condition lines and want to use the boolean Or operator. This is how it works:

- **Without brackets, the conditional expressions are evaluated according to their order in the list.**

In this case we have the expression Type = Note AND Pitch = C3 OR Channel = 1, without brackets. This means that the Logical Editor will find all MIDI notes with the pitch C3, as well as all events (regardless of their type) set to MIDI channel 1.

Maybe you wanted to find all notes that either had the pitch C3 or the MIDI channel 1 (but no non-note events)? Then you need to add some brackets:

Here the expression is Type = Note AND (pitch = C3 OR Channel = 1), which will find what you want. The rule behind this is:

- **Expressions within brackets are evaluated first.**

If there are several layers of brackets, these are evaluated “from the inside out”, starting with the innermost brackets.

You add brackets by clicking in the bracket columns and selecting an option. Up to triple brackets can be selected.
Editing filter conditions as text

The area directly below the filter condition list shows you the current filter conditions as text. It also allows you to enter and edit the filter conditions in textual form. For tips on the syntax, please study the included presets.

- There is no additional functionality involved when editing filter conditions as text; it is simply another way to make settings.

When you enter something in the text field you will see the corresponding settings appear in the filter condition list (provided that you have used the correct syntax).
Selecting a function

The pop-up menu in the upper left corner of the Logical Editor is where you select the function – the basic type of editing to be performed. When you select an option from the pop-up menu, the field to the right displays a clarifying text, making it easier to see what the function does.

In the Logical Editor, processing isn’t performed until you click the Do It button. When using the Transformer MIDI effect there is no Do It button – the current settings are automatically applied in real time during playback or live playing.

Below, the available options are listed. Note that some options are available in the Logical Editor only – not in the Transformer effect.

Delete

Deletes all events found by the Logical Editor. In the case of the Transformer, this function will remove (or “mute”) all found events from the “output stream” – the actual events on the track are not affected.

Transform

Changes one or several aspects of the found events. You set up exactly what should be changed in the action list, as described on page 579.

Insert

This will create new events and insert these into the part(s) (Logical Editor) or the output stream (Transformer). The new events will be based on the events found by the Logical Editor’s filter conditions, but with any changes you have set up in the action list applied.

Another way of expressing this is that the Insert function copies the found events, transforms them according to the action list and inserts the transformed copies among the existing events.
**Insert Exclusive**

This will transform the found events according to the action list. Then, all events that were not found (that didn’t fit the filter conditions) are deleted (Logical Editor) or removed from the output stream (Transformer).

**Copy (not available in the Transformer)**

This will copy all found events, transform them according to the action list and paste them into a new part on a new MIDI track. The original events are not affected.

**Extract (not available in the Transformer)**

This works like Copy, but will cut the found events instead. Or in other words, Extract will transform all found events and move them to a new part on a new MIDI track.

**Select (not available in the Transformer)**

This will simply select all found events, highlighting them for further work in the regular MIDI editors.
Specifying actions

The lower list in the Logical Editor window is the action list. This is where you specify any changes that should be made to the found events (relevant for all function types except Delete and Select).

The handling of the action list is similar to the filter condition list, but without the brackets and booleans. You simply add lines by clicking the Add Line button to the right, and fill out the columns as required. To remove a superfluous action line, select it and click the Delete Line button.

Below, the four list columns are described:

### Action Target

This is where you select the property that should be changed in the events:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>Adjusting this value will move the events.</td>
</tr>
<tr>
<td>Length</td>
<td>Lets you resize the events (notes only)</td>
</tr>
<tr>
<td>Value 1</td>
<td>This adjusts value 1 in the events. As described on page 570, the meaning of value 1 depends on the event type. For notes, value 1 is the pitch.</td>
</tr>
<tr>
<td>Value 2</td>
<td>This adjusts value 2 in the events. As described on page 570, the meaning of value 2 depends on the event type. For notes, value 2 is the velocity value.</td>
</tr>
<tr>
<td>Channel</td>
<td>Allows you to change the MIDI channel setting. See page 572.</td>
</tr>
<tr>
<td>Type</td>
<td>Allows you to change an event from one type to another, e.g. transform aftertouch events to modulation events.</td>
</tr>
<tr>
<td>Value 3</td>
<td>This adjusts value 3 in the events. At the time of this writing, this option is only implemented for notes and corresponds to the note off value.</td>
</tr>
</tbody>
</table>
Operation

This setting determines what to do with the Action Target. The options on this pop-up menu are different depending on the selected Action Target. Below, all available operations are listed:

Add
Add the value specified in the Parameter 1 column to the Action Target.

Subtract
Subtracts the value specified in the Parameter 1 column from the Action Target.

Multiply by
Multiplies the Action Target value with the value specified in the Parameter 1 column.

Divide by
Divides the Action Target value with the value specified in the Parameter 1 column.

Round by
This “rounds” the Action Target value with the value specified in the Parameter 1 column. In other words, the Action Target value is changed to the closest value that can be divided by the Parameter 1 value.

For example, if the Action Target value is 17 and Parameter 1 is 5, the result of rounding will be 15 (the closest value that can be divided by 5). Another word for this type of operation would be “quantizing”, and it’s actually possible to use it for this, by setting the Action Target to “Position” and specifying a quantize value with Parameter 1 (in ticks, with 480 ticks per quarter note).

Set Random Values between
This will set the Action Target value to a random value within the range specified with Parameter 1 and 2.
Set Relative Random Values between

This will add a random value to the current Action Target value. The added random value will be within the range specified with Parameter 1 and 2. Note that these can be set to negative values.

For example, if you set Parameter 1 to -20 and Parameter 2 to +20, the original Action Target value will get a random variation, never exceeding ±20.

Set to fixed value

This sets the Action Target to the value specified in the Parameter 1 column.

Add Length

This is only available when Action Target is set to Position. Furthermore, it is only valid if the found events are notes (and thus have a length). When Add Length is selected, the length of each note event will be added to the Position value. This can be used for creating new events (using the Insert function) positioned relative to the end positions of the original notes.

Transpose to Scale

This is only available when Action Target is set to Value 1, and when the filter conditions are specifically set up to find notes (a “Type = Note” filter condition line has been added). When Transpose to scale is selected, you can specify a musical scale using the Parameter 1 and 2 columns. Parameter 1 is the key (C, C#, D, etc.) while Parameter 2 is the type of scale (major, melodic or harmonic minor, etc.).

Each note will be transposed to the closest note in the selected scale.
Use Value 2

This is only available when Action Target is set to Value 1. If this option is selected, the Value 2 setting in each event will be copied to the Value 1 setting.

For example, this would be useful if you are transforming all Modulation controllers to Aftertouch events (since controllers use Value 2 for their amount, while Aftertouch use Value 1 – see the table on page 570).

Use Value 1

This is only available when Action Target is set to Value 2. If this option is selected, the Value 1 setting in each event will be copied to the Value 2 setting.

Mirror

This is only available when Action Target is set to Value 1 or Value 2. When this option is selected, the values will be “mirrored” or “flipped” around the value set in the Parameter 1 column.

In the case of notes, this will invert the scale, with the key set in the Parameter 1 column as “center point”.

Linear Change in Loop Range

This will affect events within the cycle loop range (between the left and right locators) only. It will create a linear “ramp” of values (replacing the original values) starting at the value in the Parameter 1 column and ending at the Parameter 2 value.

This can be used for creating linear controller sweeps, velocity ramps, etc.
Relative Change in Loop Range

As with the previous option, this will create a ramp of values, affecting events in the cycle loop range only. However, here the changes are “relative”, meaning that values will be added to the existing values.

In other words, you set up a value ramp starting at Parameter 1 and ending at Parameter 2 (note that the Parameter values can be negative). The resulting value ramp is then added to the existing values for the events within the cycle loop range.

For example, if you apply this to note velocities with Parameter 1 set to 0 and Parameter 2 set to -127, you would create a velocity fade-out, keeping the original velocity relations:

<table>
<thead>
<tr>
<th>Filter Type</th>
<th>Condition</th>
<th>Parameter 1</th>
<th>Parameter 2</th>
<th>Loop Range</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Velocity</td>
<td>Inside Range</td>
<td>0</td>
<td>127</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Add Action Target</th>
<th>Operation</th>
<th>Parameter 1</th>
<th>Parameter 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value 2</td>
<td>Relative Change in Loop Range</td>
<td>0</td>
<td>-127</td>
</tr>
</tbody>
</table>

Performing the Logical editing

Once you have set up filter conditions, selected a function and set the required actions (or loaded a preset), you perform the Logical editing by clicking the Do It button.

Logical editing can be undone just like any other editing.

- Again, when using the Transformer MIDI effect there is no Do It button. The processing is applied to the events played back from the track (or played live “thru” the track) as soon as you set it up.

  Since no existing events on the track are affected by the Transformer setting, there is no need for undo.
Working with presets

The Presets section in the lower right area of the window allows you to load, store and manage Logical Editor presets. A preset contains all settings in the window, which means you can perform Logical editing by simply loading a preset and clicking Do It.

• To load a preset, select it from the Presets menu.

Storing your own settings as a preset

If you have made Logical Editor settings that you may want to use again, you can store them as a preset:

1. If you like, enter some explanatory text in the Comment field.
   An extra description of the preset can be useful, especially if the settings are complex.

2. Click the Store button in the Presets section.
   A name dialog appears.

3. Enter a name for the preset and click OK.
   The preset is stored.

• To remove a preset, load it and click the Remove button.

Organizing and sharing presets

The Logical Editor presets are stored as individual files within the Cubase SX/SL program folder, in the presets\Logical Edit subfolder. While these files cannot be edited "manually", you can reorganize them (e.g. putting them in subfolders) like any files.

This also makes it easy to share presets with other Cubase SX/SL users, by transferring the individual preset files.

• The list of presets is read each time the Logical Editor is opened.
The Input Transformer

This function allows you to selectively filter out and change MIDI data coming to a MIDI track, before it is recorded. The Input Transformer is very similar to the Transformer MIDI effect, but contains four independent “modules”, for which you can set up different filtering and actions if you like. You can activate any or all of these four modules.

Here are some of the things the Input Transformer allows you to do:

- Make up split keyboard combinations for recording left and right hands separately.
- Turn a controller like a foot pedal into MIDI notes (for playing bass drum the right way).
- Filter out one specific type of MIDI data on one MIDI channel only.
- Turn aftertouch into any controller (and vice versa).
- Invert velocity or pitch.

And again: four of these things can be done at the same time.

Opening the Input Transformer

To open the Input Transformer for a MIDI track, select the track and click the Input Transformer button in the Inspector.

![Image of Input Transformer interface]
Handling the four modules

The Input Transformer is really four separate transformers, or modules.

• You select which module to view and make settings for by clicking its button in the Selected Module section.

Module 2 selected for viewing and editing.

• The checkboxes in the Active Module section determine which module(s) are active.

Here, modules 1, 2 and 4 are active.

The two modes

The Mode pop-up menu contains two modes: Filter and Transform.

• In the Filter mode, only the filter conditions (the upper list) are taken into account. All events matching the conditions set up will be filtered out (excluded from the recording).

• In the Transform mode, events matching the filter conditions will be transformed according to the settings in the action list (the lower list).
Setting up filtering and actions

This is done just like in the Logical Editor. Here is a brief rundown:

- Click the Add Line buttons to add lines to the filter condition list or action list.
  To remove a line, click it to select it and click the Delete Line button to the right.

- Clicking the columns in the filter condition list brings up pop-up menus, allowing you to specify the conditions to match.

- Clicking the columns in the action list brings up pop-up menus, allowing you to specify what should be done to the found events (when Transform mode is selected).

  For detailed descriptions of the filter conditions and action columns, see page 566.

- Selecting the Init option from the Presets pop-up menu will reset the selected module, removing all filter condition and target list lines.

- The Input Transformer has no “Do It” button – the settings are active as soon as you activate an Active Module checkbox.
  The settings made in the activated modules will affect all MIDI data you record on the track.

  **Closing the Input Transformer window does not turn it off – you need to deactivate all Active Module checkboxes for this!**
  A lit Input Transformer button in the Inspector indicates that one or more modules are active.
The Logical Editor, Transformer and Input Transformer
23
The Tempo Track Editor
Background

For each audio or MIDI track in Cubase SX/SL, you can specify whether it should be time based or tempo based (see page 72). For tempo based tracks, the tempo can either be fixed through the whole project (this is called “Rehearsal tempo”) or follow the Tempo track (this is called “Master tempo”), which may contain tempo changes.

- To switch between Rehearsal mode and Master Tempo track mode, use the Master button on the Transport bar or in the Tempo Track Editor.
  When the Master button is activated, the tempo follows the Tempo track, when it is de-activated, the Rehearsal Tempo is used (see page 598).

The Tempo track also contains time signature events. These are always active, regardless of whether Rehearsal mode or Master mode is selected.

A note about tempo based audio tracks

For tempo based tracks, the start time position of audio events depends on the current tempo setting. However, it is important to realize that the actual audio (“within” the events) will play back as recorded, regardless of any tempo changes you make. Therefore, it’s good practice to make the proper tempo and time signature settings before you start recording tempo based audio.

- To make an already recorded audio track follow the tempo changes, you can use the Hitpoints and Slicing features, as described on page 382.
  How well this works depends on the character of the audio recordings, since the Hitpoint detection feature works best with fairly rhythmical material.

Opening the Tempo Track Editor

To make changes to the actual Tempo track, you need to open the Tempo Track Editor. This is done by selecting “Tempo track” on the Project menu.
Window overview

The toolbar

The toolbar contains various tools and settings. The Tempo and Signature displays to the right allow you to view and edit the value of the selected tempo curve point or time signature event, much like the info line in other editors.
The ruler

The ruler in the Tempo Track Editor shows the timeline. As in other windows, you can select a display format by clicking on the arrow button to the right of the ruler, and selecting an option from the pop-up menu that appears.

The two additional items at the bottom of the menu have the following functionality:

- If “Time Linear” is selected, the ruler, time signature area and tempo curve display will be linear in relation to the timeline. This means that if the ruler shows bars and beats, the distance between the bar lines will vary depending on the tempo.
• If “Bars+Beats Linear” is selected, the ruler, time signature area and tempo curve display will be linear in relation to beats. This means that if the ruler shows bars and beats, the distance between beats will be constant.

The time signature area

The area below the ruler contains time signature events.

The tempo curve display

The main display shows the tempo curve (or, if Rehearsal mode is selected, the Rehearsal tempo – see page 598). To the left of the display is a tempo scale to help you quickly locate the desired tempo.

• Note that the vertical “grid lines” correspond to the display format selected for the ruler.
Operations

Zooming

Changing the magnification is done using any of the following methods:

• By using the zoom sliders in the lower right corner of the window.
• By using the Magnifying Glass tool.
  This works according to the standard procedures.
• By using the Zoom submenu on the Edit menu.
  The options on the menu work as in other windows.

Editing the tempo curve

☐ This section assumes that you are working in Tempo track mode, i.e. the Master button is activated.

Adding tempo curve points

1. Use the “Insert Curve” pop-up menu in the toolbar to select whether you want the tempo to change gradually from the previous curve point to the new one (“Ramp”) or change instantly to the new value (“Jump”).

2. Select the Pencil tool.

3. Click at the desired time position in the tempo curve display, and keep the mouse button pressed.
   If Snap is activated on the toolbar, this determines at which time positions you can insert tempo curve points, see page 599.

When you click, the Tempo Display in the toolbar shows the tempo value.
4. Drag the curve point to the desired tempo value (indicated in the Tempo Display), and release the mouse button.
The tempo curve point is inserted. The result depends on whether you selected “Ramp” or “Jump” in step 1 above:

- You can also just click and draw a tempo curve with the Pencil tool, having curve points automatically inserted as you draw.
  You would probably want to select the “Ramp” Insert Curve mode when doing this.

- Instead of using the Pencil tool, you can press [Alt]/[Option] and use the Arrow tool.
  This will only insert a single point (i.e. you cannot draw a curve with the Arrow tool).

You can also have tempo values automatically inserted by the Beat Calculator, see page 600.

Selecting tempo curve points

Selecting curve points is done using any of the following methods:

- Use the Arrow tool.
  The standard selection techniques apply.

- Use the Select submenu on the Edit menu.
  The options are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Selects all curve points on the Tempo track.</td>
</tr>
<tr>
<td>None</td>
<td>Deselects all curve points.</td>
</tr>
<tr>
<td>In Loop</td>
<td>Selects all curve points between the left and right locator.</td>
</tr>
<tr>
<td>From Start to Cursor</td>
<td>Selects all points to the left of the project cursor.</td>
</tr>
<tr>
<td>From Cursor to End</td>
<td>Selects all points to the right of the project cursor.</td>
</tr>
</tbody>
</table>
You can also use the left and right arrow keys on the computer keyboard, to go from one curve point to the next. If you press [Shift] and use the arrow keys, the current selection will be kept, allowing you to select several points.

**Editing tempo curve points**

Curve points can be edited in the following ways:

- By clicking and dragging horizontally and/or vertically. If several points are selected, all of them are moved. If Snap is activated on the toolbar, this determines to which time positions you can move curve points, see page 599.

- By adjusting the tempo value in the Tempo Display on the toolbar. For this to work, a single tempo curve point must be selected.

Dragging tempo curve points with a time based display format (any other format than “Bars+Beats”) may give confusing results. This is because moving a point will change the relationship between tempo and time. Specifically, let’s say you move a tempo point to the right and drop it on a certain time position. When you release the mouse button, the mapping between tempo and time will be adjusted (since you have changed the tempo curve). As a result, the moved point will appear at another position. For this reason, we recommend that you use the Bars+Beats display format when editing tempo curves.
Adjusting the curve type

You can change the curve type of a tempo curve segment at any time, using the following method:

1. Select all curve points within the segment you want to edit.

   ![Diagram](image1)

2. Pull down the Curve pop-up menu on the toolbar and select “Jump” or “Ramp”.
   The curve sections between the selected points are adjusted.

   ![Diagram](image2)

Removing tempo curve points

To remove a curve point, either click on it with the Eraser tool or select it and press [Backspace]. The first tempo curve point cannot be removed.
Setting the Rehearsal tempo

When the Master button is deactivated, the Tempo track curve is greyed out (but still visible). Since the Rehearsal tempo is constant throughout the whole project, there are no tempo curve points. Instead, the Rehearsal tempo is displayed as a horizontal black line in the tempo curve display.

There are two ways to set the tempo in Rehearsal mode:

- Drag the tempo line up or down with the Arrow tool.
- Adjust the value numerically in the Tempo Display on the toolbar.
Adding and editing time signature events

- To add a time signature event, click in the time signature area with the Pencil tool. This adds a default 4/4 time signature event at the closest bar position. You can also do this by pressing [Alt]/[Option] and clicking with the Arrow tool.

- To edit the value of a time signature event, select it and adjust the value in the Signature display on the toolbar. Note that there are two thumbwheel controls for the Signature display; the left adjusts the numerator and the right adjusts the denominator.

- You can move a time signature event by clicking and dragging it with the Arrow tool. Again, note that time signature events can only be positioned at the start of bars.

- To remove a time signature, either click on it with the Eraser tool or select it and press [Backspace]. The first time signature event cannot be removed.

Options and settings

Snap

You activate or deactivate Snap by clicking the Snap icon on the toolbar. The behavior of the function depends on the display format selected for the ruler:

- If “Bars+Beats” is selected, tempo curve points will snap to the start of bars.

- If any other display format is selected, tempo curve points will snap to the vertical grid lines in the tempo curve display. The spacing of the grid lines depends on the horizontal magnification.

- Time signature events can only be positioned at the start of bars, regardless of whether Snap is activated or not.

Auto Scroll

When this option is activated, the tempo curve display will scroll during playback, keeping the project cursor visible.
The Beat Calculator

The Beat Calculator is a tool for calculating the tempo of freely recorded audio or MIDI material. It also allows you to set the tempo by tapping.

Calculating the tempo of a recording

1. In the Project window, make a selection that covers an exact number of beats of the recording.

2. Select “Beat Calculator…” from the Project menu.

3. Enter the number of beats that the selection encompasses in the Beats field.

4. If you like, you can insert the calculated tempo into the Tempo track, by clicking one of the buttons in the lower left corner of the Beat Calculator window.

   • If you need to adjust the selection, you can just go back to the Project window, leaving the Beat Calculator open.
   
   □ If Rehearsal mode is selected when you insert the calculated tempo, the Rehearsal tempo will be adjusted, regardless of which button you click.
Using Tap Tempo

The Tap Tempo function allows you to specify a tempo by tapping:

1. Open the Beat Calculator.

2. If you want to tap the tempo to some recorded material, activate playback.

3. Click the Tap Tempo button.
   The Tap Tempo window appears.

   Tap the space bar or mouse button to set tempo.
   Press the ESC key when you are done.

4. Tap the tempo on the computer keyboard’s space bar or with the mouse button.
   The tempo display will update the calculated tempo between each tap.

5. When you stop tapping, the program calculates the average timing of the taps and displays it.

6. Press [Esc] to close the Tap Tempo window.
   The tapped tempo is now shown in the Beat Calculator’s BPM display. If you like, you can insert it into the Tempo track as described on the previous page.
Background

While the Project window and the editors display events and other data graphically, the Project Browser window provides a list based representation of the project. This allows you to view and edit all events on all tracks by using regular value editing in a list.

Opening the Project Browser

You open the Project Browser by selecting “Browser” from the Project menu. The Browser window can be open while you are working in other windows; any changes made in the Project window or an editor are immediately reflected in the Project Browser and vice versa.

Window Overview

- The Domain (display format) pop-up menu.
- The Add pop-up menu and Add button, for creating new parts, events and regions.
- The Filter pop-up menu, used when editing MIDI.
- The Project Structure list. This is where you navigate through the project.
- The event display. This is where you view and edit parts, events and Regions.
Navigating in the Browser

You use the Project Browser much like you use the Mac OS X Finder and Windows Explorer for browsing folders on your hard disk:

- Click on an item in the Project Structure list to select it for viewing. The contents of the item are shown in the event display.

In this figure, the parts on a MIDI track are displayed.

- Click the Up button above the event display to view the items “one step up” in the hierarchy. For example, if you are viewing the contents of a MIDI part and click the Up button, the contents of the MIDI track are displayed instead.
• Items with hierarchical substructures can be folded out by clicking the plus symbols or the “Closed Folder” symbols in the Project Structure list.
  When the substructure of an item is revealed, a minus symbol or an “Open Folder” symbol is shown instead – click this to hide the substructure.

• To reveal or hide all substructures in the Project Structure list, use the buttons “[+] All” and “[–] All” above the list.

• The actual editing is done in the event display, using regular value editing techniques.
  There is one exception: You can rename items in the Project Structure list by clicking on their names and typing.
Customizing the View

You can drag the divider between the Project Structure list and the event display to make one of them wider and the other narrower. Furthermore, the event display can be customized in the following ways:

• You can change the order of the columns by dragging the column headings to the left or right.

• You can resize columns by dragging the dividers between the column headings.

• To select a display format for all position and length values, use the Domain pop-up menu.

• You can sort events in the display by columns, by clicking the column heading. If you for example want to sort events by their start positions, click that column heading. An arrow appears in the column heading, indicating that events are sorted by that column. The direction of the arrow indicates whether the events are sorted in ascending or descending order. To change the direction, click the column heading again.

About the Sync Selection option

If the “Sync Selection” checkbox is activated (in the upper right corner of the Project Browser), selecting an event in the Project window automatically selects it in the Project Browser, and vice versa. This makes it easy to locate events in the two windows.

• This function is only available when a single event or part is selected.
Editing audio tracks

Audio tracks have two “subitems”: Track Data and Automation.

- The Automation item corresponds to the Automation subtrack in the Project window, and contains the track’s automation events (see page 613).
- The Track Data item corresponds to the actual audio track in the Project window. It contains audio events and/or audio parts, which in turn can contain audio events.

The following parameters are available for the different items:

The list columns for audio parts:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the part. Double clicking on the part symbol beside it opens the Audio Part Editor for the part.</td>
</tr>
<tr>
<td>Start</td>
<td>The start position of the part. Editing this value is the same as moving the part in the Project window.</td>
</tr>
<tr>
<td>End</td>
<td>The end position of the part. Editing this value is the same as resizing the part in the Project window.</td>
</tr>
<tr>
<td>Length</td>
<td>The length of the part. Editing this value is the same as resizing the part in the Project window.</td>
</tr>
<tr>
<td>Offset</td>
<td>This adjusts the start position of the events within the part. Adjusting this value is the same as sliding the contents of the part in the Project window (see page 87): setting a positive Offset value is the same as sliding the contents to the left, while a negative Offset corresponds to sliding the contents to the right.</td>
</tr>
<tr>
<td>Mute</td>
<td>Click in this column to mute or unmute the part.</td>
</tr>
</tbody>
</table>
The list columns for audio events:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Allows you to enter a descriptive comment for the event. Double clicking on the waveform image beside it opens the Sample Editor for the event.</td>
</tr>
<tr>
<td>File</td>
<td>The name of the audio file referred by the event’s audio clip.</td>
</tr>
<tr>
<td>Start</td>
<td>The start position of the event. If the event belongs to an audio part, you cannot move it outside the part.</td>
</tr>
<tr>
<td>End</td>
<td>The end position of the event.</td>
</tr>
<tr>
<td>Snap</td>
<td>The absolute position of the event’s Snap point. Note that adjusting this value will not change the position of the Snap point within the event – instead it is another way of moving the event!</td>
</tr>
<tr>
<td>Length</td>
<td>The length of the event.</td>
</tr>
<tr>
<td>Offset</td>
<td>This determines &quot;where in the audio clip&quot; the event starts. Adjusting this value is the same as sliding the contents of the event in the Project window (see page 87). You can only specify positive Offset values, since the event cannot start before the start of the clip. Likewise, it cannot end after the end of the clip. If the event already plays the whole clip, the Offset cannot be adjusted at all.</td>
</tr>
<tr>
<td>Volume</td>
<td>The volume of the event, as set with the Volume handle or on the info line in the Project Window.</td>
</tr>
<tr>
<td>Fade In</td>
<td>The length of the fade-in and fade-out areas respectively. If you use these settings to add a fade (where there previously was none), a linear fade will be created. If you adjust the length of an existing fade, the previous fade shape will be maintained.</td>
</tr>
<tr>
<td>Mute</td>
<td>Click in this column to mute or unmute the event.</td>
</tr>
<tr>
<td>Image</td>
<td>Displays a waveform image of the event inside a grey box corresponding to the clip. The image is scaled according to the width of the column. Click on the image to open the Sample Editor for the event.</td>
</tr>
</tbody>
</table>

Creating audio parts

When the “Audio” item of an audio track is selected in the Project Structure list, you can create empty audio parts on the track by clicking the Add button on the toolbar. This will insert a part between the left and right locator.
Editing MIDI tracks

Just like audio tracks, MIDI tracks can have two "subitems": Track Data and Automation.

- The Track Data item corresponds to the actual MIDI track in the Project window and can contain MIDI parts (which in turn can contain MIDI events).
- The Automation item corresponds to the automation subtrack in the Project window, and contains the track's automation events (see page 613).

When editing the Track Data, the following parameters are available:

The list columns for MIDI parts:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the part.</td>
</tr>
<tr>
<td>Start</td>
<td>The start position of the part. Editing this value is the same as moving the part.</td>
</tr>
<tr>
<td>End</td>
<td>The end position of the part. Changing this is the same as resizing the part (and will automatically affect the Length value as well).</td>
</tr>
<tr>
<td>Length</td>
<td>The length of the part. Changing this resizes the part and automatically changes the End value.</td>
</tr>
<tr>
<td>Offset</td>
<td>This adjusts the start position of the events within the part. Adjusting this value is the same as sliding the contents of the part in the Project window (see page 87): setting a positive Offset value is the same as sliding the contents to the left, while a negative Offset corresponds to sliding the contents to the right.</td>
</tr>
<tr>
<td>Mute</td>
<td>Click in this column to mute or unmute the part.</td>
</tr>
</tbody>
</table>
The list columns for MIDI events:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>The type of MIDI event. This cannot be changed.</td>
</tr>
<tr>
<td>Start</td>
<td>The position of the event. Editing this value is the same as moving the event.</td>
</tr>
<tr>
<td>End</td>
<td>This is only used for note events, allowing you to view and edit the end position of a note (thereby resizing it).</td>
</tr>
<tr>
<td>Length</td>
<td>This is only used for note events. It shows the length of the note – changing this resizes the note and automatically changes the End value as well.</td>
</tr>
</tbody>
</table>
| Data 1    | The property of this value depends on the type of MIDI event:
For notes, this is the note number (pitch). This is displayed and edited as a note name and an octave number, with the values ranging between C-2 and G8.
For Controller events, this is the type of Controller, displayed in words. Note that you can edit this by entering a number – the corresponding Controller type is automatically displayed.
For Pitch Bend events, this is the fine adjustment of the bend amount.
For Poly Pressure events, this is the note number (pitch).
For other event types, this is the value of the event. |
| Data 2    | The property of this value depends on the type of MIDI event:
For notes, this is the note-on velocity.
For Controller events, this is the value of the event.
For Pitch Bend events, this is the coarse bend amount.
For Poly Pressure events, this is the amount of pressure.
For other event types, this is not used. |
| Channel   | The event’s MIDI Channel. See page 43. |
| Comment   | This column is used for some event types only, providing an additional comment about the event. |

- For SysEx (system exclusive) events, you can only edit the position (Start) in the list.
  However, clicking the Comment column opens the SysEx Editor, in which you can perform detailed editing of system exclusive events. This and other aspects of working with system exclusive messages are described in a separate chapter – see page 617.
Filtering MIDI events

When you are editing MIDI in the Project Browser, the large number of different MIDI events displayed can make it hard to find your way. To remedy this, the Filter pop-up menu allows you to select a single event type for display.

![Filter pop-up menu]

When this option is selected, only Program Change events will be shown in the event display. To reveal all event types, select the top item (“---”) from the menu.

Creating MIDI parts

When a MIDI track is selected in the Project Structure list, you can create empty MIDI parts on the track by clicking the Add button. This will insert a part between the left and right locator.

Creating MIDI events

You can use the Project Browser to create new MIDI events, in the following way:

1. Select a MIDI part in the Project Structure list.
2. Move the project cursor to the desired position for the new event.
3. Use the Add pop-up above the event display to select which type of MIDI event to add.

![Add pop-up menu]

4. Click the Add button.
   An event of the selected type is added to the part, at the project cursor position. If the cursor is outside the selected part, the event is added at the beginning of the part.
Editing Automation tracks

All kinds of Cubase SX/SL automation (the automation subtracks for MIDI, audio or group channel tracks, the Master automation track or the individual automation tracks for send effects, master effects and VST Instruments) are handled in the same way in the Project Browser. Each Automation item in the Project Structure list will have a number of subentries, one for each automated parameter. Selecting one of these parameters in the Project Structure list shows its automation events in the list:

You can use the two columns in the list to edit the position of the events and their values.
Editing the Video track

When the Video track is selected in the Project Structure list, the event display lists the video events on the track, with the following parameters:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the video clip that the event refers to.</td>
</tr>
<tr>
<td>Start</td>
<td>The start position of the event. Editing this value is the same as moving the event.</td>
</tr>
<tr>
<td>End</td>
<td>The end position of the event. Editing this value is the same as resizing the event, and will automatically change the Length value as well.</td>
</tr>
<tr>
<td>Length</td>
<td>The length of the event. Editing this value is the same as resizing the event, and will automatically change the End value as well.</td>
</tr>
<tr>
<td>Offset</td>
<td>This determines “where in the video clip” the event starts. Note that the event cannot start before the start of the clip, or end after the end of the clip. Thus, if the event already plays the whole video clip, the Offset cannot be adjusted at all.</td>
</tr>
</tbody>
</table>
Editing the Marker track

Marker events have the following parameters:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the marker. This can be edited for all markers except the left and right locator.</td>
</tr>
<tr>
<td>Start</td>
<td>The position of “regular” markers or the start position of cycle markers.</td>
</tr>
<tr>
<td>End</td>
<td>The end positions of cycle markers. Editing this value is the same as resizing the cycle marker, and will automatically change the Length value as well.</td>
</tr>
<tr>
<td>Length</td>
<td>The length of cycle markers. Editing this value is the same as resizing the marker, and will automatically change the End value as well.</td>
</tr>
<tr>
<td>ID</td>
<td>The number of the marker. For regular (non-cycle) markers, this corresponds to the key commands used for navigating to the markers. For example, if a marker has ID 3, pressing [3] on the computer keyboard will move the song position to that marker. By editing these values, you can assign the most important markers to key commands. Note that you cannot edit the “L” and “R” marker IDs (Left and Right locator) or assign IDs 1 and 2 to markers (since these are reserved for the locators).</td>
</tr>
</tbody>
</table>

When the Marker track is selected, you can insert markers selecting “Marker” or “Cycle Marker” from the Add pop-up menu and clicking the Add button. Regular markers will be added at the current project cursor position while cycle markers will be added between the current left and right locator positions.
Editing the Tempo track

When Tempo track is selected in the Project Structure list, the event display shows the events on the Tempo track, with the following parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>The position of the Tempo event. You cannot move the first event on the Tempo track.</td>
</tr>
<tr>
<td>Tempo</td>
<td>The tempo value of the event.</td>
</tr>
<tr>
<td>Type</td>
<td>This indicates whether the tempo should jump to the value of the event (&quot;Jump&quot; type) or whether it should change gradually from the previous Tempo event, creating a ramp (&quot;Ramp&quot; type). See page 594.</td>
</tr>
</tbody>
</table>

You can add new Tempo events by clicking the Add button. This creates a Jump-type event with the value 120 bpm, at the project cursor position. Make sure that there is no other tempo event at the current cursor position.

Editing Time Signatures

When “Signature track” is selected in the Project Structure list, the event display shows the Time Signature events in the project:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>The position of the event. Note that you cannot move the first Time Signature event.</td>
</tr>
<tr>
<td>Signature</td>
<td>The value (time signature) of the event.</td>
</tr>
</tbody>
</table>

You can add new Time Signature events by clicking the Add button. This creates a 4/4 event, at the beginning of the bar closest to the project cursor position. Make sure that there is no other time signature event at the current cursor position.
Working with System Exclusive messages
**Introduction**

System Exclusive (Sys Ex) is a special type of MIDI message used to send things that only make sense to a unit of a certain make and type. Every major MIDI manufacturer has its own Sys Ex identity code. System Exclusive messages are typically used for transmitting patch data, i.e. the numbers that make up the settings of one or more sounds in a MIDI instrument.

Cubase SX/SL allows you to record and manipulate System Exclusive data in various ways. This chapter points to various features that help you manage and create System Exclusive data.

**Bulk dumps**

**Recording a bulk dump in Cubase SX/SL**

In any programmable device, all settings are stored as numbers in computer memory. Change those numbers, and you will change the settings.

Normally, MIDI devices allow you to dump (transmit) all or some settings in the device’s memory, in the form of MIDI System Exclusive messages. Return these messages, and you get the settings back. This is (among other things) a way of making backup copies of the settings of any instrument.

If your instrument allows the dumping of a few or all of its settings via MIDI by activating some function on the front panel, this dump will most probably be recordable in Cubase SX/SL.

1. Open the Preferences dialog from the File menu (on the Mac, this is located on the Cubase SX/SL menu) and select the MIDI–Filter page. As described in the section page 46, this allows you to govern which MIDI event types should be recorded and/or thru-put.
2. Deactivate the Sysex checkbox in the Record section, but make sure the Sysex checkbox in the Thru section is activated.
   
   With this setting (shown in the figure above) SysEx messages will be recorded but not echoed back out to the instrument (which could lead to strange results).

3. Activate recording on a MIDI track and initiate the dump from the front panel of the instrument.

4. When done recording, select the new part and open the List Editor from the MIDI menu.
   
   This allows you to check that the System Exclusive dump was recorded – there should be one or several SysEx events in the part/event list.

---

❗ If your MIDI instrument doesn’t offer a way to initiate a dump “by itself”, you have to send a Dump Request message from Cubase SX/SL to start the dump. You will then have to use the SysEx Editor (see page 622) to insert the specific Request message (see the instrument’s documentation) at the beginning of a MIDI track. When you activate recording, the Request message will be played back (sent to the instrument), the dump will start and be recorded as above.
Transmitting a bulk dump back to a device

1. Make sure the MIDI track with the System Exclusive data is routed to the device.
You may want to check your device’s documentation to find details about which MIDI channel should be used, etc.

2. Solo the track.
This might not be necessary, but it is a good safety measure.

3. Make sure the device is set up to receive System Exclusive data (often, the reception of SysEx is turned off by default).

4. If necessary, put the device in “Standby to Receive System Exclusive” mode.

5. Play back the data.

Some advice

• Don’t transmit more data than you need. If all you want is a single program, don’t send them all, it will only make it harder to find the one you want. Usually, you can specify exactly what you want to send.

• If you want the sequencer to dump the pertinent sounds to your instrument each time you load a song, put the SysEx data in a silent “count-in” before the song itself starts.

• If the dump is very short (for instance, a single sound) you can put it in the middle of the Song to re-program a device on the fly. However, if you can achieve the same effect by using Program Change, this is definitely preferable, since less MIDI data is sent and recorded. Some devices may be set up to dump the settings for a sound as soon as you select it on the front panel.

• If you create parts with useful “SysEx dumps”, you can put these on a special muted track. When you want to use one of them, drag it to an empty unmuted track and play it back from there.

• Do not transmit several SysEx dumps to several instruments at the same time.

• Make a note of the current Device ID setting of the instrument. If you change this, the instrument may refuse to load the dump later.
Recording System Exclusive parameter changes

Often you can use System Exclusive to remotely change individual settings in a device, open up a filter, select a waveform, change the decay of the reverb etc. Many devices are also capable of transmitting changes made on the front panel as System Exclusive messages. These can be recorded into Cubase SX/SL, and thus incorporated into a regular MIDI recording.

Here’s how it works: let’s say you open up a filter while playing some notes. In that case, you will record both the notes and the System Exclusive messages generated by your opening of the filter. When you play it back, the sound changes exactly like it did when you recorded it.

1. Open the Preferences dialog from the File menu (on the Mac, this is located on the Cubase SX/SL menu), select the MIDI–Filter page and make sure that System Exclusive gets recorded.

2. Make sure the instrument is actually set to transmit front panel control movements as System Exclusive data.

3. Record normally.
   When you’re done, you can check that the events were recorded properly in the List Editor.
Editing System Exclusive messages

While System Exclusive events are shown in the List Editor/Project Browser, their entire content is not (only the beginning of the message is displayed in the Comment column for the event). Furthermore, you cannot edit the event (other than moving it) as you can with other event types in the List Editor.

Instead, you use the MIDI SysEx Editor for this.

• To open the SysEx editor for an event, click in the Comments column for the event in the List Editor/Project Browser.

The display shows the entire message on one or several lines. All System Exclusive messages always begin with F0 and end with F7 with a number of arbitrary bytes in between. If the message contains more bytes than fit on one line, it continues on the next. The Address indication to the left helps you find out on which position in the message a certain value resides.
Selecting and viewing values

To select a value, either click on it or use the cursor keys. The selected byte is indicated in various formats:

- In the main display, values are shown in Hexadecimal.
- To the right of this, values are shown as ASCII.
- At the bottom of the dialog, the selected value is shown in binary and decimal formats.

Editing a value

The selected value can be edited directly in the main display or in the decimal and binary displays. Just click on it and type in the desired value as usual.

Adding and deleting bytes

Using the Insert and Delete buttons, or their corresponding computer keyboard keys, you can add and delete bytes from the message. Inserted data will appear before the selection.

Importing and exporting Data

The Import and Export buttons allow you to get SysEx data from disk and to export the edited data into a file. The file format used is called “Raw SysEx” (.SYX), which means that data is saved exactly as is, in a binary file. Only the first dump in a “SYX” file will be loaded.

This format should not be confused with MIDI Files.
Export Audio Mixdown
Background

The Export Audio Mixdown function allows you to mix down all audio tracks, complete with effects and automation, into one or several audio files, in one of several file formats. The following rules apply:

- All audio you hear on playback will be included in the mixdown file! You can however choose whether you want effects and automation included in the mixdown, as described below.

- Cubase SX/SL can export to a number of different file formats, each with different options. See page 629.

- If you are working with multi channel audio (surround - Cubase SX only), Cubase SX allows you to export all channels at once, either as separate files or as one multi channel audio file. The file(s) can then be imported into stand-alone encoding applications, etc. See page 630.

- MIDI tracks are not included in the mixdown! To make a complete mixdown containing both MIDI and audio, you first need to record all your MIDI music to audio tracks (by connecting the outputs of your MIDI instruments to your audio inputs and recording, as with any other sound source).
Mixing down to an audio file

1. Set up the left and right locator to encompass the area that you want to mix down.

2. Set up your tracks, so that they play back the way you want. This includes muting unwanted tracks or parts, making manual mixer settings and/or activating the R (Read) automation buttons for some or all mixer channels.


4. If you want to include any activated Mixer automation, activate the “Include Automation” checkbox.

5. If you want to include insert effects, send effects and master effects, activate the “Include Effects” checkbox.
6. Select a file format with the file type pop-up menu.

7. If you want to automatically import the resulting audio file back into Cubase SX/SL, activate the “Import to” checkboxes.
   If you activate the “Pool” checkbox, a clip referring to the file will appear in the Pool. Activating the “Audio Track” checkbox as well will create an audio event that plays the clip, and place it on a new audio track, starting at the left locator.

   The Import options are only available if you have selected one of the following file formats: AIFF, Wave (uncompressed) or Broadcast Wave files.

8. Make additional settings for the file to be created.
   This includes selecting stereo or mono, sample rate, resolution, quality, etc. The available options depend on the selected file format – see page 629.

9. Select a folder and a name for the audio file to be created.

   With some file formats, there is a Stereo Split option (see page 630). If this is selected, two files will be created, one for each side. The two files will have the same name, but with the letter “L” appended for the left channel file and “R” for the right channel file.

10. Click Save.
    A dialog with a progress bar is displayed while the audio file is created. If you change your mind during the file creation, you can click the Abort button to abort the operation.

   • If you have activated the “Import to” options, the file will be imported back into the project.
     When playing back the re-imported file in Cubase SX/SL, remember to mute the original tracks so that you really hear the true result.
File Format Specifics

The following pages describe the different export file formats, and their options and settings.

**AIFF files**

AIFF stands for Audio Interchange File Format, a standard defined by Apple Computer Inc. AIFF files have the extension “.aif” and are used on most computer platforms. When AIFF is selected as export file format, the following settings are available:

**Resolution**

Allows you to select 8, 16, 24 bit or 32 bit (float) files.

- If the file is an “intermediate mixdown” that you plan to re-import and continue working on in Cubase SX/SL, we recommend that you select the 32 bit (float) option. 32 bit (float) is a very high resolution (the same resolution as used internally for audio processing in Cubase SX/SL), and the audio files will be twice the size of 16 bit files.
- If you are making a mixdown for CD burning, you should use the 16 bit option, as CD audio is always 16 bit. In this case, we recommend that you activate the UV-22HR/UV22 dithering plug-in (see page 190). This reduces the effects of quantization noise and artifacts from being introduced when converting the audio down to 16 bit.
- 8 bit resolution should only be used if required, since it will result in limited audio quality. Examples of situations when 8 bit audio may be suitable are some multimedia applications, etc.
### Channels

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mono</td>
<td>The audio is mixed down to mono.</td>
</tr>
<tr>
<td>Stereo Split</td>
<td>Two mono files are created, one for each side of the stereo mix. The files will have the name you specify in the dialog, but with “L” and “R” added, respectively. Select this format if you plan to use the resulting file in another application, that doesn’t support stereo interleaved files. If you plan to re-import the file into Cubase SX/SL, we recommend that you use the Stereo Interleaved option instead, since Cubase SX/SL doesn’t automatically handle stereo split files as one entity.</td>
</tr>
<tr>
<td>Stereo Interleaved</td>
<td>A stereo audio file is created. This is the recommended stereo option if you want to re-import the file into Cubase SX/SL.</td>
</tr>
<tr>
<td>Multi Channel Split (Cubase SX only)</td>
<td>This option is only available if you are working with a multi channel (Surround) mix. Exporting with this option selected will create one mono audio file for each Master channel, which you later can import into other applications. For example, if you have selected the “5.1 Surround” preset in the Master Setup dialog (see page 234), there are six Master channels. This option will then be called “6 Chan. Split” and result in six mono audio files.</td>
</tr>
<tr>
<td>Multi Channel Interleaved (Cubase SX only)</td>
<td>This option is only available if you are working with a multi channel (Surround) mix. Exporting with this option selected will create a single audio file containing all Master channels, which you later can import into other applications. For example, if you have selected the “5.1 Surround” preset in the Master Setup dialog (see page 234), there are six Master channels. This option will then be called “6 Chan. Interleaved” and result in a single audio file, containing six channels. This is not a very common file format – make sure the receiving application can import multi-channel audio files.</td>
</tr>
</tbody>
</table>
Sample Rate

Allows you to select a sample rate for the exported audio file. In most cases, you should select the sample rate set for the project, since a lower sample rate will degrade the audio quality (mainly reducing the high frequency content) and selecting a higher sample rate will only increase the file size, without adding to audio quality. However, you should also consider the future usage of the file; for example, if you plan to import the file into another application, you should make sure to select a sample rate supported by that application.

- If you are making a mixdown for CD burning, you should select 44.100 kHz, since this is the sample rate used on audio CDs.

Sound Designer II files (Mac OS X only)

The SD II format was developed by Digidesign. It is one of the most popular audio file formats on the Macintosh, especially for professional audio work. The following export settings are available:

Channels

Allows you to select mono or stereo files, with the same options as for AIFF files (see page 630).

Resolution

The bit resolution of the file, with the same options as for AIFF files (see page 629), except that 32-bit (float) files are not supported.

Sample Rate

The options are the same as for AIFF files. See page 631.
Wave files

Wave files have the extension ".wav" and are the most common file format on the PC platform. Wave files can be uncompressed or compressed, as described below. For uncompressed Wave files (the most common choice), the following settings are available:

Channels

Allows you to select mono or stereo files, with the same options as for AIFF files (see page 630). You can also export multi-channel Wave files using the new multi-channel wave format extension from Microsoft, in which speaker information is included (so that a certain channel is identified as belonging to a certain speaker).

Resolution

The bit resolution of the file, with the same options as for AIFF files (see page 629).

Sample Rate

The options are the same as for AIFF files. See page 631.
Coding (Windows only)

The Coding pop-up menu allows you to select a compression scheme for the Wave file, creating smaller files (with a loss of audio quality).

- Which options are available depends on the installed and activated codecs in the ACM (Audio Compression Manager) under Windows. See the operating system documentation for details.

- When a compression option is selected, not all Channels, Resolution and Sample Rate options may be available (depending on the selected compression scheme). The Attributes pop-up menu displays the currently selected properties for the file.

- For regular, uncompressed Wave files, select “PCM / uncompressed Waves”.

Wave files exported by Cubase SX/SL for Macintosh are always uncompressed.
MPEG Layer 3 files (Cubase SX only)

- Cubase SL users can export to MP3 20 times as a “trial” feature (fully functional), after which the function is disabled.
  When the MP3 format is selected, a text at the bottom of the Export Audio Mixdown dialog shows you how many remaining encodings you have left.
  You can upgrade your Cubase SL copy to include unlimited MP3 encoding by clicking the “Order now” link in the lower right corner of the dialog (this takes you to Steinberg’s online store on the web - a working internet connection is required).

MPEG Layer 3 files have the extension “.mp3”. By use of advanced audio compression algorithms, mp3 files can be made very small, maintaining good audio quality.

The following options are available for MPEG Layer 3 files:

Channels

Use the radio buttons to select mono or stereo files. This setting affects which options are available on the Attributes pop-up menu (see below).

Sample Rate

Determines the frequency range of the audio – the lower the sample rate, the lower the highest audible frequency in the audio. This setting will also affect which options are available on the Attributes pop-up menu, as described below.
Attributes

This pop-up menu allows you to select a bit rate for the mp3 file. As a rule, the higher the bit rate, the better the audio quality and the larger the file. For stereo audio, 128 kBit/s is often considered to result in “good” audio quality.

- Note that the available options on this pop-up menu depend on the Channels and Sample Rate settings.
  This is because for mono audio and/or low sample rates, there is no point in using the highest bit rates – they would simply create larger files without adding to audio quality.

Algorithm

These options determine the “depth” of the encoding algorithm and thus the quality of the resulting file. In the “Highest” mode, the encoding will take the longest time, while in the “Fast” mode, the audio quality may be lower. The file size is not affected by these options.

Options

Clicking the Options button opens a dialog in which you can enter information about the file. This additional information (called the ID3 tag) will be embedded as text strings in the file, and can be displayed by some mp3 playback applications.

- For the information to be included in the file, you need to activate the “Insert Options” checkbox in the dialog.
Ogg Vorbis files

Ogg Vorbis is an open, patent-free audio encoding and streaming technology, offering compressed audio files (extension "ogg") of small size but with comparatively high audio quality.

The following options are available for Ogg Vorbis files:

**Channels**

Use the radio buttons to select mono or stereo files.

**Sample Rate**

Determines the frequency range of the audio – the lower the sample rate, the lower the highest audible frequency in the audio.

**Algorithm**

These options determine the quality of the encoding. The Ogg Vorbis encoder uses variable bit rate encoding, and the Algorithm setting determines between which limits the bit rate will vary. Generally speaking the better the Algorithm setting, the higher the sound quality but also the larger the files.

**Options**

Clicking the Options button opens a dialog in which you can enter information about the file, as when creating mp3 files.

- For the information to be included in the file, you need to activate the “Insert Options” checkbox in the dialog.
Real Audio V5 and G2 files (Windows only)

Real Audio files allow very high compression rates and can therefore be made very small. This makes the format especially useful for downloading and streaming multimedia from the internet. The files have the extension ".rm".

The following options are available for Real Audio files:

**Coding and Content**

By selecting an option from the Coding pop-up menu, you specify the desired audio quality for the file. In the Real Audio G2 format, this information is divided in two pop-up menus: Coding (determining the bit rate) and Content (specifying the typical audio content – voice, music, etc.)

When you select a Coding/Content, a descriptive text appears in the field below the pop-up menu, describing the suitable use of the selected format.

- **Note that the choice of mono or stereo is included in the Coding/Content options.**

**Options**

Clicking the Options button opens a dialog in which you can select one or more modes (each explained in the dialog) for the file. You can also enter information about the file. These text strings will be embedded in the file and can be displayed by some Real Audio playback applications.
Windows Media Audio files (Windows only)

Windows Media Audio is an audio format developed by Microsoft Inc. Due to advanced audio compression algorithms, Windows Media Audio files can be made very small, maintaining good audio quality. The files have the extension ".wma".

The following options are available for Windows Media Audio files:

**Attributes**

This pop-up menu allows you to select a bit rate for the WMA file. As a rule, the higher the bit rate, the better the audio quality and the larger the file. For stereo audio, 96 kBit/s is often considered to give “good” audio quality.

**Options**

Clicking the Options button opens a dialog in which you can enter information about the title and author of the file, as well as copyright information. These text strings will be embedded in the file and can be displayed by some Windows Media Audio playback applications.
Audio-wise, Broadcast Wave files are the same as regular Wave files. They have the same options as Wave files, with the following additions:

- There are no Coding (compression) options for Broadcast Waves.
- Clicking the Options button opens a dialog in which you can specify a number of text strings to be included in the file. This allows you to embed information in the file, such as author, description etc. Furthermore, a Timecode position is included in the file, allowing you to insert exported audio at the correct position in other applications, video projects, etc. By default, the Timecode position is set to the start position of the exported audio in the project (i.e. the left locator position), but you can adjust this in the Options dialog if needed.

- **You can enter default text strings for author, description and reference in the Preferences dialog (Audio – Broadcast Wave page).**
  These will automatically appear in the Options dialog when Broadcast Wave dialog is selected. For example, this saves you from having to enter the author name each time you export, if it is the same.
Synchronization
Background

What is synchronization?

Synchronization is said to exist when you make two pieces of equipment agree on time or tempo. You can establish synchronization between Cubase SX/SL and a number of other types of devices, including tape recorders and video decks, but also MIDI devices that “play back”, such as other sequencers, drum machines, “workstation sequencers” etc.

When you set up a synchronization system you must decide which unit is the master. All other devices are then slaved to this unit, which means they will adjust their playback speed to the master’s.

Cubase SX/SL as a slave

When a synchronization signal is coming in to Cubase SX/SL, from another device (such as a tape recorder, video recorder etc.), this device is the master and Cubase SX/SL is the slave. Cubase SX/SL will adjust its playback to the other device.

Cubase SX/SL as a master

When you set up Cubase SX/SL to transmit synchronization information to other devices, Cubase SX/SL is the master and the other devices are the slaves; they will adjust their playback to Cubase SX/SL.

Cubase SX/SL – both master and slave

Cubase SX/SL is a very capable synchronization device. It can operate as both a master and a slave at the same time. For example, Cubase SX/SL might be slaved to a tape recorder transmitting timecode, while at the same time transmitting MIDI Clock to a drum machine, acting as a master for that.

The VST System Link feature (with which you can synchronize separate computers running Cubase SX/SL or Nuendo) is described in a separate chapter. See page 661.
Timecode, MIDI clock and word clock

Basically there are three types of synchronization signals for audio, timecode, MIDI clock and word clock:

Timecode (SMPTE, EBU, MTC, VITC etc.)

Timecode appears in a number of guises. No matter which “format” it has, it always supplies a “clock on the wall” type of synchronization, that is, a synchronization related to hours, minutes, seconds and two smaller units called “frames” and “subframes”.

- LTC (SMPTE, EBU) is the audio version of timecode. This means that it can be recorded on the audio track of an audio or video recorder.
- VITC is the video format timecode, that is it is stored in the actual video image.
- MTC is the MIDI version of timecode, transmitted in MIDI cables.
- ADAT sync (Alesis) is only used with the ASIO Positioning Protocol, see later in this chapter.

For the ASIO Positioning Protocol, other high precision timecode formats may also be supported.

Format recommendations for timecode – without ASIO Positioning Protocol

When synchronizing your system to external timecode, via a synchronizer, the most common timecode format is MTC. Contrary to some reports you might have heard, MTC delivers good precision for external sync. This is due to the fact that the operating system can “time stamp” incoming MIDI messages, which increases precision.

Format recommendations for timecode – with ASIO Positioning Protocol

- LTC and VITC are the formats with the highest precision and are recommended when available.
- MTC is the next best option and probably the most common choice, since few audio hardware solutions have built in LTC or VITC readers. However, LTC and VITC offer even higher precision when available.
MIDI Clock

MIDI Clock is a tempo based type of synchronization signal, that is it is related to the number of “beats per minute”. MIDI Clock signals are suitable for synchronizing two devices that agree on tempo, such as for example Cubase SX/SL and a drum machine.

- MIDI Clock is not suitable as a master sync source for an application like Cubase SX/SL. Therefore Cubase SX/SL will transmit MIDI Clock signals to other devices, but it will not receive MIDI Clock.

Word Clock

Word clock is basically a replacement for the sample rate clock in for example an audio card. Word clock hence runs at the same rate as the sample rate in the audio, 44.1kHz, 48kHz etc.

Word clock does not contain any position information, it is only a “simple” signal for clocking the audio at its sample rate.

Word clock comes in many formats, analog on coaxial cable, digital as part of an S/PDIF, AES/EBU or ADAT audio signal, etc.
Synchronizing the transport vs. synchronizing audio

How timing is handled in a non-synchronized system

Let's first look at the situation where Cubase SX/SL is not synchronized to any external source.

Any digital playback system has an internal clock that ultimately affects the playback speed and stability, and PC audio hardware is no exception. This clock is extremely stable.

When Cubase SX/SL is playing back with no external synchronization, all playback is internally synchronized to the internal digital audio clock, to ensure synchronization between digital audio and MIDI.

Synchronizing Cubase SX/SL's playback

Let's assume now that we use external timecode synchronization, with Cubase SX/SL. For example, we might synchronize playback to a tape recorder.

Timecode coming from an analog tape recorder will always vary slightly in speed. Different timecode generators and different tape recorders will also supply timecode with slight differences in speed. In addition, the shuttling of tape mechanisms due to overdubs and re-recordings can cause the physical tape to wear and stretch, which affects the speed of the timecode.

If you set up Cubase SX/SL to sync to incoming timecode, it will vary its overall playback speed to compensate for such fluctuations in the speed of the timecode – that’s the whole purpose of synchronization.

What happens with the digital audio?

The fact that Cubase SX/SL’s playback is synchronized to the timecode does not affect the playback of the digital audio. It still relies on the perfectly stable, built-in clock in the audio hardware.

As you may understand by now, problems will appear when the perfectly stable digital audio gets related to the slightly varying speed of a system synchronized to timecode.

The playback timing of each event will not be in total accordance with the tape or the MIDI playback, since the playback speed of the audio is determined by the digital audio hardware’s built-in clock.
Resolving to word clock

The solution to this problem is to use one external clock for all components in the system. One master clock is used to derive whatever type of clock signal each component in the system needs. For example, something called a house clock can be used to generate sample rate clocks for the digital audio hardware and timecode for Cubase SX/SL. This ensures all components in the system use the same reference source for their timing.

Synchronizing digital audio to external clocks running at sample rate is often called “resolving” or “synchronizing to word clock”.

If you aim to perform synchronization to external signals, we strongly recommend that you obtain proper synchronization equipment. This encompasses:

- An audio card that can be slaved to external word clock.
- A synchronizer that can read timecode (and possibly house clock) and generate the required sync signals from that, such as the Steinberg TimeLock Pro.
- An audio system with complete built-in synchronization possibilities, preferably supporting the ASIO Positioning Protocol.

Using timecode without word clock

Of course, it is possible to set up a synchronization system where you lock Cubase SX/SL to timecode without using word clock. However, please note that the timing of audio vs. MIDI cannot be guaranteed and that fluctuations in speed in the incoming timecode will not affect the playback of audio events. This means that synchronizing to timecode may work in the following situations:

- When the timecode was originally generated by the audio card itself.
- When the source providing the timecode is extremely stable (such as a digital video system, a digital tape recorder or another computer).
- When you remain synchronized to that same stable source throughout the entire process, both while recording and playing back audio.
About the ASIO Positioning Protocol (APP)

- ASIO Positioning Protocol requires audio hardware with specific ASIO drivers. As of this writing, APP is not available for audio hardware with non-ASIO drivers under Mac OS X.

The ASIO Positioning Protocol is a technology that expands on the type of sync described above and makes sample accurate positioning possible.

When transferring audio digitally between devices, it is important that synchronization using word clock and timecode is completely correlated. If not, the audio will not be recorded at the exact intended (sample accurate) position, which can cause various types of problems, such as inaccurately positioned audio material, clicks and pops etc.

A typical situation is when transferring material from a digital multi-track tape recorder to Cubase SX/SL (for editing) and then back again. If you do not have sample accurate synchronization set up, you cannot be sure that the material will appear in its exact original position, when transferred back to the tape recorder.

In order to take advantage of the ASIO Positioning Protocol, your audio hardware must be suitably equipped and the functionality must be included in the ASIO driver for the hardware.

An example of a system for doing sample accurate transfers, would be transferring audio tracks from an Alesis ADAT to Cubase SX/SL. Here the ADAT will be the sync master (though it doesn’t necessarily have to be). It provides both the digital audio (with an inherent word clock) and positional information (timecode) via its ADAT sync protocol. The master clock is generated by the ADAT itself.

Hardware and software requirements for APP

- Your computer audio hardware (in our example above this would be an ADAT card in your computer) must support all the functionality required for the ASIO Positioning Protocol. That is, it must be able to read the digital audio and the corresponding positional information from the external device.
- There must be an ASIO 2.0 driver for the audio hardware.
- For resolving to external timecode, the audio hardware must have a timecode reader/writer on-board.
• For information about which audio hardware models currently support APP, see the Steinberg web site (www.steinberg.net).

The ASIO Positioning Protocol exploits the specific advantage of having an audio card that has a built-in timecode reader. With such a card and the ASIO Positioning Protocol, you can achieve constant sample accurate synchronization between the audio source and Cubase SX/SL.

Machine control
Cubase SX/SL can control external tape transports and similar devices via MIDI Machine Control. This allows you to operate an external tape transport from Cubase SX/SL's Transport panel. That is, Cubase SX/SL can make the tape recorder locate to a certain position, start, stop, rewind etc.

About sync and machine control
Controlling tape transports is a two-way process:
• Cubase SX/SL sends out machine control commands to the tape recorder, asking it to locate to a certain position and activate playback etc.
• The tape recorder locates to the requested position, starts and delivers time-code back to Cubase SX/SL, to which Cubase SX/SL is synchronized.

Even though it appears as if Cubase SX/SL is controlling the tape recorder completely, it is important to remember that in this setup, Cubase SX/SL is still being synchronized to the external tape transport, not vice versa.

Also note that the two processes of sync and machine control are completely separated, in terms of protocols used. You can for example synchronize to MTC while sending out transport commands via MMC.

About MIDI Machine Control (MMC)
This is a standard MIDI protocol for controlling tape transports. There are a number of tape recorders and hard disk recording systems on the market that support this protocol. Cubase SX/SL implements three MMC commands: Start, Stop and Locate.
Window Overview

The Synchronization Setup dialog box

This dialog box is used for setting up everything that has to do with Cubase SX/SL’s synchronization to other units. You reach it from the Transport menu.
Operations

Making connections and basic settings

The descriptions below are for a basic setup with a separate synchronizer and audio card. Depending on your exact situation and requirements for communication with external devices, there are endless variations on this theme. Please consult your dealer for more detailed recommendations.

The following connections are required for external sync via a synchronizer, including resolving of the audio card. For details on audio card and synchronizer settings and connections, see the included manuals.

- Route the master clock signal (LTC, VITC, etc.) to an input on the synchronizer.
- Connect the word clock output on the synchronizer to an input on the audio card.
- Connect the MIDI Timecode (MTC) on the synchronizer to the corresponding input on the computer.
- Set up the synchronizer and make sure the frame rate settings are in accordance with the master clock.

For more information on frame rates, see page 658.

A typical synchronization setup.
Setting up the audio card for external synchronization

1. Open the Device Setup dialog from the Devices menu and select the item VST Multitrack from the list to the left.

2. Click the Control Panel button to open the card’s proprietary setup dialog.
   If this card is accessed via a special ASIO driver (as opposed to MME or Direct X), this dialog is provided by the card, not by Cubase SX/SL. Hence the settings vary with the card brand and model.

3. Adjust the settings as recommended by the card manufacturer, then close the dialog.
   The dialog may also contain various diagnostic tools that allow you to verify for example whether word clock is arriving correctly.

4. From the Clock Source pop-up, select the input to which you routed the word clock signal.
   This pop-up may not be used if you selected an input in the Control Panel dialog instead.

Setting up Cubase SX/SL for external sync to timecode

1. In the Synchronization dialog, set Timecode Source to MIDI Timecode or ASIO Positioning Protocol (only if your hardware is ASIO Positioning Protocol compatible).

2. For MIDI Timecode, use the “MIDI Timecode Settings - MIDI Input” pop-up menu to select an input for the timecode.
   If you are using the ASIO Positioning Protocol this is not required, since the timecode is then coming in directly via your audio hardware.

3. Close the Synchronization Setup dialog and instead open the Project Setup dialog from the Project menu.
4. Use the Start value to set which frame on the external device (e.g. a video tape) should correspond to the beginning of the project.

5. Close the Project Setup dialog.

6. On the Transport panel, activate the Sync button (or select Sync Online from the Transport menu).

7. Start the tape (or video, or...) that contains the timecode. Cubase SX/SL starts playing when it receives timecode with a position “higher” than, or equal to, the Project Start frame.

You can wind the device that sends the timecode to any position and start from there.

- When the device with the timecode is stopped, you can use the Cubase SX/SL transport controls as you normally do, when it is not synchronized.

You should also look into the Sync Options, see page 659.
The Sync indicator

On the Transport panel you can check the status of incoming timecode by observing the sync indicator. It switches between “Offline” (not waiting for sync), “Idle” (ready for sync but no signal is coming in), and “Lock xx” (where xx is indicating the frame rate of the incoming signal).
Synchronizing other Equipment to Cubase SX/SL

You may have other MIDI devices that you want to synchronize to Cubase SX/SL. There are two types of synchronization that Cubase SX/SL can transmit: MIDI Clock and MIDI Timecode.

Transmitting MIDI Clock

If you transmit MIDI Clock to a device supporting this type of synchronization signal, the other device will follow Cubase SX/SL’s tempo. The tempo setting in the other device is of no relevance. Instead it plays at the same tempo as Cubase SX/SL. If the device also reacts to Song Position Pointers (which Cubase SX/SL transmits) it will follow when you wind, rewind and locate using the Cubase SX/SL Transport panel.

- MIDI Clock transport commands include “Start”, “Stop” and “Continue”. However, some MIDI equipment (e.g. some drum machines) do not recognize the “Continue” command. If this is the case with your equipment, activate the option “Always Use MIDI Clock Start” in the Preferences (Transport page). When this is activated, only the Start command is used.

Transmitting MIDI Timecode

If you transmit MIDI Timecode to a device supporting this type of synchronization signal, the device will synchronize time-wise to Cubase SX/SL, that is, the time displays on Cubase SX/SL’s Transport panel and on the other device will agree. When you wind and locate Cubase SX/SL and then activate playback, the other device will follow from the same position (if it has this capability and is set up for it!).
Setting Up
1. Connect the desired MIDI Outputs from Cubase SX/SL to the device(s) that you plan to synchronize.

2. Open the Synchronization Setup dialog from the Transport menu.

3. Activate the sync outputs by using the corresponding checkboxes in the lower right part of the dialog.
   You can output any combination of MIDI Timecode and MIDI Clock to any combination of outputs (however, you probably don’t want to send MTC and MIDI Clock to the same output).
   - Some MIDI Interfaces will automatically send MIDI Clock to all MIDI outputs, regardless of the MIDI Clock Port selection you make in Cubase SX/SL. If this is the case, you should only select one MIDI Clock Port (consult the documentation of the MIDI Interface if in doubt).

4. Set the other device(s) to their “external synchronization” mode (or some other mode with a similar name) and activate playback on them if necessary.

5. Activate playback in Cubase SX/SL, and the other device(s) will follow.
Machine Control

Machine control commands can be sent using the MIDI Machine Control (MMC) protocol. Proceed as follows:

1. Set up and test basic timecode synchronization, as described earlier in this chapter.

2. Connect a MIDI Out on your MIDI interface to MIDI In on the tape recorder (or similar device).
   If you have not already done so (when setting up for MIDI Timecode), also connect a MIDI cable from the MIDI Output on the tape recorder to a MIDI In on the computer.

3. Make sure you have timecode recorded on the tape recorder, and that it is set up to utilize MMC.

4. Open the Synchronization Setup dialog on the Transport menu in Cubase SX/SL.

5. Select MIDI Machine Control from the Machine Control section of the dialog.

6. Select the correct MIDI In- and Outputs from the MIDI Machine Control Settings pop-ups.

7. Open the Preferences dialog from the File menu (on the Mac, this is located on the Cubase SX/SL menu), select the MIDI Filter section and make sure Sysex is activated in the Thru section.
   This is necessary since MMC uses two-way communication (the tape recorder “replies” to the MMC messages it receives from Cubase SX/SL). By filtering out Sysex Thru, you ensure that these MMC System Exclusive replies are not echoed back to the tape recorder.

8. Open the Project Setup dialog from the Project menu.
9. As when synchronizing without using transport control, use the Start value to specify which frame on the tape should correspond to the beginning of the project.

10. Close the Project Setup dialog.

11. On the Transport panel, activate the Sync button.

12. Press play on the external tape transport and let the tape roll for a few seconds, so that Cubase SX/SL can "learn" about the timecode positions on the tape. Stop the tape transport.

13. Now activate play from Cubase SX/SL.

The external tape transport should wind the tape to a position just before the project cursor in Cubase SX/SL and go into Play. After a short while, Cubase SX/SL should start, in sync.

Try to Stop, Fast Forward and Rewind from Cubase SX/SL and activate Play from different positions in the project. The tape transport should follow.

Each time you start up your external tape transport, you may have to activate play from its front panel for a couple of seconds. If you don't, Cubase SX/SL has no chance of "knowing" where to wind the first time, since it doesn't know what timecode is recorded on the tape.

Whenever you want to turn off the synchronization between the tape recorder and Cubase SX/SL, simply deactivate Sync on the Transport panel.
Options

Making Project Settings

About Frame Rates

The frame rate is the number of frames per second in a film or on a video tape. Just as there is always sixty seconds to a minute, there is always a certain number of frames to each second. However, the frame rate used varies with the type of media (film or video), which country the video tape has been produced in, and other circumstances.

In the Project Setup dialog are two settings for frame rates:

• The Frame Rate pop-up is automatically adjusted to the frame rate of the incoming timecode.
  There is an exception to this when you are synchronizing Cubase SX/SL to MIDI Time-code: If you have selected 29.97 fps or 30 dfps as Frame Rate in Cubase SX/SL, this selection will be kept, since these frame rates are not included in the MTC format.

• The Display Format pop-up has, in addition to various other formats, an identical set of frame rates.
  This is the “master” setting for the display format used in the various windows’ rulers and position displays. To make editing with frame accuracy correspond to the actual frame rate in an external sync source, set this pop-up to the same value as the Frame Rate pop-up.

In Cubase SX/SL there are six frame rates to choose from:

<table>
<thead>
<tr>
<th>Frame Rate</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>24 fps</td>
<td>The traditional frame rate of 35mm film.</td>
</tr>
<tr>
<td>25 fps</td>
<td>The frame rate used for all video and audio in Europe (EBU).</td>
</tr>
<tr>
<td>30 fps</td>
<td>Straight 30 frames per second. This is often used in the United States for audio only work.</td>
</tr>
<tr>
<td>30 dfps</td>
<td>Very rarely used.</td>
</tr>
<tr>
<td>29.97 fps</td>
<td>Straight 29.97 frames per second.</td>
</tr>
<tr>
<td>29.97 dfps</td>
<td>“Drop frame” code running at 29.97 frames per second, most often used in the United States of America for work with color video.</td>
</tr>
</tbody>
</table>
Sync Options

The following Options are available in the Synchronization Setup dialog:

Drop Out Time

On an analog tape with timecode, dropouts may occur. If a drop-out is very long, Cubase SX/SL may (temporarily) stop. In the Dropout Time field you can set how long a drop-out (in frames) should be tolerated until Cubase SX/SL decides that the tape isn’t good enough to synchronize to. If you have a very stable timecode source, you may lower this number to make Cubase SX/SL stop more swiftly after the tape recorder has been stopped.

Lock Time

Using this field you can set how many frames of “correct” timecode Cubase SX/SL should receive before attempting to “lock” (synchronize) to incoming timecode. If you have an external tape transport with a very short start-up time, you could try lowering this number to make lock-up even faster than it already is.

Ignore Hours

When this is activated, only the “minutes:seconds:frames” part of the incoming timecode positions are used for synchronization. In other words, the “hours” part of the Start time in the Project Setup dialog is then of no relevance.
VST System Link
Introduction

VST System Link is a network system for digital audio that allows you to have several computers working together in one large system. Unlike conventional networks it does not require Ethernet cards, hubs, or CAT-5 cables; instead it uses the kind of digital audio hardware and cables you probably already possess in your studio.

VST System Link has been designed to be simple to set up and operate, yet give enormous flexibility and performance gains in use. It is capable of linking computers in a “ring” network (the System Link signal is passed from one machine to the next, and eventually returns to the first machine). VST System Link can send its networking signal over any type of digital audio cable, including S/PDIF, ADAT, TDIF, or AES, as long as each computer in the system is equipped with a suitable ASIO compatible audio interface.

So, why would you want to link up two or more computers? Well, the added computer power gives you vast possibilities:

• Dedicate one computer to running VST instruments while recording audio tracks on another.
• If you need lots of audio tracks, you may simply add tracks on another computer.
• You could have one computer serve as a “virtual effect rack”, running CPU-intensive send effect plug-ins only.
• Since you can use VST System Link to connect different VST System Link applications on different platforms, you can take advantage of effect plug-ins and VST instruments that are specific to certain programs or platforms.

This chapter describes how to set up and use VST System Link in Cubase SX/SL.
Preparations

Requirements

The following equipment is required for VST System Link operation:

• Two or more computers.
  These can be of the same type or use different operating systems – it doesn’t matter. For example, you can link an Intel-based PC to an Apple Macintosh without problems.

• Each computer must have audio hardware with specific ASIO drivers, installed and working.

• The audio hardware must have digital inputs and outputs.
  Of course, to be able to connect the computers the digital connections must be compatible (i.e. the same digital formats and connection types must be available).

• At least one digital audio cable for each computer in the network.

• A VST System Link host application installed on each computer.
  As of this writing, VST System Link is implemented for Cubase SX/SL, Nuendo 1.6 and Cubase 5.2s (System Link version). Any VST System Link applications can connect to each other.
  Additionally, we recommend that you use a KVM switchbox:

Using a KVM switchbox

If you want to set up a multi-computer network, or even a small network in a limited space, it's a good idea to invest in a KVM (Keyboard, Video, Mouse) switchbox. With one of these switchers you can use the same keyboard, monitor, and mouse to control each computer in the system, and switch between computers very rapidly. KVM switchers are not too expensive, and very easy to setup and operate. It you decide not to go this route, the network will function just the same, but you may end up doing a lot of jumping from one machine to the other while setting up!
Making connections

Below, we will assume that you are connecting two computers. Should you have more than two computers, it’s still best to start with two and add the others one by one once the system is working – this makes troubleshooting easier if you run into problems. For two computers, you will need two digital audio cables, one in each direction:

1. Connect a digital audio cable from the digital output of Computer 1 to the digital input of Computer 2.

2. Connect the other cable from the digital output of Computer 2 into the digital input of Computer 1.

• If a card has more than one set of inputs and outputs, choose whichever one that suits you – for simplicity usually the first set is best.
Setting up clock sync

Before you proceed you need to make sure that the clock signals on your ASIO cards are synchronized correctly. This is essential when cabling any kind of digital audio system, not just VST System Link.

- All digital audio cables by definition always carry a clock signal as well as audio signals, so you don’t need to use a special Word Clock input and output for this (although you may find that you get a slightly more stable audio system if you do, especially when using multiple computers).

The Clock Mode or Sync Mode is set up in the audio hardware’s ASIO Control Panel. In Cubase SX/SL, you proceed as follows:

1. Pull down the Devices menu and open the Device Setup dialog.
2. Select the VST Multitrack device and make sure the Setup tab is selected to the right.
3. Click the Control Panel button.
   The ASIO Control Panel appears.
4. Open the ASIO Control Panel on the other computer as well.
   If you are using another VST System Link host application on that computer, check its documentation for details on how to open the ASIO Control Panel. Hint: in Steinberg’s Nuendo 1.6, the procedure is the same as in Cubase SX/SL. In Cubase 5.2, you pull down the Options menu, select System from the Audio Setup menu and click the Control Panel button in the Audio System Setup dialog that appears.
5. Now, you need to make sure that one audio card (and only one!) is set to be the Clock Master, and all the other cards must be set to listen for the clock signal coming from the Clock Master i.e. they must be Clock Slaves.

The naming and procedure for this differs depending on the audio hardware – consult its documentation if required. If you are using Steinberg Nuendo ASIO hardware, all cards default to the “AutoSync” setting – in this case you must set one of the cards (and only one) to “Master” in the Clock Mode section of the Control Panel.

- Typically, the ASIO Control Panel for an audio card contains some indication of whether the card receives a proper sync signal or not, and the sample rate of that signal.
  This is a good indication that you have connected the cards and set up clock sync properly. Check your audio hardware’s documentation for details.

- It’s very important that one and only one card is the clock master, otherwise the network cannot function correctly. Once you have set this up, all the other cards in the network will take their clock signal from this card automatically.

The only exception to this procedure is if you are using an external clock – which could be from a digital mixing desk or special Word Clock synchronizer for example. If so, you must then leave all your ASIO cards in Clock Slave or AutoSync mode, and make sure that each of them is listening for the signal coming from the synchronizer, usually passed through your ADAT cables or Word Clock connectors in a daisy chain fashion.
Minimizing the latency

The general definition of latency is the amount of time it takes any system to respond to whatever messages are sent to it. For example, if your system’s latency is high and you play VST instruments in real time, you will get a noticeable delay between when you press a key and when you hear the sound of the VST instrument. Nowadays, most ASIO-compatible audio cards are capable of operating with very low latencies. Also, all VST applications are designed to compensate for latency during playback, making the playback timing tight.

However, the latency time of a VST System Link network is the total latency of all the ASIO cards in the system added together. Therefore it’s extra important to minimize the latency times for each computer in the network.

- The latency does not affect the synchronization – it’s always perfectly in time. But, it can affect the time it takes to send and receive MIDI and audio signals, or make the system seem sluggish.

To adjust the latency of a system, you typically adjust the size of the buffers in the ASIO Control Panel – the lower the buffer size, the lower the latency. Generally speaking it’s best to keep to fairly low latencies (buffer sizes) if your system can handle it – about 12 ms or less is usually a good idea.
Setting up your software

Now it's time to set up your programs. The procedures below describe how to set things up in Cubase SX/SL; if you are using another program on the other computer, please refer to its documentation.

Setting the sample rate

The projects in both programs must be set to use the same sample rate. Select “Project Setup...” from the Project menu and make sure the sample rate is the same in both systems.

Setting up inputs and outputs

1. Open the VST Inputs window from the Devices menu.
2. Activate the inputs you want to use by clicking the buttons in the Active column.

To make it simple you will probably want to enable all inputs available in the cable you are using. For example, if you are using an ADAT connection this would mean clicking on the first four buttons (i.e. activate the first eight inputs).

<table>
<thead>
<tr>
<th>Port</th>
<th>Active</th>
<th>Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>P3 REC 1/1</td>
<td></td>
<td>IN1L</td>
</tr>
<tr>
<td>P3 REC 1/2</td>
<td></td>
<td>IN1R</td>
</tr>
<tr>
<td>P3 REC 2/1</td>
<td></td>
<td>IN2L</td>
</tr>
<tr>
<td>P3 REC 2/2</td>
<td></td>
<td>IN2R</td>
</tr>
<tr>
<td>P3 REC 3/1</td>
<td></td>
<td>IN3L</td>
</tr>
<tr>
<td>P3 REC 3/2</td>
<td></td>
<td>IN3R</td>
</tr>
<tr>
<td>P3 REC 4/1</td>
<td></td>
<td>IN4L</td>
</tr>
<tr>
<td>P3 REC 4/2</td>
<td></td>
<td>IN4R</td>
</tr>
</tbody>
</table>
3. Close the VST Inputs window and open the VST Outputs window from the Devices menu.

4. Enable the output buses you need. Usually these should match up to the input buses you enabled above. In our ADAT example, this would mean the first four stereo outputs.

5. Repeat the steps above for all computers in the network.
   • Note that at least one computer in your network needs to have more than one physical set of audio outputs, so that you can hear what’s coming out of it! For example, if your audio card has a stereo analog out and an ADAT connector, you can use the ADAT connector for networking and the analog outs for monitoring. Make sure that the bus setup in your VST application reflects which set of outputs is doing which operation.

   Once we’ve done this we have a set of inputs and outputs that can carry both our network commands and audio signals from one computer to another. At this point, it may be a good idea to test that everything is set up properly:
Streaming digital audio between applications

1. Set things up so that Computer 1 plays back some audio. You could for example import an audio file and play this back in Cycle mode.

2. In the Mixer, make sure the playing audio channel is routed to one of the digital outputs you have set up for the VST System Link connection.

3. In Computer 2, select the corresponding digital input for an audio channel and activate monitoring for the channel. The audio being played back should now “appear” in the program running on Computer 2. You should now see the input level meters moving, and hear the audio.

4. Reverse this procedure so that Computer 2 plays back and Computer 1 “listens”.

Now you have verified that the digital connection works as it should.
Activating VST System Link

After setting up the inputs and outputs, you now need to define which input/output should carry the actual VST System Link information.

The System Link networking signal is carried on only one bit of one channel. This means that if you have an ADAT based system which normally carries eight channels of 24-bit audio, once you activate VST System Link you will have seven channels of 24-bit audio and one channel of 23-bit audio (the least significant bit of this last channel is what we will use for networking). In practice this makes no discernible difference to the audio quality, since you will still have around 138dB headroom on this channel.

To set things up we need to open the VST System Link panel:

1. Open the Device Setup dialog on the Devices menu.
2. Select the VST System Link device and make sure the Setup tab is selected to the right.
3. Use the ASIO Input and ASIO Output pop-up menus to define which channel should be the networking channel (and thus become a 23-bit audio channel, in our example).
   Quite often you will be able to just leave these pop-ups the way they are.
4. Click the Active checkbox at the top of the panel.

5. Repeat the steps above for every computer on the network.

As the computers are made active, you should see the small T (Transmit) and R (Receive) lights flashing on each active computer, and the name of each computer should appear in the list at the bottom of the pane. Each computer is assigned a random number – don’t worry about this, it’s just so the network knows internally which one is which.

- You can double click on the name in bold (which is the name of the computer you’re currently working on) and set it to whatever other name you wish.
  This name will appear in the System Link window of every computer on the network.

- If you don’t see the name of each computer appearing once you have made it active, you may have to check your settings.
  Go through the procedure above again and make sure that all ASIO cards are listening to the digital clock signals correctly, and that each computer has the correct inputs and outputs assigned to the System Link network.

**Putting the network online**

After each computer’s name you will see whether it is online or not. When a computer is online, that means it receives transport and time-code signals, and its sequencer application can be started and stopped by remote control. If it is off-line it can only be started from its own keyboard – it is effectively an independent machine, although it is still on the network.

- Note that any computer can control any and all of the others – VST System Link is a peer to peer network and there is no absolute “master” computer.
  However, most users do like to think of one machine as the master (in a one person / two computer network, this would be the machine you actually sit behind most of the time).
For now, let’s put all computers online:

1. Activate the Online checkbox in the VST System Link panel for all computers.

2. Check that the system is working by pressing Play on one computer – all computers should start almost instantly and play perfectly in time, with sample accurate precision.

- The Offset setting to the right allows you to adjust whether one machine will play back slightly ahead or behind the rest. This is normally not needed, but occasionally with some hardware you may find that the lock is a few samples out. In that case you can adjust the lock with the Offset value. For now, leave it set to 0 – it will most likely be what you want.

VST System Link sends and understands all transport commands, so you can play, stop, fast forward, rewind etc. the entire network from one computer without a problem – try it! If you jump to a locator point on one machine, all other machines will also instantly jump to that locator point.

- Don’t forget to make sure that all computers have their tempos set to the same value, otherwise your synchronization will be seriously skewed.
Using MIDI

As well as supplying transport and sync control, VST System Link also supplies up to 16 MIDI ports, each with 16 channels. You set this up as follows:

1. Use the MIDI Ins and Outs value boxes to specify the number of MIDI ports you need.
   The default value is 0 MIDI In and 0 MIDI Out ports.

2. Create a MIDI track in the Project window and open the Inspector (top section).

3. If you now pull down the “in” or “out” pop-ups, you will find the specified System Link ports added to the list of MIDI Inputs and Outputs.

This allows you to route MIDI tracks to VST instruments running on another computer, as described in the application examples (see page 678).
The “Active ASIO Ports for Data only” setting

If you are sending huge amounts of MIDI data at once, there is a small possibility that you might run out of bandwidth on your VST System Link network. This will manifest itself by notes “choking” or timing becoming erratic.

If this happens, you can devote more bandwidth to MIDI by selecting Active ASIO Ports for Data only in the VST System Link Setup panel. When this is active, the VST System Link information will be sent on the entire channel instead of just one bit, more than enough for all the MIDI you could ever hope to use. The downside is that you can no longer use this ASIO channel for audio transfer (do not connect it to a speaker!), thus leaving you only 7 channels of audio in our ADAT cable example. Depending on how you work this might be a reasonable compromise.

Hearing the network audio

If you are using an external mixing desk, hearing your audio really isn’t an issue – just plug the outputs of each computer into the desired channels on the external mixing desk, press Play on one of the computers, and you’re good to go.

However, many people prefer to mix internally inside the computer and just use a desk for monitoring (or maybe not use any external mixer at all). In this case you’ll need to select one computer to be your “main mix computer” and send the audio from your other computers into this.

In the following example, we assume you are using two computers, with Computer 1 as your main mix computer and Computer 2 running two additional audio tracks, a reverb plug-in and a VST instrument plug-in with stereo outputs.

1. First you want to set things up so that you can listen to the audio playback from Computer 1.
   In other words, you need an unused set of outputs, e.g. an analog stereo output, connected to your monitoring equipment.

2. Go to Computer 2 and assign each of the two audio tracks to a separate VST System Link output bus.
   For example, assign the audio tracks to Bus 1 and 2.
3. Assign the output of the reverb to another bus (e.g. Bus 3).
   This is done using the output routing pop-up menu in the VST Send Effects window.

4. Assign the VST instrument stereo channel to yet another bus (e.g. Bus 4).

5. Go back to Computer 1 and add four new stereo audio tracks.
   These should be routed to the bus you use for listening, e.g. to the analog stereo outputs.

6. Use the Input pop-up menus in the Mixer to select the four VST System Link buses (one for each track).

7. Activate monitoring for the four tracks.
   If you now start playback, the audio from Computer 2 will be sent “live” to the new tracks on Computer 1, allowing you to hear them together with any tracks you play back on Computer 1.

Adding more tracks

OK, but if you have more audio tracks than you have VST System Link buses (physical outputs)? Then you just use the VST Outputs window on Computer 2 as a small submixer: Assign several audio tracks to the same Output bus and then set the fader in the VST Output window to make sure you are sending the right level to your main mix computer.

Note also that if your audio cards have multiple sets of input and output connections you can link up e.g. multiple ADAT cables and send audio via any of the buses on any of the cables.

Internal mixing and latency

One problem with mixing inside the computer is the latency issue we mentioned earlier. The VST engine always compensates for record latencies, but if you are monitoring through Computer 1 you will hear a processing delay while you listen to signals coming from your other computers (not on your recording!). If your audio card in Computer 1 supports ASIO Direct Monitoring you should definitely turn this on – you’ll find the setting in the VST Multitrack Device Setup panel (see page 31). Most modern ASIO cards support this function. If yours doesn’t you may want to change the Offset value in the VST System Link Setup panel to compensate for any latency issues.
Setting up a larger network

This is not much more difficult than a two computer network. The main thing to remember is that VST System Link is a daisy chain system. In other words, the output of Computer 1 goes to the input of Computer 2, the output of Computer 2 goes to the input of Computer 3, and so on around the chain. The output of the last computer in the chain must always go back into the input of Computer 1, to complete the ring.

Once you’ve done this, the transmission of all the transport, sync, and MIDI information to the whole network is handled pretty much automatically. However, where you may run into confusion in a large network is in the transmission of audio signals back to a central mix computer.

If you have lots of hardware inputs and outputs on your ASIO cards you don’t need to send audio via the chain at all, but can transmit it directly to the master mix computer via one or more of its other hardware Inputs. For example, if you have a Nuendo Digiset interface or 9652 card on Computer 1 you could use ADAT cable 1 for networking, ADAT cable 2 as a direct audio input from Computer 2, and ADAT cable 3 as a direct audio input from Computer 3.

You can also transmit audio via the ring system if you don’t have enough hardware I/Os for direct audio transmission. For example, in a four computer scenario you could send audio from Computer 2 into a channel in the mixer in Computer 3, and from there to a channel in the mixer in Computer 4, and from there back to the master mixer in Computer 1. This can certainly be tricky to set up, so generally it is recommended that if you want to set up a complex network, you should make sure to use ASIO cards with at least three separate digital I/Os.
Application examples

Using one computer for VST instruments

In this example, you are using one computer as your main record and playback machine, and want to use another computer as a virtual synth rack.

1. Record a MIDI track into Computer 1.

2. Once you have finished recording, route the MIDI output of that track to System Link MIDI port 1.

3. Now go to Computer 2, open up the VST Instrument rack and assign an instrument to the first slot in the rack.

4. Create a new MIDI track in the Project Window of Computer 2, and assign the MIDI output of the track to go to the VST Instrument you selected earlier.

5. Assign the MIDI input of the track to be VST System Link port 1. Now, the MIDI track on Computer 1 is routed to the MIDI track on Computer 2, which in turn is routed to the VST Instrument.

6. Now activate monitoring for the MIDI track on Computer 2, so that it will listen and respond to any MIDI commands coming in. In Cubase SX/SL, you would click the monitor button in the Track list or Inspector.

7. Press play on Computer 1. It will now send the MIDI information on the track to the VST Instrument loaded on Computer 2.

Even with a slow computer you should be able to stack a whole bunch of extra VST Instruments this way, expanding your sound palette considerably. Don’t forget that VST System Link MIDI is also sample accurate, and thus has much tighter timing than any hardware MIDI interface ever invented!
Creating a virtual effect rack

The effect sends for an audio channel in Cubase SX/SL can either be routed to an effect (in the VST Send Effects rack) or to any activated Group or Output bus. This allows you to use a separate computer as a “virtual effect rack”, by setting things up in the following way:

1. Go to Computer 2 (the machine you will use as effect rack) and add a new stereo audio track.
2. Add the desired effect as an insert effect for the track.
   Let’s say you add a high-quality reverb plug-in.
3. Open the Mixer and select one of the VST System Link buses as input for the audio track.
   You want to use a separate System Link bus, which will only be used for this purpose.
4. Activate monitoring for the track.
5. Now, go back to Computer 1 and select a track to which you want to add some reverb.
6. Bring up the effect sends for the track, in the Inspector or the Mixer (Cubase SX only).
7. Pull down the send routing pop-up menu for one of the sends, and select the System Link bus assigned to the reverb in step 3.
8. Use the send slider/knob to adjust the amount of effect as usual.

The signal will be sent to the track on Computer 2 and processed through its insert effect, without using any processor power on Computer 1.

You can repeat the steps above to add more effects to the “virtual effect rack”. The number of effects available this way is only limited by the number of ports used in the VST System Link connection (and of course by the performance of Computer 2, but given that it won’t have to handle any recording or playback, you should be able to use quite a lot of effects).
Getting extra audio tracks

All computers on a VST System Link network are locked with sample accuracy. Therefore, if you find that the hard drive on one computer isn’t fast enough to run as many audio tracks as you need, you could record new tracks on one of the other computers instead. This would create a "virtual RAID system", with several disks all operating together. All tracks will remain locked together just as tightly as if they were all running on the same machine. This means that you effectively have an unlimited track count! Need another 100 tracks? Just add another computer.
Video
Background

Video support in Cubase SX/SL

Cubase SX/SL for Windows can play back video films using one of three different playback engines: DirectShow, QuickTime and Video for Windows. This ensures compatibility with as wide a range of video hardware as possible. Cubase SX/SL for Mac OS X plays back video using Quicktime.

Generally there are two ways to play back video:

• Without any special hardware at all, using the computer CPU. In this case, the "codec" is in software. While this will be fine in many situations it does put a limit on the size of the video window as well as the quality of the image.

• Using video hardware, either built-in or connected via a FireWire port, that plays back the video on an external monitor. This hardware must then use a suitable codec and have the proper drivers for the platform.

☐ Continuously updated information about video hardware support and compatibility is available on www.steinberg.net.
Operations

About the video playback engine

In Cubase SX/SL for Windows, you select a playback engine in the Device Setup dialog, under the “Setup” tab for the Video Player device:

What playback engine to select depends largely on which type of video system you are using, as well as on the file format and codec of the video files you want to work with. Below is a brief guide to which formats you may be able to use with the different playback engines. However, this also depends on the video hardware – please consult the hardware documentation for detailed information.

<table>
<thead>
<tr>
<th>Playback engine</th>
<th>Video file formats</th>
<th>Codecs</th>
</tr>
</thead>
<tbody>
<tr>
<td>DirectShow</td>
<td>AVI, MPEG</td>
<td>Cinepak, DV, Indeo, M-JPEG, MPEG</td>
</tr>
<tr>
<td>QuickTime</td>
<td>QuickTime, AVI, MPEG</td>
<td>Cinepak, DV, Indeo, M-JPEG, MPEG</td>
</tr>
<tr>
<td>Video for Windows</td>
<td>AVI</td>
<td>Cinepak, Indeo, M-JPEG (with some video cards)</td>
</tr>
</tbody>
</table>

- Generally, you can expect most Windows hardware to work with DirectShow.
- For the Quicktime playback method to be available, you must have QuickTime installed on your computer. A QuickTime installer is included on the Cubase SX/SL CD if required.
- Under Mac OS X, the Quicktime playback engine is always used, supporting the formats AVI, MPEG, QuickTime and DV.
Importing a video file

Video files are imported just as audio files, see page 73.

- By using the File menu (Import Videofile).
- By using drag and drop.
- By importing to the Pool first and then dragging to the Project window (see the Pool chapter for details).

Note:
- To be able to play back the video, you must add a video track (by using the Add Track submenu on the Project menu or Quick menu). You can only have one video track in each project.
- All video files on the track must be of the same size and compression format.
- The audio in the video file is not included.

Playing back a video file

Video files are displayed as events/clips on the video track, with thumbnails representing the frames in the film.

A video event on a video track.

To view the video on the computer screen (as opposed to on an external monitor), proceed as follows:

1. Open the Device Setup from the Devices menu, click Video Player in the list and make sure “Onscreen Window” is selected in the Video Output section of the dialog.
2. Pull down the Devices menu and select Video (or use a key command – by default [F8]).
   A video window appears. In stop mode, this displays the video frame at the project cursor position.
   Playback is done together with all other material, using the Transport panel.
Setting video output to external equipment (Mac OS X only)

For Apple computers equipped with a FireWire port, you can easily connect external video hardware via this, as OS X has built-in video support for the most common formats (NTSC/PAL/DVCPRO). FireWire is capable of high data-transfer speed and is the most common standard for communicating with video-related peripheral equipment.

- To play back a video file via hardware connected to the FireWire port, select “FireWire” in the Outputs pop-up of the Device Setup - Video Player dialog.
  When FireWire is selected as output, a number of format options appear on the Format pop-up, allowing you to select between various video formats and resolutions.

Setting the window size

If you are playing back video in a window on your computer screen, you may want to adjust the size: Open Device Setup from the Devices menu, click Video Player in the list and use the Video Window buttons to select a size.

Project window and Browser editing operations

Video clips are played back by events just as audio clips are. You can use all the basic editing operation on video events, just as with audio events (see page 80). The following operations are not possible on the video track:

- Drawing, Gluing, Muting and Scrubbing.
- The video track has no editor and does not make use of parts.
Pool operations

For more about operations on video clips in the Pool, see page 386.

Options

In the Preferences dialog (Event Display–Video page), there are two options for video playback:

- **Show Video Thumbnails.**
  When this is activated, thumbnail frames of the video contents are shown in the track.

- **Video Cache Size.**
  This determines how much memory is available for video thumbnails. If you have long video clips and/or work with a large zoom factor (so that a lot of frames are shown in the thumbnails), you may have to raise this value.
Introduction

ReWire and ReWire2 are special protocols for streaming audio between two computer applications. Developed by Propellerhead Software and Steinberg, ReWire provides the following possibilities and features:

- Real-time streaming of up to 64 separate audio channels (256 with ReWire2), at full bandwidth, from the “synthesizer application” into the “mixer application”. In this case, the “mixer application” is of course Cubase SX/SL. An example of a “synthesizer application” is Propellerhead Software’s Reason.

- Automatic, sample accurate synchronization between the audio in the two programs.

- The possibility to have the two programs share one sound card and take advantage of multiple outputs on that card.

- Linked transport controls that allow you to play, rewind etc, either from Cubase SX/SL or from the synthesizer application (provided it has some kind of transport functionality).

- Automatic audio mixing functions of separate channels as required. In the case of Reason for example, this allows you to have separate mixer channels for the different devices.

- Additionally, ReWire2 offers the possibility to route MIDI tracks in Cubase SX/SL to the other application, for full MIDI control. For each ReWire2 compatible device, a number of extra MIDI outputs will be made available in Cubase SX/SL. In the case of Reason, this allows you to route different MIDI tracks in Cubase SX/SL to different devices in Reason, having Cubase SX/SL serve as main MIDI sequencer.

- Less total system requirements than when using the programs together in the conventional way.
Launching and quitting

When using ReWire, the order in which you launch and quit the two programs is very important:

Launching for normal use with ReWire

1. First launch Cubase SX/SL.
2. Enable one or several ReWire channels in the ReWire Device dialog for the other application. This is described in detail on page 690.
3. Launch the other application. It may take slightly longer for the application to start when you are using ReWire.

Quitting a ReWire session

When you are finished, you also need to quit the applications in a special order:

1. First quit the synthesizer application.
2. Then quit Cubase SX/SL.

Launching both programs without using ReWire

We don’t know exactly why you would want to run Cubase SX/SL and the synthesizer application at the same time on the same computer, without using ReWire, but you can:

1. First launch the synthesizer application.
2. Then launch Cubase SX/SL.

Please also note that the two programs now compete for system resources such as audio cards, just as when running either with other, non-ReWire audio applications.
Activating ReWire channels

ReWire supports streaming of up to 64 separate audio channels, while ReWire2 supports 256 channels. The exact number of available ReWire channels depends on the synthesizer application. Using the ReWire Device panels in Cubase SX/SL, you can specify which of the available channels you want to use:

1. Pull down the Devices menu and select the menu item with the name of the ReWire application. All recognized ReWire compatible applications will be available on the menu. The ReWire panel appears. This consists of a number of rows, one for each available ReWire channel.

2. Click on the green buttons in the "Active" column to activate/deactivate the desired channels. The buttons light up to indicate activated channels. Please note that the more ReWire channels you activate, the more processing power is required.

- For information about exactly what signal is carried on each channel, see the documentation of the synthesizer application.

3. If desired, double click on the labels in the right column, and type in another name. These labels will be used in the Cubase SX/SL Mixer to identify the ReWire channels.
Using the transport and tempo controls

- This is only relevant if the synthesizer application has some sort of built-in sequencer or similar.

Basic transport controls

When you run ReWire, the transports in the two programs are completely linked. It doesn’t matter in which program you Play, Stop, Fast Forward or Rewind. However, recording (if applicable) is still completely separate in the two applications.

Loop settings

If there is a loop or cycle facility in the synthesizer application, that loop will be completely linked to the Cycle in Cubase SX/SL. This means that you can move the start and end point for the loop or turn the loop on or off in either program, and this will be reflected in the other.

Tempo settings

As far as tempo goes, Cubase SX/SL is always the Master. This means that both programs will run in the tempo set in Cubase SX/SL.

However, if you are not using the Tempo track in Cubase SX/SL, you can adjust the tempo in either program, and this will immediately be reflected in the other.

- If you are using the Tempo track in Cubase SX/SL (if Master is activated on the Transport bar), you should not adjust the tempo in the synthesizer application, since a tempo request from ReWire will automatically deacti-vate the Master switch in Cubase SX/SL!
How the ReWire channels are handled in Cubase SX/SL

When you activate ReWire channels in the ReWire Device panels, they will become available as channel strips in the Mixer. The ReWire channel strips have the following properties:

• ReWire channels appear to the right of the track-based (audio and MIDI) channel strips.

• ReWire channels may be any combination of mono and stereo, depending on the synthesizer application.

• ReWire channels have the same functionality as regular audio channels.
  This means you can set volume and pan, add EQ, insert and send effects and route the channel outputs to Groups or Buses. All settings can be automated using the Read/Write functions.

• All unmuted ReWire channels are included when you mix down to an audio file using the Export Audio Mixdown function (see page 627). This allows you to “convert” your ReWire channels into hard disk tracks. If you want to mix down the ReWire channels only, make sure all audio tracks and VST Instrument channels are muted.
Routing MIDI via ReWire2

This feature is only available with ReWire2-compatible applications.

When using Cubase SX/SL with a ReWire-compatible application, additional MIDI outputs will automatically appear on the MIDI Output pop-up menus for MIDI tracks. This allows you to play the synthesizer application via MIDI from Cubase SX/SL, using it as one or several separate MIDI sound sources.

The number and configuration of MIDI Outputs depends on the synthesizer application.
Considerations and limitations

Sample rates

Synthesizer applications may be limited to audio playback in certain sample rates. If Cubase SX/SL is set to a sample rate other than those, the synthesizer application will play back at the wrong pitch. Consult the documentation of the synthesizer application for details.

ASIO drivers

ReWire works well with ASIO drivers. By using the Cubase SX/SL bussing system you can route sounds from the synthesizer application to various outputs on an ASIO compatible audio card.
31

File Handling
File Operations

New Project

The New Project command on the File menu allows you to create a
new project, either empty or based on a template:

1. Select New Project from the File menu.
   A list of templates is displayed. When you install Cubase SX/SL, a number of tem-
   plates for various purposes are included, but you can also create your own (see page
   700).

2. Select a template from the list, or select “Empty”.
   A project file dialog appears, allowing you to specify a folder for the new project.

3. Select an existing project folder or create a new one by typing its
   name in the dialog.
   A new, untitled project is created.

Open

The Open command on the File menu is used for opening saved
project files. Both Cubase SX/SL project files (extension “.cpr”) and
project files created in Steinberg’s Nuendo (extension “.npr”) can be
opened (although Nuendo-specific settings will be ignored).

- Several projects can be open at the same time.
  The active project is indicated by the red Activate button in the upper left corner of the
  Project window. To make another project active, click its Activate button.

An active project.
• You can also open project files by selecting a shortcut from the "Recent Projects" submenu on the File menu. This submenu lists the projects you have recently worked with, with the most recent one at the top of the list.

• Projects can also automatically be opened when you launch Cubase SX/SL. See page 712.

• If you are using Cubase SL, it's fully possible to open a Project file created in Cubase SX. Features not supported by Cubase SL will however not be available. For example, if you open a Cubase SX project that uses more than five insert effects for a channel (or more than 16 VST Instruments) a dialog will appear, informing you that not all effects/instruments can be loaded.

Close

The Close command on the File menu closes the active window. If a Project window is active, selecting Close will close the corresponding project.

• If the project contains unsaved changes, you will be asked whether you want to save the project before closing it. If you select “Don’t Save”, and have recorded or created new audio files since saving, you get the choice to delete or keep these.

Save and Save As

The commands Save and Save As allow you to save the active project as a project file (file extension ".cpr"). The Save command stores the project under its current name and location, while Save As allows you to rename and/or relocate the file. If you haven’t yet saved the project, or if it hasn’t been changed since it was last saved, only Save As will be available.

Generally, we recommend that you save project files in their project folders, to keep the projects as manageable as possible.
A word about file extensions

Under Windows, file types are indicated by three letter file name extensions (such as *.cpr for Cubase SX/SL Project files). Under Mac OS X, it is not necessary to use file name extensions, since the file types are stored internally in the files. However, if you want your Cubase SX/SL Projects to be compatible with both platforms, you should make sure the option “Use File Extension in File Dialog” is activated in the Preferences dialog (User Interface page) - this is the default setting. When this is activated, the proper file name extension is automatically added when you save a file.

Saving a Default Project

If you always want the same default project to open when you launch Cubase SX/SL, you can save a default project:

1. Set up a project the way you want it.
2. Select “Save As” from the File menu and save the project in the Cubase SX/SL application folder, under the name “default.cpr”.

This is the one case when the file name extension is crucial under Mac OS X as well!

3. Open the Preferences dialog and select the User Interface page.
4. Open the “On Startup” pop-up menu and select “Open Default Project”.
   The next time you launch Cubase SX/SL, the default project is automatically opened.
   For details on the other Startup options, see page 712.
Save Project to new folder

This function is very useful if you want to move or archive your project. If you select this item, you will first be asked where to store the saved project. Then a dialog will appear, with the following options:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Name</td>
<td>By default, this will be the current name of the project you’re saving, but you can change it if you like.</td>
</tr>
<tr>
<td>Minimize Audiofiles</td>
<td>If this is activated, only the audio file portions that are actually used in the project will be included. This can significantly reduce the size of the project folder (if you are using small sections of large files), but it will also mean you cannot make use of the remaining audio file portions if you continue working with the project in its new folder.</td>
</tr>
<tr>
<td>Freeze Edits</td>
<td>This will perform a Freeze Edits operation, making all processing and applied effects permanent to each clip in the Pool. See page 319.</td>
</tr>
<tr>
<td>Remove Unused Files</td>
<td>When this is activated, only files in the Pool that are actually used in the project will be stored in the new folder.</td>
</tr>
</tbody>
</table>

When you’ve made your settings, click OK to save the project in the new folder. The original project isn’t removed or affected.
Save as Template

This function allows you to save the current project as a template. Templates are always stored in the Templates folder (within the Cubase SX/SL program folder). When you create a new project, the available templates will be listed, allowing you to base the new project on a template.

- Templates can contain clips and events, just like regular projects. If this is not what you want, make sure to remove all clips from the Pool before you save the project as a template.

Revert

If you select Revert from the File menu, you will be asked whether you really want to revert to the last saved version of the project. If you click “Revert”, all changes you have made since the last saving will be discarded.

- If you have recorded or created new audio files since saving, you will be asked whether you want to delete or keep these.

The “Cleanup” function

The Cleanup function on the File menu helps you to save hard disk space by locating, and if you like, deleting unused audio files in the project folders on your disk.

1. Select “Cleanup…” from the File menu.
If there are any open projects, an alert will appear, allowing you to close these. Clicking “Close” closes all open projects and brings up the Cleanup dialog.

2. If you want to restrict the Cleanup function to a certain folder only, click the “Search Folder” button and select the folder.
You should only select a specific folder if you are certain it doesn’t contain audio files used in other projects (outside the folder)! See the note below.
If you want the Cleanup function to be applied to all folders on all hard disks, you don’t need to make any special settings, as this is the default mode. After selecting a folder you can reset the function to search all folders by opening the “Search Folder” dialog again and clicking “Cancel”.

3. Click the Start button.
   Cubase SX/SL will now scan the selected folder (or all hard disks) for Cubase SX/SL project folders and check for audio and image files (in the Audio, Edits, Fades and Images subfolders) that are not used by any project. The found files are listed in the dialog.

4. When the scan is complete, you can select files by clicking in the list. Use [Ctrl]/[Command]-click to select several files, and [Shift]-click to select a range of files. You can also click the Select All button to select all files in the list.

   ▶ There are situations when the Cleanup function will list files that are not unused!
   - If you have moved or renamed files or folders (without updating the project files to use the new paths), there is no way for Cubase SX/SL to know that these files are used in a project.
   - If you are performing the Cleanup function on a folder in which there are audio files belonging to other projects (outside the folder), these files will be considered “unused”.
   - Also, make sure you don't delete any files used in other applications, or files that you generally want to keep!

   However, you can safely delete Image files and Fade files (files within the Fades folder of a project) since these can be reconstructed by the program if necessary.

5. Delete any files you don’t want to keep, by selecting them and clicking Delete.

6. Close the dialog by clicking its close button.
Exporting and Importing MIDI Files

Cubase SX/SL can import and export Standard MIDI Files, which makes it possible to transfer MIDI material to and from virtually any MIDI application, on any platform.

Exporting MIDI Files

To export your MIDI tracks as a Standard MIDI File, pull down the File menu and select "MIDI File..." from the Export submenu. A regular file dialog appears, allowing you to specify a location and name for the file. You will then be asked whether the MIDI file should be of Type 0 (all data on a single track, but on different MIDI channels) or Type 1 (data on separate tracks). Which type to choose depends on what you want to do with the MIDI file (in which application or sequencer it should be used, etc.).

- The MIDI File will contain the Master Tempo, including all changes in the Tempo track.
- Inspector settings for the tracks are not included in the MIDI file! To include these, you need to convert the settings to "real" MIDI events and properties by using the Merge MIDI in Loop function for each track, see page 462.

Importing MIDI Files

To import a MIDI file from disk, proceed as follows:

1. Select "MIDI File..." from the Import submenu on the File menu.
2. In the dialog that appears, select whether you want the MIDI file to be imported into the current project, or whether a new project should be created.
3. Locate and select the MIDI file in the file dialog that appears, and click Open.
4. If you chose that a new project should be created, you are asked to specify a project folder for the new project. Select an existing project folder or create a new one by typing its name in the dialog.
The MIDI file is imported, starting at the beginning of the project. The result depends on the type of MIDI file:

- If the MIDI file is of Type 0 (all data on a single track), only one MIDI track will be created. This track will be set to MIDI Channel “Any”, allowing all MIDI events to play back on their original channels. You can use the Dissolve Part function on the MIDI menu to distribute the events onto different tracks with different MIDI Channels (see page 483).

- If the MIDI file is of Type 1 (data on several tracks) a number of new MIDI tracks and parts will be created.

In both cases, the Tempo track is adjusted according to the tempo track in the MIDI file.

Importing older Cubase files

It is possible to import files created in older versions of Cubase. There are three options for this on the File – Import submenu:

Import Cubase Song

This will open a Song file (Windows file extension “.all”) created in Cubase 5.0 or later and convert it to a Cubase SX/SL project. When importing a Song, you will be asked to specify a folder for the new project, as usual.

- Cubase Songs can contain more than one Arrangement (containing independent part and event data). If this is the case, you will be asked which one of these Arrangements to import.

To import all Arrangements in a Cubase Song, simply repeat this for all Arrangements, and save each as a separate project.

The conversion has the following limitations:

<table>
<thead>
<tr>
<th>Data</th>
<th>Conversion result</th>
</tr>
</thead>
<tbody>
<tr>
<td>MIDI output setting for MIDI tracks</td>
<td>If the output information stored in the original Song doesn’t match the current outputs, a “Pending Connections” dialog will appear, allowing you to remap each MIDI output in the Song to a new output.</td>
</tr>
<tr>
<td>MIDI track play parameters (Inspector settings)</td>
<td>Only the volume and transpose settings are included; the other parameters (velocity, compression, length and pan) are ignored.</td>
</tr>
</tbody>
</table>
### Data

<table>
<thead>
<tr>
<th>Data</th>
<th>Conversion result</th>
</tr>
</thead>
<tbody>
<tr>
<td>MIDI part play parameters (Inspector settings)</td>
<td>All settings are included, except transpose.</td>
</tr>
<tr>
<td>Group tracks</td>
<td>Removed.</td>
</tr>
<tr>
<td>Style tracks</td>
<td>Removed.</td>
</tr>
<tr>
<td>Chord tracks</td>
<td>Removed.</td>
</tr>
<tr>
<td>Drum tracks</td>
<td>Converted to MIDI tracks with drum maps. MIDI output settings for individual drum sounds will be ignored.</td>
</tr>
<tr>
<td>Solo/Mute status of tracks</td>
<td>Ignored.</td>
</tr>
<tr>
<td>MIDI “effect” devices, such as the arpeggiator and IPS</td>
<td>Removed.</td>
</tr>
<tr>
<td>Window layouts</td>
<td>Ignored.</td>
</tr>
<tr>
<td>Key command settings</td>
<td>Ignored.</td>
</tr>
<tr>
<td>Grooves</td>
<td>Ignored.</td>
</tr>
<tr>
<td>MIDI Mixermaps</td>
<td>Removed.</td>
</tr>
<tr>
<td>Dynamic events in audio parts (including M-points)</td>
<td>Ignored.</td>
</tr>
<tr>
<td>Automation</td>
<td>The VST channel automation is included, but limited to volume, pan and EQ data. Plug-in automation and automation for DSP Factory settings are ignored.</td>
</tr>
<tr>
<td>Left/right locator positions and cycle status</td>
<td>Ignored.</td>
</tr>
<tr>
<td>Sync settings and status</td>
<td>Ignored.</td>
</tr>
<tr>
<td>Master track hitpoints</td>
<td>Removed.</td>
</tr>
<tr>
<td>VST Group channels</td>
<td>Removed.</td>
</tr>
<tr>
<td>Multiple audio tracks routed to the same audio channel</td>
<td>Will be replaced by separate audio tracks (with separate channels in the Mixer). This is because in Cubase SX/SL there is always one channel per track.</td>
</tr>
<tr>
<td>Solo/Mute status of VST channels</td>
<td>Ignored.</td>
</tr>
</tbody>
</table>

- **It's also possible to import Songs created in version 3.7x of Cubase for Windows.**
  However, this will only include the basic audio and MIDI data, ignoring most of the settings.
Import Cubase Arrangement

As mentioned above, a Song in previous versions of Cubase could contain one or several Arrangements. These contained all the part and event data along with file references, but without mixer settings and similar, which were global to all Arrangements in the Song. Arrangements could be saved as separate files, with the extension ".arr".

When you import a Cubase Arrangement into Cubase SX/SL, it will be converted to a project, just as when importing a Song. The same limitations apply.

Import Cubase Part

Just as in Cubase SX/SL, previous Cubase versions used parts as containers for MIDI or audio events. These could be saved as separate files with the extension ".prt". When you import a part file, the following happens:

- A new track is created, with the name of the part. That is, the name of the part when it was saved in Cubase, not (necessarily) the file name.
- The part appears as a Cubase SX/SL part, at the left locator position.
- If the imported part was an audio part, the necessary clips and file references are added to the Pool.

Note that none of these file formats contain any actual audio data. Just as with Cubase SX/SL projects, the files only contain references to audio files. This means that you need access to the referenced audio files as well, to properly import Songs, Arrangements or Parts with audio.
Importing audio CD tracks (Cubase SX only)

You can import audio from audio CDs, for use in Cubase SX Projects. This is done by selecting “Import Audio CD” from the Pool menu (or by selecting the “Audio CD…” option from the Import submenu on the File menu).

- If the project window is active, the imported audio CD track(s) will be inserted on the selected audio track, at the project cursor position. It is also possible to import audio CD tracks into the Pool, which may be the preferred method if you want to import several CD tracks in one go.

Selecting one of the Import Audio CD menu items brings up the following dialog:
• If you have more than one CD drive, you use the Drives pop-up menu to select the one holding the audio CD.

• The Speeds pop-up menu (Windows version only) lists all possible data transfer speeds for the selected CD drive. While you normally want to use the fastest possible speed, you may have to select a slower speed for flawless audio extraction.

• The main display in the dialog lists all audio tracks on the CD. The columns have the following functionality:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grab</td>
<td>Activate the checkbox in this column for the track you want to grab (import). To activate more than one checkbox (import more than one track), click and drag over the checkboxes (or press [Ctrl]/[Command] or [Shift] and click).</td>
</tr>
<tr>
<td>Track</td>
<td>When you import an audio CD track, the file will be named according to the name in this column. You can rename a track by clicking in the Track column and typing a new name. You can also apply a name to all audio CD tracks (e.g. the name of the album, see below).</td>
</tr>
<tr>
<td>Length</td>
<td>The length of the whole audio CD track, in minutes and seconds.</td>
</tr>
<tr>
<td>Size</td>
<td>The file size of the whole audio CD track, in MegaBytes.</td>
</tr>
<tr>
<td>Grab Start</td>
<td>You can grab a section of a track if you like. This indicates the start of the section to be grabbed in the track. By default, this is set to the start of the track (0.000) but you can adjust this on the grab selection ruler (see below).</td>
</tr>
<tr>
<td>Grab End</td>
<td>Indicates the end of the section to be grabbed in the track. By default, this is set to the end of the track but you can adjust this on the grab selection ruler (see below).</td>
</tr>
</tbody>
</table>

• You can audition the selected audio CD track by clicking the Play button. The track will be played back from the grab selection start (see below) to the track end (or until you click the button again). During playback, the button is labeled “Stop”.

• The arrow buttons next to the Play button allow you to audition the start and end of the grab selection only. The left button will play a short snippet beginning at the start of the grab selection (see below), while the right button will play a snippet starting just before the end of the grab selection.
• If you want to import a section of an audio CD track only, you select the track in the list and specify the start and end of the grab selection by dragging the handles in the grab selection ruler. Use the start and end audition buttons to fine tune the selection boundaries.

Note that you can import sections of several audio CD tracks by selecting them in turn and adjusting the grab selection. The grab start and end settings for each track will appear in the list.

• If you wish, you can change the generic audio file name in the File Name field. By default, the imported audio files will get this name with a track number added (typically Track 01, Track 02, and so on). However, if you have adjusted the track name for a specific audio CD track in the list, the corresponding audio file will use that name instead.

• By default, imported audio CD tracks will be stored as Wave files (Windows) or AIFF files (Mac) in the Audio folder of the current project. You can select another folder by clicking the Change Folder button.

• Clicking the Grab button will convert the selected audio CD tracks (the tracks for which the Grab checkbox is ticked) to audio files. The grabbed files will be listed at the bottom of the dialog – click OK to actually import the files into the project and close the dialog, or click Cancel to discard the grabbed files.
Importing ReCycle files

ReCycle, developed by Propellerhead Software, is a program designed especially for working with sampled loops. By “slicing” a loop and making separate samples of each beat, ReCycle makes it possible to match the tempo of a loop and edit the loop as if it was built up of individual sounds. Cubase SX/SL can import two file types created by ReCycle:

- REX files (export file format of the first versions of ReCycle, extension “.rex”).
- REX 2 files (file format of ReCycle 2.0 and later, extension “.rx2”).

Proceed as follows:

1. Select an audio track and move the project cursor to where you want the imported file to start.
   You probably want to import REX files to tempo based audio tracks, since this will allow you to change the tempo later on (having the imported REX file automatically adjust).

2. Select “Audio File…” from the Import submenu on the File menu.

3. Select REX files or REX 2 files with the file type pop-up menu in the file dialog.

4. Locate and select the file and click Open.
   The file is imported, and automatically adjusted to the current Cubase SX/SL tempo.
   Unlike a regular audio file, the imported REX file will consist of several events, one for each “slice” in the loop. The events will automatically be placed in an audio part on the selected track, and positioned so that the original internal timing of the loop is preserved.

5. If you now open the part in the Audio Part Editor, you can edit each slice separately by muting, moving and resizing events, adding effects and processing, etc.
   You can also adjust the tempo and have the REX file automatically follow (provided that its track is tempo based).

- You can also achieve similar results by using Cubase SX/SL’s own loop slicing features.
  See page 362.
Importing compressed audio files

During the last years, various audio compression formats have become very common. The major advantage of using such file formats is that the file size is significantly reduced, with very little degradation of sound quality. This allows for quick download, mass storage and easy transportation.

Cubase SX/SL can import (and export, see page 627) several common audio compression formats. The procedure is the same as when importing any non-compressed audio file, with one important thing to note:

- If you import a compressed audio file, Cubase SX/SL will create a copy of the file and convert this to Wave format (Windows) or AIFF format (Mac OS X) before importing it (the original compressed file will not be used in the project). The Wave/AIFF file will be placed in the designated Project Audio folder. Please be aware that the converted Wave/AIFF file will be several times larger than the original compressed file!

The following file types are supported:

MPEG audio files

MPEG, which stands for Moving Picture Experts Group, is the name of family of standards used for coding audio-visual information (e.g. movies, video, music) in a digital compressed format.

Cubase SX/SL can read three types of audio MPEG files: MPEG Layer 1 (file extension *.mpeg), MPEG Layer 2 (*.mp2) and MPEG Layer 3 (*.mp3). Currently, mp3 is the most common format of these, while the mp2 format is mostly used in broadcast applications.

- Note that the file extension “.mpeg” can also be used by MPEG video files. If you select an MPEG video file in the Import Audio dialog you will not be able to import it.

Ogg Vorbis files

Ogg Vorbis is a relatively new format that is open and patent-free and offers very small audio files maintaining comparatively high audio quality. Ogg Vorbis files have the extension “.ogg”.

The following file types are supported:
Windows Media Audio files (Windows only)

Windows Media Audio is an audio format developed by Microsoft Inc. Due to advanced audio compression algorithms, Windows Media Audio files can be made very small, maintaining good audio quality. The files have the extension ".wma".

Options and Settings

Auto Save

If you activate the Auto Save checkbox in the Preferences dialog (User Interface page), Cubase SX/SL will automatically save backup copies of all open projects with unsaved changes.

- You specify how often a backup copy should be created with the Auto Save Interval setting.
- Backup copies are named “Name.bak”, where “Name” is the name of the project. The files are saved in the project folder.
- Unsaved projects are also backed up in the same way. Backup copies of unsaved projects will be named “#UntitledX.bak” where “X” is an incremental number, to allow multiple backup copies in the same project folder.
**Startup Options**

The “On Startup” pop-up menu in the Preferences dialog (User Interface page) allows you to specify what should happen each time you launch Cubase SX/SL. The following options are available:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do Nothing</td>
<td>Cubase SX/SL launches without opening a project.</td>
</tr>
<tr>
<td>Open Last Project</td>
<td>The last saved project is opened on launch.</td>
</tr>
<tr>
<td>Open Default Project</td>
<td>The default project is opened (see page 698).</td>
</tr>
<tr>
<td>Show Open Dialog</td>
<td>The Open dialog appears on launch, allowing you to manually locate and open the desired project.</td>
</tr>
<tr>
<td>Show Template Dialog</td>
<td>The Template dialog appears on launch, allowing you to create a new project from one of the templates.</td>
</tr>
<tr>
<td>Show Open Options Dialog</td>
<td>The Open Document Options dialog appears on launch, see below. It allows you to make a different choice each time you launch Cubase SX/SL.</td>
</tr>
</tbody>
</table>
Cubase SX/SL Open Document Options Dialog

The Cubase SX/SL projects you have used recently are displayed in the list. To open one of them, select it and click the “Open Selection” button. To open another project not listed there, click the “Open Other...” button. A file dialog appears that allows you to look for the desired file on your disk. Click the “New Project” button to create a new project using a template or not.

If you hold down [Ctrl]/[Command] while launching Cubase SX/SL this dialog will always be displayed, regardless of the startup option selected in the Preferences dialog (User Interface page).
32

Key Commands
Background

Introduction

Most of the main menus in Cubase SX/SL have key command shortcuts for certain items on the menus. In addition, there are numerous other Cubase SX/SL functions that can be performed via key commands. These are all factory default settings. If you want, you can customize existing key commands to your liking, and also add commands for menu items and functions currently not assigned any.

You can also assign tool modifier keys, i.e. keys that change the behavior of various tools when pressed. This is done in the Preferences dialog – see page 724.

How are key command settings saved?

Every time you edit or add any key command assignment, this is stored as a global Cubase SX/SL preference – not as part of a project. Hence, if you edit or add a key command assignment, any subsequent projects that you create or open will use these modified settings. However, the factory default settings can at any time be restored by selecting "Reset All" in the Key Commands dialog. In addition, you can save (Export) complete key command settings as a “key commands file”, which can be stored separately and imported into any project. This way you can quickly and easily recall customized settings, when moving projects between different computers, for example. See later in this chapter for details on how to save complete key command settings.
The Key Commands dialog

Adding or modifying a key command

In the Key Commands dialog you will find all main menu items and a large number of other functions, all arranged on different “pages” depending on which menu/window they belong to. You can also open a list of the currently assigned key commands by clicking the “Show List” button. To add a key command, proceed as follows:

1. Pull down the File menu and select “Key Commands…”.  
The Key Commands dialog appears.

2. Use the list in the Categories column to select the preferred page.  
You may have to use the vertical scroll bar to display the desired page.
3. In the Commands list, select the item to which you wish to assign a key command. Already assigned key commands are shown in the Keys section of the dialog.

If a selected item or function has a key command assigned already, it is displayed here.

4. Double-click in the “Type new Key Command” field and enter a new key command. You can choose between any single key or a combination of one or several modifier keys (Command, Option (Mac), Ctrl, Alt (Win), Shift) plus any key.

5. Click the Assign button. The new key command appears in the Keys List.

Please note that this will not replace any key command previously defined for the function. That is, you can have several different key commands for the same function. To remove an assigned key command, see “Removing a key command” below.

If the key command you enter is already assigned to another function, you will get a prompt asking if you want to replace the currently assigned command or cancel the operation.

6. Click OK to exit the dialog.
Removing a key command

To remove a key command, proceed as follows:

1. Pull down the File menu and select “Key Commands…”.
2. Use the list in the Categories column to select the desired page.
3. In the Commands list, select the item you wish to remove.
   The key command for the item is shown in the Keys list.
4. Select the key command in the Keys list and click the “Remove” button.
   You will get a prompt asking if you want to remove the key command or cancel the operation.
5. Click OK to close the dialog.

Setting up Macros

A Macro is a combination of several functions or commands, to be performed in one go. For example, you could select all events on the selected audio track, remove DC offset, normalize the events and duplicate them, all with a single command.

Macros are set up in the Key Commands dialog:

1. Click the Show Macros button.
   The Macro settings are shown in the lower part of the dialog. To hide these from view, click the button again.

2. Click New Macro.
   A new, unnamed Macro appears in the Macros list.

3. Use the Categories and Commands in the upper half of the dialog to select the first command you want to include in the Macro.
4. Click Add Command.
   The selected command appears in the Commands list in the Macros section.

5. Repeat this to add more commands to the Macro.
   Note that commands are added after the currently selected command in the list. This allows you to insert commands “in the middle” of an existing Macro.

   ![Macro with three commands]

   A Macro with three commands.

   • To remove a command from the Macro, select it in the lower Commands list and click Remove Command.

6. When you’re done, you may want to name the Macro by clicking it in the list to the left and typing a new name.

   After you’ve closed the Key Commands dialog, all Macros you have created appear at the bottom of the Edit menu, available for instant selection.

   ![Key Commands Dialog]

   You can also assign key commands to Macros. All Macros you have created appear in the upper section of the Key Commands dialog under the Macros category – just select each Macro and assign a key command as with any function.

   • To remove a Macro, select it in the Macros list in the Key Commands dialog and click Delete Macro.
Saving complete key command settings (export)

As mentioned previously, any changes made to the key commands (and Macros) are automatically stored as a Cubase SX/SL preference. It is also possible to store key commands settings separately. In this way, you can store any number of different complete key command settings for instant recall. Proceed as follows:

1. Set up the key commands and Macros to your liking.
   When editing key commands, remember to click “Assign” to keep the changes.
2. Click “Export”.
   A standard “Save As” dialog appears.
3. Navigate to the desired folder, and enter a name for the key commands file.
4. Click “Save”.
   A separate key commands file is created at the chosen location (the file gets the extension “*.key”). This file is actually a regular text file, and can be edited with any text editor.

Recalling saved key command settings (import)

To recall saved key command settings, proceed as follows:

Note that this operation will replace your existing key commands and Macros! If you want to be able to revert to these settings again, make sure to save them first!

1. Open the Key Commands dialog from the File menu.
2. Click “Import”.
3. Select the key commands file you wish to open.
4. Click “Open”.
   The opened key commands file replaces the current key command settings.
About the “Show List” function

Clicking this button opens a list of all currently assigned key commands divided into three columns: Keys, Categories and Commands – just like in the main Key Commands dialog. Note that this list only represents an overview and cannot be edited directly.

- If you press a key combination while viewing this list, the list automatically scrolls to the corresponding command (if available) and selects it in the list.
  This allows you to quickly check whether a certain key combination is “taken”.

Searching for key commands

If you want to know which key command is assigned to a certain function in the program, you can use the Search function in the Key Commands dialog:

1. Click the Search button.
   A search dialog appears.

2. Click in the text field at the top of the dialog and type in the function for which you want to know the key command.
   This is a standard word search function, so you should type the command as it is spelled in the program. Partial words are OK; to search for e.g. all quantize related commands you could type “Quantize”, “Quant”, etc.

3. Press [Return].
   The found commands are listed below. The left column shows the assigned key commands, if any.

4. When you’re done, click OK to close the dialog.
About the “Reset” and “Reset All” functions

These two buttons in the Key Commands dialog will both restore the factory default settings. The following rules apply:

• “Reset” restores the factory default key command setting for the function selected in the Commands list.

• “Reset All” will restore the factory default key commands for all commands.

Note that the “Reset All” operation will remove any changes that may have been made to the factory default key commands! If you want to be able to revert to these settings again, make sure to save them first!

The default key commands

As mentioned before there are numerous default key commands. These are listed in the Getting Started book for quick access, but you can also view a list of them in the program:

1. If you want to keep any unsaved changes that may have been made to the factory default settings, save them first by using the Export function (see page 721).

2. Click “Reset All”.
   A prompt appears asking if you want to reset all key commands.

3. Click “Reset All”.

4. Now click “Show List”.
   The factory default key commands are shown in the list.
Setting up tool modifier keys

A tool modifier key is what you press to get an alternate function when using a tool. For example, clicking and dragging and event with the Arrow tool normally moves it – holding down a modifier key (by default [Alt]/[Option]) will copy it instead.

The default tool modifier keys are listed in the Getting Started book, but you can customize them if needed. This is done in the Preferences dialog:

1. Open the Preferences dialog from the File menu (on the Mac, this is located on the Cubase SX/SL menu) and select the Editing – Tool Modifiers page.

2. Locate the action for which you want to edit the modifier key, by selecting an option in the Categories list. For example, the “copy” function mentioned above resides in the category “Drag & Drop”.

3. Select the action in the Action list.

4. Hold down the desired modifier key(s) and click the Assign button. The current modifier key(s) for the action is replaced. If the modifier key(s) you pressed are already assigned for this tool, you will be asked whether you want to replace them.

5. When you’re done, click OK to close the dialog.
Troubleshooting/FAQ
Frequently Asked Questions

This chapter contains answers to some commonly asked questions:

Q: When I import a Cubase 5 Song into Cubase SX/SL why doesn't it sound like it did before?
A: This is dependent on a number of things. For example, Cubase SX/SL doesn't import dynamic events, so if that function was used a lot in the Song there will be a discrepancy. Also, automation is handled differently in Cubase SX/SL. For a complete listing of what is and what is not imported, please refer to page 703 in the File Handling chapter.

Q: When I import a Cubase 5 Song, how do I move around my audio events in the Project window?
A: In Cubase 5, audio events were always placed in a part. In Cubase SX/SL, you can have both audio events and parts containing audio events in the Project window. So if what you want to do is to freely move around the events currently contained in the part – to other tracks for example – the solution is to select the part in the Project window and then select "Dissolve Part" from the Audio menu.

Q: I added my Remote device in the Device Setup but nothing happens.
A: Make sure you selected the right MIDI Input/Output Port for your remote control device. Open the Device Setup dialog, select your device in the Devices list and click the Setup tab.

Q: Where is the Toolbox?
A: Cubase SX/SL has no Toolbox. You select tools via the Quick menu (displayed by right-clicking in a window) or from the toolbar at the top of the current window.
Q: I have problems with audio playback – it stutters intermittently.

A: Check the VST Performance meter (selectable from the Devices menu). If the CPU load is showing high levels, try mixing down some audio tracks and/or VST Instrument channels.

If this doesn’t cure the problem, try increasing the Buffer size on the Device Setup dialog – VST Multitrack page (Mac OS X) or in the ASIO Control Panel (Windows).

Q: Is there any way to edit my audio parts in an external audio editor?

A: Currently there is no direct support for external audio editors. You can always bounce the part you want to edit and open it manually.

Q: I opened an audio file in my external audio editor, but there is no sound when I play it back. What could be the problem?

A: Make sure "Release ASIO Driver in Background" is activated (ticked) in the Device Setup - VST Multitrack dialog on the Devices menu. This allows other audio programs to temporarily “take over” audio playback when Cubase SX/SL is running.

Q: When using a VST Instrument, why is there a delay between playing a note on my MIDI device and the audio output?

A: This is what is referred to as audio system “latency”. Latency is the delay between when audio is “sent” from the program and when you actually hear it. The latency value depends on the audio card used and its drivers. Newer audio cards with specific ASIO drivers or Mac OS X drivers generally produce very low latency values.

Latency does not occur on MIDI playback to the VST Instrument, only during recording. Hence, if the latency of your audio system makes it difficult to play a VST Instrument, a workaround solution is to record using some other MIDI sound source, and switching the track output to the VST Instrument during playback.
Q: I can’t seem to activate MIDI Thru to play a connected MIDI device – what’s the problem?

A: Make sure the track is record enabled (the Record Enable icon for the track should be red) or is in Monitor mode (the speaker icon is lit).

If the problem persists, make sure MIDI Thru is enabled in the Preferences - MIDI page on the File menu (on the Mac, the Preferences dialog is located on the Cubase SX/SL menu).

If none of this solves the problem, check that you have connected your system properly – read the chapter “Setting up your system” in the Getting Started book.
About this chapter

This chapter lists all main menu items in Cubase SX/SL, for quick reference. However, you won’t find deeper explanations, backgrounds or procedures here – for this, please refer to the previous chapters in the manual.

Cubase SX/SL menu (Mac OS X only)

About Cubase SX/SL

This opens a window with information about the Cubase SX/SL version number etc.

Preferences…

The Preferences dialog contains various settings and options. The dialog has several pages, that you access by selecting items in the Explorer-like list on the left. To make settings without closing the dialog use the Apply button.

Use the Help button in the dialog for information about the items on the selected page.

Quit

This quits the program. If there are any unsaved changes in an open project, you will have the option of keeping these or discarding them before the program quits.
File menu

New Project

This item allows you to create a new untitled project. A list appears allowing you to select an empty project or a project template. The factory templates are preconfigured setups to suit various types of projects. A project can be saved as a template, and will then appear on this list.

After making a selection, a project file dialog appears allowing you to specify a folder where all files relating to the new project will be stored. Select an existing folder or click the Create button to create a new folder.

Open…

This item opens a file dialog allowing you to locate and open saved project files. Project files have the extension ".cpr". Several projects can be open at the same time, but only one can be active. The active project is indicated by the red light at the top left corner of the Project window.

Close

This closes the active window. If the Project window is active, the corresponding project will close.

Save

This saves any changes made to the project since you last saved. The Save command stores the project under its current name and location.

Save As...

Save As allows you to specify a new name and a new project folder for the project.
Save Project to New Folder...

This item allows you to save the project into a new empty folder. It has some additional features that can be used for archiving purposes.

When a new empty folder has been selected, a dialog appears where you can change the name of the project and set the following options:

- You can choose to minimize audio files.
  This will crop files based on the audio clips referenced in the project. As the clips used in the project may be references to much larger audio files, this can reduce the project size significantly.

- You can apply Freeze Edits.
  This will make all processing and applied effects (Cubase SX only) permanent for clips. See page 319.

- You can choose to remove all unused files.
  When you save a project to a new folder, all files relating to the project based on the options set will be saved in the new project folder. The contents of the original project folder will be left untouched. If you are absolutely certain that you do not have any further need for the original project files you can delete them.

Save as Template...

You can save any project as a template. When you create a new project, the available templates are listed, allowing you to base the new project on the selected template.

Saved templates will contain everything that was in the original project, including clips and events.

Revert

This menu item allows you revert to the last saved version of a project. If any new audio files has been recorded since you last saved, you have the option of keeping or deleting these.

Page Setup...

This item opens the standard Page Setup dialog, used for deciding about paper formats etc., before printing.
Print…

Opens the standard Print dialog, allowing you to select which pages to print, how many copies of each etc.

Import

Audio File…

This command lets you import audio files directly into a project. The imported file will be placed at the current cursor position of the selected audio track.

Audio CD… (Cubase SX only)

This opens the Import from Audio CD dialog where you can import audio from CDs. For details about the dialog, see page 706 or use the Help function in the dialog.

Video File…

This opens a file dialog allowing you to import a video file onto the video track. You do not have to create a video track before importing, it is automatically created. The imported video will be placed at the current cursor position.

Cubase Song/Arrangement/Part…

You can import songs, arrangements and parts created with previous versions of Cubase (3.7 or later). Due to the complete redesign of Cubase SX/SL, there are certain limitations. Exactly what is and isn’t imported from the different previous versions is described on page 703.

MIDI File…

You can import Standard MIDI Files of Type “0” (all data on single track) or Type “1” (data on several tracks). When you import, you can choose to import the file into the current project, or to create a new project.
Export

MIDI File...
This allows you to export your MIDI files as a Standard MIDI file. See page 702 for more information.

Audio Mixdown...
This allows you to export all your audio tracks, complete with effects and automation to one or several audio files, in one of several file formats. This is described on page 625.

Preferences...

• Under Mac OS X, the Preferences dialog is reached from the Cubase SX/SL menu.

The Preferences dialog contains various settings and options. The dialog has several pages, that you access by selecting items in the Explorer-like list on the left. To make settings without closing the dialog use the Apply button.

Use the Help button in the dialog for information about the items on the selected page.
Recent Projects

This submenu provides shortcuts to the most recent projects you have been working with. The list is chronological with the most recent project at the top of the list.

Cleanup...

The Cleanup function helps you to save hard disk space by locating unused files which you can delete in the project folders on your disk.

Key Commands...

The Key Commands dialog allows you to create key commands for virtually any Cubase SX/SL function, as well as customizing existing key commands to your liking. Use the Help button in the dialog for information about the items in the dialog.

Quit

• Under Mac OS X, this item is reached from the Cubase SX/SL menu.

This quits the program. If there are any unsaved changes in an open project, you will have the option of keeping these or discarding them before the program quits.
Edit menu

Undo/Redo

Cubase SX/SL offers wide-ranging, multiple Undo, allowing you to undo virtually any action you perform.

- To undo the last performed action, select Undo from the Edit menu, or use the corresponding key command (by default [Ctrl]/[Command]-[Z]).
  If you select Undo again, the previously performed action will be undone, and so on.
- To redo the last undone action, select Redo from the Edit menu or use the corresponding key command (by default [Ctrl]/[Command]-[Shift]-[Z]).
  Undone actions will be available for Redo until you perform another action (at which point the “Redo Stack” is cleared – see “History...” below).

☐ You can specify how many levels of Undo should be available with the “Maximum Undo” setting on the User Interface page in the Preferences dialog on the File menu.

History...

The Edit History window contains a graphic representation of the “Undo Stack” (the performed actions, with the most recent action at the top of the stack) and the “Redo Stack” (the undone actions, with the most recently undone action at the bottom of the stack). The two stacks are separated by a divider line.

The Edit History dialog allows you to undo or redo several actions in one go, by moving the divider between the Undo Stack and the Redo Stack (in essence, moving actions from the Undo Stack to the Redo Stack, or vice versa).

Cut/Copy/Paste

You can cut or copy selected events (or selection ranges) and paste them in again at the current cursor position on the original track(s).
Paste at Origin
This will paste an event to its original position, i.e. where it was originally cut or copied from.

Delete
This will delete all selected events.

Split at Cursor
This splits selected events at the cursor position. If no events are selected, all events on all tracks intersected by the cursor will be split.

Split Loop
This splits all events at the left and right locator positions.

Range
The items on the Range submenu have the following functions:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut Time</td>
<td>Cuts out the selection range and moves it to the clipboard. Events to the right of the removed range are moved to the left to fill out the gap.</td>
</tr>
<tr>
<td>Delete Time</td>
<td>The selection range is removed and events to the right are moved to the left to close up the gap.</td>
</tr>
<tr>
<td>Paste Time</td>
<td>Pastes the clipboard data at the start position and track of the current selection. Existing events are moved to make room for the pasted data.</td>
</tr>
<tr>
<td>Paste Time at Origin</td>
<td>Pastes the clipboard data back at its original position. Existing events are moved to make room for the pasted data.</td>
</tr>
<tr>
<td>Split</td>
<td>Splits any events or parts that are intersected by the selection range, at the positions of the selection range edges.</td>
</tr>
<tr>
<td>Crop</td>
<td>All events or parts that are partially within the selection range are cropped, that is, sections outside the selection range are removed. Events that are fully inside or outside the selection range are not affected.</td>
</tr>
<tr>
<td>Insert Silence</td>
<td>Inserts empty track space at the start of the selection range. The length of the inserted silence equals the length of the selection range. Events to the right of the selection range start are moved to the right to “make room”. Events that are intersected by the selection range start are split, and the right section is moved to the right.</td>
</tr>
</tbody>
</table>
Select

The items on this submenu have different functions, depending on whether the regular event selection tool (Arrow tool) or the Range Selection tool is selected:

Event selection

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Selects all events in the window.</td>
</tr>
<tr>
<td>None</td>
<td>Deselects all events.</td>
</tr>
<tr>
<td>In Loop</td>
<td>Selects all events that are partly or wholly between the left and right locator.</td>
</tr>
<tr>
<td>From Start to Cursor</td>
<td>Selects all events that begin to the left of the project cursor.</td>
</tr>
<tr>
<td>From Cursor to End</td>
<td>Selects all events that end to the right of the project cursor.</td>
</tr>
<tr>
<td>All on Selected Tracks</td>
<td>Selects all events on the selected track.</td>
</tr>
</tbody>
</table>
### Range selection

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>In the Project window, this makes a selection that covers all tracks, from the start of the project to the end. In the Sample Editor, this selects the whole clip.</td>
</tr>
<tr>
<td>None</td>
<td>Removes the current selection range.</td>
</tr>
<tr>
<td>In Loop</td>
<td>Makes a selection between the left and right locator. In the Project window, the selection will span all tracks.</td>
</tr>
<tr>
<td>From Start to Cursor</td>
<td>Makes a selection from the start of the project to the project cursor. In the Project window, the selection will span all tracks.</td>
</tr>
<tr>
<td>From Cursor to End</td>
<td>Makes a selection from the project cursor to the end of the project. In the Project window, the selection will span all tracks.</td>
</tr>
<tr>
<td>Select event</td>
<td>This item (only available in the Sample Editor) selects the audio that is included in the edited event only.</td>
</tr>
<tr>
<td>Left Selection Side to</td>
<td>Moves the left side of the current selection range to the project cursor position.</td>
</tr>
<tr>
<td>Cursor</td>
<td></td>
</tr>
<tr>
<td>Right Selection Side to</td>
<td>Moves the right side of the current selection range to the project cursor position.</td>
</tr>
<tr>
<td>Cursor</td>
<td></td>
</tr>
</tbody>
</table>
Duplicate/Repeat...

- Duplicate creates a copy of the selected event and places it directly after the original.
  If several events are selected, all of these are copied “as one unit”, maintaining the relative distance between the events.

- Selecting “Repeat…” from the Edit menu opens a dialog, allowing you to create a number of copies (regular or shared) of the selected event(s). This works just like the Duplicate function, except that you can specify the number of copies.

Fill Loop

This creates a number of copies starting at the left locator and ending at the right locator. The last copy is automatically shortened to end at the right locator position.

Move to

The following functions are available from this submenu:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to Cursor</td>
<td>Moves the selected event to the project cursor position. If there are several selected events on the same track, the first event will start at the cursor, and the following will be lined up end-to-start after the first one.</td>
</tr>
<tr>
<td>Move to Origin</td>
<td>Moves the selected events to their original positions, i.e. the positions at which they were originally recorded.</td>
</tr>
<tr>
<td>Move to Front/Move to Back</td>
<td>This function doesn’t actually change the position of the events, but moves the selected events to the front or back, respectively. This is useful if you have overlapping events, and want to see one that is partially obscured. For audio events, this is an extra important feature, since only the visible sections of events will be played back. Moving an obscured audio event to front (or moving the obscuring event to back) will allow you to hear the whole event on playback. Note that it is also possible to use the “Front” function on the event context menu for this (although this works in a different way – see page 34).</td>
</tr>
</tbody>
</table>
**Convert to Real Copy**

This creates a new version of a clip (that can be edited independently) and adds this to the Pool.

**Lock.../Unlock**

If you want to make sure you don’t edit or move an event by accident, you can lock the selected event(s). Locking can affect one (or any combination) of the following properties:

<table>
<thead>
<tr>
<th>Lock Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>If this is locked, the event cannot be moved.</td>
</tr>
<tr>
<td>Size</td>
<td>If this is locked, the event cannot be resized.</td>
</tr>
<tr>
<td>Other</td>
<td>If this is locked, all other editing of the event is disabled. This includes adjusting the fades and event volume, processing, etc.</td>
</tr>
</tbody>
</table>

To specify which of these properties should be affected by the Lock function, use the “Lock Event Attributes” pop-up menu in the Preferences dialog (Editing page).

Selecting locked events and choosing “Unlock” will unlock the events.

**Mute/Unmute**

You can mute (silence) events by selecting them and selecting “Mute”.

Similarly, you can unmute the selected events by selecting “Unmute”.
Zoom

The following options are available on the Zoom submenu on the Edit menu:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom In</td>
<td>Zooms in one step, centering on the position cursor.</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Zooms out one step, centering on the position cursor.</td>
</tr>
<tr>
<td>Zoom Full</td>
<td>Zooms out so that the whole project is visible. “The whole project” means</td>
</tr>
<tr>
<td></td>
<td>the timeline from the project start to the Length set in the Project Setup</td>
</tr>
<tr>
<td></td>
<td>dialog (see above).</td>
</tr>
<tr>
<td>Zoom to Selection</td>
<td>Zooms in horizontally so that the current selection fills the screen.</td>
</tr>
<tr>
<td>Zoom to Event</td>
<td>This option is available only in the Sample Editor (see page 336).</td>
</tr>
<tr>
<td>Zoom In Vertical</td>
<td>Zooms in one step vertically.</td>
</tr>
<tr>
<td>Zoom Out Vertical</td>
<td>Zooms out one step vertically.</td>
</tr>
<tr>
<td>Zoom In Tracks</td>
<td>Zooms in selected track(s) one step vertically.</td>
</tr>
<tr>
<td>Zoom Out Tracks</td>
<td>Zooms out selected track(s) one step vertically.</td>
</tr>
<tr>
<td>Zoom Tracks</td>
<td>This zooms in vertically on the selected track(s) and minimizes the height</td>
</tr>
<tr>
<td>Exclusive</td>
<td>of all other tracks.</td>
</tr>
</tbody>
</table>

Macros

If you have created Macros, these will be available on the Macros submenu. A Macro is a combination of several functions or commands, to be performed in one go. Macros are set up in the Key Commands dialog – see page 719.
Project menu

Add Track
This will add a track of the type selected on the Add Track submenu. Selecting “Multiple” allows you to add a specified number of tracks of a selected type.

Remove Selected Tracks
This will remove all selected tracks and any parts or events on them from the Project window.

Show Used Automation
This will open all used automation subtracks for all tracks.

Hide All Automation
This closes all open automation subtracks.

Pool
This opens the audio Pool, which contains all clips (audio and video) that belong to a project.

Markers
This opens the Marker window. Markers store positions to facilitate quick navigation to important locations in a project.

Tempo Track
This menu item opens the Tempo Track Editor. For tempo based tracks, the tempo can follow the Tempo track (activated with the Master button on the Transport panel), which may contain tempo changes.
Browser

This opens the Project Browser window which provides a list based representation of the project. This allows you to view and edit all events on all tracks by using regular value editing in a list.

Beat Calculator...

This opens the Beat Calculator window. The Beat Calculator is a tool for calculating the tempo of recorded audio or MIDI material.

Notepad

This opens a standard text notepad.

Project Setup...

This dialog contains general settings for a project. See the dialog help for specifics.

Auto Fades Settings...

This opens the Auto Fades dialog, where you can specify various fade options. Use the Help button in the dialog for details.
Audio menu

Process

Basically, you apply audio processing by making a selection and selecting a function from the Process submenu. For more details about what is affected see page 295. For details about the functions and parameters in the various processing dialogs, use the Help button in the corresponding dialog.

Envelope

The Envelope function allows you to apply a volume envelope to the selected audio.

Fade In/Out

Allows you to set fade-ins and fade-outs.

Gain

Allows you to change the gain (level) of the selected audio.

Merge Clipboard

This function mixes the audio from the clipboard into the audio selected for processing, starting at the beginning of the selection.

For this function to be available, you need to have cut or copied a range of audio in the Sample Editor first.

Noise Gate

Scans the audio for sections weaker than a specified threshold level, and silences them.
**Normalize**

The Normalize function allows you to specify the desired maximum level of the audio. It then analyzes the selected audio and finds the current maximum level. Finally it subtracts the current maximum level from the specified level, and raises the gain of the audio by the resulting amount (if the specified maximum level is lower than the current maximum, the gain will be lowered instead). A common use for normalizing is to raise the level of audio that was recorded at too low an input level.

**Phase Reverse**

Reverses the phase of the selected audio, turning the waveform “upside down”.

**Pitch Shift**

This function allows you to change the pitch of the audio with or without affecting its length. You can also create “harmonies” by specifying several pitches, or apply pitch shift based on a user specified envelope curve.

**Remove DC Offset**

This function will remove any DC offset in the audio selection. A DC offset is when there is too large a DC (direct current) component in the signal, sometimes visible as the signal not being visually centered around the “zero level axis”. DC offsets do not affect what you actually hear, but they affect zero crossing detection and certain processing, and it is recommended that you remove them.

It is recommended that this function is applied to complete audio clips, since the DC offset (if any) is normally present throughout the entire recording.

**Reverse**

Reverses the audio selection, as when playing a tape backwards.

**Silence**

Replaces the selection with silence.
Stereo Flip

This function works with stereo audio selections only. It allows you to manipulate the left and right channel in various ways.

Time Stretch

This function allows you to change the length and “tempo” of the selected audio, without affecting the pitch.

Plug-ins (Cubase SX only)

All installed effect plug-ins are available separately on the Audio menu. This allows you to apply effects processing to one or several selected events. See page 314 for more details.

Spectrum Analyzer (Cubase SX only)

This function analyzes the selected audio, computes the average “spectrum” (level distribution over the frequency range) and displays this as a two-dimensional graph, with frequency on the x-axis and level on the y-axis.

Statistics (Cubase SX only)

The Statistics function analyzes the selected audio (events, clips or range selections) and displays a window with various information. Use the Help button in the dialog for details.

Hitpoints

This is a special feature that detects transient attacks in audio material and adds a type of marker, a “hitpoint” at each attack. Once the hitpoints have been correctly set, you can slice up the file which amongst other things enables you to change the tempo without affecting pitch. See page 362 for a full description of this feature.

Detect Silence

The Detect Silence function searches for silent sections in an event, and either splits the event, removing the silent parts from the project, or creates regions corresponding to the non-silent sections.
**Event as Region**

This function is available when one or several audio events are selected. It creates a region in the corresponding clip, with the start and end position of the region determined by the start and end position of the event within the clip.

**Event from Regions**

This function is available if you have selected an audio event whose clip contains regions within the boundaries of the event. The function will remove the original event and replace it with event(s) positioned and sized according to the region(s).

**Create Region(s)**

This allows you to create a region based on the current selection in the Sample Editor.

**Events to Part**

This allows you to create a part from selected audio events.

**Close Gaps**

This function is primarily intended for the Hitpoints feature, to close the gaps created when playing back an audio file that has been sliced for tempo changes at a tempo lower than the original.

**Dissolve Part**

This menu item dissolves a selected audio part and makes any audio events it contains appear as independent objects on the track.

**Snap point to cursor**

This allows you to set the snap point to the current cursor position. See page 339.

**Bounce Selection**

This allows you to create either a new clip or a new audio file from a selection.
Crossfade

This allows you to create a crossfade between two selected consecutive audio events.

- If the two events overlap, the crossfade will be applied to the overlapping area.
- If they do not overlap (but their respective audio clips do) the events are resized and a crossfade is applied in the overlapping range.

For more information about crossfades, see the chapter “Fades and Crossfades”.

Remove Fades

This will remove any fades or crossfades from a selected event.

Open Fade Editor(s)

This opens the Fade dialog for a selected event. Note that this will open two dialogs if the event has both fade-in and fade-out curves.

Find Selected in Pool

This can be used to quickly find the clips in the Pool for events selected in the Project window. When this menu item is selected, the Pool opens with the corresponding clip(s) highlighted.

Adjust Fades to Range

This allows you to adjust a fade area according to a range selection.

Offline Process History

This opens the Offline Process History dialog. In the dialog you can remove some or all processing previously applied to a clip. See the dialog help for details.

Freeze Edits

This allows you to make any processing or applied effects permanent for a clip. See page 319.
MIDI menu

Open Key Editor

This opens the Key Editor for a selected MIDI Part. This editor consists of a piano-roll type graphic interface, with the notes shown as boxes in a grid.

Scores submenu (Cubase SL only)

If you are using Cubase SL, this is where you open the Score Editor and make score settings. Note that the three last items on this submenu are only available when the Score Editor is open and the active window.

Open Score Editor

Opens the Score Editor for the currently selected part(s).

Staff Settings

Brings up a dialog in which you can make settings for the currently active staff (track). In the Score Editor, the active staff is indicated by a black rectangle in the left part of the first visible bar - click in a staff to make it the active staff. For a description of the items in the Staff Settings dialog, please use the Help button in the dialog.

Set Font

Allows you to make font, size and style settings for text you have inserted in the score with the Text tool. If a text block is selected when you make settings in this dialog, the settings will only apply to that text. If you make settings with no text block selected, the settings will be used as default (automatically applied to all text you enter from that point on).

Flip Stems

Flips the direction of the stems of the selected notes.
Open Score Editor (Cubase SX only)

This opens the Score Editor where MIDI data is interpreted as a musical score. See the separate Score pdf document for details.

Open Drum Editor

This opens the Drum Editor which is designed especially for editing drum and percussion tracks.

Open List Editor

This opens the List Editor. In this editor, MIDI notes, controllers and other events are shown in a list.

Over Quantize

Quantizing is a function that automatically moves recorded notes, positioning them on exact note values. This quantizes the selected MIDI parts or notes, according to the current Quantize pop-up menu setting.

Iterative Quantize

Instead of moving a note to the closest quantize grid position, Iterative Quantize moves it only part of the way. You specify how much the notes should be moved towards the grid with the Iterative Strength setting in the Quantize Setup dialog.

Quantize Setup

In the Quantize Setup dialog you can make various quantize settings. Use the help in the dialog for details.

Advanced Quantize

Quantize Lengths

This will quantize the length of the notes, without changing their start positions. At its most basic level, this function will set the length of the notes to the Length Quantize value on the toolbar of the MIDI editors.

This function is only available from within the MIDI editors.
Quantize Ends
The Quantize Ends function on the Quantize submenu will only affect the end positions of notes. Apart from that, it works just like regular quantizing, taking the Quantize pop-up menu setting into account.

Undo Quantize
You can revert the selected MIDI notes to their original, unquantized state at any time. This is independent from the regular Undo History.

Freeze Quantize
There may be situations when you want to make the quantized positions "permanent". For example, you may want to quantize notes a second time, having the results based on the current quantized positions rather than the original positions. To make this possible, select the notes in question and use this function.

Transpose…
This opens the Transpose dialog, where you can make transpose settings for selected notes.

Merge MIDI in Loop
This combines all MIDI events between the left and right locator on all unmuted tracks and generates a new MIDI part, containing all the events as you would hear them play back. The new part will end up on the selected track, between the locators. You are asked whether to include MIDI insert effects and/or send effects and whether to overwrite (erase) the data on the destination track.

A typical use for this is to “freeze” the settings you have made in the MIDI Track Inspector, applying e.g. MIDI effects to a single part.
Dissolve Part

This item has two uses:

- To separate events according to MIDI channel when a MIDI Part contains events on different channels (MIDI channel “Any”).
- To separate MIDI events according to pitch. Drum tracks typically have separate drum sounds for each pitch.

See page 465 for a closer description of these functions.

O-Note Conversion

This function (only available if a drum map has been assigned for the MIDI track) goes through the selected MIDI part(s) and sets the actual pitch of each note according to its O-note setting. This is useful if you want to convert the track to a “regular” MIDI track (with no drum map) and still have the notes play back the correct drum sound.

Functions

Legato

Extends each selected note so that it reaches the next note. You can specify the desired gap or overlap with the “Legato Overlap” setting in the Preferences dialog (MIDI – Function Parameters page).

Fixed Lengths

Resizes all selected notes to the length set with the Length Quantize pop-up menu on the MIDI Editor toolbar.

This function is only available from within the MIDI Editors.

Delete Doubles

Removes double notes, i.e. notes of the same pitch on the exact same position. Double notes can occur when recording in Cycle mode, after Quantizing, etc. This function always affects whole MIDI parts.
Delete Controllers

Removes all non-note Events from the selected MIDI parts. This function always affects whole MIDI parts.

Delete Notes...

Allows you to delete very short or weak notes. This is useful for automatically removing unwanted “ghost notes” after recording. Selecting “Delete Notes…” opens a dialog in which you set up the criteria for the function.

Restrict Polyphony

Selecting this item opens a dialog in which you can specify how many “voices” should be used (for the selected notes or parts). Restricting the polyphony this way is useful when you have an instrument with limited polyphony and want to make sure all notes will be played. The effect is achieved by shortening notes as required, so that they end before the next note starts.

Pedals to Note Length

This function scans for sustain pedal on/off events, lengthens the affected notes to match the sustain pedal off position, and then removes the Sustain Controller on/off events.

Delete Overlaps (mono)

This function allows you to make sure that no two notes of the same pitch overlap (i.e. that one starts before the other ends). Overlapping notes of the same pitch can confuse some MIDI instruments (a new Note On is transmitted before the Note Off is transmitted). This command can then be used to automatically rectify the problem.

Delete Overlaps (poly)

This function shortens notes when required, so that no note begins before another ends. This happens regardless of which pitch the notes have.
Velocity…

Opens a dialog that allows you to manipulate the velocity of notes in various ways.

Fixed Velocity

This function sets the velocity of all selected notes to the Insert Velocity value on the toolbar in the MIDI Editors.

Reverse

This inverts the order of the selected events (or of all events in the selected parts), causing the MIDI music to play backwards. Note though, that the effect is different from reversing an audio recording. With MIDI, the individual notes will still play as usual in the MIDI instrument – it’s only the order of playback that is changed.

Logical Editor…

This opens the Logical Editor where you can perform advanced “search and replace” operations on MIDI data. The Logical Editor is described on page 561.

Logical Presets

This submenu contains various presets for use with the Logical Editor.

Drum Map Setup…

This is where you load, create, modify and save drum maps. The list to the left shows the currently loaded drum maps; selecting a drum map in the list displays its sounds and settings to the right.

Reset

This function sends out note-off messages and resets controllers on all MIDI channels. You can use this if you experience hanging notes or stuck controllers etc.
Scores menu (Cubase SX only)

The items on the Scores menu are described separately in the pdf document “Score Layout and Printing” (opened from the Windows Start menu or the Help menu in the program).

Pool menu

Import Medium…

The Import Medium dialog is used for importing files directly into the Pool. It is only available from the Pool menu when the Pool is open.

Import Audio CD… (Cubase SX only)

This opens a dialog that allows you to import audio from audio CDs.

Import Pool…

Steinberg’s Nuendo application can export the Pool as a separate file (file extension “.npl”). Such Pool files can be imported into Cubase SX/SL, by using the Import Pool command on the Pool menu. When you import a Pool file, the file references in it are “added” to the current Pool.

The audio and video files themselves are not saved in the Pool file, only a reference to them. For there to be any point in importing a Pool file, you need access to all reference files (which preferably should have the same file paths as when the Pool was saved).

Export Pool…

This allows you to export the pool as a separate file (see above).
Find Missing Files…

This opens the Resolve Missing Files dialog that can be used to find referenced files that may have been moved or renamed etc.

In the dialog that appears, decide if you want the program to try the find the file for you (Search), if you want to do it yourself (Locate) or if you want to specify in which directory the program should search for the file (Folder).

Remove Missing Files

If the Pool contains audio files that cannot be found or reconstructed, you may want to remove these:

Select this item to remove all missing files from the Pool (and remove their corresponding events from the Project window).

Reconstruct

If a missing file cannot be found (e.g. if you have accidentally deleted it from the hard disk) it will normally be indicated with a question mark in the Status column in the Pool. However, if the missing file is an edit file (a file created when you process audio, stored in the Edits folder within the project folder), it may be possible for the program to reconstruct it by recreating the editing to the original audio file. See page 393.

Convert Files…

This opens the Convert Options dialog which operates on selected files. Use the pop-up menus to specify which audio file attributes you want to keep and which you want to convert.

Conform Files…

This will change all selected files that have different file attributes to what is specified for the project, to conform to this standard.

Create Folder

This allows you to create a new audio subfolder and designate this as your Pool Record folder.
Empty Trash
To delete a file permanently from the hard disk, it must first be moved to the Trash folder. When clips are in the Trash folder they can be removed permanently by using this command.

Remove Unused Media
This function finds all clips in the Pool that are not used in the project, and either moves them to the Pool Trash folder where they can be permanently deleted, or removes them from the Pool.

Prepare Archive...
This command should be used when you want to archive a project. It checks that every clip referenced in the project is located in the same folder.

Set Pool Record Folder
This is used to designate a new Pool Record folder. Select the folder, and choose this command to change the Pool Record folder to the selected folder.

Minimize File
This allows you to change the size of audio files according to the audio clips referenced in a project. The files produced using this option will only contain the audio file portions actually used in the project, which can significantly reduce the size of the project (given that large portions of the audio files are unused).

Update Origin
The original start position where a clip was recorded in the project is shown in the Pool “Origin Time” column. As this value can be used as a basis for the “Insert into Project” Pool menu item (and other functions), you can change it if the Origin Time value is redundant. This can be done by selecting the corresponding clip in the Pool, moving the project cursor to the new desired position and selecting this menu item.
New Version

This allows you to create a new version of a selected clip. The new
version appears in the same Pool folder, with the same name but with
a "version number" after it, to indicate that the new clip is a duplicate.
The first copy made of a clip will logically get the version number “2”
and so on.

• Copying a clip does not create a new file on disk, but just a new edit ver-
sion of the clip (referring to the same original file).

Insert into Project

This allows you to insert clips selected in the Pool to the project. Ei-
ther the Origin Time value or the current cursor position can decide
where the clips are inserted, and is selected on the submenu for this
menu item.

Select in Project

If you want to find out which events in the project refer to a particular
clip in the Pool you can use this function. Select the clip in the Pool,
and use this menu item. The corresponding event(s) will then be se-
lected in the Project window.

Find in Pool...

You can perform a search of the Pool to locate particular clips or re-
gions. You can specify various criteria to match in the dialog that ap-
ppears.
**Transport menu**

**Transport Panel**

This opens the Transport panel.

**Locators to Selection**

This will set the locators to encompass the currently selected range.

**Locate Selection**

This moves the project cursor to the start of the currently selected range.

**Locate Next Marker**

This moves the project cursor to the next marker position.

**Locate Previous Marker**

This moves the project cursor to the previous marker position.

**Locate Next Event**

This moves the project cursor to the next event start or end on the selected track.

**Locate Previous Event**

This moves the project cursor to the previous event start or end on the selected track.

**Play from Selection Start**

This will move the project cursor to the start of the current selection and activate playback.
Play from Selection End
This will move the project cursor to the end of the current selection and activate playback.

Play until Selection Start
This activates playback two seconds before the start of the currently selected range and stops at the selection start.

Play until Selection End
This activates playback two seconds before the end of the selected range and stops at the selection end.

Play until Next Marker
This will activate playback from the current project cursor position to the next marker and stop.

Play Selection Range
This will play back the current selection range and stop at the end.

Loop Selection
This will loop playback of the current selection range.

Use Pre/Post-Roll
If this is ticked, Pre/Postroll is activated. This is described on page 48.

Start Record at Left Locator
If this is ticked, the project cursor will jump to the left locator position and begin recording when you hit the Record button. If this is off (unticked), recording will start directly from the current project cursor position.
Metronome Setup
This opens the Metronome Setup dialog where you can make various metronome settings.

Metronome On
This activates the metronome.

Sync Setup
This opens a dialog where settings relating to synchronization can be made.

Sync Online
This activates synchronization.
Devices menu

MIDI Device Manager

The MIDI Device manager allows you to install MIDI devices. You can either select pre-configured MIDI devices from a list, or define a device from scratch. For information about installing MIDI devices, please refer to the chapter “MIDI devices and patches”.

Mixer

This opens the Mixer. All audio, MIDI and group tracks in a project have a corresponding channel strip in the Mixer, as do any activated VST Instruments and ReWire channels. The Master bus fader can also be shown in the Mixer.

Plug-in Information

The Plug-in Information window lists all installed VST, DirectX and MIDI plug-ins, and shows various information about them.

True Tape (Cubase SX only)

TrueTape™ is a unique Steinberg technology that emulates the behavior of a professional analog tape recorder. This effect is applied when you record audio – in other words, TrueTape can be viewed as a separate recording mode. Selecting this item opens the TrueTape panel, in which you can activate and set up TrueTape.

VST Inputs

This opens the VST Inputs window, which allows you to activate audio inputs connected to your audio hardware.

VST Instruments

This opens the VST Instruments window, where you can select up to 32 VST Instruments (16 in Cubase SL). When a VST Instrument has been selected for a slot in the window, the corresponding instrument is selectable as a destination on the MIDI output pop-up for MIDI tracks.
VST Master Effects

Up to 8 Master effects can be added to the signal on the Master bus (up to 4 in Cubase SL). The last two effect slots are post Master gain (in Cubase SL there is one - slot 4), which is useful for dithering plug-ins.

VST Master Setup (Cubase SX only)

This opens the VST Master Setup dialog, which is used for selecting various surround configurations.

VST Outputs

The VST Outputs window shows the output buses connected to the physical outputs on your audio hardware.

VST Performance

This window indicates the current CPU load and disk transfer rate.

VST Send Effects

This is used for selecting global send effects. Up to 8 send effects can be selected.

Video

This opens the default video player. The default video player is selected in the Device Setup dialog.

Show Panel

This opens a panel where you can directly select any of the current devices on the Device menu.

Device Setup...

This dialog allows you to add or remove remote control devices and to make various basic settings for audio and MIDI such as selecting ASIO drivers and MIDI ports etc.
Window menu

Close
This closes the currently active window. If the active window is a Project window, the project will close.

Close All
This closes all windows including all open projects.

Minimize All
Minimizes all windows.

Restore All
Restores all minimized Cubase SX/SL windows.

Tile Horizontal/Vertical (Windows version only)
Arranges the open windows next to each other on screen.

Cascade (Windows version only)
Arranges the open windows in a partially overlapping pattern.

Window Layout
A configuration of windows for the active project is called a “Window Layout”. By storing different window combinations as Window Layouts, you can quickly switch between different working modes.

Windows...
This opens a dialog where you can manage and make settings for all open windows.

The open windows list
Selecting a window from the list at the bottom of the menu brings it to front.
Help menu

HTML Help (Windows) / Cubase SX/SL Help (Mac OS X)

This opens the browsable Help. You can also get help on specific windows and dialogs by pressing [F1] or clicking the Help button in a dialog.

Documentation (Acrobat PDF format)

Getting Started

Opens the Getting Started book in Acrobat pdf format. To read this you need to have the Acrobat Reader installed (included with Cubase SX/SL).

Operation Manual

Opens the Operation Manual (this document) in Acrobat pdf format. To read this you need to have the Acrobat reader installed (included with Cubase SX/SL).

Score Layout and Printing (Cubase SX only)

Opens the separate pdf document about using the Cubase SX Score Editor. To read this you need to have the Acrobat reader installed (included with Cubase SX/SL).

Steinberg on the Web

On the submenu you can select various Steinberg related web pages. Selecting one will open the corresponding page in your default browser. An active internet connection is required.

About Cubase SX/SL

- Under Mac OS X, this menu item is reached from the Cubase SX/SL menu.

This opens a window with information about the Cubase SX/SL version number etc.
Index
A
A1 Synthesizer 211
Activate Project button 696
Active ASIO Ports for Data only 675
Active Staff 543
Add Track 71
Adjust Fades to Range 123
Aftertouch
   Deleting 513
   Editing 509
   Recording 43
AIFF files 629
Always use MIDI Clock Start 654
Any (MIDI Channel setting) 40
Apogee UV22/UV22 HR 188
APP
   Introduction to 647
   Setting Up 651
Apply Effects 314
AQ button 42, 473
Arpache 5 434
Arpeggiator 434
ASIO 2.0 31
ASIO Direct Monitoring 31
ASIO Positioning Protocol
   Introduction to 647
   Setting up 651
Audio Channels
   Copying Settings 163
   Linking 171
   Making Settings for 158
   Saving Settings 173
Audio Clips
   About 294
   Creating New Versions 386
   Deleting 388
   Locating Events 389
   Managing in Pool 386
   Opening in Sample Editor 395
Audio Effects
   About 179
   Applying 314
   Automating 265
   Editing 191
   In Surround Configurations 245
   Loading 192
   Naming 192
   Organizing in subfolders 198
   Parameters 196
   Pre/Post fader sends 183
   Saving 192
   Sends 182
   Tempo Sync 178
   Using VST System Link 679
Audio Events
   Blue Handles 122, 123
   Editing in Project Browser 609
   Editing in Sample Editor 330
   Making selections in 340
   Slicing 375
Audio Files
   Converting 403
   Deleting Permanently 388
   Exporting 627
   Format for recording 27
   Formats 396
   Import Options 74
   Importing into Pool 396
   Importing into
      Project Window 73
   Locating Missing 392
   Reconstructing Missing 393
   Removing Missing 393
Audio Inputs 25
<table>
<thead>
<tr>
<th>Audio Parts</th>
<th>Automation Events</th>
</tr>
</thead>
<tbody>
<tr>
<td>About 53</td>
<td>About 261</td>
</tr>
<tr>
<td>Creating by gluing events 85</td>
<td>Editing 262</td>
</tr>
<tr>
<td>Creating from Events 77</td>
<td>Editing in Project Browser 267</td>
</tr>
<tr>
<td>Drawing 77</td>
<td>Removing 265</td>
</tr>
<tr>
<td>Editing in Audio Part Editor 352</td>
<td>Selecting 264</td>
</tr>
<tr>
<td>Editing in Project Browser 608</td>
<td>Automation Subtracks</td>
</tr>
<tr>
<td>Sliding contents 87</td>
<td>Assigning parameters to 254</td>
</tr>
<tr>
<td>Auditioning</td>
<td>Hiding and Showing 256</td>
</tr>
<tr>
<td>Audio Part Editor 356</td>
<td>Muting 257</td>
</tr>
<tr>
<td>MIDI Editors 494</td>
<td>Opening 253</td>
</tr>
<tr>
<td>Project window 78</td>
<td>AutoPan (MIDI effect) 436</td>
</tr>
</tbody>
</table>
| Sample Editor 337 | B
| Auto Fades 133 | Backup (.bak) files 711 |
| Auto Monitoring modes 30 | Bank Select 408 |
| Auto Quantize 42, 473 | Bars+Beats Linear 489, 593 |
| Auto Quantize (Score) 546 | Beat Calculator 600 |
| Auto Save 711 | Bounce Selection 91, 343, 398 |
| Auto Scroll 100, 493 | Broadcast Wave files |
| Auto Select Events | Exporting 639 |
| under Cursor 519 | Recording 27 |
| MIDI Editors 496 | Browser 604 |
| Project Window 81 | Buses 166 |
| Autolatch mode 259 | Bypass |
| Automation | Effect sends 183 |
| About 250 | Insert effects 186 |
| Channel Automation Track 252 | C
| Editing in Project Browser 613 | Calculate (Hitpoints) 366 |
| Master Automation Track 252 | Channel (MIDI) 37 |
| Modes 259 | Channel Settings |
| Opening subtracks 253 | Audio Tracks 158 |
| Plug-in Automation tracks 252 | Copying 163 |
| Reduction Preference 269 | MIDI Tracks 170 |
| Showing and hiding 253 | Channel View Sets 144 |
| Write/Read buttons 258 | Chase 17 |
| | Chn setting 40 |
| | Chorder 438 |
Clean Lengths 548
Cleanup 700
Clef 547
Click 49
Clips, see “Audio Clips”
Close 697
Close Gaps 377
CM Motor Mix 277
Color pop-up menu
  MIDI Editors 559
  Project window 72
Compress (MIDI effect) 442
Conform Files 404
Control (MIDI Effect) 443
Controller Display
  About 491
  Adding and Removing Lanes 505
  Editing Events 509
  Editing Velocity 507
  Selecting Event Type 506
Controllers
  Deleting 513
  Editing 509
  Recording 43
Convert Files 403
Convert to Real Copy 83
Cpr files 697
Create Events
  (Cycle Rec Mode) 34
Create Groove Quantize 376
Create Images During Record 33
Create new controller lane 505
Create Regions (Cycle Rec Mode) 35
Create Slices 375
Crop 95
Crossfades
  Creating 128
  Editing in dialog 130
  Presets 132
  Removing 129
Csh files 401
Cubase 5 Plug-ins 199
Cubase files
  (previous versions) 703
Cut Time 94
Cycle
  About 24
  Recording Audio 34
  Recording MIDI 42
Cycle Markers
  About 110
  Adding in Marker window 112
  Drawing 115
  Editing 117
  Making selections with 118
  Navigating to 117
  On Marker track 114
Cycle Record modes 42
D
DC Offset 309
Deactivate Punch In on Stop 47
Default Edit Action 487
Default Project 698
Delete
  Audio Files from Disk 388
  Events in Project window 91
  MIDI Controllers 478, 513
  MIDI Drum notes 520
  MIDI Notes 500
Delete Controllers function 478
Delete Doubles function 478
Delete Notes function 479
Delete Overlaps
   Mono 480
   Poly 480
Delete Time 95
Density (MIDI Effect) 444
Detect Silence 320
DirectShow 683
DirectX Plug-ins 199
Disable Hitpoints 370
Disable Inserts 186
Disable Sends 183
Disable Track 15
Display format 61
Display Quantize 545
Display Transpose 547
Dissolve Part
   Audio 77
   MIDI 483
Dither 188
Divide audio events 377
Drag Delay 81
Draw
   Automation Events 262
   Hitpoints 372
   Markers 115
   MIDI Controllers 509
   MIDI Notes 494
   Parts 77
Dropout Time 659
Drum Editor
   Creating and editing notes 518
   Muting drum sounds 520
   Selecting drum maps 527
Drum Machine 227

Drum maps
   About 521
   Making settings 522
   MIDI Channel and Output 526
   O-Note Conversion 530
   Selecting 527
   Setup dialog 528
Drum mode (Timestretch) 313
Drum Name lists 530
Drum Sound Solo 520
Drumstick tool 518
Duplicate 82, 497
Duplicate Track 71

E
Earlier VST Plug-ins 199
Edit as Drums when Drummap is assigned 487
Edit button
   Audio Track Inspector 57
   MIDI Channel Strips 170
   MIDI Track Inspector 424
Editing via MIDI 502
Edits folder 294
Effects, see “Audio Effects” or “MIDI Effects”
Elements (Sample Editor) 331
Enable Record on
   Selected Track 21
Enable Track 15
Enharmonic Shift 555
Envelope 297
EQ
   Bypassing 162
   Presets 162
   Setting 160
Eraser tool 91
Event as Region 96
Events
- Duplicating 82
- Locking 88
- Moving 81
- Muting 90
- Overlapping 82, 355
- Removing 91
- Renaming 84
- Renaming all on Track 71
- Resizing 85
- Resizing with time stretch 86
- Selecting 80
- Sliding contents 87
- Splitting 84

Events (Snap mode) 98
Events from Regions 96
Events to Part 77, 358
Events, see also “Audio Events”
Exclusive Solo 154
Export Audio Mixdown 627
Export MIDI Files 702

F
- F button 537
- Fade handles 122
- Fade In/Out functions 124
- Faders 152
- Fades
  - Auto Fades 133
  - Creating 122
  - Editing in dialog 125
  - Presets 126
  - Processing 124
  - Removing 125
- Fill Loop 83
- Filter (MIDI) 46
- Filter (Project Browser) 612
- Filter bar 537
- Find Missing Files 392
- Find Selected in Pool 390

Fixed Lengths 478
Fixed Velocity 482
Flip Stems 556
Folder parts 107
Folder Tracks
  - About 102
  - Moving Tracks into 103
  - Muting and Soloing 104
- Foot button 503
- Frame Rates 658
- Freeze Edits 319
- Freeze Quantize 476

G
- Gain 298
- Generic Remote Device 287
- Glue Tube tool
  - Project window 85
  - Score Editor 555
- Grid (Snap mode) 98
- Groove Quantize 376
- Group Channel Tracks
  - About 52
  - Routing audio to 165
  - Using effects with 193
- GS Control Panel 454

H
- Hitpoint Edit tool 370
- Hitpoint Sensitivity 368
- Hitpoints
  - Auditioning 367
  - Background 362
  - Calculating 366
  - Disabling 370
  - Editing manually 372
  - Locking 371
- Houston 276
I
Ignore Hours 659
Import
  Audio CD 398
  Audio CD Tracks 706
  Audio files 73
  Cubase Arrangement 705
  Cubase Song 703
  Medium in Pool 396
  MIDI Files 702
  MPEG files 710
  Ogg Vorbis files 710
  Older Cubase Files 703
  REX 709
  Video files 73
  WMA files 711
Info Line
  Drum Editor 515
  Key Editor 489
  Pool 383
  Project Window 60
  Sample Editor 335
  Score Editor (Cubase SL) 541
I-Note 524
Input (MIDI) 37
Input Transformer 585
Insert Effects (Audio) 185
Insert into Project 390
Insert pop-up menu 534
Insert Silence 95, 343
Insert Velocity 495, 518
Inspector
  Audio tracks 57
  Folder tracks 58
  Handling 56
  MIDI Tracks 423
Interpolate Audio Images 336
Iterative Quantize 474

J
JL Cooper CS-10 278
JL Cooper MCS-3000 279
Jump tempo curve mode 595

K
Key (Scores) 547
Key Commands
  About 716
  Default 723
  Modifying 717
  Recalling Saved (Import) 721
  Removing 719
  Resetting to default 723
  Saving (Export) 721
  Searching for 722
  Show List 722

L
Lanes 354
Latency
  Monitoring 30
  VST System Link 667
Left Locator 110
Legato 478
Length Compression 428
Length Correction 45
Length Quantize 495
Level Faders 152
LFE Slider 243
Line mode
  Automation
    (Project window) 263
    MIDI Controllers 509
    MIDI Velocity 508
  Linear time base 72
List Editor
  Adding events 534
  Editing in the list 535
  Editing in the Value display 539
  Filtering events 537
  Masking events 538
LM-7 Drum Machine 227
Locate when clicked in empty space 13
Locators 110
Lock 88
Lock Event Attributes 88
Lock Hitpoints 371
Lock Time 659
Logical Editor
  About 562
  Actions 579
  Filter Conditions 566
  Functions 577
  Opening 564
  Presets 565, 584
Loop Icon
  Audio Part Editor 357
  Pool 394
  Sample Editor 337

M
Machine Control
  Introduction to 648
  Setting up 656
Mackie Control 276
Macros 719
Magnetic Cursor (Snap mode) 99
Magnifying Glass tool 64
Markers
  About 110
  Adding in Marker window 112
  Drawing on the Marker Track

MIDI
  Activation 49
  Settings 50
  Micro Tuner (MIDI Effect) 444
  MIDI Channel
    "Any" 40
    In drum maps 526
    Selecting for tracks 40
    Send effects 433
  MIDI Clock
    About 644
    Always use "Start" 654
    Transmitting 654
  MIDI Connector Button 502
  MIDI Device Manager 409
MIDI Devices
- Defining new 415
- Editing patches for 414
- Installing 410
- Selecting patches for 413

MIDI Echo 445

MIDI Effects
- About 430
- Deactivating 460
- Inserts 431
- Presets 433
- Sends 432

MIDI Files 702

MIDI Filter 46

MIDI Input (Editing via) 502

MIDI Input Transformer 585

MIDI Inputs
- Renaming 38
- Selecting for tracks 38

MIDI Notes
- Deleting 500
- Drawing 494
- Editing Velocity 507
- Moving 497, 519
- Muting 500, 520
- Quantizing 467
- Resizing 499
- Selecting 496, 519
- Splitting and Gluing 499
- Transposing 519
- Transposing (function) 477
- Transposing (in editor) 497

MIDI Outputs
- In drum maps 526
- Renaming 38
- Selecting for tracks 40
- Send effects 433

MIDI Parts
- About 53
- Drawing 77
- Editing 487
- Editing in Project Browser 610
- Sliding contents 87

MIDI Reset 44

MIDI Step Sequencer 450

MIDI Thru 37

MIDI Tracks
- Channel Settings window 170
- Selecting patches 413
- Settings 424
- Track Parameters 426

Minimize Files 401

Mix (Cycle Record mode) 42

Mixer
- Activating Buses 166
- Common Panel 149
- Extended channel strips 142
- Group Channels 165
- Link/Unlink Channels 171
- Loading Settings 174
- Master Gain Fader 168
- Pan 155
- Saving Settings 173
- Solo and Mute 154
- View Options 138
- Volume 152

Mixer Selection Follows Project 159

Mixing down to an audio file 627

MMC
- Introduction to 648
- Setting up 656
- Modifier Keys 724
- Monitor button
  - Audio tracks 30
  - MIDI tracks 37

Monitoring modes 30
Mono/Stereo button 29
Mono/Stereo Mismatch 76
Move Hitpoints 372
Move to Back 82
Move to Cursor 82
Move to Front 82
Move to Origin 82
MP3 files
  Exporting 634
  Importing 710
MPEG files
  Audio 710
  Video 683
MPEX
  Pitch Shift 304
  Time Stretch 313
Multiple Audio Tracks 71
Musical time base 72
Mute
  Events in Project window 90
  MIDI Notes 500, 520
  Mixer 154
  Tracks 90
  Mute Tool 90
New Project 62, 696
No Overlap 548
Noise Gate 300
Non Quantize setting 472
Normal Record mode 41
Normal Sizing 85
Normalize 301
Note On Priority 45
Notes to CC 448
Notes, see “MIDI Notes”
Npl files 402
Nudge position buttons 14
Numeric Keypad 12, 113
Offline Process History 317
Ogg Vorbis files
  Exporting 636
  Importing 710
On Import Audiofile 74
On Processing Shared Clips 295
On Startup setting 712
Online (VST System Link) 672
O-Note 524
O-Note Conversion 530
Open 696
Open Document Options 713
Output (MIDI) 37
Over Quantize 473
Overlapping Events 82, 355
Overview 70
Overwrite (Cycle Record mode) 42
Padlock Symbol 88
Pan Law 155
Parabola mode
  Automation
    (Project window) 263
    MIDI Controllers 510
    MIDI Velocity 508
Part Data mode 69
Parts, see “Audio Parts” or “MIDI Parts”
Paste at Origin 84
Paste Time 94, 498
Patch Banks 412
Patch Editor (Surround) 245
Pattern Sequencer 450
Peak Hold Time 164
Pedals to Note Length 480
Pencil tool 77
Pending Connections 703
Performance Meter 176
Phase Reverse 302
Pitch Bend
  Deleting 513
  Editing 509
  Recording 43
Pitch Shift 302
Play Icon
  Audio Part Editor 357
  Pool 394
  Sample Editor 337
Plug-in Automation tracks
  About 252
  Creating 253
  Opening 265
Plug-In Information window
  Audio plug-ins 200
  MIDI plug-ins 460
Plug-ins
  Applying 314
  Automating 265
  In Surround Configurations 245
  Organizing 198
  Parameters 196
Poly Pressure events 513
Polyphony (restricting) 480
Pool
  About 380
  Auditioning 394
  Convert Files 403
  Finding Clips in 389
  Handling Audio Clips 386
  Import Medium 396
  Importing Pool Files 402
  Locate Missing Files 392
  Record Folder 399
  Status column icons 385
Postroll 48
Pre/Post Crossfade 296
Precount 50
Preload Waves Plugins
  on Startup 198
Prepare Archive 401
Preroll 48
Prg field 413
Printing Scores 558
Processing
  About 295
  Plug-ins 314
  Settings and Functions 296
  Undoing 317
Program Change 408
Project
  Activating 696
  Creating 62, 696
  Default 698
  Opening 696
  Saving 697
  Saving Templates 700
Project Browser 604
Project Cursor
  Auto Scroll 100
  Moving 13
  Selecting Events with 81
  Snapping to 99
Project overview line 70
Project Setup dialog 62
Punch In
  Automatic 22
  Manual 22
Punch Out 23
Q
Quantize
   About 467
   Applying 473
   As MIDI effect 449
   Automatic during recording 473
   Creating grooves from audio 376
   Ends 476
   Freezing 476
   Lengths 474
   Setting on Toolbar 468
   Setup dialog 469
   Undoing 476
Quantizer (MIDI Effect) 449
Quick Zoom 65
Quicktime 683

R
R button 258
Radikal Technologies SAC-2K 281
Ramp tempo curve mode 595
Random (Track Parameter) 428
Random Quantize setting 472
Range (Track Parameter) 429
Range Selection tool 92
Read button 258
Real Audio Files 637
Rec Mode 41
Reconstruct 393
Record Catch Range 45
Record Enable 21
Record file type 27
Record Format 27
Recording in MIDI editors 45
ReCycle files 709
Redo 736

Regions
   Creating 344
   Creating from Events 96
   Creating with Detect Silence 322
   Editing 345
   Exporting as Audio Files 398
   Removing 346
   Rehearsal tempo 590
Remote Control
   Assigning Remote Key Commands 275
   Devices 276
   Writing Automation 274
Remove DC Offset 309
Remove Fades 125, 129
Remove Missing Files 393
Remove Parameter 265
Repeat 83, 497
Reset 44
Resolution 27
Resolving 646
Restrict Polyphony 480
Return To Start Position on Stop 15
Reverse 309
Reverse (MIDI function) 482
Revert 700
ReWire
   About 688
   Activating 690
   Channels 692
   Routing MIDI 693
REX files 709
Right Locator 110
Roland GS Control Panel 454
Roland MCR-8 280
Ruler 61
S button 90
Sample Rate 63
Sample Size 27
Save 697
Save Project to new folder 699
Scissors tool
  Project window 84
  Score Editor 555
Score
  Displaying 544
  Printing 558
Scrubbing
  Project window 79
  Resizing events by 86
  Sample Editor 338
Search Key Commands 722
Select
  Events in Project window 80
  MIDI Notes 496, 519
  Mixer Channels 159, 163
Send Effects (Audio) 180
Sensitivity slider 368
Set Pool Record Folder 399
Shared Copy 83
Shared VST Plug-ins Folder 198
Show Controllers 69
Show Data on Small Track Heights 68
Show Event Names 68
Show Event Volume Curves Always 68, 122
Show Used Automation 260
Show Video Thumbnails 686
Shuffle 548
Shuffle (Snap mode) 99
Silence 309
Sine mode 264, 510
Sizing applies timestretch 86
Sizing Moves Contents 85
Slices
  Auditioning 367
  Creating 375
  Disabling 370
  Locking 371
Snap
  MIDI Editors 559
  Project window 97
Snap Point
  Setting for Clips in Pool 395
  Setting in Project window 97
  Setting in Sample Editor 339
Snap Record Parts to Bars 45
Snap to Zero Crossing 100, 349
Snap Track Heights 65
Solo
  Audio Part Editor 356
  Folder Tracks 104
  MIDI Editors 493
  Mixer 154
  Tracks 90
Solo Group 154, 195
Solo Record in Editors 45
Speaker icon (MIDI Editors) 494
Speaker tool
  Audio Part Editor 356
  Project window 78
Speakers (SurroundPanner) 241
Spectrum Analyzer 323
Split
  Events 84
  Range 95
Split (Piano) Staff 545
Split at Cursor 84, 499
Split Loop 84, 499
Split MIDI Events 84
Square mode 264, 510
Staff Mode 545
Staff Settings 544
Start Record at Left Locator 22
Startup options 712
Static Value Line (Automation) 261
Stationary Cursors 100
Statistics 326
Step Designer 450
Step input 503
Stereo Flip 310
Stereo Pan Law 155
Stereo Split 630
Stop after Automatic Punchout 47
Strip Silence 322
Surround
About 232
Applying plug-ins 245
Positioning sounds 239
Setting up 237
Surround Panner 239
Swing 470
Sync Indicator 653
Sync Selection 607
Synchronization
About 642
Audio Card settings 651
Connections for 650
Formats 643
Frame Rates 658
Indicator (Transport bar) 653
Machine Control 656
Options 659
Synchronization Setup 649
Syncing equipment to
Cubase 654
To Timecode 651
Syncopation 548
System Exclusive
About 618
Bulk Dumps 618
Editing 622

Recording parameter changes 621

T
T button (Scores) 541
Tap Tempo 601
Tascam US-428 283
Templates 700
Tempo
About 590
Calculating 600
Editing 594
Editing in Project Browser 616
Setting in Rehearsal mode 598
Tapping 601
Tempo Based Tracks 72
Time Based Tracks 72
Time format 61
Time Linear 489, 592
Time Signature 599
Time Stretch 311
Timecode
About 643
Frame Rates 658
Synchronizing to 651
Tool Modifier Keys 724
Toolbar
Audio Part Editor 353
Drum Editor 515
Key Editor 488
List Editor 532
Pool 382
Project window 59
Sample Editor 332
Score Editor (Cubase SL) 540
Touch Fader mode 259
Track Controls (MIDI Effect) 454
Track FX (MIDI Effect) 458
Track List 55
Track Parameters 426
Track Types 52
Tracks
   Adding 71
   Changing height of 65
   Disabling/Enabling 15
   Locking 89
   Musical/Linear time base 72
   Removing 72
   Renaming 71
   Routing MIDI to VST Instruments 207
   Selecting 71
   Stereo/Mono 76
Transformer (MIDI effect) 563
Transparent Events 68
Transport Menu
   Functions 11
   Playback Options 16
Transport Panel
   Display Format 14
   Hiding and Showing 11
   Key Commands 12
   Overview 10
   Resizing 11
Transpose
   MIDI function 477
   Track Parameter 427
Triangle mode 264, 510
TrueTape 28

U
Undo
   About 736
   Processing 317
   Recording 33
   Undo Quantize 476
   Unlock 88
   Update Origin 384
   Use File Extension in File 698
   UV22/UV22 HR 188

V
VB-1 225
Velocity
   Editing 507
   Editing via MIDI 502
   MIDI function 481
   Velocity Compression 427
   Velocity Shift 427
   Video Cache Size 686
   Video for Windows 683
   Video Playback Engine 683
   Video Track
      About 684
      Editing in Project Browser 614
      Showing Thumbnails 686
Volume (Info Line) 152
Volume handle 123
VST Inputs 25
VST Instruments
   A1 Synthesizer 211
   Activating 207
   Automating 210
   Channels 208
   LM-7 227
   Routing tracks to 207
   Selecting patches 209
   Using VST System Link 678
   VB-1 Bass Synth 225
VST Master Setup 237
VST Outputs 166
VST Performance Window 176
VST Plug-ins 197
VST System Link
  About 662
  Activating 671
  Connections 664
  Latency 667
  MIDI 674
  Putting computers online 672
  Requirements 663
  Setting up sync 665
  Settings 668
VU-Meter Peak’s Hold Time 164

W
  W button 258
  Wave files 632
  Wave Image Style 68
  Waveform Zooming 64
  Waves plug-ins 198
  Windows Media Audio files
    Exporting 638
    Importing 711
  WMA files
    Exporting 638
    Importing 711
  Word Clock
    About 644
    Selecting for sync 651
    Setting up 650
  Write button 258

X
  X button 90
  XG Control Panel 454
  X-Over mode 259

Y
  Yamaha 01V 286
  Yamaha DM2000 276
  Yamaha XG Control Panel 454

Z
  Zero Crossings 100
  Zoom
    About 64
    Sample Editor 336
    Track height 65
    Waveforms 64
  Zoom N Tracks 65